Preface ................................................................. xv

Document Change Log ........................................... xv

About NiagaraAX Framework ..................................... 1–1

Well designed ......................................................... 1–1

The Niagara Framework solution ................................. 1–2

About control systems integration ............................... 1–2
About Java .......................................................... 1–3
About Virtual Machines ........................................... 1–3
About common networking and Internet protocols .......... 1–3
About programming for non-programmers ................... 1–3
About embedded systems capabilities ......................... 1–4
About distributed systems capabilities ......................... 1–4
About component software design ............................. 1–4
About Niagara software architecture ............................ 1–4

About Baja ........................................................... 1–5

About APIs .......................................................... 1–6
javax.baja ........................................................... 1–6
com.tridium ......................................................... 1–6

About Niagara building blocks .................................. 1–6

About modules ....................................................... 1–6

About module characteristics .................................... 1–7
About jar files ......................................................... 1–7
About module versions ............................................ 1–7
About module directory structure ............................... 1–8
About module benefits ............................................ 1–8

About components .................................................. 1–9

About slots .......................................................... 1–9
Slot type ............................................................. 1–10
Slot name ............................................................ 1–10
Slot definition ....................................................... 1–10
Flags ................................................................. 1–10
Facets ................................................................. 1–10
About master/slave components ............................... 1–11
About point components ......................................... 1–11
About component naming ....................................... 1–12
Escaped names ....................................................... 1–12
About palettes ....................................................... 1–12

About presentation ................................................ 1–13

About presentation modules ..................................... 1–13
About presentation xml (Px) ...................................... 1–13
About presentation design philosophy ......................... 1–14
About presentation media ........................................ 1–14

About stations ....................................................... 1–15

About BOG files .................................................... 1–16

About ORDs ........................................................ 1–16
### About Workbench

**Tour of the Workbench GUI**
- About Workbench window controls .......................... 2–1
- About the side bar panes ......................................... 2–2
- About side bars .................................................. 2–3
- About the side bar title bar ...................................... 2–3
- Types of side bars ............................................... 2–3
- About the bookmark side bar ................................... 2–4
- About the help side bar ......................................... 2–5
- About Jobs side bar ............................................. 2–5
- About the nav side bar .......................................... 2–6
- Types of nodes in the nav side bar tree ....................... 2–6
- About the nav side bar toolbar ................................ 2–7
- About the palette side bar ..................................... 2–8
- About the palette side bar toolbar ............................ 2–8
- About the Open Palette dialog box ............................ 2–9
- About the Todo list sidebar .................................. 2–9
- About the jobs side bar ........................................ 2–9
- About the bound ards side bar ................................. 2–10
- About the widget tree side bar ................................ 2–10
- About the Px properties side bar .............................. 2–11
- About the properties side bar .................................. 2–11
- About the view pane ............................................ 2–12
- About the console ............................................... 2–13
- About the menu bar ............................................ 2–13
- About the toolbar .............................................. 2–13
- About the locator bar ........................................... 2–14
- About the view selector ........................................ 2–15
- Types of popup menus ......................................... 2–15
- About the nav side bar popup menus ......................... 2–15
- About the wire sheet popup menu ............................ 2–16
- About the property sheet popup menu ...................... 2–16
- Px Editor popup menu ........................................... 2–17
- Types of data–presentation controls and options .......... 2–17
- Table controls and options .................................... 2–18
- Batch editing (or batch processing) .......................... 2–19
- Chart controls and options .................................... 2–19

**Customizing the Workbench environment**
- Creating Additional Windows .................................. 2–20
- Editing popup menu “new” item ............................... 2–20
- Creating tabs in the view pane ................................. 2–21
- Working with the Wire Sheet view ............................ 2–22
- Types of Workbench options .................................. 2–25
- General Workbench options .................................. 2–26
- Alarm console options ......................................... 2–26
- Alarm portal options .......................................... 2–27
- Text editor options ............................................ 2–28
- Lexicon editor options .......................................... 2–28
- Bajadoc options .................................................. 2–29
- Station copier options ......................................... 2–29
- Px editor options .................................................. 2–29
- Wire sheet options .............................................. 2–30
Data and Control Model .................................................. 3–1

About control points ...................................................... 3–1
  Types of control points .............................................. 3–1
  Other control components ........................................ 3–2
  About data value categories ....................................... 3–2
  About point types ...................................................... 3–2
  About point Out ........................................................ 3–2
  About point inputs ..................................................... 3–3
  About point actions .................................................... 3–3
  About override actions .............................................. 3–4
  About set (Fallback) action ......................................... 3–4
  Modifying default actions ........................................... 3–5
  About point facets ..................................................... 3–7
  Accessing and editing facets ....................................... 3–7
  Facets importance for Enum points ............................... 3–8
  Effect of facets on point actions .................................. 3–9

About point extensions .................................................. 3–10
  Extension process overview ....................................... 3–10
  Types of point extensions ......................................... 3–11
  About the proxy extension ........................................ 3–11
  About control extensions ........................................... 3–11
  Types of control extensions ....................................... 3–12
  About alarm extensions ............................................ 3–12
  Types of alarm extensions ......................................... 3–13
  About history extensions ........................................... 3–14
  Types of history extensions ....................................... 3–14

About control triggers .................................................. 3–15
  How triggers are used ................................................. 3–15
  About related objects ................................................ 3–15

About point status ....................................................... 3–16
  Types of status flags ................................................ 3–16
  Priority of status indication ....................................... 3–17
  How status flags are set ............................................. 3–17
  Simple control point status ....................................... 3–17
  Propagate Flags status option (linked Math and Logic objects) ............................ 3–18
  About “isValid” status check ........................................ 3–19

About writable points .................................................... 3–19
  About the priority scheme ......................................... 3–19
  Priority input scan ..................................................... 3–19
  Priority linking rules .................................................. 3–20
  Priority level conventions .......................................... 3–20
  About minimum On and Off times ................................... 3–20

About composites ........................................................ 3–21
  Some composite examples ......................................... 3–21
  Point-level composite ................................................ 3–21
  Folder-level composite .............................................. 3–23
  Composite issues ........................................................ 3–24

About Histories .......................................................... 4–1

Types of History Services ............................................. 4–2
  About the history service .......................................... 4–2
  About the history extension manager view ..................... 4–3
  About history service property sheet ............................ 4–3
  History service actions .............................................. 4–3
  About the audit history service ................................... 4–4
  About the log history service ..................................... 4–5

Types of history space views ......................................... 4–5
  About the history chart builder view ............................. 4–6
  About Time Zones and the Chart Builder view .................. 4–8
About alarms ................................................................. 5–1
  Alarm examples ......................................................... 5–1
  Overview of the alarming process .................................... 5–2
About alarm sources ...................................................... 5–3
  About alarm extensions and components .............................. 5–3
  About alarm extension properties ...................................... 5–3
  About alarm instructions ................................................ 5–6
  About notes .......................................................... 5–6
About the alarm service .................................................. 5–7
About memory alarm service ............................................. 5–7
About the On Call Service ............................................... 5–8
  About On Call Service alarm data in the alarm console ............ 5–9
About the On Call List .................................................... 5–10
About the On Call List Manager view ................................. 5–10
About the On Call Contact ............................................... 5–11
About the On Call Contact Manager view ............................. 5–12
About the On Call User Report view ................................... 5–13
  Exporting the On Call User Report view .............................. 5–14
About the Email Alarm Acknowledger ................................. 5–15
About the EmailService .................................................. 5–16
Contents

About the OutgoingAccount ................................................................. 5–17
About the IncomingAccount ................................................................. 5–19
About the Email Recipient (report-EmailRecipient) ..................................... 5–21

About the SmsService ................................................................. 5–22
About the Sms Alarm Acknowledger ......................................................... 5–22

Using Spy pages with the On Call Service ............................................. 5–24

Common alarm controls and indicators .............................................. 5–24

About the alarm database ................................................................. 5–25

Types of alarm service views ............................................................... 5–26
  About alarm extension manager ............................................................. 5–26
  Types of extension manager display features ........................................... 5–27
  About the Instructions Manager view .................................................... 5–27
  About the alarm class summary view .................................................... 5–29
  About the alarm database maintenance view .......................................... 5–30
  About the Alarm details dialog box ....................................................... 5–31
  Types of alarm database maintenance ................................................... 5–31
  About the alarm database view ............................................................. 5–31
  About alarm service property sheet ...................................................... 5–32

About alarm class ........................................................................ 5–32
  About alarm escalation ..................................................................... 5–33
  About alarm class properties .............................................................. 5–34
  About alarm class mapping ................................................................. 5–34

Types of alarm recipients ................................................................. 5–36
  About the console recipient ................................................................. 5–36
  About the alarm console .................................................................... 5–37
  Hide, show, add, and remove alarm data columns in the alarm console .... 5–37
  Types of Alarm Details View dialog boxes ............................................. 5–38
  About the station recipient ................................................................. 5–41
  About the On Call Recipient ............................................................... 5–41
  About the Email Recipient (email-EmailRecipient) .................................. 5–43
  About the Sms recipient .................................................................... 5–43
  About the lineprinter recipient ............................................................ 5–44

About Presentation XML (Px) ......................................................... 6–1

About Px views ........................................................................ 6–2
  Px views as slot properties ................................................................ 6–2
  About the New Px View wizard ........................................................... 6–3

About Px files ........................................................................ 6–3
  Shared Px files ................................................................................ 6–4

About Px viewer ........................................................................ 6–4

About Px Editor ........................................................................ 6–5
  About the Px Editor Canvas ............................................................... 6–6
  About Widget sizing in the Px Editor ..................................................... 6–6
  About Px Properties ........................................................................ 6–7
  Px Property concepts ......................................................................... 6–7
  About the Px Property palette ............................................................ 6–8
  Using Px Properties ........................................................................ 6–8
  Example use of Px Properties ............................................................. 6–9
  About Px Layers ............................................................................... 6–9
  About the Px Layers palette ............................................................... 6–10
  Using Px Layers ........................................................................ 6–10
    Add a new Px Layer in the Px Editor view ............................................. 6–10
    Add, remove or change a Px Layer assignment in the Px Editor view .... 6–10
    Rename a Px Layer ........................................................................ 6–11
    Remove a Px Layer ........................................................................ 6–11

View Source XML dialog box ......................................................... 6–11
About Widgets ................................................................. 6–12
  Widget layout ......................................................... 6–12
  Types of panes ..................................................... 6–13
  Widget painting ..................................................... 6–14
  Commands .............................................................. 6–14
  About widget properties ........................................... 6–14

About the PxInclude Widget ............................................ 6–15
  PxInclude Widget Concepts ........................................ 6–15
  Types of PxInclude Widget Properties .......................... 6–16

Using the PxInclude Widget ........................................... 6–17
  About ORD Variables ............................................... 6–18
  General Procedure for Using the PxInclude Widget and ORD Variables ............................. 6–19
  Examples Using PxIncludes and ORD Variables .............. 6–19
    Example: Using a Pxinclude Widget with a Single ORD Variable ...................................... 6–19
    Example: Using Pxinclude Widgets with Multiple ORD Variables .................................. 6–20

Animating Graphics .................................................... 6–20
  Data binding ............................................................ 6–20
  Types of bindings .................................................. 6–21
  Types of binding properties ....................................... 6–22
  About bound label bindings ........................................ 6–24
  About value bindings ................................................ 6–24
    Types of Converters ............................................... 6–24
  About spectrum bindings ........................................... 6–25
  About setpoint bindings ............................................ 6–25
  About increment setpoint bindings ............................... 6–26
  About spectrum setpoint bindings ............................... 6–26
  About action bindings .............................................. 6–26
  About table bindings ............................................... 6–26
  About field editor bindings ....................................... 6–27
  About Popup Bindings ............................................... 6–27
  Using the Popup Binding ............................................ 6–27
  Relative and absolute bindings ................................... 6–28

About Px target media .................................................. 6–29

About profiles ............................................................. 6–29
  About Web Profiles .................................................. 6–30
    Default Wb Web Profile ........................................... 6–30
    Simple Admin Wb Web Profile .................................... 6–31
    Basic Wb Web Profile .............................................. 6–31
    Default Hx Profile ................................................ 6–32
    Basic Hx Profile .................................................. 6–32
    Default Touchscreen Profile ..................................... 6–32
    Basic Touchscreen Profile ....................................... 6–33
    Handheld Touchscreen Profile ................................... 6–33
    NiagaraAX-3.3 Hx profile-related updates .......................... 6–33
    About Kiosk Profiles .............................................. 6–35

Px Editor workflow .................................................... 6–36

About the Make Widget wizard ...................................... 6–36
  Create a bound label widget ....................................... 6–37
  Create a widget using a palette kit module ...................... 6–39
  Create a widget with a Workbench view ........................... 6–42
  Create a widget using a component properties option .......... 6–44
  Create an action widget .......................................... 6–46
  Create a Time Plot widget ........................................ 6–48
  Create a Chart widget ........................................... 6–50

About the Nav file .................................................... 6–52
  Nav file elements .................................................. 6–53

About the Nav File Editor ............................................. 6–54
  Nav File Editor source objects ................................... 6–55
Navigation file editor result tree .............................................. 6–55
Navigation file editor buttons ............................................... 6–55
About Reporting .................................................................. 6–56
About the reporting process .................................................. 6–56
Types of report components .................................................. 6–57
About the ReportService component ...................................... 6–57
About the ExportSource component ......................................... 6–58
About the EmailRecipient ..................................................... 6–58
About the FileRecipient component ......................................... 6–59
About the BqlGrid component ................................................. 6–59
About the ComponentGrid component ..................................... 6–60
About the ReportPane component .......................................... 6–61
About the SectionHeader component ........................................ 6–61
About the Grid Table view .................................................... 6–61
About the Grid Label Pane view ............................................. 6–62
About the Grid Editor view .................................................... 6–63
About the Report Edit Row and Edit Column dialog boxes ........ 6–64
About ReportPxFile ............................................................... 6–65

About Security ....................................................................... 7–1
Security model overview ...................................................... 7–1
Categories and security ......................................................... 7–2
Users and security ............................................................... 7–2
About built-in users ............................................................. 7–4
About authentication .......................................................... 7–4
Network users .................................................................. 7–5
Challenge ........................................................................ 7–5
User Service changes .......................................................... 7–5
NiagaraNetwork changes ....................................................... 7–5
Permissions and security ....................................................... 7–5
About permission levels ....................................................... 7–6
Component permission levels ................................................. 7–6
File permissions ................................................................. 7–7
History permissions ............................................................ 7–8
UserService security notes .................................................... 7–8
Notes on user permissions and category assignments .............. 7–8
About user audits ............................................................... 7–9
AuditHistoryService configuration ......................................... 7–9
AuditHistory content .......................................................... 7–9
AuditHistory station login activities ........................................ 7–10
Multi-station security notes ................................................... 7–11
Domain-wide cookies authentication ..................................... 7–11
To configure domain-wide cookies authentication .................. 7–11
Workbench single sign-on (SSO) realm ................................... 7–13
To configure station’s realms for Workbench single sign-on .......... 7–13
Alarm ack permission notes .................................................. 7–14
UserService ....................................................................... 7–14
UserService properties ......................................................... 7–14
UserManager .................................................................... 7–15
Lockout notes .................................................................... 7–16
Network user notes ............................................................. 7–16
User ................................................................................... 7–17
Network user related properties .............................................. 7–20
PermissionsBrowser .......................................................... 7–20
Show Configured ............................................................... 7–20
Permissions abbreviations ................................................... 7–21
Access permissions ............................................................ 7–21
About User prototypes ......................................................... 7–22
Properties of User Prototypes ................................................. 7–22
Naming User Prototypes ....................................................... 7–23
CategoryService ............................................................... 7–23
CategoryManager ............................................................... 7–23
About Scheduling ......................................................... 8–1

About the scheduling model ........................................ 8–1
Schedule component categories .................................. 8–1
Schedule component views ........................................ 8–2
Refresh ........................................................................ 8–2
Save ........................................................................... 8–2
Schedule component links .......................................... 8–2
Weekly schedule links ................................................. 8–3
Trigger schedule links ................................................ 8–3
Schedule special events .............................................. 8–3
Special events permission change .............................. 8–3
Schedule exports and imports (master/slave) .............. 8–4

About weekly schedules ............................................ 8–4
Types of weekly schedule components .................. 8–5
About the BooleanSchedule .................................... 8–5
About the EnumSchedule ......................................... 8–5
About the NumericSchedule .................................... 8–5
About the StringSchedule ........................................ 8–5
Weekly schedule output processing ....................... 8–5
Out slot .................................................................... 8–5
Out Source slot ......................................................... 8–6
Next Time and Next Value slots ............................. 8–6
Weekly Scheduler view ............................................ 8–6
Weekly Schedule ........................................................ 8–6
Special Events .......................................................... 8–8
Properties ................................................................. 8–11
Summary .................................................................... 8–13

About calendar schedules (holidays) ....................... 8–14
CalendarSchedule Usage ........................................ 8–14
Calendar Scheduler view ......................................... 8–14
Adding calendar events .......................................... 8–15
Right-click menus and other controls .................. 8–15
Calendar day selections .......................................... 8–16
Date selection notes ................................................ 8–16
Date range selection notes ...................................... 8–17
Week and day selection notes ............................... 8–17
Custom selection notes .......................................... 8–18
CalendarSchedule slots and other notes ................ 8–18

About trigger schedules ........................................ 8–19
Trigger Scheduler view ........................................... 8–19
Adding trigger events .............................................. 8–20
Adding trigger event times ..................................... 8–20
Right-click menus and other controls ................ 8–20
TriggerScheduler slots and other notes ................ 8–21
Trigger Missed slot ................................................. 8–22

About ScheduleSelector components .................. 8–22
Types of ScheduleSelector components .................. 8–22
Types of ScheduleSelector component properties .... 8–23
Example ScheduleSelector configurations .............. 8–23
Example 1: Using a NumericScheduleSelector component ...................................................... 8–23
Example 2: Using a BooleanScheduleSelector component ...................................................... 8–24

Using schedules ....................................................... 8–25
Adding a schedule or calendar ................................ 8–25
To add a component from the schedule palette ........ 8–25
To copy an existing, saved (configured) schedule component ..................................................... 8–25
About Workbench tools .................................................. 9–1

Types of Workbench Tools ............................................ 9–1

Alarm portal ................................................................. 9–2

Bacnet service ............................................................. 9–4

Color chooser .............................................................. 9–4

Lexicon editor ............................................................. 9–5

Lexicon Report view ..................................................... 9–5

Lexicon Editor view ...................................................... 9–6

Lexicon display options ................................................ 9–7

Notes on English (en) lexicon usage ............................... 9–7

Example edit of the English (en) lexicon ......................... 9–8

Local license database .................................................. 9–8

Lon XML Tool ............................................................. 9–9

Lonworks service ......................................................... 9–10

Credentials manager .................................................... 9–10

New driver wizard ...................................................... 9–11

New module wizard .................................................... 9–11

New station wizard ..................................................... 9–12

Request license .......................................................... 9–12

Resource estimator ...................................................... 9–13

Time Zone Database Tool ............................................. 9–14

Manifest Info ............................................................. 9–14

Time Zone Database ................................................... 9–14

Daylight Savings Time Calculator ................................ 9–15

Time Zone Calculator .................................................. 9–15

Todo list ................................................................. 9–15

Workbench job service ................................................ 9–15

Workbench service manager ....................................... 9–16
Performing Workbench tasks ......................................................... 10–1

Starting and exiting Workbench ............................................. 10–1
To start Workbench ............................................................. 10–1
To close a Workbench window .............................................. 10–1
To exit Workbench .............................................................. 10–2

Getting started with stations .................................................... 10–2
To open a platform using Workbench GUI ................................ 10–2
To connect to a platform using Workbench GUI ....................... 10–2
To close a platform using Workbench ..................................... 10–3
To disconnect from a platform using Workbench ...................... 10–3
To start a station using Workbench ........................................ 10–4
To stop a station using Workbench ........................................ 10–4
To open a station ............................................................... 10–4
To close a station using Workbench ...................................... 10–5
To connect to a station using Workbench .............................. 10–5
To disconnect from a station .................................................. 10–5

Using the side bar pane ........................................................... 10–5
To open the side bar pane ..................................................... 10–5
To open the bookmarks side bar .......................................... 10–5
To open the help side bar ..................................................... 10–6
To open the nav side bar ...................................................... 10–6
To open the palette side bar .................................................. 10–6
To close a side bar ............................................................. 10–6
To close the side bar pane .................................................... 10–6
To vertically resize a side bar ................................................. 10–6
To restore a side bar to a previous size ................................... 10–6
To maximize a side bar ....................................................... 10–6

Using bookmarks ..................................................................... 10–6
To add a bookmark .............................................................. 10–7
To manage bookmarks ......................................................... 10–7
To edit a bookmark ............................................................. 10–7
To remove a bookmark ........................................................ 10–7

Using the help side bar ........................................................... 10–7
To search for topics in the help side bar: ................................. 10–8

Using the nav side bar (tree) .................................................... 10–8
To refresh a nav side bar tree node ....................................... 10–8
To Go Into a nav side bar tree node ...................................... 10–8

Using the jobs side bar ............................................................ 10–9
To view job details ............................................................. 10–9
To cancel a job from the jobs side bar .................................... 10–9
To dismiss a job ................................................................. 10–9

Using the palette side bar ........................................................ 10–9
To open a palette .............................................................. 10–9
To close a palette ............................................................. 10–10
To create a palette ............................................................. 10–10
To add a new component to a palette (PaletteFile.palette) ...... 10–10
To add a new component to a palette (module palette) ......... 10–10
To copy a component to a palette ....................................... 10–11
To add a side bar preview using the compPreviewWidget property .......................................................... 10–11

Using the view pane ............................................................. 10–12

Editing components .............................................................. 10–12
Selecting a component .......................................................... 10–12
To select a component ........................................................ 10–12
To select multiple components in the nav tree .................... 10–12
To select a multiple components in the wire sheet ................ 10–13
Viewing a component .......................................................... 10–13
To select a component view ................................................. 10–13
To reorder components (in a component container) ............. 10–13
To create a composite view ................................................. 10–14
Working with components ..................................................... 10–14
To add a new component (property sheet, nav side bar, or wire sheet view) .......................................................... 10–14
Component Guides

Component Reference Summary .................................................. 11–1
Components in alarm module .......................................................... 11–1
Example ......................................................................................... 11–5
Components in alarmRdb module .................................................... 11–5
Components in backup module ....................................................... 11–5
Components in baja module ......................................................... 11–6
Components in bajaui module ....................................................... 11–10
Components in chart module .......................................................... 11–14
Components in control module ...................................................... 11–14
Components in converters module ............................................... 11–15
Components in crypto module ....................................................... 11–16
Components in devkit module ....................................................... 11–16
Components in email module ....................................................... 11–16
Components in file module ............................................................ 11–19
Components in flr module ............................................................. 11–21
Components in gx module ............................................................. 11–21
Components in help module ........................................................... 11–21
Components in history module ..................................................... 11–21
Components in kitPx module .......................................................... 11–25
Components in ldap module .......................................................... 11–29
Components in net module ............................................................ 11–30
Components in onCall module ....................................................... 11–31
Components in program module ................................................... 11–31
Components in pxeditor module .................................................... 11–31
Components in report module ...................................................... 11–32
Components in the Sms module ..................................................... 11–32
Components in schedule module .................................................. 11–33
Components in timesync module .................................................. 11–35
Components in web module ......................................................... 11–35
Components in workbench module ................................................. 11–35

Plugin Guides

Types of plugin modules .............................................................. 12–1
Plugins in alarm module .............................................................. 12–1
Plugins in backup module ............................................................ 12–3
Plugins in chart module .............................................................. 12–3
Plugins in devkit module ............................................................. 12–3
Plugins in email module ............................................................. 12–5
Plugins in help module .............................................................. 12–5
Plugins in history module ........................................................... 12–6
Plugins in history module ........................................................... 12–8
Plugins in html module .............................................................. 12–12
Plugins in ldap module .............................................................. 12–29
Topics:

- Plugins in onCall module
- Plugins in program module
- Plugins in pxEditor module
- Plugins in raster module
- Plugins in report module
- Plugins in schedule module
- Plugins in timesync module
- Plugins in wiresheet module
- Plugins in wbutil module
- Plugins in workbench module

References

- In this appendix (introduction)
- About keyboard shortcuts
- Types of menu bar items
  - About the File menu
  - About the Edit menu
  - About the Search menu
  - About the Bookmarks menu
  - About the Tools menu
  - About the Window menu
  - About the Px Editor menu
  - About the History Ext Manager menu
  - About the Help menu
- Types of popup menu items
  - About the nav side bar popup menu items
  - About the wire sheet popup menu items
  - About the property sheet popup menu items
  - About the Px Editor popup menu items
  - About the history extension manager popup menu items
  - About the Todo list popup menu items
  - About the point manager popup menu items
- Types of edit commands
- Types of toolbar icons
  - Standard toolbar icons
  - Slot Sheet toolbar icons
  - Px Editor toolbar icons
  - About the history extension manager toolbar icons
  - About the history editor toolbar icons
  - About the Todo list toolbar icons
- Types of console commands
  - Niagara shell commands
  - nre (station) commands
  - wb (Workbench) commands
  - plat (platform) commands

Glossary
Document Change Log

Updates (changes/additions) to this NiagaraAX User Guide document are listed below.

- NiagaraAX-3.6 release revision, April 4, 2011
  Numerous updates were made to cover new and changed features in NiagaraAX-3.6 (AX-3.6), such that this document now applies to both AX-3.5 and AX-3.6. A few screen captures were updated. Note that references are still occasionally made to prior NiagaraAX releases. Changes include those described below.
  - The section “About lexicons” on page 1-19 and has a new “Nested lexicon values” subsection. Related to lexicons, the section “Lexicon display options” on page 9-7 now describes “Show Only” menu options.
  - In the “Data and Control Model” section, “Types of alarm extensions” on page 3-13 now lists the `StringChangeOfValueAlarmExt` added in AX-3.6; more details about it are in “alarm-StringChangeOfValueAlarmExt” on page 11-4.
  - In the “About Security” section, it was noted in multiple places that a station may use a different user service than the standard (baja) UserService. Other edits were made in “UserService properties” on page 7-14 to describe more “lock out” properties, and more properties were described for a “User” on page 7-17, including “Email”, “Cell Phone Number”, and some “Web Profile” parameters.
  - In the “About Workbench tools” section, a new subsection “Time Zone Database Tool” on page 9-14 was added.
  - In the “Component Guides” section, several component summaries were edited or added, including “Components in alarm module” on page 11-1 and “Components in ldap module” on page 11-29.
  - In the “References” appendix, the “SVG Colors” section was removed.
- Initial NiagaraAX-3.5 release revision, January 29, 2010
Software frameworks provide a platform to allow businesses to more easily build their end-product offerings. Tridium’s patented Niagara Framework® is targeted at solving the challenges associated with managing diverse smart devices, unifying their data, and connecting them to enterprise applications. Examples of smart devices include: monitoring and control systems, sensors, metering systems, and embedded controls on packaged equipment systems.

*framework, n.* something composed of parts fitted together and united; a structural frame; a basic structure (as of ideas); in object-oriented programming, a reusable basic design structure, consisting of abstract and concrete classes, that assists in building applications.

**Niagara Framework, n.** a universal software infrastructure that allows companies to build custom, web-enabled applications for accessing, automating, and controlling smart devices in real time over the Internet.

NiagaraAX is the third generation of Tridium’s Niagara Framework. This Java–based software framework provides an infrastructure to enable systems integrators and developers to build device–to–enterprise solutions, and Internet–enabled control and monitoring products. The Framework integrates diverse systems and devices (regardless of manufacturer or communication protocol) into a unified platform that can be easily managed in real time over the Internet (or intranet) using a standard web browser. The Framework also includes a comprehensive toolset that enables non-programmers to build rich applications in a drag-and-drop environment.

NiagaraAX is fully scalable, meaning that it can be run on platforms spanning the range from small, embedded devices to enterprise class servers. Niagara is being successfully applied in energy–services, building–automation, industrial–automation and M2M applications today.

**Well designed**

The Niagara Framework addresses the challenges of automation, control and device to enterprise connectivity of real time systems. NiagaraAX, and its derivative products, offer compelling value to both end users and partners. For OEM and reseller partners, the Niagara Framework solves several key challenges present in all control-related industries:

- High development costs associated with the foundation or infrastructure layer of software that communicates with devices and manipulates the data from them.
- The need to transform information from real-time control processes into a homogeneous structure enabling advanced product and service applications.
- Integration of legacy systems to enable companies to easily migrate their existing customers to new technologies and product offerings.

Partners who adopt the Niagara Framework as their infrastructure eliminate substantial engineering effort and are able to focus on their core competencies of application development and marketing. These companies gain competitive advantage in their markets from lower development costs and quicker time-to-market for their specific products, applications and value-add services.

End users of Niagara benefit from:

- Being able to preserve existing investments in control and monitoring devices as they move to new, standards-based technologies.
- Being able to access and control all of their diverse systems through a standard web browser.
- Combining information from different systems to support better overall management of their enterprise assets.
- Being able to specify interoperable systems and applications from multiple vendors, thereby reduc-
Niagara is designed to address the following specific technical challenges:

- **Platform independence** - NiagaraAX works with a wide variety of operating systems and hardware platforms.
- **Unification of diverse systems** - NiagaraAX integrates heterogeneous systems, protocols, and field-buses into normalized components.
- **Distributed architecture** - NiagaraAX supports a highly distributed architecture. It successfully combines Internet/IT technology with the services necessary to implement real-time, peer-to-peer automation applications.
- **Programming for non-programmers** - NiagaraAX provides an environment and comprehensive toolset to enable domain experts to create sophisticated applications without writing code.
- **Extensibility** - NiagaraAX provides an extensible component model and rich library of open APIs to enable programmers to extend and enhance the Framework and build their own unique applications and products.
- **Support for embedded systems** - NiagaraAX can be embedded in small low cost devices.

### The Niagara Framework solution

The following section describes how the Niagara framework addresses these challenges:

- **About control systems integration**
- **About Java**
- **About common networking and Internet protocols**
- **About programming for non-programmers**
- **About embedded systems capabilities**
- **About distributed systems capabilities**
- **About component software design**

### About control systems integration

Using the Niagara Framework, control systems integration means:

1. connecting devices on a common communications media
2. modeling those devices in software
3. programming applications to use the information in those devices

Before a device, such as a chiller, VAV box, or temperature sensor, can be used, information from those devices must be pulled into the Niagara software.

Niagara then models those devices and their data types in software through the common object model. This usually entails simplifying the device's data types to make them easier to manipulate and control through the software.

The Niagara common object model is then used to build applications, with the goal being to provide non-programmers a means to program the system easily without developing raw code. The Niagara common object model is similar to a programming language in that there are a few key concepts that are used, but the real power is in the reusable libraries of applications and collections of objects that are available. Once you understand the key concepts and you can put them to work, you can use Niagara objects to build control system solutions quickly and efficiently.

The Niagara common object model, shown in Figure 1-1, allows the Niagara Framework to:

- provide two-way communication between devices and the Internet
- send real-time device information across the Internet
- control devices in real-time across the Internet.
About Java

All of the Niagara software is written in Java, which means that it is platform independent. Prior to Java, most software was written and compiled for a particular machine or operating system. If that software needs to run on some other processor, the program has to be compiled again. Java, on the other hand, compiles once. NiagaraAX software runs on embedded JACE controllers using the QNX operating system and the IBM J9 Java Virtual Machine (JVM), and runs on Microsoft Windows desktop operating system platforms, as well as Linux and Solaris using the HotSpot JVM.

About Virtual Machines

It is possible to compile code once and run it on any platform due to a layer of software that exists between the machine and the software called the Java virtual machine (JVM). The Niagara framework uses the Java VM as a common runtime environment across various operating systems and hardware platforms. The core framework scales from small embedded controllers to high end servers. The framework runtime is targeted for J2ME compliant VMs. The user interface toolkit and graphical programming tools are targeted for J2SE 1.4 VMs.

There are a number of different virtual machines for different platforms on which the NRE is running, but the NRE itself, and all of its modules, are the same regardless of platform. The VM is responsible for defining how the software works with a given set of hardware—how it talks to a LonWorks adapter, how it talks to the communications port, how it interacts with the operating system, among other tasks.

About common networking and Internet protocols

Niagara is designed from the ground up to assume that there will never be any one “standard” network protocol, distributed architecture, or fieldbus. Niagara’s design goal is to integrate cleanly with all networks and protocols. The Niagara Framework standardizes what’s inside the box, not what the box talks to.

The Niagara software suite implements a highly efficient adaptation of the JavaBean component software model and Internet technologies to provide true interoperability across a wide range of automation products. The Niagara object model can be used to integrate a wide range of physical devices, controllers, and primitive control applications including LonMark profiles, BACnet objects, and legacy control points. The architecture supports future enhancements by allowing legacy systems to be brought forward, where they can readily adopt new standards, solutions, and applications.

Enterprise-level software standards include Transmission Control Protocol/IP/Internet Protocol (TCP/IP), eXtensible Markup Language (XML), Hyper Text Transfer Protocol (HTTP), and others. These standards provide the foundation on which to build solutions that allow information to be shared between the control system and the enterprise information system.

About programming for non-programmers

Most features in the Niagara Framework are designed for dual use (for programmers as well as non-programmers). These features are designed around a set of Java APIs to be accessed by developers writing Java code. At the same time, most features are also designed to be used through high level graphical programming and configuration tools. This vastly increases the number of users capable of building applications on the Niagara platform.
About embedded systems capabilities

NiagaraAX is one of the only software stacks designed to run across the entire range of processors from small embedded devices to server class machines. Niagara is targeted for embedded systems capable of running a Java VM. This excludes some very low-end devices that lack 32-bit processors or have only several megabytes of RAM, but opens up a wide range of processor platforms.

To speed time to market for partners designing smart devices, Tridium has developed a reference design processor core. Known as the Niagara Processor Module (NPM), this platform can be licensed from Tridium and makes it possible to quickly develop NiagaraAX-based products.

About distributed systems capabilities

The framework is designed to provide scalability to highly distributed systems composed of tens of thousands of nodes running the Niagara Framework software. Systems of this size span a wide range of network topologies and usually communicate over unreliable Internet connections. Niagara is designed to provide an infrastructure for managing systems of this scale.

About component software design

Niagara uses an architecture centered around the concept of “Component Oriented Development.” A component is a piece of self-describing software that can be assembled like building blocks to create new applications. A component–centric architecture solves many problems in Niagara:

- **Data normalization**
  Components provide a model used to normalize the data and features of different types of protocols and networks so that they can be integrated seamlessly.

- **Graphic development tools**
  Applications can be assembled with components using graphical tools in the Niagara Workbench. This allows new applications to be built without requiring a Java developer.

- **Application visibility**
  Components provide unsurpassed visibility into applications. Since components are self-describing, it is very easy for tools to look at how an application is assembled, configured, and to determine what is occurring at any point in time. This provides great value in debugging and maintaining Niagara applications.

- **Software reuse**
  Components enable software reuse. NiagaraAX supports custom development and extension of the framework. Niagara components are extensible and go beyond data and protocols to unify the entire development environment.

About Niagara software architecture

There are four layers to the Niagara software architecture. The bottom layer, as shown in Figure 1-2 is the host platform, either a JACE controller or a PC. The next layer is the Java virtual machine (JVM). The JVM provides a layer between the hardware and its operating system and the Niagara software, known as the Niagara run-time environment (NRE). On top of the NRE are the Niagara modules.

Figure 1-2  NiagaraAX software architecture

NiagaraAX software subsystems are illustrated in Figure 1-3 and the software processes and protocols are shown in Figure 1-4.
About Baja

The core framework built by Tridium is designed to be published as an open standard. This standard is being developed through Sun’s Java Community Process as JSR 60. This JSR is still an ongoing effort, but it is important to understand the distinction between Baja and Niagara.

Fundamentally Baja is an open specification and the Niagara Framework is an implementation of that specification. As a specification, Baja is not a set of software, but rather purely a set of documentation.

The Baja specification will include:
- Standards for how Baja software modules are packaged
- XML schema for the component model;
- The component model and its APIs
- Historical database components and APIs
- Alarming components and APIs
- Control logic components and APIs
- Scheduling components and APIs
- BACnet driver components and APIs
- lonWorks driver components and APIs

Over time many more specifications for features will be added to Baja. But what is important to remember is that Baja is only a specification. Niagara is an implementation of that specification. Furthermore you will find a vast number of features in Niagara, that are not included under the Baja umbrella. In this respect Niagara provides a superset of the Baja features.
**About APIs**

The API (Application Programming Interface) defines how software engineers access the capabilities of software like the Niagara Framework. Workbench is the Niagara API — and using the Niagara Workbench, you can create and edit the control logic for your job site.

Many features found in Niagara are exposed through a set of Java APIs. In the Java world, APIs are grouped together into packages, which are scoped using DNS domain names. Software developed through the Java Community Process is usually scoped by packages starting with "java" or "javax." It is important to understand the two types of APIs related to the Niagara framework:

- `javax.baja`
- `com.tridium`

**javax.baja**

The APIs developed for Baja (see "About Baja" on page 1-5 for more about Baja) are all grouped under `javax.baja`. These are APIs that will be part of the open Baja specification and may be implemented by vendors other than Tridium. Using these APIs guarantees a measure of vendor neutrality and backward compatibility.

**com.tridium**

Software developed by Tridium which is proprietary and outside of the Baja specification is grouped under the `com.tridium` packages. The `com.tridium` packages contain code specific to how Niagara implements the Baja APIs. The `com.tridium` code may or may not be documented. If `com.tridium` APIs are publicly documented then Tridium encourages developers to use them, but does not guarantee backward compatibility. Undocumented `com.tridium` APIs should never be used by developers.

*Note:* Tridium has developed some APIs under `javax.baja` even though they are not currently part of the Baja specification. These are APIs that Tridium feels may eventually be published through Baja, but are currently in a development stage.

**About Niagara building blocks**

This section describes some of the fundamental building blocks of the Niagara framework. It is important to understand these concepts and associated terminology in order to fully benefit from the use of the NiagaraAX Workbench. Concepts discussed in this section include the following:

- **Modules**
  Modules are the most basic unit of the software that comprises NiagaraAX. For more details about modules, see "About modules" on page 1-6.

- **Components**
  Components are the primary building blocks of the NiagaraAX framework. For more details about components, see "About components" on page 1-9.

- **Px**
  For more details about Px, see "About presentation xml (Px)" on page 1-13.

- **stations**
  For more details about stations, see "About stations" on page 1-15.

- **ORDs**
  For more details about ORDs, see "About ORDs" on page 1-16.

- **Views**
  For more details about views, see "About views" on page 1-19.

**About modules**

Modules are the smallest units of software in the Niagara architecture. Major releases of the Niagara software are distributed along with a set of release modules, but as new modules are made available for that release of Niagara, they may be distributed as independent revisions within that release.

Figure 1-5 shows a partial list of modules, as displayed in the nav side bar pane.
Note: Don’t confuse modules with components. Components are used to build Niagara implementations, while modules make up the Niagara software itself. Refer to “About components” on page 1-9 for more information about components.

The following sections describe module characteristics and benefits.

**About module characteristics**

All modules:

- are composed of a single Java ARchive (JAR) file compliant with PKZIP compression
- contain an XML manifest
- are independently versioned and deployable
- state their dependencies on other modules and their versions

**About jar files**

JAR files are the standard mechanism for distributing Java modules. JAR stands for “Java archive.” A JAR file (.jar) is basically a compressed package whose components can be viewed with WinZip or other archive viewing tool. Do not attempt to unzip a JAR file—it will not work. JAR files are the add-ins that are plugged into the software to give additional functionality. Inside the JAR file are the compressed software; its documentation; in some cases, examples or pre-canned applications; and libraries.

Some modules, such as the lonWorks module, are distributed as multiple JAR files because there are so many different lonWorks devices. The core protocol is packaged in a JAR file called lonWorks.jar. There are individual JAR files for each LON device manufacturer (for example, lon_mfgName.jar). Every JAR file or module is versioned independently.

**About module versions**

Niagara’s versioning system allows you to check to make sure that you have the latest available module for your system. Versions are specified as a series of whole numbers separated by a period, for example “1.0.42”. To understand which version of a module is more recent, simply observe the module version number. For example, 2.3.42 is later than 2.3.35 because 2.3.42 > 2.3.35.

Figure 1-6 shows modules listed, by name, with the version number and file name, as viewed in the Workbench software manager.

**Figure 1-6** Module descriptions viewed in the software manager

<table>
<thead>
<tr>
<th>Part Name</th>
<th>Type</th>
<th>Installed Version</th>
<th>Build Version</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarm</td>
<td>Module</td>
<td>Tridium 3.8.13</td>
<td>Tridium 3.0.43</td>
<td>alarm.jar</td>
</tr>
<tr>
<td>bonnet</td>
<td>Module</td>
<td>Tridium 3.0.43</td>
<td>Tridium 3.0.43</td>
<td>bonnet.jar</td>
</tr>
<tr>
<td>buslink</td>
<td>Module</td>
<td>Tridium 3.0.43</td>
<td>Tridium 3.0.43</td>
<td>buslink.jar</td>
</tr>
<tr>
<td>baua</td>
<td>Module</td>
<td>Tridium 3.0.43</td>
<td>Tridium 3.0.43</td>
<td>baua.jar</td>
</tr>
<tr>
<td>baseDriver</td>
<td>Module</td>
<td>Tridium 3.0.43</td>
<td>Tridium 3.0.43</td>
<td>baseDriver.jar</td>
</tr>
<tr>
<td>sol</td>
<td>Module</td>
<td>Tridium 3.0.43</td>
<td>Tridium 3.0.43</td>
<td>sol.jar</td>
</tr>
</tbody>
</table>

Niagara versioning uses the following set of conventions:

- Versions are specified using a base four-part version with optional patch versions.
- The first number specifies the specification revision. This number starts at one and is incremented each time the specification of the module is incremented. It is used with Baja modules to track the Baja specification version.
- The next two numbers specify a major Niagara release.
- The fourth number specifies a build number. A build number starts at zero for each major release and increments each time all the software’s modules are built.
- Additional numbers may be specified for code changes made off a branch of a specific build. These are usually minor changes and bug fixes.
Every module has two versions. The first is the "bajaVersion" which maps the module to a Baja specification version. If the module is not published under the Baja process then this value is "0". Secondly every module declares a "vendor" name and "vendorVersion". The vendor name is a case insensitive identifier for the company who developed the module and the vendorVersion identifies the vendor's specific version of that module.

Tridium's vendorVersions are formatted as "major.minor.build[.patch]":

- Major and minor declare a feature release such as 3.0.
- The third number specifies a build number. A build number starts at zero for each feature release and increments each time all the software modules are built.
- Addition numbers may be specified for code changes made off a branch of a specific build. These are usually patch builds for minor changes and bug fixes.

So the vendorVersion "3.0.22" represents a module of build 22 in Niagara release 3.0. The vendorVersion "3.0.45.2" is the second patch of build 45 in release 3.0.

About module directory structure

Every module is managed in its own directory structure. Figure 1-7 shows an example of a directory for the alarm module.

All of the source code that is used to build the module's jar file is located under the "src" directory. During the build process the "libJar" directory is used to build up the image, which will be zipped up for the module's jar file.

About module benefits

Modular software development provides several benefits, including the following:

- **Improves tracking deployment and versioning**
  Modular development assists in tracking the deployment and versioning of Niagara features and releases. For example, if a new driver is available to be added to NiagaraAX Framework, it can be packaged, delivered, and added in as a single module or with multiple modules, using the NiagaraAX software manager, as shown in Figure 1-8. Refer to the Platform Guide section “Software Manager” for more information about managing modules.
• **Requires less space on JACE**
  Niagara’s modular development allows you to save space on your JACE by only installing the modules that you need and choose for that JACE.

• **Requires less space on the workstation**
  When you install NiagaraAX, you can choose the modules that you want to install with your application and omit any modules that you do not need. Later, if want to add additional modules you can do so with the Software Manager (as shown in Figure 1-8).

• **Create new modules**
  Software developers can use the tools in NiagaraAX to create new modules and deploy them using the **New Module Wizard**, as shown in Figure 1-9.
  Refer to “New module wizard” on page 9-11 for more details about the New Module Wizard.

---

**About components**

A component is the primary building block that you use to engineer an application using NiagaraAX Workbench. As described in the “**About component software design**” on page 1-4, components provide many advantages for the application developer.

Components differ from modules in that components compose a Niagara implementation whereas modules compose the Niagara software itself.

The following sections describe characteristics of components:

• **About slots**
• **About master/slave components**
• **About point components**

**About slots**

Niagara components are defined as a collection of “slots.” You can see all the slots that make up a component by viewing the “slot sheet” as shown in Figure 1-10. Slots have the following types of attributes:

• **Slot type**
• **Slot name**
• **Slot definition**
• **Flags**
• **Facets**
### Slot type

There are three types of slots:

- **Property**
  
  Property slots represent a storage location of another Niagara object.

- **Action**
  
  An action is a slot that specifies behavior that may be invoked either through a user command or by an event. Actions provide the capability to provide direction to components. They may be issued manually by the operator or automatically through links. Actions can be issued by right-clicking on the component.

- **Topic**
  
  Topics represent the subject of an event. Topics contain neither a storage location, nor a behavior. Rather a topic serves as a place holder for an event source.

### Slot name

Every slot is identified by a name that is unique within its Type. Slot names must contain ASCII letters or numbers.

### Slot definition

Slots are either frozen or dynamic. A frozen slot is defined at compile time within a Type’s Java class. That means that frozen slots are consistent across all instances of a specified Type – they don’t change. Dynamic slots may be added, removed, renamed, and reordered during runtime – they can change. The power of the Niagara Framework is in providing a consistent model for both frozen (compile time) slots and dynamic (runtime) slots.

### Flags

Slots have flags that allow modification of an object’s presentation or behavior. For example, “read-only”, “operator allowed”, and “hidden”, are some of the slot flags that may be used to restrict the presentation or behavior of an object.

### Facets

Facets contain meta data – or additional data about an object. For example, “units of measurement” is a type of facet. Facets may be viewed in the slot sheet and edited from a component property sheet, as shown in Figure 1-11.
About master/slave components

Master components can be defined so that persistent properties are copied to slave components when they are changed. This allows you to change a property in one component that automatically updates the components that are linked to it as slaves. In this way a master component can update slave components in all the other stations in a system.

About point components

In any NiagaraAX station, all real-time data is normalized within the station database as points, a special group of components. Figure 1-12 shows several types of control points, as listed in the control module palette in Workbench.

Figure 1-12  Point types

Each type of point may be used for different purposes in Workbench. When you engineer a job you may want to name a point, as shown in Figure 1-13 (a NumericWritable point named CondSetpoint). Points may be named and renamed but they retain their initial point type characteristics and their characteristic icon color.

Figure 1-13  Numeric writable point named

Points serve as a type of shell in NiagaraAX, to which you may add point extensions. These extensions allow you to select only those functions that you need and thereby limit your point properties to just those that are necessary for your current application.

Figure 1-14  Adding point extensions

For detailed information about points and point extensions, refer to “Data and Control Model” on page 3-1.
About component naming

In a NiagaraAX station, components should be properly named using the following set of rules:

- Only alphanumeric (A-Z, a-z, 0-9) and underscore (_) characters are used—spaces, hyphens, or other symbols characters (e.g. %, &, ., #, and so on) are illegal in component names. For further details, see the next section "Escaped names".
- The first character in the name must be a letter (not a numeral).
- Name must be unique for every component within the same parent component. Workbench automatically enforces this rule, via a popup error dialog.
- Naming is case-sensitive—for example, zone21 and Zone21 are unique names.

**Note:** Case differences among names affect "name sorts" in table-based views, which order by ASCII code sequence, that is capital letters (A-Z) first, lower case (a-z) following.

To convey multiple-word names without using spaces, naming “conventions” such as “CamelCase” and/or underscores are often used, as needed. Examples of such component names are:

- Floor1 or Floor_1
- ReturnAirTemp or Return_Air_Temp
- Zone201_SAT or Zone_201_SAT

Escaped names

Workbench does allow you to name components "improperly," such as with spaces or other non-alphanumeric characters, without any warning. Further, various NiagaraAX drivers have “learn” features to automate the creation of points, some of which (by default) may also have such “improper” names—reflective of the “native name” of the source object. For example, a BACnet proxy point might have the default name "Zone 6 RH%" that matches the actual (native) BACnet object’s name.

In any case, be aware that the “actual” component name has all illegal characters “escaped” using a “$” character, along with the ASCII code for that character, in hexadecimal. The proxy point mentioned above, for example, will have the name "Zone$206RH$25", where the $20 escapes the space and the $25 escapes the % . You can see these escaped names in the slot sheet of the component's parent container. Or, with the component selected, look at its ord (shortcut Ctrl + L) to see its actual name. Other examples include the dash character “-” which is "$2d" and anytime you begin a name with a number, the "$3" is appended to the front of the name.

For the most part, this "escaped name" scheme is transparent to users. Whenever the name is displayed to the user, say in the Nav side bar, property sheet, wire sheet, or a point manager, the component's name is "unescape"d by replacing the code (say, $20) with the actual ASCII character (say, a space). This way, the user sees “Zone 6 RH%” and so on. This is the component's "display name."

In some cases, escaped names lead to confusion. You should avoid them if possible (rename using rules—see "About component naming"). For example, if you add history extensions to escaped-named points, you see those escape codes listed for source points when accessing the History Ext Manager (although associated histories use the display names). Or, if you are building Px pages and manually typing in ords in Px widgets, you probably know source points by "display names" only. If you manually type in an ord without the actual (escaped) name, the widget binding fails with an error.

**Note:** If this sounds too complicated, remember that "drag and drop" operations resolve escaped names without problems—for example, drag any point onto a Px page to get its proper ord.

About palettes

The palette provides a hierarchical view of available components. You may copy a component from the palette and paste it where you need it — on a wire sheet, property sheet, Px View, or in the palette nav side bar pane. You can also create custom palettes that you associate with a module and use for holding frequently used components. For more information about using the palette side bar, refer to “About the palette side bar” on page 2-8.
About presentation

The NiagaraAX framework provides a powerful presentation architecture based on XML and the Niagara component model.

Presentation is a term that is used to describe how Niagara provides visualization of information across different types of media. The terms information, visualization, and media may comprise the following:

- **information**
  - real-time data
  - historical data
  - configuration data
  - alarm data
  - scheduling data
  - graphical data
  - textual data

- **visualization**
  - bitmap and vector graphics
  - text documents
  - tables
  - charts
  - input controls (text fields, check boxes, trees)

- **media**
  - desktop web browsers (HTML, CSS, JavaScript)
  - workbench (Niagara stack)
  - pdf
  - printed pages
  - svg
  - handhelds
  - cell phones

About presentation modules

Niagara’s presentation architecture is based on many modules and their associated public APIs:

- **baja**
  The baja module defines the core component model upon which Niagara subsystems are built. This document describes enhancements to the baja component model which will be used by the presentation stack.

- **gx**
  The gx module provides an API for drawing 2D graphics to a device. The gx module deals with drawing primitives: color, strokes, gradients, vector geometries (line, rectangle, ellipse, paths), bitmap images, fonts, and transforms.

- **bajaui**
  The bajaui module provides the widget toolkit. Widgets are the basis for graphical composition, layout, user input, and data binding. The bajaui module builds upon gx to paint the widgets.

- **PDF**
  The PDF implementation of the gx APIs.

- **HTML**
  The HTML rendering and data binding engine.

About presentation xml (Px)

An XML file format is used to define a Niagara presentation. This file format is called “Px” for presentation XML and the term “Px” is commonly used to describe the Niagara presentation architecture. Presentation is a term that describes how Niagara visualizes information (text, graphics, alarms, and so on) across heterogeneous media – such as: Workbench, desktop browsers, handheld devices, and so on. Niagara uses “presentation xml” (Px) to accomplish this. Figure 1-15 shows an example of a Px file in the Text Editor (Px source file), the Px Editor view, and as displayed in the Px Viewer.
About presentation design philosophy

The presentation architecture is based on the following design principles:

- **Component model**
  The core philosophy of every subsystem in Niagara is to build atop the component model. The presentation architecture is no exception. The design embraces a pure component model solution. The component model is used for the normalized representation of presentation - the “document object model” (DOM) of a Niagara presentation is always a BComponent tree.

- **Unified visualization**
  Presentations include a unified approach to representing graphics, text, and input controls all within a single component model. This allows all visualizations to share a common file format as well as a rendering, layout, and input API.

- **Unified media**
  The design goal of Px is to build a single presentation that can be used across multiple media. For example, given a Px file, it can be automatically rendered using the workbench, as an HTML web page, or as a PDF file. All presentations are stored in the normalized component model as Px files.

About presentation media

There are four primary target medias that NiagaraAX supports.

- **Workbench**
  The Niagara stack must be available to take full advantage of the presentation architecture. The desktop version of Workbench provides a stand alone application that can render Niagara presentations with their full power. With the WbProfile feature, new custom applications can easily be built using Workbench framework and its presentation engine.

- **Workbench applet**
  Workbench applet allows the full Niagara stack to be downloaded to a client machine using a web browser with the Java plug-in. Once loaded to the client, Workbench may be run as an applet within an HTML page. In this scenario, the presentation engine will be available with the full feature set. The WbProfile feature may be used to customize how Workbench is decorated inside the HTML page.

- **PDF**
  Adobe’s PDF format is the standard way to export a presentation to be printed to paper. PDF provides explicit control for how a presentation is rendered on paper in various sizes. It is also a convenient file format for access via HTTP or email. The presentation architecture includes an engine for generating PDF files from Px files.

- **HTML**
  For the casual user where installing the Java plug-in or downloading Workbench is impractical, Niagara supports an engine for generating plain HTML pages from Px. A simple set of HTML, CSS, and
JavaScript provide a web interface using common standards. This interface may also be used to support handheld devices and cell phones. Designers are limited to a subset of widgets when creating HTML presentations (the Px tools provide this support). Refer to “About Px target media” on page 6-29 for information about presentation media technologies.

---

**Figure 1-16** Presentation media options

---

**About stations**

A station is the main unit of server processing in the Niagara architecture.

- A station database is defined by a single .bog file, for example:
  
  "file://stations/[name]/config.bog"

- Stations are booted from their config.bog file into a single Virtual Machine (VM), or process, on the host machine.

- There is usually a one-to-one correspondence between stations and host machines (Supervisors or JACEs). However it is possible to run two stations on the same machine if they are configured to use different IP ports.

A station runs the components of the Niagara Framework and provides the access for client browsers to view and control these components. The primary parts of a station include components and services. It is the combination of a database, a web server, and a control engine. The station either runs on a Web Supervisor PC or a JACE controller.

---

**Figure 1-17** Station in nav tree

---

A system can be a single station or multiple stations depending on the size of the project and it is defined by a bog file.
**About BOG files**

A **bog file** (baja object graph) contains Niagara components. It can be a complete database or any collection of components. A bog file is a special file that describes the components in a database. All views can be used on components in a bog file just as if they were in a station.

![Sample bog file and nav tree presentation](image)

**Figure 1-18**  Sample bog file and nav tree presentation

**About ORDs**

An ORD is an "Object Resolution Descriptor". The ORD is the Niagara universal identification system and is used throughout the Niagara framework. The ORD unifies and standardizes access to all information. It is designed to combine different naming systems into a single string and has the advantage of being parsable by a host of public APIs.

An ORD is comprised of one or more queries where each query has a scheme that identifies how to parse and resolve to an object. ORDs may be displayed visually, as with the Open Ord locator or they may be entered in a text field, as shown in the Open ORD dialog box (see **Figure 1-19**).

![Open ORD and graphic locator system](image)

**Figure 1-19**  Open ORD and graphic locator system

ORDs can be relative or absolute. An absolute ORD usually takes the general format of "host|session|space", as illustrated in **Figure 1-20**.

![Absolute ORD typical structure](image)

**Figure 1-20**  Absolute ORD typical structure

- **host**
  The host query identifies a machine – usually by an IP address such as "ip:hostname". For example "fox:" indicates a fox session to the host.

- **session**
  The session is used to identify a protocol being used to communicate with the host.

- **space**
  The space query is used to identify a particular type of object. Common spaces are "module:", "file:", "station:", "view:", "spy:”, or "history:".
The local VM is a special case identified by "local:“ which always resolves to BLocalHost.INSTANCE. The local host is both a host and a session (since no communication protocols are required for access).

Both a slot path and a handle scheme can name components within a ComponentSpace. So the ORD for a component usually involves both a space query and a path/handle.

**Examples of ORDs:**
- ip:somehost|fox:|station:|slot:/MyService
- ip:somehost|fox:|station:|h:/42
- ip:somehost|fox:|file:/C:/dir/file.txt
- local:|file:lib/log.properties
- local:|module://icons/x16/cloud.png
- local:|spy:/

In Niagara you may view the complete list of installed ORD schemes at "spy:/sysManagers/registry-Manager/ordSchemes" ("local:|fox:|spy:/sysManagers/registryManager/ordSchemes").

**About schemes**
An ORD is a list of one or more queries separated by the "|" pipe symbol. Each query is an ASCII string formatted as "<scheme>:<body>".

**Figure 1-21 Example ORD scheme and body**

- **scheme**
The scheme name is a globally unique identifier which specifies, in Niagara, how to find a piece of code to lookup an object from the body string. Refer to “Types of schemes” for a listing of different types of schemes.
- **body**
The body string is formatted differently, according to the requirements of the scheme. The only rule is that it cannot contain a pipe symbol. Queries can be piped together to let each scheme focus on how to lookup a specific type of object. In general, absolute ords are in the following format: host | session | space (see Figure 1-20).

Some examples follow:
- ip:somehost|fox:|file:/dir/somefile.txt
  In this example, the “ip” scheme is used to identify a host machine. The “fox” scheme specifies a session to that machine usually on a specific IP port number. Finally, the “file” scheme identifies an instance of a file within the “somehost” file system.
- ip:somehost|fox:1912|station:|slot:/Graphics/Home
  In this example, the “ip” scheme is used to identify a host machine using an IP address. The “fox” scheme specifies a session to that machine usually on a specific IP port number. Finally, the “station” and “slot” schemes identify a specific component in the station database.
- local:|module://icons/x16/cut.png
  This example illustrates a special case. The scheme “local” which always resolves to BLocalHost.INSTANCE is both a host scheme and a session scheme. It represents objects found within the local VM.

**Types of schemes**
- **ip:**
The “ip” scheme is used to identify an Ip Host instance. Ords starting with "ip" are always absolute and ignore any base that may be specified. The body of a “ip” query is a DNS hostname or an IP address of the format “dd.dd.dd.dd”.
- **fox:**
The "fox" scheme is used to establish a Fox session. Fox is the primary protocol used by Niagara for IP communication. A "fox" query is formatted as "fox:" or "fox:<ports>". If port is unspecified then the default 1911 port is assumed.
- **file:**
The “file” scheme is used to identify files on the file system. All file ords resolve to instances of java.baja.file.BIFile. File queries always parse into a FilePath. File ords include the following examples:
  - Authority Absolute: "//hostname/dir1/dir2"
  - Local Absolute: "/dir1/dir2"
  - Sys Absolute: "lib/system.properties"
Sys absolute paths indicate files rooted under the Niagara installation directory identified via
Sys.getBajaHome().

• User Absolute: "^config.bog"
User absolute paths are rooted under the user home directory identified via Sys.getUserHome(). In the case of station VMs, user home is the directory of the station database.

• Relative: "myfile.txt"
• Relative with Backup: ".../myfile.txt"

• module
The "module" scheme is used to access BIFiles inside the module jar files. The module scheme uses
the "file:" scheme’s formatting where the authority name is the module name. Module queries can
be relative also. If the query is local absolute then it is assumed to be relative to the current module.
Module queries always parse into a FilePath:

- module://icons/x16/file.png
- module://baja/javajava/s/sys/BObject.bajadoc
- module://doc/index.html

• station:
The "station" scheme is used to resolve the BComponentSpace of a station database.

• slot:
The "slot" scheme is used to resolve a BValue within a BComplex by walking down a path of slot
names. Slot queries always parse into a SlotPath.

• h:
The "h" scheme is used to resolve a BComponent by its handle. Handles are unique String identifiers
for BComponents within a BComponentSpace. Handles provide a way to persistently identify a
component independent of any renames which modify a component’s slot path.

• service:
The "service" scheme is used to resolve a BComponent by its service type. The body of the query
should be a type spec.

• spy:
The "spy" scheme is used to navigate spy pages. The javax.baja.spy APIs provide a framework for
making diagnostics information easily available.

• bql:
The "bql" scheme is used to encapsulate a BQL query.

**Types of space**
Space defines a group of objects that share common strategies for loading, caching, lifecycle, naming, and
navigation. Following, is a list of some of the different types of space:

- component
- file
- history
- module
- orion (starting with NiagaraAX-3.4)
- station
- view

**Types of files**
In the file system, you may create and edit various types of files, as shown in Figure 1-22. Following, is a
list of some of the different types of files that reside in the file space:

![Types of files available from the new file menu](image)
• **BogFile.bog**
  Bog files are database files. Refer to "About BOG files" on page 1-16 for more information about this type of file.

• **HtmlFile.html**
  Html files are edited in the Text File Editor view and viewed in the Html View.

• **JavaFile.java**
  Java files are edited in the Text File Editor view.

• **PaletteFile.palette**
  These files are custom collections of components that you create and save for viewing in the palette side bar. Refer to "To create a palette" on page 10-10 for information about creating custom palettes.

• **PxFile.px**
  Px files are edited in the Px view and are used to store graphic presentations that are available for viewing in the Px viewer and in a browser. Refer to "About presentation xml (Px)" on page 1-13 for more information about Px files.

• **TextFile.txt**
  Text files are edited and viewed in the text file editor.

• **NavFile.nav**
  Nav files are edited in the nav file editor and viewed in the nav tree. Refer to "About the Nav file" on page 6-52 for more information about nav files.

### About views

There are many ways to visualize your system and its components. A "view" is a "visualization" of a component. One way to view a component is directly in the side bar nav tree. In addition, you can right-click on an item and select one of its views to display in the view pane. You can see many different views of components. For example, a component that appears in the nav side bar tree may have a wire sheet view, a property sheet view, and a slot sheet view, that all display in the view pane as shown in **Figure 1-23**. Each component has a **default view** that appears whenever you activate a component (double-clicking, for example) without specifying a particular view.

![Figure 1-23 Views](image)

See "About the view pane" on page 2-12 for more information on the view pane. Refer to the "Plugin Guides" for a comprehensive list of views.

### About lexicons

NiagaraAX provides *non-English* language support by use of **lexicons**. Lexicons are identified by Java locale codes, such as "fr" (French) or "de" (German). When installing NiagaraAX on your PC, an installation step asks you to select "language packages"—these are lexicons. Typically, you install only those you might need, even though a "Select All" option is available.

**Note:** In some cases, lexicon editing provides utility even in English language scenarios. For more details, see "Notes on English (en) lexicon usage" on page 9-7.

Each lexicon is a folder that contains a collection of lexicon files (*moduleName*.lexicon). Lexicon files are simple text files that map various entity "keys" (such as interface names or error and status values) to localized language character values. Often, mapped characters use special encoding.

For example, the following 3 lines are a "snippet" from the alarm.lexicon file in a French (fr) lexicon set:

```plaintext
commands.reset.label=Remettent \u00E0 l'\u00E9tat initial
messages.connectionError=N'a pas pu se r\u00E9ler \u00E0
portal.wizard.title=Ajoutez La Console D'Alarme
```
Note: Factory-supplied lexicons on a NiagaraAX installation CD typically require review and editing before they can be used on an actual job. If needed, you can install lexicons from a NiagaraAX CD to your Workbench PC by simply copying them from the CD's lexicon folder into a "lexicon" directory created under your Niagara release directory.

Lexicon files installed on your PC can be accessed and modified using a simple text editor. However, you typically use the Workbench's lexicon editor (Tools > Lexicon Editor). The lexicon editor not only provides edit features, but also shows the default (English) value for each line entry.

In addition, the editor provides a “Lexicon Report” view, useful to see various statuses about a lexicon and its contained files. For more details, see “Lexicon Editor view” on page 9-6. Once reviewed and edited, you typically install any needed lexicon into all JACE platforms. For more details, see the “Lexicon Installer” section in the Platform Guide.

Nested lexicon values

Starting in AX-3.6, support was added for “nested lexicon values”, meaning the value of a lexicon key can reference another key in either the same module's lexicon file, or a different module's lexicon file. Multiple levels of nesting are supported, as needed. This feature may be most used by NiagaraAX developers who are creating new modules that need lexicons.

The syntax for nested lexicon values is as follows:

{lexicon:moduleName:key} (if referencing a key in a different lexicon file), or
{lexicon:key} (if referencing a key in the same lexicon file)

For a multi-level example within the same (module) lexicon file, consider these key=value pairs in the "test" module's lexicon:

fum.text={lexicon:foe.text} Fum
foe.text={lexicon:fie.text} Foe
fie.text={lexicon:fee.text} Fie
fee.txt=Fee

In the example above, the value for fum.text resolves to “Fee Fie Foe Fum”.

This could be seen in a Px label widget using BFormat scripting syntax: %lexicon(test.fum.text)%
About Workbench

Workbench is the term for the NiagaraAX graphic user interface. The following sections describe the general layout and many of the features of the Workbench user interface. Refer to the following sections for more information:

- Tour of the Workbench GUI
- Customizing the Workbench environment

Tour of the Workbench GUI

When you start Workbench, you will see the Workbench screen, as shown in Figure 2-1.

![Niagara AX Workbench](image)

The primary window of the Workbench GUI is divided into three main areas:

- **Side bar pane**
  Top-left area displays one or more side bars that you may choose from the Windows menu. For details, see “About the side bar panes” on page 2-2.

- **View pane**
  Top-right area displays the currently selected view. For details, see “About the view pane” on page 2-12.

- **Console**
  Bottom area displays a command line that allows you to issue certain commands directly to the system. For details, see “About the console” on page 2-13.

About Workbench window controls

The Workbench window provides typical Windows-type controls plus other features unique to Niagara, as shown in Figure 2-2.
You may create additional windows after starting Workbench—all have these basic features:

- **Title bar**
  Has standard Windows title bar features, including windows name and icons to minimize, maximize, and close. Double-click the title bar to toggle between maximized and a sizable window.

- **Border Controls**
  As needed, drag any outside border to resize the entire window. Drag the inside border between the side bar and view areas, or (if shown) the console area to change their relative sizes.

- **Scroll bars**
  Scroll bars appear in window areas when some content portions are not visible. They are along the right and/or bottom portions of a window area (side bar, view, or console).
  Simply drag a scroll slider (highlighted area) to scroll quickly. Or, click an ending scroll arrow to move in small increments.

- **Status bar**
  At the bottom left of the Workbench window is a status bar. The status bar displays meanings of toolbar buttons. When working in a Wire Sheet view, other details are revealed in the status line.

### About the side bar panes

Side bar panes are normally visible only if a side bar is open. When you close all side bars, the side bar pane will collapse and the view pane and console pane (if open) will expand to fill the window. Two types of side bar panes are:

- **Primary side bar pane**
  The primary side bar pane is the first area on the left, below the locator bar, as shown in Figure 2-3.

- **Px Editor side bar pane**
  This side bar pane appears on the right side of Workbench and is only available when the Px Editor is active.

---

**Figure 2-2** Window controls

- **Title Bar**
- **Scroll Bars**
- **Border Controls**
- **Status Bar**
You use a popup menu to perform all operations that are available from inside the side bars (such as cutting or pasting). You use the title bar to open, close, and resize the side bars.

- For more information about the side bar title bar, see "About the side bar title bar" on page 2-3.
- For more information about types of side bars see "Types of side bars" on page 2-3.

**About side bars**

All side bars display in the side bar pane and have some common features, such as the side bar title bar. The following sections describe characteristics of each type of side bar:

- About the side bar title bar
- Types of side bars

**About the side bar title bar**

All side bars have a title bar across the top as shown in Figure 2-4. You can click and drag on the title bar to vertically resize the side bar or you can click on a minimized side bar to restore it to the previous size.

![Figure 2-4 Side bar title bar](image)

In addition, all side bars have the following controls:

- Close menu
  Drop down control used to close the side bar pane.
- Pane title
  Icon and text that identifies the side bar.
- Maximize button
  When more than one side bar is open, this button appears on the right side of any non-maximized side bar. Clicking on the maximize button will expand the side bar to fill the side bar pane and the restore button will change to the maximize button.
- Restore button
  If the side bar pane is at maximum size, the restore button appears on the top right corner of the title bar. Clicking on this button will restore the side bar pane to its previous size and the maximize button will change to the restore button.

To find out more about specific side bar panes and their controls see “Types of side bars”.

**Types of side bars**

The workbench interface may be customized by adding unique side bars that are designed to fit particular applications. The following side bars may be displayed in the side bar pane by default:
Tour of the Workbench GUI

Chapter 2 – About Workbench

April 4, 2011

• **Bookmarks side bar**
  Displays a list of bookmarks. For details, see "About the bookmark side bar" on page 2-4.

• **Help side bar**
  Provides a tree view of available help documentation. For details, see "About the help side bar" on page 2-5.

• **Jobs side bar**
  Provides a tree view of available help documentation. For details, see "About Jobs side bar" on page 2-5.

• **Navigator side bar**
  Provides a tree view of the system. For details, see "About the nav side bar" on page 2-6. For more information about the nav side bar, see "Types of nodes in the nav side bar tree" on page 2-6, and "About the nav side bar toolbar" on page 2-7.

• **Palette side bar**
  Provides a tree view of components that are available in specific palettes. For details, see "About the palette side bar" on page 2-8 and "About the palette side bar toolbar" on page 2-8.

• **Todo side bar**
  Provides a customizable list of tasks or notes. For details, see "About the Todo list sidebar" on page 2-9.

• **Bound ords side bar**
  Provides a listing of all bound ords used in a Px file. For details, see "About the bound ords side bar" on page 2-10.

• **Widget tree side bar**
  Provides a tree view of all widgets used in a Px file. For details, see "About the widget tree side bar" on page 2-10.

• **Px Properties side bar**
  Provides a listing of all Px Properties that are defined for the viewed Px page. For details, see "About the Px properties side bar" on page 2-11.

• **Properties side bar**
  Provides a listing of all properties for a component that is selected in the Px Editor. For details, see "About the properties side bar" on page 2-11.

**About the bookmark side bar**

When you open the bookmark side bar, it appears in the side bar pane, as shown in Figure 2-5.

![Bookmark side bar](image)

From the bookmark side bar, you can double click on bookmark nodes or use popup menus to perform all operations that are available from the side bar (for example, go directly to a bookmarked location, manage bookmarks, edit bookmarks, and more). The quick access provided here is very helpful for changing screens without having to go through multiple selections using other menus or submenus.

For more details about the bookmark side bar, refer to the following:

- To find out how to add or remove bookmarks in the bookmark side bar, see “To add a bookmark”
on page 10-7.

- For details about managing bookmarks, see “To manage bookmarks” on page 10-7
- For details about editing bookmarks, see “To edit a bookmark” on page 10-7

**About the help side bar**

When you open the help side bar, it appears in the side bar pane, as shown in Figure 2-6.

![Figure 2-6 Help side bar](image)

The help side bar has three tabs that you may select by clicking on the tab. The three help tabs are listed and briefly described, as follows:

- **Table of Contents**
  Contains a tree view of help topics, listed in alphabetical order by topic.
- **API**
  Contains a tree view of help topics, listed in alphabetical order by module.
- **Search**
  Contains a **Find** text entry field and **Search** button. For details on using the Search, see “Using the help side bar” on page 10-7.

**About Jobs side bar**

When you open the Jobs side bar, it appears in the side bar pane as shown in Figure 2-7. The Jobs side bar contains a list of jobs that have been performed or that are currently being performed.

![Figure 2-7 Jobs side bar](image)

The following icons on the Jobs side bar indicate job status:

- **Running**
  Indicates that the job is currently running.
- **Success**
  Indicates that the job has completed without error.
- **Failed**
  Indicates that the job did not complete.
- **Unknown**
  Indicates that the job status is not available.
From the Jobs side bar, you can click on the arrows icon >> to open the Job Log dialog box. The Job Log dialog box displays a listing of the actions performed as part of the job. Each entry in this log contains a detailed description that you can view by double-clicking on the entry to open the Log Details dialog box, as shown in Figure 2-8.

Figure 2-8 Log Details dialog box

About the nav side bar

When you open the nav side bar, it appears in the side bar pane, as shown in Figure 2-9. The nav side bar contains the tree view that provides a hierarchical view of the whole system. From the nav side bar, you can double click on nodes in the nav tree or use popup menus to perform all operations that are available from the nav side bar (for example, connect or disconnect to a station, refresh a tree node, and more).

The expandable tree provided here is very useful for performing actions on nodes and for navigating through various screens and views in the Workbench. Items are displayed in the tree with an icon that represents the associated function or file type.

Items are displayed in the tree with a symbol based on type. If the item is a file, it will be based on file type. Refer to "Types of nodes in the nav side bar tree" on page 2-6 for more details about file types. Refer to "About the nav side bar popup menu items" on page A-9 for more details about the nav side bar popup menu.

Figure 2-9 Nav side bar

At the highest level, the nav side bar tree may include the following (when working from a localhost):

- My Host (local system)
- My Modules
- Platform
- Stations (connected or disconnected)

Types of nodes in the nav side bar tree

The nav side bar tree may include the following types of nodes and their child nodes:
- **Host node**
  Represents a physical computer (hardware) that the rest of the nodes (subnodes) reside on. For more details about how the host fits into the Niagara architecture, see "About Niagara software architecture" on page 1-4.

- **Module node**
  When expanded, displays a tree view of available modules, listed in alphabetical order by module. For more details on modules, see "About modules" on page 1-6.

- **File system node**
  Represents the top level of a tree view of the host file system. File system subnodes represent drives and locations on the host system. It is important to understand that the file system provides access to files that are outside of the station database.

- **Station node**
  Represents a station (connected or disconnected). When expanded, the station node displays the station contents in a hierarchical tree. For more details on stations, see "About stations" on page 1-15.

- **Platform**
  When expanded, displays a hierarchical view of the Niagara host platform. You can double-click on the platform node and sub-nodes, or use a right-click shortcut menu to perform all operations that are available on or under this node (connecting, disconnecting, refreshing, and more). For details on the platform node and its subnodes, refer to "About a platform connection" in the Platform Guide for more details.

- **Config node**
  When expanded, displays a tree view of the station contents or "configuration". The config node usually contains one or more of the following types of nodes:
  - **Component**
    When expanded, components (as containers) display a tree view of the sub-components that they contain. Various component types may be displayed either in containers or at the root of the component node. For more details on components, see "About components" on page 1-9.
  - **Control**
    Control points may be displayed directly in the root of the Config node. For more information about Control points, see "About point components" on page 1-11 and "Data and Control Model" on page 3-1.
  - **Drivers**
    Provides a place to store driver modules (such as the Niagara Network, BACnet drivers, Modbus, and more). When expanded, displays a tree view of loaded driver modules. For more details, refer to the "About Network architecture" section in the Drivers Guide.
  - **Services**
    Component for storing services, such as alarm service, history service, program service, and more.

**About the nav side bar toolbar**

In addition to the standard side bar title bar (see "About the side bar title bar" on page 2-3 for more details) the nav side bar has a toolbar, located just below the title bar as shown in Figure 2-10.

*Figure 2-10  Nav side bar toolbar*

The nav side bar toolbar includes the following:

- **New tree button**
  When clicked, creates a new tree in the nav side bar. When you have more than one tree node, you can select one to activate from the Drop-down tree selector.

- **Close tree button**
  When clicked, closes the currently displayed side bar.
• **Drop-down tree selector**
  When more than one nav side bar is open, this selector allows you to choose which one to display

**About the palette side bar**

When you open the palette side bar, it appears on the left side of the Workbench in the side bar pane, as shown in Figure 2-11. The palette side bar provides a place to open and view sets of modules or custom palettes that you build for yourself. From the palette side bar, you can open multiple palettes (displaying them one at a time), close palettes and view modules within palettes. You may also double-click or use popup menus to perform all operations that are available from the palette side bar (for example, copy modules, select a module view, refresh the tree node, and more). The expandable tree provided in the palette allows you to perform actions on nodes within the palette and to navigate through the palette subdirectories. Items are displayed in the tree with an icon that represents an associated function or file type.

The palette side bar also has a component preview pane that displays an image (when available) of the selected component (shown below).

**Figure 2-11  Palette side bar with preview pane**

Palette previews display in the palette when components have images configured either as the default image property or as the image assigned to the compPreviewWidget property. If no preview is associated with a component, in AX-3.5 and later, you can add a compPreviewWidget property to a widget in order to display an image in the preview pane of the palette side bar. See “To add a side bar preview using the compPreviewWidget property” on page 10-11.

For more details about the palette side bar, refer to the following:

- To find out how to use the palette side bar, see "Using the palette side bar” on page 10-9.
- For details about adding palettes to the palette side bar, see “To open a palette” on page 10-9

**About the palette side bar toolbar**

In addition to the standard side bar title bar (see "About the side bar title bar" on page 2-3 for more details) the palette side bar has a toolbar, located just below the title bar as shown in Figure 2-12.

**Figure 2-12  Palette side bar tool bar**

The palette toolbar includes the following:

- **Open palette** button
  When clicked, opens the Open Palette dialog box. Refer to “To open a palette” on page 10-9 for information about opening palettes.
- **Close palette** button
  When clicked, closes the currently displayed palette.
Chapter 2 – About Workbench Tour of the Workbench GUI

About side bars

- **Drop-down palette** selector
  When palettes are open in the palette side bar, this selector allows you to choose which palette to display.

- **Open preview pane** button (AX-3.5 and later)
  This control button toggles the preview pane on and off. Previews are available on some components.

**About the Open Palette dialog box**

The **Open Palette** dialog box displays a tabular list of available palettes. If there are palettes located in locations other than the My Modules directory, you can use the browse button to find them.

*Figure 2-13  Open Palette dialog box*

The **Open Palette** dialog box is shown above and has the following features:

- **Filter field**
  This is a text field that allows you to type the beginning letters of the desired palette name to filter out palettes from the view. For example, typing in the letters “mo” removes palettes that do not begin with the letters “mo”. You may use the * (asterisk) character as a “wild card” entry in this field. All palettes are listed in the table if no text is entered in this field.

- **Browse button**
  This button opens the **File Chooser** dialog box to allow you to select palettes that are located in alternate locations.

- **Table of palettes**
  The table of palettes has the following columns
  - **Module**
    This is the name of the palette’s parent module
  - **Description**
    This is a short title or name of the palette’s parent module

**About the Todo list sidebar**

The Todo list sidebar is a convenient way to create and access Todo List items from a palette. Click the + button on the toolbar to open the **Add** dialog box. The **Add** dialog box provides a text field for adding and categorizing Todo list items. For more details about the Todo List see “Todo list” on page 9-15.

*Figure 2-14  Todo bar*

**About the jobs side bar**

The Jobs side bar shows all the current jobs in all the stations with which you have a connection. The current status of each job is shown as: running, canceling, canceled, success, or failed. If the job is running then a progress bar displays estimated progress. You may cancel a running job by pressing the **Cancel** button. Normally, once a job has completed you are notified via the async notification feature. You may then dismiss the job by pressing the **Close** button. The details of the job may be accessed using the ”>>” button to display the **Job Log** dialog box. For details about using the job side bar, refer to “Using the jobs side bar” on page 10-9.
About the bound ords side bar
The bound ords side bar, in Figure 2-16, is available when the Px editor view is active. It displays a listing of all the bound ords in the current Px view. Double click on any ORD in the list to display the ORD in the ORD editor dialog box.

About the widget tree side bar
The widget tree, in Figure 2-17, displays a tree hierarchy of the widgets (panes, labels, graphic elements, and so on) that are in the current Px view.
Chapter 2 – About Workbench Tour of the Workbench GUI
April 4, 2011

About side bars

**Figure 2-17  Widget tree side bar**

Note: It is often easier to use the Widget Tree to select objects when you have a lot of objects on a view—especially when there are several layers of objects. When you select an object in the tree view it is selected in the Px view as well and displays the selection borders and handles.

**About the Px properties side bar**

Starting in NiagaraAX-3.3, the Px properties side bar, shown in Figure 2-18, is available when the Px editor view is active. It displays a listing of all the Px properties that are defined in the currently active Px file. Use the menu bar icons to add, define, assign, and delete Px properties. For more information about px Properties, see “About Px Properties” on page 6-7.

**Figure 2-18  Px properties side bar**

**About the properties side bar**

The properties side bar, shown in Figure 2-19, is available when the Px editor view is active. It displays a listing of all the properties that are in the currently selected object in the Px view. Double click on any object in the widget tree or in the in the Px viewer to display the **properties** dialog box (same information as the properties side bar).
About the view pane

The View pane is the largest window area and is located on the right side, below the locator bar, as shown in Figure 2-20. Features of the view pane include tabbed views and a thumbnail view.

Multiple tabbed views may be added to the view pane by using the tab feature. You can add, close, and select tabs in the view window. The view area displays the currently selected view for the active tab. You can change the selected view by doing any of the following:

- double-click on an item in the nav palette tree
- select a view or action from the nav palette popup menu
- select a command from a menu or submenu
- select a command from the locator bar
- select a view from the view selector or from the view popup menu

The thumbnail view, when active, appears in the top right corner of the window to help you find your way around the wire sheet. For more details about the thumbnail view, refer to “Show Thumbnail” on page 12-17.

For more details about using tabs, refer to “Creating tabs in the view pane” on page 2-21.
### About the console

The console, see Figure 2-21, is located along the bottom of the Workbench interface and may be alternatively hidden or shown by selecting **Window > Hide Console** or **Window > Console** from the menu bar.

**Figure 2-21** Niagara AX console

![Niagara AX console](image)

The console has scroll bars on the right side and the window size may be adjusted by dragging the top border bar. The console provides you with access to a command line prompt without leaving the Workbench environment. From the console you may type in commands directly, including the help command for additional help. The following lines are some console level commands, parameters, and options:

```
> wb -help
```

**usage:**

```
wb [options] <ord>
```

**parameters:**

- **ord** initial ord to display

**options:**

- **-profile:<type>** workbench:WbProfile to use
- **-locale:<x>** set the default locale (en_US)
- **-@<option>** pass option to Java VM

### About the menu bar

The menu bar is the row of pulldown menus located along the very top of the Workbench GUI, as shown in Figure 2-22. You may use these menus to perform operations throughout the Workbench GUI. Many of the menus on the menu bar are context-sensitive and only appear when certain views are active.

**Figure 2-22** Menu bar

![Menu bar](image)

For detailed information about the menus, refer to “Types of menu bar items” on page A-2.

### About the toolbar

The toolbar is the row of icons, just below the menu bar, as shown in Figure 2-23. The toolbar provides menu choices for objects that appear in the view pane. Usually, toolbar icons provide single-click access to many of the most commonly used features of the Workbench.
About the locator bar

The locator bar is the area just below the toolbar that spans horizontally from the left edge of the Workbench GUI all the way to the right side, including the view selector on the right side, as shown in Figure 2-24. The part of the locator bar that shows your current path (not including the view selector) is referred to as the PathBar.

The purpose of the locator bar is to provide a graphical navigation field for selecting and displaying destination references. The locator serves two functions.

- First, it is automatically updated each time a new view is selected - so that it shows you the Ord of each view.
- Second, since the Ord is displayed in a graphical row of icons, you may click on any icon along that Ord or any child node from the Ord graphical dropdown menu.

Find the Open Ord command by selecting File > Open from the menu bar.
**About the view selector**

The view selector appears on the right side of the locator bar, just below the tool bar, as shown in Figure 2-25.

**Figure 2-25 View selector**

The view selector provides a context sensitive menu with commands that allow you to quickly display different views of the information that is currently in the view pane. The commands in the view selector differ, depending on the current view pane contents. For example, the view selector commands that are available when you are viewing the platform in the view pane are different from the commands that are available when you are displaying the driver manager view.

**Types of popup menus**

Workbench provides view–specific, or context–specific commands for editing components in many of the views. Following, is a list of the standard Workbench popup (right–click) menus.

- **Nav side bar**
  For an overview of the popup menus in the nav side bar, refer to "About the nav side bar popup menus" on page 2-15.
  For an overview of the nav side bar, refer to "About the nav side bar" on page 2-6.

- **Wire sheet**
  For an overview of the popup menus in the wire sheet, refer to "About the wire sheet popup menu" on page 2-16.

- **Property sheet**
  For an overview of the popup menus in the property sheet, refer to "About the property sheet popup menu" on page 2-16.
  For descriptions of the property sheet popup menu items, refer to "About the property sheet popup menu items" on page A-10.

- **Px Editor**
  For an overview of the popup menus in the Px Editor, refer to "Px Editor popup menu" on page 2-17.

**About the nav side bar popup menus**

The nav side bar menu is the popup menu that displays command options when you right–click on a component item in the nav side bar. The nav side bar popup menu is context-sensitive and displays items that relate to the object that is currently selected. For example, the popup menu for a station is different from a popup menu for a folder or a point. Figure 2-26 shows a popup menu for a selected node in the nav side bar.
If you right-click in a blank area of the pane (not selecting any items any the tree), the nav side bar pane will display the **Refresh Tree Node** and **Sync Tree** commands. For descriptions of nav side bar popup menu items, refer to “About the nav side bar popup menu items” on page A-9.

**About the wire sheet popup menu**

Figure 2-27 shows the wire sheet popup menu with a wire sheet object selected. The menu displays different items depending on whether you right-click on an item or on a blank area of the wire sheet. For descriptions of wire sheet popup menu items, refer to “About the wire sheet popup menu items” on page A-10.

**Figure 2-27  Wire sheet popup menu**

For a description of the wire sheet, refer to “wiresheet-WireSheet” on page 12-16.

**About the property sheet popup menu**

Figure 2-28 shows the property sheet popup menu. For descriptions of wire sheet popup menu items, refer to “About the property sheet popup menu items” on page A-10.
Figure 2-28  Property sheet popup menu

For a description of the property sheet refer to “workbench-PropertySheet” on page 12-21.

Px Editor popup menu

The Px Editor popup menu appears when you right-click on an object in the Px Editor view. The menu commands are context-sensitive and are dimmed or available, depending on the type of object that you select.

Figure 2-29 shows the Px Editor popup menu. For descriptions of the Px Editor popup menu items, refer to "About the Px Editor popup menu items" on page A-10.

Figure 2-29  Px editor popup menu

For a description of the Px Editor view, refer to “workbench-WbPxView” on page 12-25.

Types of data—presentation controls and options

Workbench views often present information in text fields, charts, or tabular layouts. Similar views share many of the same types of controls and options features. Those common features are described, by category, in the following lists:
Table controls and options

These controls affect the display of information in a table view. For details see "Table controls and options" on page 2-18.

Batch editing

Batch editing is available in many table views. For details see "Batch editing (or batch processing)" on page 2-19.

Chart controls and options

These controls affect the display chart views. For details see "Chart controls and options" on page 2-19.

Table controls and options

Many views that present information in a table have one or more of the following display features and use one or more of the controls and options described in the following list:

- On Demand History
  Starting in NiagaraAX-3.4, this "play" button icon is available for the History Table view. Click the button to start On Demand History updating. The button changes to a "pause" button icon while On Demand History is active. See also, "About On Demand history views" on page 4-20.

- Data parameters
  These controls include Delta (for history logging) and Time Range settings.
  - Delta reporting option
    This option is useful for history logging, when you want to display value changes (delta) in your report. Refer to "About delta logging" on page 4-23 for information about delta logging.
  - Time range option list
    This list has a variety of predefined time range options, including an option that allows you to restrict your data presentation to a particular date and time range that you specify.

- Title bar
  This area of the table displays the name of the data collection on the left side of the title bar and in some tables (collection table, history table, alarm extension manager, and others) displays the total number of records in the table on the right side of the title bar.

- Column headings
  Each column of data has a title that indicates the data type.

- Column boundaries
  Each column has a movable column boundary that can be used to re-size the column using the mouse control. Stretch or shrink column width by dragging the column boundary, as desired. Use the Reset column widths menu item to reset all column widths to their default size.

- Table Options menu
  This menu is located in the top right corner of the table and provides one or more of the following controls and options. The standard table options menu includes the following items:
  - Reset column widths
    This menu item sets all columns in the table to their default widths. This is useful if you manually changed widths of columns, and now some contents are hidden (even after scrolling).
  - Export
    This menu item opens the Export dialog box where you can choose to export the table to PDF, text, HTML, or CSV (comma separated variable).

- Context-sensitive menu items
  Additional context-sensitive menu items appear in the table options menu, depending on the component that you are viewing. These additional menu items allow you to select or deselect the item in order to display or hide the column data in the table.
Chapter 2 – About Workbench Tour of the Workbench GUI

April 4, 2011

Batch editing (or batch processing)
Batch editing is available in many of the table views in Workbench. This is a process of editing or processing more than one record at a time and typically includes the following general steps:

- Select multiple rows in a table by pressing the Ctrl or Shift key while clicking the desired rows.
- Use the popup (right-click, context-sensitive) menu or a toolbar icon to select an editing command that performs an action or opens a dialog box editor that is appropriate for the view.
- Edit appropriate fields if a dialog box is used and click the OK button to process the edits.

**Note:** Some actions, such as moving rows, or editing certain types of fields, are not appropriate for batch editing. In these cases – even though you can select multiple rows in the table, the action will be performed on only one (usually the top, or highest) selected record in the table.

Figure 2-31 shows an example of batch processing three alarms by selecting three rows in a table view and using the popup menu. In this case all three alarms are acknowledged when the Acknowledge command is selected.

**Figure 2-31** Batch processing (acknowledging) multiple alarms

---

Chart controls and options

**Note:** Some of the control and option features in the following description are available only in NiagaraAX-3.1 and later versions.

Many views that present information in a chart have one or more of the following display features and use one or more of the controls and options described in the following list:

**Figure 2-32** Chart view controls and options

- **Data parameters**
  These controls include Delta (for history logging) and Time Range settings.
  - Delta reporting option
    This option is useful for history logging, when you want to display value changes (delta) in your report. Refer to “About delta logging” on page 4-23 for information about delta logging.
  - Time range option list
    This list has a variety of predefined time range options, including an option that allows you to restrict your data presentation to a particular date and time range that you specify.

- **On Demand History**
  Starting in NiagaraAX-3.4, this “play” button icon is available for the History Chart view. Click the button to start On Demand History plotting. The button changes to a “pause” button icon while On Demand History plotting is active. See also, “About On Demand history views” on page 4-20.

- **Chart Title**
  This area of the chart displays the name of the chart. This title is editable in the chart builder view.
• **Y Axis**
  Displays units for the y axis.

• **X Axis**
  Displays units for the x axis.

• **Zoom Controls**
  Zoom controls appear when you drag the mouse cursor left-to-right or top-to-bottom in order to zoom into the plotted data area. Use the zoom control to reduce the magnification amount, or to move the chart left, right, up, or down. You can reduce the zoom level in increments by using the “decrease zoom” icon 📡. You can restore normal view (no zoom) in one click by clicking the “normal view” icon 🌃. Zoom Controls in Hx Web profile view are available from a popup menu, shown in Figure 2-33, that is activated after you click once on the chart area.

![Figure 2-33  Hx chart popup menu (for zoom controls)](image)

The popup menu includes the following control-related menu items:
- **Zoom In**—zooms in one increment each time you select this menu item.
- **Zoom Out**—zooms out one increment each time you select this menu item.
- **Original View**—returns to the non-zoomed display (only available if you have zoomed in).
- **Higher Quality**—toggles between higher and lower quality graphic display for the chart.

• **Charted Values**
  The color of the line and type of line is editable in the Chart Builder view.

• **Popup menu (Export)**
  The popup menu displays the PDF Export menu item. This menu item opens the Export dialog box where you can choose to export the chart to PDF, text, HTML, or CSV (comma separated variable).

  **Note:** This export function works only with charts that are using a single history. Multiple histories do not export in a usable format.

• **Tool Tip**
  When you “hover” the mouse pointer over the chart, a “tool tip” displays the date, time, and value of that location in the chart. The values are defined by chart axes and not the values of the actual data points. Figure Figure 2-32.

### Customizing the Workbench environment

You can customize your Workbench GUI as well as many of the settings in the Workbench environment. Some settings require an acknowledgement via the OK button on a dialog box, while others are invoked immediately and saved automatically on exit from Workbench. For example, when you exit Workbench with four tabbed windows in your view pane, those same four windows will be displayed the next time you open Workbench.

You can customize the Workbench environment in the following ways.

• Creating Additional Windows
• Editing popup menu “new” item
• Creating tabs in the view pane
• Working with the Wire Sheet view
• Types of Workbench options

### Creating Additional Windows

Workbench allows you to create multiple fully functioning Workbench windows. Choosing **File:** > **New Window** from the menu bar, creates a duplicate of your current Workbench window.

After you create multiple windows, you can then customize each individual window, as needed, to access different information, allowing you to see multiple concurrent views. You can also copy and paste items from one window into another window.
Editing popup menu “new” item

You can change the menu items that display on the context-sensitive popup menu by editing the files under the workbench subfolder. For example, Figure 2-34 shows the “newWidgets.bog” file that has been edited so that a “boundLabel” widget appears in the popup menu under the New submenu.

Figure 2-34 Customizing the popup menu

Creating tabs in the view pane

Workbench allows you to create multiple tabbed views within the view pane of a Workbench window, as shown in Figure 2-35, by doing one of the following:

- From the menu bar, select File: > New Tab.
- If tabs already exist, right-click on a tab and select New Tab from the popup menu.

The new tab has a view identical to the previous one.

Figure 2-35 Tabs in view

As needed, you can use each tab to display a different view, component, or even host, all within the same Workbench window. When you select a tab (make it active), the locator bar shows the current path and view. Also, the menu and tool bars update to show appropriate options for the current view.

From the view of the active tab, you can copy items, select another tab, and then paste them into that view. You can also drag items into an active view from the (Nav or Palette) side bar.

In the Workbench view pane you can use tabs to help organize and selectively display information.

Only one tab may be active at a time. In addition to simply clicking on a tab to make it active, you can select File: > Next Tab from the menu bar to move to the next tab, moving left to right, or you can move to the last tab by choosing File: > Last Tab from menu bar.

To close a tab, do any of the following:

- Right-click a tab and choose Close Tab to close that tab, or
- Right-click a tab and choose Close Other Tabs to close all tabs except that tab.
- From the menu bar, choose File: > Close Tab.

The currently active tab is closed.
Working with the Wire Sheet view

The Wire Sheet view has the following unique controls and features.

- **Zoom controls**
  Zoom controls appear on the WorkbenchAX toolbar when the Wire Sheet view is active. Click the Zoom In, Zoom Out, and Zoom Reset buttons, as needed to adjust the size of objects in the view.

![Figure 2-36  Zoom controls in the Wire Sheet view](image)

- **Wire Sheet maximum size limits**
  Starting in NiagaraAX-3.6, you can limit the size of the wire sheet by setting size of the wire sheet in the Options dialog box. From the workbench main menu, select Tools > Options to open the dialog box. Then select the Wire Sheet option and enter a desired maximum value in the Max Width and Max Height fields, as shown, below. Click the OK button to complete the setting change. If you decrease the maximum wire sheet size, objects are repositioned to stay within the view, after the size change.

  **Note:** You may need to refresh the wire sheet view to see the changes in wire sheet size and object repositioning. Also, the wire sheet borders may not be visible until you zoom out in the wire sheet view.

![Figure 2-37  Setting maximum wire sheet size](image)

- **Object linking**
  Following are methods for performing object linking.

  - **Drag wire**
    Move the mouse over the In or Out node of a wire sheet object (glyph) until the area is highlighted and the mouse pointer changes to a white arrow. Click and drag from the point of origin to the desired In or Out node of the target object and release the mouse button to complete the link.

    ![Figure 2-38  Basic object linking](image)

    Dragging a “wire” to a vacant slot on a wire sheet object causes the **Link** dialog box to open, as shown below.
Select the desired slots in the **Link** dialog box and click the **OK** button to create the link.

- You cannot select invalid (dimmed) slots in the dialog box.
- Slot selection is indicated by a red rectangle surrounding the selection.
- Object names are listed at the top of their respective columns to identify them and to indicate which object is the “Source” and “Target” object.
- A summary of the currently selected slots displays above the **OK** and **Cancel** buttons.

**Multi-linking (continuous link state)**

You can maintain a continuous “link state” as you drag connection wires to link to multiple target objects from a single source object. This allows you to link from a single source to as many targets as you want without having to click on the source object to reinitiate each link. To do this, hold down the Shift key any time you release the mouse button. If the mouse pointer is over a valid object node, a link is established or the **Link** dialog box opens to complete the link. This continued link state is indicated by the target end of the wire “sticking” to and moving with the mouse pointer. Release the Shift key and click anywhere or touch any key to deactivate the link state.

**Link Mark**

Link Mark is a feature that allows you to perform “one to many”, “many to one”, or “many to many” linking in a single operation. Use the following three menu item commands to create many links in at the same time.

- **Link Mark**
  Select the **Link Mark** command to define one or more selected objects as a link source or link target. This command specifies that the selected objects are to be one side of the link operation. The names of the “marked” objects display as part of the **Link Mark** or **Link From** command in the popup menu.

- **Link From**
  Select the **Link From** command to define one or more selected objects as a link source or link target. This command opens the **Link** dialog box with the “marked” object as the source object. You can still change source and target roles in the dialog box using the **Reverse** button.

- **Link To**
  Select the **Link To** command to define one or more selected objects as a link source or link target. This command opens the **Link** dialog box with the “marked” object as the tar-
get object. You can still change source and target roles in the dialog box using the Re-
verse button.

**Figure 2-41**  Multiple links with Link Mark

- **Link Highlighting** (NiagaraAX-3.6)
  Starting in NiagaraAX-3.6, a link highlighting option (enabled by default) is available on the wire sheet. Link highlighting makes it easier to distinguish links on a crowded wire sheet. Link highlighting is comprised of the following features:

  - **Colored link highlights**
    When you select a component on the wire sheet, all links associated with the selected object display with a colored outline around them.  
    **Note:** Highlighted links do not mean that the LINK is selected.

  - **Distinct coloring**
    Selecting additional components causes subsequent link highlights to display a different color highlighting (up to 20 colors before repeating).

  - **Custom colors**
    You can customize the colors by editing the “system.properties” file (in the nav tree “lib” folder, under MyFiles > Sys Home) as follows:
    ```
    niagara.wiresheet.linkHighlightColor1=#00FF00
    ...and following, to...
    niagara.wiresheet.linkHighlightColor20=#00FFFF
    ```
    Each color is specified using the standard hexadecimal notation used for HTML color display.

- **Off-view link navigation** (NiagaraAX-3.6)
  Starting in NiagaraAX-3.6, link “knob” indicators (used for off-view or crowded view links) have additional properties.

  - **Off-view linking**
    Double-clicking on the knob hyperlinks to the component on the opposite end of the link, displaying the wiresheet view with the linked knob highlighted.

  - **Goto Link command**
    Right-clicking on the knob dispays a GoToLink command on the popup menu. Selecting this command hyperlinks to the component on the opposite end of the link, displaying that component’s wiresheet view with the linked knob highlighted.
• **Delete Links command**
  When one or more off-view links (or knobs) are selected, the *Delete Links* command (available on the popup menu) deletes all selected links and their associated off-view references. This is effective for multiple selected in-view and off-view (knob) links.

• **Link selection**
  A Link Selection command is available from the popup menu when multiple links overlap on the wire sheet. Right-click on a link knob on the active wire sheet to select this command, then choose the desired link from the secondary popup menu.

![Figure 2-43 Link Selection menu](image)

• **Edit Link command**
  Starting in NiagaraAX-3.6, you can edit a link directly from the wire sheet view using an *Edit Link* dialog box - instead of the source component’s Link Sheet view. To open the dialog box, right-click a single link (not multiple links or knob links) and select *Edit Link* from the popup menu. The *Edit Link* dialog box displays, as shown below.

![Figure 2-44 Edit Link dialog box](image)

Use the property fields to change any of the following link property values: Source Ord, Source Slot Name, Target Slot Name, or Enabled. Click the OK button to commit and save the link changes.

**Types of Workbench options**

Use the Workbench options dialog box, shown in Figure 2-45, to customize your Workbench GUI and to set other preferences. Open this dialog box by selecting **Tools > Options** from the menu bar.

![Figure 2-45 Options dialog box](image)

The following options are available in the options dialog box:

- **General Workbench options**
- **Alarm console options**
- **Alarm portal options**
- **Text editor options**
Customizing the Workbench environment

General Workbench options

General Workbench options, shown in Figure 2-46, include settings for a variety of Workbench display and behavior options.

**Figure 2-46 General Workbench options**

- **Time Format**
  Choose from a format option to set the way that Workbench time values are displayed by default.

- **Unit Conversion**
  Choosing the English or Metric option converts values that are displayed in Workbench to the chosen unit type. Selecting None leaves units in the state that is assigned at the point facet.

- **AutoLogoff Enabled**
  Setting this parameter to True will activate the AutoLogoff feature. When activated, the AutoLogoff feature will automatically log off a user from a platform when there is no activity detected in Workbench for the period specified in the AutoLogoff Period field. Setting this parameter to False will disable the AutoLogoff feature.

- **AutoLogoff Period**
  Time until Workbench logs off a user when AutoLogoffEnable is set to True.

- **Prompt For Name On Insert**
  When set to True, Workbench will display a Name dialog box, when a new item is added to the workspace.

- **Use Anti Alias**
  Anti-aliasing causes text to look crisper or smoother on the screen. When this parameter is set to true, any editable text (for example a label or a text block) will be anti-aliased.

- **Font Size**
  Choose between Normal and Large font options for Workbench display.

**Alarm console options**

Alarm console options, shown in Figure 2-47, allow you to customize both the appearance and behavior of the alarm console.
Alarm console options include the following:

- **Notes Required on Ack**
  This option, when set to true, causes the Notes dialog box to open whenever you initiate an alarm acknowledgement from the alarm console.

- **Sounds Enabled**
  When set to true – causes a sound to accompany an alarm. You can also set this value under the Alarms menu in the workbench main menu when the Alarm Console view is active.

- **Default Sound File**
  Sets the path to the default sound file.

- **Continuous Alarm**
  When set to true, causes an alarm to repeat continually, until it is acknowledged or cleared. This option works together with the Continuous Alarm Delay property. You can also set this value under the Alarms menu in the workbench main menu when the Alarm Console view is active.

- **Continuous Alarm Delay**
  When Continuous Alarm is enabled, this property causes a “pause” time between in the continuous alarm sound. The continuous alarm is interrupted for a time equal to the value of this property.

- **Alarm priority coloring**
  The following properties work together in combination to produce a range of colors that are assigned to the possible range of alarm priorities (1 - 255).
  - **Low Priority Color**
    Choose a color to designate a low priority alarm.
  - **Mid Priority Color**
    Choose a color to designate a mid priority alarm.
  - **High Priority Color**
    Choose a color to designate a high priority alarm.
  
  The highest priority (priority 1) is assigned the color of the High Priority Color setting. The Mid-Priority and Low Priority colors are assigned likewise, to Mid and Low Priority alarms. Alarm priorities that fall between these priority levels are assigned colors on a color-scale along a path defined by the three assigned colors.

- **Time Zone Display**
  This property allows you to choose to display alarm record timestamp values in the time zone of the alarm console view (Console) or in the time zone of the alarm source (Source).

- **Alarm Class Mapping**
  Provides a way for you to create alarm classes and map specific alarms to classes.

- **Alarm Ack Responses**
  Use this property to create one or more text entries that you can use to populate the Notes dialog box when acknowledging an alarm. When the Notes Required on Ack is set to true, the Notes dialog box displays an additional option list containing any entries you create with this property. Use the >> button to open the associated Edit dialog box and add, edit, or remove response options, as desired. When the Notes Required on Ack is set to false, these Alarm Ack responses are not visible.

- **View Instructions**
  When set to true, this property causes the alarm Instructions pane to display across the bottom of the Alarm Console. Instructions display in the pane for any single selected alarm that has associated instructions.
Alarm portal options

Alarm portal options, shown in Figure 2-48, allow you to customize both the appearance and behavior of the alarm console.

**Figure 2-48 Alarm portal options**

<table>
<thead>
<tr>
<th>Alarm Portal</th>
<th><img src="image1" alt="Alarm Portal Settings" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Tray Icon Enabled:</td>
<td><img src="image2" alt="Tray Icon Setting" /></td>
</tr>
<tr>
<td>Alarm Popup Enabled:</td>
<td><img src="image3" alt="Alarm Popup Setting" /></td>
</tr>
<tr>
<td>Alarm Popup Always On Top</td>
<td><img src="image4" alt="Alarm Popup Always On Top" /></td>
</tr>
<tr>
<td>Alarm Popup Uncloseable</td>
<td><img src="image5" alt="Alarm Popup Uncloseable" /></td>
</tr>
<tr>
<td>Kiosk Mode</td>
<td><img src="image6" alt="Kiosk Mode" /></td>
</tr>
<tr>
<td>Reconnect Interval</td>
<td><img src="image7" alt="Reconnect Interval" /></td>
</tr>
</tbody>
</table>

Alarm console options include the following:

- **Tray Icon Enabled**
  When set to **True**, displays an alarm icon in the system tray when the alarm portal is active.

- **Alarm Popup Enabled**
  When set to **True**, displays an alarm popup window when the alarm portal is active.

- **Alarm Popup Always On Top**
  When set to **True**, causes the alarm popup window to stay on top of other windows when the alarm portal is active.

- **Alarm Popup Uncloseable**
  When set to **True**, makes the alarm popup window uncloseable when the alarm portal is active.

- **KioskMode**
  When set to **True**, the alarm portal opens in Kiosk Mode the next time it is started. For related information, refer to, “About Kiosk Profiles” on page 35, “workbench-KioskService” on page 36, and the document Engineering Notes - NiagaraAX Kiosk Mode.

- **Reconnect Interval**
  The alarm portal checks for “disconnected” alarm consoles. If a console is disconnected, a reconnect is attempted within the Reconnect Interval time.

Text editor options

These options offer a whole range of ways to customize the presentation and behavior characteristics of the text editor tool. Settings include text and symbol color coding options, as well as key bindings for shortcut keys. The text editor options properties are shown in Figure 2-49.

**Figure 2-49 Text editor options**

<table>
<thead>
<tr>
<th>Text Editor</th>
<th><img src="image8" alt="Text Editor Settings" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Spaces:</td>
<td><img src="image9" alt="Show Spaces Setting" /></td>
</tr>
<tr>
<td>Show Tabs:</td>
<td><img src="image10" alt="Show Tabs Setting" /></td>
</tr>
<tr>
<td>Show Newlines:</td>
<td><img src="image11" alt="Show Newlines Setting" /></td>
</tr>
<tr>
<td>Tab To Space Conversion:</td>
<td><img src="image12" alt="Tab To Space Setting" /></td>
</tr>
<tr>
<td>Show Tab:</td>
<td><img src="image13" alt="Show Tab Setting" /></td>
</tr>
<tr>
<td>Show Margin:</td>
<td><img src="image14" alt="Show Margin Setting" /></td>
</tr>
<tr>
<td>Color Coding:</td>
<td><img src="image15" alt="Color Coding Setting" /></td>
</tr>
<tr>
<td>Key Bindings:</td>
<td><img src="image16" alt="Key Bindings Setting" /></td>
</tr>
<tr>
<td>Unit Navigation:</td>
<td><img src="image17" alt="Unit Navigation Setting" /></td>
</tr>
<tr>
<td>Match Parentheses:</td>
<td><img src="image18" alt="Match Parentheses Setting" /></td>
</tr>
<tr>
<td>Match Braces:</td>
<td><img src="image19" alt="Match Braces Setting" /></td>
</tr>
<tr>
<td>Match Brackets:</td>
<td><img src="image20" alt="Match Brackets Setting" /></td>
</tr>
<tr>
<td>Word Right To End Of Word:</td>
<td><img src="image21" alt="Word Right To End Of Word Setting" /></td>
</tr>
</tbody>
</table>

Lexicon editor options

These options offer ways to customize the default settings of the lexicon editor. The lexicon editor options properties are shown in Figure 2-50 and described in “Lexicon Editor view” on page 9-6. All of these properties may be overridden using the options that are available in the Lexicon Editor.
Bajadoc options

Baja reference documentation includes both Java API details as well as Baja slot documentation.

- **Show Baja Only**
  When set to *True* displays only the reference documentation for slots (Properties, Actions, and Topics). When set to *False*, documentation on the Java constructors, methods and fields is also displayed.

- **Flatten Inheritance**
  This option allows you to flatten the inheritance hierarchy into a single set of documentation. When set to *False* only the Java members and Baja slots declared in the specified class are displayed. When set to *True* all Java members and Baja slots inherited from super classes are also shown.

Station copier options

This feature allows you to easily ignore critical data when copying stations to and from a platform. These properties allow you to configure station transfer options from a workbench view. The properties include options to specify which directories and files to ignore when copying a station (by use of space delimited pattern filters). You can also use the property options to set default values for copying station alarm, history, job and critical data directories (hidden).

- **File Pattern Exclude List**
  Use this option to set a pattern filter that excludes any specified file types from being copied with the station.

- **Directory Pattern Exclude List**
  Use this option to set a pattern filter that excludes any specified directories from being copied with the station. For example, if you wanted to exclude copying all directories in the station that begin with the letters “lighting”, then you could type “lighting*” in this field.

- **Copy options: (Station Alarm Data, Station History Data, Station Jobs Data)**
  These properties allow you to choose to copy (true) or not copy (false) certain station data.

Px editor options

These options offer ways to customize the presentation and behavior characteristics of the Px editor view. The Px editor options properties are shown in Figure 2-52 and described in the following list:
Figure 2-52  Px editor options

- **Show Grid**
  This property sets the default condition of the Px editor grid. Select `true` to make the grid visible by default or select `false` to make the grid hidden by default. Either setting may be changed at any time using the PxEditor menu.

- **Grid Size**
  This property sets the size of the grid in the Px editor.

- **Grid Color**
  This property sets the color of the grid in the Px editor. Click in the color field to display the Color Choose dialog box. Use the Color Chooser to set the color that you want to assign to the grid.

- **Use Snap**
  This property sets the default condition of the Snap feature in the Px editor. Select `true` to make objects snap to locations when they are at a distance equal to the Snap Size. Select `false` to disable the snap feature. Either setting may be changed at any time from the PxEditor menu.

- **Snap Size**
  Set an integer value in this field to define the interval between successive snaps.

- **Show Hatch**
  This property sets the default condition of the Px editor hatching that displays on objects on the Px editor canvas. Select `true` to make the hatching visible by default or select `false` to make the hatching hidden by default. Either setting may be changed at any time using the PxEditor menu.

- **Hatch Color**
  This property sets the color of the hatching in the Px editor. Click in the color field to display the Color Choose dialog box. Use the Color Chooser to set the color that you want to assign to the Px editor hatching.

- **Preserve Identities**
  When set to `true`, this property allows you to explicitly turn on support for encoding all names and handles on a Px page.

- **Animate Bindings**
  This option, `true` by default, allows the Px Editor to display live binding data for widgets in Px Edit mode. If you set this option to `false`, then no data animation occurs in the Edit mode, although animation does occur, as expected, in View mode.

**Wire sheet options**

Wire sheet options, shown in Figure 2-53, allow you to customize the appearance of the wire sheet.

Figure 2-53  Wire sheet options

Wire sheet options include the following:
• **Show Grid**
  When set to `True` displays a grid background on the Wire Sheet view.

• **Show Status Colors**
  When set to `True`, will display a different color for each status when it appears in the wire sheet.

• **Show Thumbnail**
  When set to `True` – provides a small “thumbnail” view of the whole Wire Sheet for orientation and navigation purposes.

• **Thumbnail X**
  A field is provided here for setting the X axis for the default position of the thumbnail view.

• **Thumbnail Y**
  A field is provided here for setting the Y axis for the default position of the thumbnail view.

• **Link Highlighting (NiagaraAX-3.6 and later)**
  When set to `True` – turns on link highlighting. See also, “Working with the Wire Sheet view” on page 2-22.

• **Max Width (NiagaraAX-3.6 and later)**
  Use this property to specify a maximum size for the wiresheet width. See also, “Working with the Wire Sheet view” on page 2-22.

• **Max Height (NiagaraAX-3.6 and later)**
  Use this property to specify a maximum size for the wiresheet height. See also, “Working with the Wire Sheet view” on page 2-22.
Data and Control Model

In any NiagaraAX station, all real-time data is normalized within the station database as points, a special group of components. Each point represents one data item.

Note: This applies to a Supervisor station as well as a JACE station, a shift from r2 Niagara data modeling. Stations no longer have "external links" between them. Instead, proxy points under a Niagara network are used. For more details, refer to the Drivers Guide section "About the Niagara Network".

The following sections provide more details:

- About control points
- About point extensions
- About control triggers
- About point status
- About writable points
- About composites

About control points

In the most simple form, points are control points. Find them in palette control: Points.

Figure 3-1 Control points

Control points are the foundation for all points in the station, including all proxy points.

- Types of control points
- Other control components
- About data value categories
- About point types
- About point Out
- About point inputs
- About point actions
- About point facets

Types of control points

As shown in Table 3-1 there are 8 different simple control points. Each type reflects a combination of a data (value) category and a point type.
Other control components

Apart from the 8 simple points, many other components are found in both the control palette and the kitControl palette. Briefly, these components include:

- **Extensions**
  To “extend” point functionality. See "About point extensions" on page 3-10.

- **Triggers**
  To provide periodic “actions.” See “About control triggers” on page 3-15.

- **Other control objects**
  Found in various folders in the kitControl palette. Use these to provide station control logic based on data obtained from points. Example objects include (numeric) math types, (Boolean) logic types, and a PID loop, among others. Also, a few point extensions are in kitControl. See the section “Application for kitControl components” in the kitControl Guide.

About data value categories

There are four distinct data value categories for points, as well as for other components (for example, weekly schedules). These value types are:

- **Boolean**
  Represents a binary value with only two states, such as “Off” or “On.”

- **Numeric**
  Represents an analog value such as a temperature, level, rate or similar floating point number, or a varying count (integer). Double-precision (64 bit) values are used.

- **Enum**
  Represents an enumerated state (more than two), such as a multi-speed fan with states “Off,” “Slow,” and “Fast.” Enums are often called multi-states or discretes. States typically derive from established integer value/state name pairs.

- **String**
  A string of one or more ASCII characters (and if alpha-numeric), often with some literal meaning.

Among the four categories, numeric and boolean points are the most common, as data usually falls into these two categories.

About point types

Within each of the four point data categories, there are two point types:

- **(read-only) e.g. BooleanPoint or NumericPoint**
  Represents a read-only data item. Unlike with the writable point type, there are no “input” type properties.
  **Note:** As copied directly from the control palette, there is no application for read-only points. However, proxy points based upon read-only points, identical except for a non-null proxy extension and manner of creation, are both common and useful. For more details, see "About the proxy extension" on page 3-11, or refer to "About proxy points" in the Drivers Guide.

- **Writable**
  Represents a data item that can be written, as well as read by the station (typically). An array of 16 “InN” inputs, each with a different priority level, is available to write the value. By default, the point’s value can also be set with an operator-issued action (right-click command), available at priority levels 8 (override) and 1 (emergency). For more details, see "About point actions" on page 3-3. Writable points also have other features. See, “About writable points” on page 3-19.

About point Out

Each point has a property “Out” that provides real-time information, as shown in Figure 3-2.

<table>
<thead>
<tr>
<th>Table 3-1 Control point types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boolean Category</td>
</tr>
<tr>
<td>BooleanPoint</td>
</tr>
<tr>
<td>BooleanWritable</td>
</tr>
</tbody>
</table>

See “About data value categories” on page 3-2 and “About point types” on page 3-2.
About control points

Chapter 3 – Data and Control Model

Figure 3-2  point Out provides real-time information

At a minimum, the Out property provides:

- **value**
  Current value of the data item, within one of four possible data categories. See "About data value categories" on page 3-2.

- **facets**
  Items affecting the display of the value, such as decimal places, engineering units, or text descriptors for Boolean/enum states. See "About point facets" on page 3-7.

- **status**
  Current status of the data, meaning the health and validity of the associated value. Status is specified by a combination of status flags, such as “fault,” “overridden,” “alarm,” and so on. If no status flag is set, status is considered normal and appears by default as “{ok}.” Status flags are set in a number of ways. See "About point status" on page 3-16.

- **priority**
  Currently active Niagara priority level (from a 16-level priority scheme), for writable control points only. For more details on priority, see "About the priority scheme" on page 3-19.

  **Note:** All writable control points include priority in status, including writable proxy points. Priority appears at the end of the Out value, by default formatted as “@ n”, where n is 1 to 16, or if the fallback value is in effect, formatted as “@ def”. For example: "Off {ok} @ 1".

**About point inputs**

Writable points have 16 input properties: "In1" to "In16," corresponding to priority levels. As needed, you can link up to 14 of these inputs to another component in the station. Figure 3-3 shows a BooleanWritable with links made to 3 inputs.

  **Note:** Read-only (plain) points do not have any input properties.

Figure 3-3  Example links made to priority inputs

By default, a writable point’s glyph (shape on wire sheet) shows only inputs In10 and In16 "pinned" for linking. However, when linking to a writable point, the Link editor shows all available priority inputs. For more details, see "About the priority scheme" on page 3-19.

**About point actions**

Writable points have actions—by default, these appear in a right-click menu when you select a point in a Workbench view or in the Nav tree (Figure 3-4).
An action is a slot that defines a behavior. Some other control objects and extensions also have actions.

In the case of the 4 writable control points, default actions include the ability to:

- Override the point at priority levels 8 (override) and 1 (emergency override), where control can be independently set or “auto’ed” at either level. An override can be for a defined (or custom) length duration, as specified in the action’s popup dialog. See “About override actions” on page 3-4.
- Set the value of the point’s “Fallback” property. See “About set (Fallback) action” on page 3-4. Often, you modify a writable point’s default actions—see “Modifying default actions” on page 3-5.

**About override actions**

Whenever a writable point is controlled from an action issued at either *override* level, it has an “override” status. By default, override status color is magenta, as shown in **Figure 3-4**. For more point status details, see “How status flags are set” on page 3-17.

An override action to a value (not an “auto”) prompts for an override duration, see **Figure 3-5**.

By default, a “Permanent” override is the first choice in the drop-down list—the override value will remain effective until the next time this action is auto’ed. Other *timed durations* are available, including a “Custom” selection in which a user specifies a duration in hours, minutes, and seconds. After clicking OK, the override action is issued to the point—if this is the highest effective priority level, the writable point operates under this control. If this is a timed override, the action is automatically auto’ed upon expiration of the override period.

**About set (Fallback) action**

Whenever a writable point has a “null” or “invalid” value at inputs In1—In16 (note this means that both override levels are currently “auto’ed”), the Out slot is set to the value of the fallback property. For more details, see “About the priority scheme” on page 3-19.

By default, an operator-level user can change the Fallback property, using the “set” action. This produces a popup dialog that displays the current Fallback value (**Figure 3-6**).
From the set action prompt, a "Cancel" leaves the current Fallback property unchanged. Otherwise, the Fallback property is set to the value entered (or currently displayed value).

**Note:** The set action prompt does not display (or accept) a "null" value for Fallback. However, a Fallback of null can be entered from the point's property sheet.

A common application for this feature is with NumericWritables used as setpoints, particularly under a NiagaraNetwork. As Niagara proxy points are always read-only points (not writable types), yet inherit any actions of the source point, this feature provides user access to setpoints via px graphics without creating additional proxy points. In particular, this "set" action is designed to work well with "SetPoint" type widgets (found in the kitPx palette). For details, see "About Widgets" on page 6-12.

**Note:** Each of the four "constant" kitControl components also provides a "set" action that works in a similar manner, including with kitPx widgets. However, a constant object (NumericConst, BooleanConst, etc.), has no priority inputs or Fallback property—the set action simply writes directly to the component's current Out slot. For details, see the "About Constant components" section in the kitControl Guide.

### Modifying default actions

Unless all the "defaults" for actions of a writable point are acceptable (display names, all actions available, default user access), you may wish to modify action defaults. You can do this selectively from the slot sheet of the writable point. For general information, see "About slots" on page 1-9, and "Using the slot sheet" on page 10-18.

The following sections provide more details:

- **Display names** — Change how the point's popup action menu lists available actions
- **Action access** — Limit the actions that are made available, either by user level or for all users

**Note:** As a "global" alternative to editing display names on slot sheets, you can edit the default values of lexicon keys, in this case for the control module for action type slots. For details, see "Notes on English (en) lexicon usage" on page 9-7.

**Note:** You can also modify the display name of the same action in multiple points in a single operation, using the (default) "Batch Editor" view of the station's ProgramService (Config > Services > Program-Service). This is one of many examples of using the Batch Editor, available in all NiagaraAX releases. Also, starting in AX-3.6, you can use the Batch Editor to modify a config flag of the same slot on multiple components in a single operation. For details, refer to the Batch Editor - Engineering Notes document.

**Display names** By default, action display names are generic ("Emergency Inactive" and so on). You can change the display name for any action. From the slot sheet, click on an action's Display Name for an editor (Figure 3-7). When you change a display name from defaults, it appears in listed in bold.
When a user invokes an action, the popup menu lists possible actions by more meaningful descriptors. For example, you could change the “set” action display name from “Set” to “Set Fallback.”

Action access  By default, for any writable point, all actions are available to any admin-level user, and all actions except emergency-level ones are available to an operator-level user. As needed, you can selectively “hide” actions (from any level user), or change default permissions for actions.

Note:  From a Px widget, you can also disable Px access to a bound writable point’s actions, by setting the “popupEnabled” binding property of the widget to false. In this case, access to the point’s actions would still be available from the point’s property sheet or in the wire sheet, unless otherwise changed from its slot sheet. For related Px details, see “Types of binding properties” on page 6-22.

From the slot sheet, do this by editing the action’s config flags (right-click the action and select Config Flags, as shown in Figure 3-8).

In the Config Flags editor, you click to assign or remove config flags. As pertains to action slots, the following flags are most often changed:

- **Operator**
  If checked, only operator-level access is needed to invoke the action. If cleared, admin-level access is needed. For details on permission levels, see "About permission levels" on page 7-6.

- **Confirm Required**
  If checked, a second (confirmation) dialog appears after the action is invoked, before the action executes. An example confirmation dialog is shown in Figure 3-9. By default, this flag is cleared.

- **Hidden**
  If checked, the action does not appear (is hidden) from the action popup menu—for any user. You may wish to do this selectively for some actions, for example, the “set” action for Fallback access. (Note that a user with admin-level rights to the point may still access the point’s slot sheet.)
As previously noted, starting in AX-3.6, the **Batch Editor** lets you modify a slot’s config flag on multiple points in one operation. Refer to the **Batch Editor - Engineering Notes** document for details.

### About point facets

Primarily, facets determine how the point’s value *displays* in the station. Examples include engineering units and decimal precision for numeric types, and descriptive value (state) text for boolean and enum types.

With the exception of proxy points (with possible defined device facets), point facets do *not* affect how the point’s value is processed. Refer to the **Drivers Guide** section “Effect of facets on proxy points” for related details.

**Note:** Besides control points, various other components have facets too. For example, many kitControl and schedule components have facets. Details about point facets apply to these components too, unless especially noted.

Topics about facets include:

- Accessing and editing facets
- Facets importance for Enum points
- Effect of facets on point actions

### Accessing and editing facets

Facets is a frozen slot in all control points and objects in the kitControl module. As shown in Figure 3-10, you modify facet values in a point’s property sheet, using the **Config Facets** dialog.

**Figure 3-10** Point facets and edit dialog (AX-3.3 and later shown)

In this case a BooleanWritable's default `trueText` facet is “true”—to modify you simply click to select, then type over with whatever text is needed. For example, change “true” to “On” and “false” to “Off”. When done click OK and then Save to make the actual point change.

**Note:** If using Workbench AX-3.2 or earlier, you see a slightly different facets editor—where you must click a **Modify** button to edit existing facets. See **Figure 3-11** below. However, the basic operation is the same.
Optionally, in addition to modifying existing facets, you can add or remove facet values in a point. However, for most points you will only modify or provide new values for the default facets.

**Note:** For string-type points (StringPoint, StringWritable), facets have little practical application. By default, the Facets slot is empty for string-type points.

**Facets importance for Enum points**

Facets for enum-type components (EnumPoint, EnumWritable, EnumSchedule, etc.) define the operating *range* of the component, meaning its different possible enumerated states. Each state is defined by a pairing of an integer value-to-text, also known as ordinal-tag. Each ordinal must be a unique integer, and each tag must be unique text. By default, the point's value displays using tag text.

If you add an enum point from the control palette, its Facets slot has a *blank* range entry. Until you edit this facet and supply the ordinal-tag values, it can display only integer values. As shown in Figure 3-12, a special *Enum* dialog appears when you edit range facets.

In the *Enum* dialog when adding an entry, the **Add** button becomes available after you enter an integer value in the left side Ordinal box, as shown in Figure 3-12. Type in the associated text in the right side Tag box, then click **Add** to add to the facet's range. Click **OK** when done, also **OK** on any remaining pop-ups.
Chapter 3 – Data and Control Model

April 4, 2011

About control points

About point facets

---

Figure 3-13  Type unique integer value in Ordinal box and associated text in Tag box

If using lexicons, in the “Lexicon Module Name” field you can enter the *module name* of a configured lexicon (for example, *control* or *kitControl*) if Tag strings match lexicon “keys” in that lexicon file. In this case, enumerations will display the lexicon strings (values) for those ordinals instead of the tag text.

When defining range enumerations, instead of defining a custom one with your supplied ordinals and tags text, you can also select from well known “frozen” enumerations, as defined in various installed modules. A checkbox enables this and provides a drop-down list for you to select by module and enumeration type (see Figure 3-14).

Figure 3-14  Frozen enum selection in Enum dialog

Depending on the driver/network type, the Point Manager under a device may automate this facets range configuration when you add enum-type proxy points. For example, under a Lonworks device, if you add an EnumPoint for a Lonworks NVO that uses an enumerated SNVT, that point’s facets will automatically be configured with the correct range values.

**Note:** If an enum-type point receives an input value not included in its defined facets range, it displays the ordinal integer value for that input. This varies from the multistate objects used in r2 Niagara, which would display “Error” for any value not defined in its “stateText” entries.

**Effect of facets on point actions**

For some points with actions (see “About point actions” on page 3-3), facets also affect availability in the point’s action (command) menu, as follows:

- **EnumWritable**
  
  Upon an override or emergency action, a secondary drop-down selection dialog lists the possible enum values (in its range), using display tag text. This list appears ordered top-to-bottom by the tag associated with each ordinal, lowest-to-highest.
• **NumericWritable**  
  Upon an override or emergency action, an entry dialog permits a value only between the facets "min" and "max" values, inclusive. By default, these facets values for numeric-type points are min= -inf and max= +inf (no effective range checking for an action).  
  For example, you could use this facet’s feature with a NumericWritable that sets a temperature control setpoint, by setting its facets min= 65 and max=85. After saving this change, any override or emergency action issued to that NumericWritable would need to fall within this range. Otherwise, a user would see a message showing the acceptable range, and be prompted to try again.  
  **Note:** Facets "min" and "max" values do not affect any received input values or proxied data, only what can be issued via an action.

---

**About point extensions**  
As needed, you can add one or more extensions to a point, each as a child of that point. Extensions are a way to add functionality to a point (or extend it) in a modular fashion.  
The following topics provide more details on extensions:  
• Extension process overview  
• Types of point extensions  
• About the proxy extension  
• About control extensions  
• About alarm extensions  
• About history extensions  
  **Note:** Extensions also apply to most kitControl objects. See the kitControl Guide section “Extensions and kitControl components” for more details.

**Extension process overview**  
Extensions are found in several palettes, including alarm, control, history, and kitControl.  
You typically add an extension by either:  
• dragging it into the property sheet of the point, or  
• dropping it on the point’s icon in the Nav tree.  
A point’s property sheet lists extensions below its normal (frozen) properties. You can expand each extension to view and modify its properties, as shown in Figure 3-15.

**Figure 3-15** Extension expanded in a point’s property sheet  
![Extension expanded in a point’s property sheet](image)

If a point has multiple extensions, they are processed in the same top-to-bottom order that they appear listed in that point’s property sheet. You can re-order extensions in a point—from the top of the point’s property sheet, or on the point’s icon in the Nav sidebar, right-click and select Reorder.  
  **Note:** If needed, you can also select and expose extension properties (for linking convenience) on the point’s glyph by using the Composite editor of the parent point. For more details, see “About composites” on page 3-21.
**Types of point extensions**

Point extensions include the *standard* proxy extension (one for each point, see “About the proxy extension” on page 3-11) and also *optional* extensions.

Optional extensions are in three main categories:

- **control extensions**
  - from control palette. See “About control extensions” on page 3-11.
- **alarm extensions**
  - from alarm and kitControl palette. See “About alarm extensions” on page 3-12.
- **history extensions**
  - from history palette. See “About history extensions” on page 3-14.

**About the proxy extension**

Each point has a proxy extension (Proxy Ext), a frozen property. The proxy extension is important—it indicates how the point’s data originates, including details specific to the parentage of the point’s network and communications (driver).

A point’s proxy extension is either:

- **Null**
  - For any point that you copy from the control palette (or add using the right-click menu), the proxy extension is simply null (NullProxyExt)—an empty placeholder. The station itself originates the point’s default Out value.
  - Also, many kitControl components also have a NullProxyExt, as they are based upon ControlPoints. For details, see “Extensions and kitControl components” in the *NiagaraAX kitControl Guide*.

- **<DriverType>**
  - For any proxy point, meaning any of the 8 point types you create using the Points extension under a device represented in any of the network types, the proxy extension is <DriverType>ProxyExt. For example, a BooleanWritable proxy point under the Points container of a Bacnet Device has a proxy extension of "BacnetBooleanProxyExt."
  - For any proxy point, its proxy extension contains information organized in child properties. Some properties may be unique to that specific driver type.

**Figure 3-16** Proxy extension for control point (null) and a Bacnet proxy point.

For more details, refer to Drivers Guide sections “About proxy points” and “ProxyExt properties”.

**About control extensions**

Control extensions are found in palette control Extensions (Figure 3-17). As needed, you can add them to points along with alarm and history extensions.
Control extensions perform additional processing on a point's received value. There are relatively few types of control extensions. See “Types of control extensions” on page 3-12.

### Types of control extensions

Table 3-2 lists all available control extension types and the applicable point parents.

<table>
<thead>
<tr>
<th>Control extension type (palette:Folder)</th>
<th>Applies to point types (read-only)</th>
<th>Writable</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>DiscreteTotalizerExt (control:Extensions)</td>
<td>BooleanPoint</td>
<td>BooleanWritable</td>
<td>Accumulates runtime and change of state (COS) count. Extension actions permit resetting (zeroing) the runtime and COS count.</td>
</tr>
<tr>
<td></td>
<td>EnumPoint</td>
<td>EnumWritable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>any object with single Boolean Out, e.g. kitControl: Logic object “And”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NumericTotalizerExt (control:Extensions)</td>
<td>NumericPoint</td>
<td>NumericWritable</td>
<td>Accumulates numeric total using hourly or minutely totalization. Extension has action to reset (zero) total.</td>
</tr>
<tr>
<td></td>
<td>any object with single Numeric Out, e.g. kitControl: Math object “Add”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ProxyExt (control:Extensions)</td>
<td>(standard for any point, see “About the proxy extension” on page 3-11)</td>
<td></td>
<td>Provides methods to reset driver communications.</td>
</tr>
</tbody>
</table>

### About alarm extensions

Use an alarm extension for any point you wish to monitor for offnormal values, and show alarm indication when a limit or value is met or exceeded. In an alarm extension, you also specify whether an alarm annunciation should occur upon alarm transitions, plus many other parameters.

Find the alarm extensions in palettes alarm Extensions (Figure 3-18) and kitControl:Alarm.
Alarm extension properties define items such as alarm enable (annunciation) transition types, alarm delay times, associated alarm class, and alarm display text for different transition types. You define the actual alarm limits or state(s) in properties in the extension’s “Offnormal Algorithm” slot. For more details, see “About alarm extension properties” on page 5-3.

**Types of alarm extensions**

Table 3-3 lists all alarm extension types and the applicable point parents.

<table>
<thead>
<tr>
<th>Alarm extension type (palette:Folder)</th>
<th>Applies to point types (read-only)</th>
<th>Writable</th>
<th>General description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OutOfRangeAlarmExt (alarm:Extensions)</td>
<td>NumericPoint</td>
<td>NumericWritable</td>
<td>Provides alarming based upon numeric alarm high and low limits. Includes configurable deadband.</td>
</tr>
<tr>
<td>StringChangeOfValueAlarmExt (alarm:Extensions)</td>
<td>StringPoint</td>
<td>StringWritable</td>
<td>Provides alarming based upon either inclusion or exclusion of the entered string value (or “regular expression”, as needed).</td>
</tr>
<tr>
<td>Note: AX-3.6 or later required</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BooleanChangeOfStateAlarmExt (alarm:Extensions)</td>
<td>BooleanPoint</td>
<td>BooleanWritable</td>
<td>Provides alarming based upon one of two possible values (state) as an alarm condition.</td>
</tr>
<tr>
<td>BooleanCommandFailureAlarmExt (alarm:Extensions)</td>
<td>—</td>
<td>BooleanWritable</td>
<td>Provides alarming based upon mismatch between commanded value and actual (sensed) value. Extension has feedback-Value input property for linking.</td>
</tr>
<tr>
<td>EnumChangeOfStateAlarmExt (alarm:Extensions)</td>
<td>EnumPoint</td>
<td>EnumWritable</td>
<td>Provides alarming based upon one of multiple possible values (state) as an alarm condition.</td>
</tr>
<tr>
<td>EnumCommandFailureAlarmExt (alarm:Extensions)</td>
<td>—</td>
<td>EnumWritable</td>
<td>Provides alarming based upon mismatch between commanded value and actual (sensed) value. Extension has feedback-Value input property for linking.</td>
</tr>
<tr>
<td>StatusAlarmExt (alarm:Extensions)</td>
<td>any type that accepts extensions</td>
<td>any type that accepts extensions</td>
<td>Provides alarming based upon any combination of status flags, including overridden, null, etc.</td>
</tr>
<tr>
<td>LoopAlarmExt (kitControl:Alarm)</td>
<td>—</td>
<td>LoopPoint</td>
<td>Sliding alarm limit for LoopPoint based upon controlled process deviation from setpoint.</td>
</tr>
<tr>
<td>ElapsedActiveTimeAlarmExt (kitControl:Alarm)</td>
<td>BooleanPoint with DiscreteTotalizerExt</td>
<td>BooleanWritable with DiscreteTotalizerExt</td>
<td>Provides alarming based upon accumulated runtime (elapsed active time). References a specific DiscreteTotalizerExt under same parent point.</td>
</tr>
<tr>
<td>ChangeOfStateCountAlarmExt (kitControl:Alarm)</td>
<td>BooleanPoint with DiscreteTotalizerExt</td>
<td>BooleanWritable with DiscreteTotalizerExt</td>
<td>Provides alarming based upon accumulated COS (change of states). References a specific DiscreteTotalizerExt under same parent point.</td>
</tr>
</tbody>
</table>
About history extensions

Add a history extension to any point for which you want to log historical data, that is collect a history. In a point history, each collected sample of slot “Out” has a date-timestamp, point status and value. Point history data is viewable in both a table and chart format.

Find the history extensions in palette **history: Extensions** (Figure 3-19).

Figure 3-19  History extensions

Each history extension has various properties in two major groups:

- **Collector**
  Determines how or when data is collected, such as active time, and (if applicable) either change tolerance or the collection interval time.

- **History Config**
  Determines how the data is stored and accessed in the system, such as history name, capacity, and full policy.

For more details, see “Configure history extensions” on page 4-25.

Types of history extensions

Table 3-4 lists all history extension types and the applicable point parents.

<table>
<thead>
<tr>
<th>History extension type</th>
<th>Applies to point types</th>
<th>General description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(read-only)</td>
<td>Writable</td>
</tr>
<tr>
<td>BooleanChangeOfValue</td>
<td>BooleanPoint</td>
<td>BooleanWritable</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>any object with single Boolean Out, e.g. kitControl: Logic object type “And”</td>
</tr>
<tr>
<td>BooleanInterval</td>
<td>as above</td>
<td>as above</td>
</tr>
<tr>
<td>NumericChangeOfValue</td>
<td>NumericPoint</td>
<td>NumericWritable</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>any object with single Numeric Out, e.g. kitControl: Math object type “Add”</td>
</tr>
<tr>
<td>NumericInterval</td>
<td>as above</td>
<td>as above</td>
</tr>
<tr>
<td>EnumChangeOfValue</td>
<td>EnumPoint</td>
<td>EnumWritable</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>any object with single Enum Out</td>
</tr>
<tr>
<td>EnumInterval</td>
<td>as above</td>
<td>as above</td>
</tr>
</tbody>
</table>
Chapter 3 – Data and Control Model
April 4, 2011

How triggers are used

About control triggers

There are two “time triggers” in the palette controlTrigger. These objects do not represent data, but instead regularly fire a topic.

**Figure 3-20** Control triggers

The two control trigger types are:

- **Interval**
  - Fires at a regular, repeating intervals specified in its Trigger Mode property.
  - For example, every n minutes, n hours, or whatever combination needed.

- **Daily**
  - Fires once a day at a specific time and day of week, as specified in its Trigger Mode property. For example, at 00:00:00 (midnight) all days of week except Sunday.

Each type has even more configuration capabilities to further define the fire time.

How triggers are used

To use a trigger, you typically link it to a selected action of a point extension (e.g. control, alarm, and history) to automate an action. Often, you use a trigger as a child of a particular point (sibling to the linked extension). Or, you can have a trigger in the same container as multiple points, and link it to more than one point or point extension.

For example, a Daily trigger (defined for midnight) can be linked to the ResetElapsedActiveTime action of a DiscreteTotalizerExt extension of a BooleanWritable point. In this case, that point’s DiscreteTotalizerExt would only show runtime accumulated during the current day.

About related objects

Other objects with trigger functions are found in various palettes. The most closely related is the Trigger-Schedule object, found in the Schedule palette. See “About trigger schedules” on page 8-19.

<table>
<thead>
<tr>
<th>History extension type</th>
<th>Applies to point types</th>
<th>General description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(read-only)</td>
<td>Writable</td>
</tr>
<tr>
<td>StringChangeOfValue</td>
<td>StringPoint</td>
<td>StringWritable</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>any object with single String Out</td>
</tr>
<tr>
<td>StringInterval</td>
<td>as above</td>
<td>as above</td>
</tr>
</tbody>
</table>

**About the Update History Id action**

All history extensions have an Update History action available. This popup menu item provides a way to refresh the History Id after a rename. It applies the formatting property (as designated by enclosing % signs) of the Name Format field to the Id of the History Config Id.

For example, if the History Name property under a history extension is set to $parent.name$, then the History Config Id is initially named based on this parent display name. However, if you rename the parent component, the History Config Id property does not automatically or immediately change. The Update History Id action invokes a renaming of the History Config Id based on the formatting property, so if the parent component (in this example case) is changed, the Update History Id action changes the Id property and, if different from the history name, it results in a change in the history name as well. See “About history names” on page 4-26 for more information about history naming.
About point status

Along with point value, point status is available at point Out. Status reflects status flags, which may get set singly, or in combinations. Status flags are typed by a unique text string (for example: "alarm" or "down"), and many have associated status colors (a background and a foreground). For example, the default status colors for alarm is white text on red background.

Status without any flags set is considered normal (text "ok"), and is without color indication.

**Note:** For each installed lexicon, text strings for status flags (plus associated colors), are individually adjustable by editing default values in that host’s *baja* lexicon, using Workbench’s Lexicon Editor. For a default English installation, to change default status appearance settings, edit the *en: baja* lexicon. For more details, see “About lexicons” on page 1-19 and “Lexicon Editor view” on page 9-6.

The following topics explain further details about point status:

- Types of status flags
- Priority of status indication
- How status flags are set
- About “isValid” status check

### Types of status flags

Status flag types are listed in Table 3-5, along with associated default colors (if any).

<table>
<thead>
<tr>
<th>Type</th>
<th>Default Colors, Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>alarm</td>
<td>white text, red background</td>
<td>Point currently has a value in an alarm range, as defined by property in its alarm extension.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="65.0°F" /></td>
</tr>
<tr>
<td>fault</td>
<td>black text, orange background</td>
<td>Originates from a proxy point only. Typically indicates a configuration or licensing error. If it occurs after normal operation, it may indicate a “native fault” in device, or the point’s parent device has a fault status.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="208.8°F" /></td>
</tr>
<tr>
<td>overridden</td>
<td>black text, magenta background</td>
<td>Current point control is from an action, meaning a user-invoked command at either priority level 8 (override) or priority 1 (emergency).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="72.0°F" /></td>
</tr>
<tr>
<td>disabled</td>
<td>gray text, light gray background</td>
<td>Originates from a proxy point only. Point (or its parent device or network) has been manually disabled (property enabled = false).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="79.0°F" /></td>
</tr>
<tr>
<td>down</td>
<td>black text, yellow background</td>
<td>Originates from a proxy point only. Driver communications to the parent device are currently lost, based upon the device status (Monitor) configuration for that network.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="68.4°F" /></td>
</tr>
<tr>
<td>stale</td>
<td>black text, tan background</td>
<td>Originates from a proxy point only. Driver communications have not received a requested response for this data item within the configured times (Tuning period).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="73.4°F" /></td>
</tr>
<tr>
<td>null</td>
<td>(no color indication)</td>
<td>Current point control has entered a null state, vs. a specific value and priority level. Typical to fallback operation for a writable point.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If linking a null status Out to a “simple data” slot, the point’s “null value” is processed. See the NiagaraAX kitControl Guide section “Status value to simple value” for more details, including its “About null values” section.</td>
</tr>
<tr>
<td>unackedAlarm</td>
<td>(no color indication)</td>
<td>Last point alarm event has not yet received user acknowledgment. Point’s alarm extension uses alarm class requiring acknowledgment.</td>
</tr>
</tbody>
</table>
**Priority of status indication**

Since status flags for a point or object can get set in combinations, status color indication uses a priority method. Among those 6 status flags with associated colors, priorities (and default colors) are:

1. disabled (dark gray)
   Proxy point origination only. Point may have other status flags set. Typically, you manually set and clear this status (unlike others). After disabled is set for a proxy point, it is no longer polled. Further status changes do not occur until disabled is cleared.
2. fault (orange)
   Typically proxy point origination only.
3. down (yellow)
   Proxy point origination only.
4. alarm (red)
   Point may have other status flags set.
5. stale (tan)
   Proxy point origination only.
6. overridden (magenta)
   Point may have other status flags set.

**Note:** Status types unackedAlarm and null do not affect the indicated status color. For more details on proxy point status, refer to “Proxy point status” in the Drivers Guide.

**How status flags are set**

Status flags are set differently depending on the type of point or control object. The following sections explain:

- Simple control point status
- Propagate Flags status option (linked Math and Logic objects)

**Note:** Refer also to the Drivers Guide section “Proxy point status” for further details.

**Simple control point status**

For simple control points (NullProxyExt) the following status flags are the only ones set and cleared:

- **alarm**
  Point is currently in an alarm condition as defined in its alarm extension.
- **unackedAlarm**
  Point has alarm extension assigned to an alarm class requiring acknowledgment, but the last alarm event has not yet been acknowledged. Point may/may not be in alarm.
- **override**
  Writable points only, during a user-initiated action at priority levels 8 (override) or 1 (emergency). The override flag clears when the action “times out,” or when a user issues an “auto” action at that same priority level.
- **null**
  Writable point has “null” or otherwise “invalid” value at In1—In16, plus “null” configured as “Fall-back” value. See “About “isValid” status check” on page 3-19.

See Figure 3-21 for examples of override and alarm status in simple control points.
Propagate Flags status option (linked Math and Logic objects)

By default, kitControl objects maintain independent status flags from input-linked points. However, as a configuration option in each math or logic-type kitControl object (kitControl palette folders “Math” and “Logic”), you can specify “out” status to propagate from input status.

The object’s Propagate Flags property allows you to select any combination of the following status types for propagation:

- disabled
- fault
- down
- alarm
- overridden

**Note:** If the math or logic object has multiple inputs, and you set the propagateFlags property to select one or more of the statuses above, simple “OR” logic is used across all inputs for the propagation of each selected status.

Depending on usage, status propagation may be extensive. Note that four of the five status types (all except alarm and overridden) are “invalid status,” meaning they cause the output of the object (if linked) to be considered invalid at its destination target. See “About “isValid” status check” on page 3-19.

As an example of status propagation, some number of NumericWritable points are used to establish setpoints, and you link them all to a Math: Average object for downstream zone control. In turn, the Average object feeds a Math: Reset object. Both math objects have “override” enabled in their “propagate-Flags” property. A user issues an override (action) to one of the NumericWritable points, to override a setpoint (Figure 3-22).

**Figure 3-21** Status with simple control points

**Figure 3-22** Status propagation in linked writable points, kitControl objects
For the duration of the override, the linked Average object will also have an overridden status, as will the Reset object, and so on. However, note that the linked writable point (NWcombined) in this example does not have overridden status—status never propagates to any point.

Note: Status propagation did not occur in Niagara r2, and is a new configuration option in NiagaraAX. Before using this feature in an actual job, you should test and evaluate results to be sure it has the desired effect. For example, if a Logic or Math object is exposed in a graphic and appears overridden, a user may (incorrectly) assume that they can right-click command (perform an action) on that kitControl object, based on status color indication.

**About “isValid” status check**

When linking an input-type slot of a writable point or kitControl object, the value received at the input is processed (evaluated) by that point or object only if it is valid.

Note: A valid input is one with none of the following status flags set:

- down
- fault
- disabled
- null
- stale

If any of the above status bits are set at an input, that input value is not used.

- If a kitControl object with a single input, by default that object uses the last known valid received (at least until the input becomes valid again).
- If a kitControl object with a multiple inputs, only the valid inputs are evaluated.
- If a writable point, the priority scan continues. See "About the priority scheme" on page 3-19.

**About writable points**

All writable points provide right-click actions. Override actions are evaluated within the priority scheme used by any writable point. In the case of the “set” action, the point’s “Fallback” property is modified (see “About point actions” on page 3-3). BooleanWritable points also offer built-in “minimum on/off” timers.

- About the priority scheme
- About minimum On and Off times

**About the priority scheme**

Each writable point uses a 16-level priority scheme, with corresponding inputs In1—In16, plus a “Fallback” property. Level 1 is the highest priority, and level 16 is the lowest.

The following topics further describe the priority scheme:

- Priority input scan
- Priority linking rules
- Priority level conventions

**Priority input scan**

For any writable point, the effective input value is determined by a priority scan, looking for a “non-auto” action at level 1 (emergency), then the value at the highest valid input, going from level 2, to 3, and so on to level 16. (At level 8, any “non-auto” action is evaluated as valid).

Like almost all control execution, this priority scan is event-driven, meaning it occurs when any input value changes. An input’s value typically comes from a link—however, note that for most inputs, you may enter a value directly in the point’s property sheet (as an alternative source).

Note: A valid input is one with none of the following status bits set:

- down
- fault
- disabled
- null
- stale

If all 16 priority levels are evaluated without a valid input (and without an action at levels 1 and 8), then the fallback value is used.

Note: You can configure the writable point’s "Fallback" property to be "null," so that the point’s Out has a null status in this condition. Depending on the specific control sequence and usage of the writable point, this may be an effective solution.
However, note that by default, a "set" action exists on any writable point, which writes directly to the Fallback value. See "About set (Fallback) action" on page 3-4. If you want a writable point to always have a Fallback of "null," go to its slot sheet and set the “Hidden” config flag on the "set" slot. Otherwise, a user can invoke a right-click command to set Fallback to any value. For more details, see "Modifying default actions" on page 3-5.

**Priority linking rules**

When linking to the priority inputs of a writable object, you may notice these default rules:

- Only one link per input (level).
- Levels 1 and 8 are unavailable for links. If a BooleanWritable, level 6 is also unavailable. Priority levels 1 and 8 are reserved for actions (emergency and override). See "About point actions" on page 3-3. Priority level 6 in a BooleanWritable is reserved for minimum on/off times. See "About minimum On and Off times" on page 3-20.

**Note:** Both rules vary from the r2 Niagara priority input scheme, where a single priorityArray input was used for a writable object (AnalogOutput, BinaryOutput, and so forth). That input could be linked to multiple priority type outputs, including those with duplicate priority levels and/or levels also used for object commands (emergency and manual).

**Priority level conventions**

The 16 priority levels used by writable points are modeled after corresponding BACnet priority levels, using the following conventions, from highest to lowest:

1. Emergency (Manual Life Safety)—Unlinkable input, but available as action (command).
2. Automatic Life Safety
3. User Defined
4. User Defined
5. Critical Equipment Control
6. Minimum On/Off (BooleanWritable meaning only, see "About minimum On and Off times")
7. User Defined
8. Override (Manual Operator)—Unlinkable input, but available as action (command).
9. Demand Limiting
10. User Defined
11. Temperature Override
12. Stop Optimization
13. Start Optimization
14. Duty Cycling
15. Outside Air Optimization
16. Schedule

**Note:** Although priority levels are patterned after BACnet, there is no direct linkage to BACnet priorities, even with BACnet writable proxy points. Priority inputs of all AX writable points are strictly a station-centric NiagaraAX implementation.

**About minimum On and Off times**

Each BooleanWritable point has built-in timers to specify minimum on and/or minimum off times. The respective point properties are “Min Active Time” and “Min Inactive Time.” Usage is optional, and both properties work independently. Typical usage is to prevent short-cycling of equipment controlled by the point.

Default property times for a BooleanWritable are all zeros ("00000h 00m 00s"), which effectively disables a timer. In either property, you can specify any value needed using a mix of hours (h), minutes (m), and seconds (s) to enable that timer.

A minimum timer is triggered by a state change transition to active or inactive. This results in the new state value being stored in the point’s priority array (at priority level 6) for the duration of that timer. While a minimum timer is in effect, only input changes at a higher priority (5 or above) or an emergency action can affect the Out value.

For example, a BooleanWritable point controls a fan, with related properties set as follows:

- **Min Active Time:**00000h 01m 30s
  
  Specifies that once started, the fan must run at least 90 seconds.
- **Min Inactive Time:**00000h 03m 5s
Specifies that once stopped, the fan must remain stopped at 3 minutes, 5 seconds. Starting with the fan stopped at schedule level (priority 16), if a user gives it a manual override on (priority level 8), the fan will run for 90 seconds at priority level 6 (a higher level). After this period, the fan continues running at the override 8 level for the duration of the override.

During the initial 90 seconds, a different override action (off or auto) will be ineffective—as the higher priority level 6 remains in control. See “Priority level conventions” on page 3-20.

Once stopped, the point’s minimum off time will keep the fan off at priority level 6 for the specified duration (in this example, 3 minutes and 5 seconds). During this period, only an emergency command or input change at In2—In5 can effect further change.

About composites

Currently, a composite is something that Workbench allows you to do to virtually any component in a station, notably control points and objects, and even folders that contain control logic. When you make a composite, you expose slots of child components in the glyph (object shape) of that parent (composited) component. This can simplify linking and promote reuse of control logic.

Caution: Composites have associated issues—see “Composite issues” on page 3-24. For now, you should avoid making folder composites in your control logic, and instead use the composite feature only at the point/object level to expose extension slots (if necessary). See example “Point-level composite” on page 3-21.

When you composite a component (say a control point, meaning its contents), you select specific slots in child components (say, properties and/or actions of its extensions) to be “exposed” in the “shape” of that point. Then, when looking at that point in the wire sheet view of its parent folder, you can see exposed properties of children as linkable slots (and/or available actions).

Note: If you are familiar with Niagara r2, the composite concept is similar to “Bundle” or “Composite” objects, only more flexible—you can expose slots in containers many levels down, for example. However, please see the Caution above.

Some composite examples

A few simple examples of composites are included here, as follows:

- Point-level composite
- Folder-level composite

Point-level composite

Figure 3-23 shows a proxy NumericPoint representing a space temperature value that has two extensions:

- an alarm extension (OutOfRangeAlarmExt)
- a history extension (NumericInterval)

Figure 3-23 Property sheet of proxy point with two extensions

In this example, when another system-related BooleanWritable (representing the system fan) has a false (Off) status, it is desired that this temperature point be:

- disabled from alarming, and
- disabled from continued history collection
To achieve these “disable” functions, you must link the controlling source fan out to a slot of each extension (visible in point’s wire sheet view, but not in the parent wire sheet for the point itself). Furthermore, other kitControl objects needed. Without making a composite, the necessary objects and links may appear as shown in Figure 3-24.

**Figure 3-24** Proxy point example without composite

Notice that when looking at the proxy NumericPoint in the wire sheet of its parent folder, it is not apparent that this point has linked extensions.

By making a composite of the NumericPoint (acting as the container for both the extensions plus the additional kitControl objects) you can simplify reuse and clarify available links. Figure 3-25 shows the now-composited NumericWritable linked to the controlling BooleanWritable, and the wire sheet view of the NumericWritable that contains the needed kitControl objects.

**Figure 3-25** Proxy point as composited container

In this example, the exposed input slots in the composite were renamed from “In” to “almInhib” and “histStop” respectively, to clarify what each does. When looking at the Composite Editor for this example NumericPoint, it appears as shown in Figure 3-26.
Figure 3-26  Composite Editor for example NumericPoint

Folder-level composite

Note: Please see the related Caution on page 21.

Figure 3-27 shows a simple example of three Math objects chained together, located in a "LogicA" folder. Together, they perform a “Celsius to Fahrenheit” conversion. A NumericWritable is also shown linked to the first Math object to test.

If this application was needed later, you could copy all 3 linked objects again and insert in another (perhaps already crowded) wire sheet. However, the middle “Multiply” object reveals an intermediary result that is distracting. Or, you could just create a new subfolder with only the 3 linked objects and then link directly to the child objects as needed (however, it would not be obvious from the parent’s wire sheet that links to children in that folder were established).

It would be better to “encapsulate” this into a single object with only a single “input” (degrees F) and single “output” (degrees C). You can do something like this by compositing the parent container, in this example folder “FolderA.”

In this case, you would want to delete the link from the test NumericWritable first, then open the Composite Editor for the parent component FolderA (Figure 3-28). The Composite Editor lets you expand the tree of all contained components and “expose” those items of interest.
Figure 3-28  Launching and using the Composite Editor

In this example, only the “In A” of the first math object and the “Out” of the third math object is selected to be exposed. The Composite Editor provides a tree pane showing slots of points and objects (by clicking the expand controls), and a slot is exposed by simply double-clicking it. Other controls in the editor are available to rename, remove, reorder and reverse exposed items, but are not used here. (For more details, see Making a composite.)

After clicking OK to perform the composite, the item composited (in this example, "LogicA") shows exposed slots when viewed in its parent’s wire sheet. Figure 3-29 shows the test NumericWritable now linked to the composited LogicA folder.

Figure 3-29  Example LogicA folder showing exposed input and output

You could later reopen this folder’s Composite Editor and rename the exposed properties differently, perhaps “inDegF” and “outDegC” (to make the purpose of the composited folder clearer). This would not affect the three (child) math objects in any way.

Composite issues

Although composites can simplify linking and make understanding logic flow easier, they always introduce performance issues. Perhaps the biggest issue is that once you link a dynamic value to a composite, for example the “out” of a proxy point, it essentially “pinned” into the “subscribed” state. This means that proxy point will always be polling (regardless of any other usage).

In addition, each item exposed in a composite represents a link, where each link consumes some small amount of station resources. If used excessively, composites could noticeably reduce the total capacity of the station.
About Histories

In Niagara, a data log is referred to as a **history**. Histories are ordered collections of timestamped records. A single “history” is a collection of specific data values from a component within any station - local or remote. Histories are organized by their source station (device), as shown in Figure 4-1.

The following topics are relevant to understanding histories:

- **History Services**
  The History Service, the Audit History service and the Log History service provide support for logging data in a Niagara station. In order to provide database support for histories in a Niagara station, the station must contain the History Service. Refer to “About the history service” on page 4-2 for details about the History Service. Refer to “About the audit history service” on page 4-4 and “About the log history service” on page 4-5 for information about those services.

- **History ORD scheme**
  Once you have a history service running, you can access histories that you create in the database using the “history” ORD scheme. The unique history scheme name “history” and each unique history ID provide identification for the individual histories. All history collections are identified by this unique id. For information on using the ORD scheme to access individual histories, refer to “About ORDs” on page 1-16.

- **History space**
  History space provides a means for viewing and working with histories in the history database. History space is visually represented in Workbench as a node in the nav tree and may be accessed by using the nav tree or by using the Open ORD dialog box. Views on the History space include the following: History Chart Builder, Database Maintenance, Nav Container View. For more information about history space and history space views, refer to “Types of history space views” on page 4-5.

- **History views**
  History views present history information in various formats for both analysis and editing. Refer to “Types of history views” on page 4-10.

- **History logging process**
  Using histories involves a process of collecting, storing and archiving data. You can configure the history collection process to collect the data that you need and store the history records where you want them - locally or remotely. This process is described in more detail in “About the history process” on page 4-22.

- **History Configuration**
  History configuration includes working with parameters such as ID, history source, timezone, record type, and more. For more details on configuration, refer to “Configure history extensions” on page 4-25.
- **History data editing**
  You can edit and filter the history data in workbench using the history editor view (described in "About the history editor view" on page 4-15). The editing process is described in more detail in "About editing history data" on page 4-28.

- **History Grouping**
  Starting with AX-3.5, this component allows you to use history properties to provide custom organization and display of history space contents. See "About history grouping" on page 4-30 for more details.

- **History Nav Shortcuts**
  Available starting with AX-3.5, history nav shortcuts provide convenience navigation links to histories. See "About history nav shortcuts" on page 4-32 for more details.

### Types of History Services

History services are available in the History Palette, as shown in Figure 4-2.

![History services in the history palette](image)

Each service is described in the following sections:

- "About the history service" on page 4-2
- "About the audit history service" on page 4-4
- "About the log history service" on page 4-5

### About the history service

To use histories, each station must contain a single history service that provides http access to all of the histories in a station. This service is responsible for creating the history database, as well as enabling the collection and storage of histories in the database. If you do not have the history service in your active station, you can add it by dragging and dropping a copy from the History Palette, as shown in Figure 4-3.

![Adding the history service](image)

The history service manages histories in ways that are not always visible to the user, including the following:

- **identifies histories**
  when the service is started (normally this is whenever the station is started) all existing histories are added to the service.

- **life cycle management**
  handles history management functions, such as creation and deletion of individual histories.

- **namespace**
  maintains the naming convention (namespace) for all histories.

- **configuration**
  maintains a global default configuration for the histories.
Chapter 4 – About Histories

About the history service

The history extension manager and the history property sheet are two views of the history service that provide ways to work with history extensions. Refer to the following sections for more information about these views:

- About the history extension manager view
- About history service property sheet

About the history extension manager view

As the default view of the history service, the history extension manager shows all history extensions in the station and displays their current status. Using this view as both a management and navigational tool, you can double-click on any entry-row to go directly to the property sheet view of that extension. This table has the standard table features. Use the Table Options menu in the top right corner of the history table to modify the table view or to export the data in the view, as desired. Refer to “Table controls and options” on page 2-18 for information about using the tabular view, including the Table Options menu.

Figure 4-4 History extension manager

You can also Enable, Disable, Rename, or (starting in NiagaraAX-3.4) Edit System Tags for any collection from this view by selecting the desired history extension in the table and using the History Ext Manager menu, popup menu, or toolbar icons, as described in the sections listed below:

- “About the History Ext Manager menu” on page A-8
- “About the history extension manager popup menu items” on page A-11
- “About the history extension manager toolbar icons” on page A-15

Note: If a history is disabled, its row is dimmed with a gray background in the history extension manager view.

About history service property sheet

The history service property sheet, shown in Figure 4-5, includes the following properties:

- Max Open Time
  this is an editable parameter for setting the amount of time that the history database may remain open without being accessed before it is subject to being closed by the Close Unused Histories action. If the history is accessed more frequently than the Max Open Time, it is not closed when Close Unused Histories action is invoked.

- History Groupings
  Starting in AX-3.5, this property is available for organizing histories according to history properties that you can designate and enable using the History Group component.

Figure 4-5 History service properties

History service actions

History service actions are available from the popup menu when you right-click the HistoryService node in the nav side bar pane. Available actions include:
Types of History Services

About the audit history service

The Audit History Service keeps a history of the changes that are made by users. If this service is enabled, it registers itself as the auditor for the system when the service is started. The easiest way to add the audit history service (if not already present) is through a simple drag and drop method from the History Palette (under the HistoryService) to the services area of the nav side bar pane, as shown in Figure 4-6.

Figure 4-6  Adding audit history service

When enabled, the Audit History Service logs all property changes and all actions taken on a component, such as the following:

- Property changed
- Property added
- Property removed
- Property renamed
- Properties reordered
- Action invoked

You can view the Audit History Service properties, enable or disable the Audit History Service, and set record capacity parameters from the Audit History Service Property Sheet, as shown in Figure 4-7.

Note: Starting in AX-3.5, schedule changes are tracked in detail, as shown below.

Figure 4-7  Audit history service properties

Refer to “About user audits” on page 7-9 for more details.
About the log history service
The Log History Service keeps a History of Niagara log records when it is enabled. This service maintains a buffered history (“LogHistory”) of some of the messages seen in the station’s standard output. This can be very helpful when you are troubleshooting problems with a station. If a station has Log History Service enabled, you can check the log history for recent error messages. Refer to the Platform Guide section “Application output” for more information about output messages.

The Log History Service is available in the History Module. The easiest way to add this service (if not already present) is through a simple drag and drop from the History Palette (under the HistoryService) onto the services area of the nav side bar pane, as shown in Figure 4-8.

Figure 4-8  Adding log history service

You can edit the Log History Service properties and set configuration properties in the property sheet, as shown in Figure 4-9.

Figure 4-9  Log history service properties

In addition to the standard HistoryConfig properties, the following properties are available for editing:

- **Enabled**
  - select the `true` option to enable or the `false` option to disable the Log History Service.
- **Minimum Severity**
  - you can choose the level of output that you want to record by setting the log level `Minimum Severity` property. This property is the lowest-level station output message that you want to log. The default log level for `Minimum Severity` is `Error`. You can change this to `Warning`, `Trace`, or `Message`.

Types of history space views
The history space views shown in Figure 4-10 and listed below are particularly helpful in working with multiple histories:

- **Completed**
- **Warning**
- **Trace**
- **Message**
Types of history space views

• **History chart builder view**
  This is the default view of the History Space node (in the nav tree). Use this view to build any one of several types of chart options from the data that is stored in one or more histories. See “About the history chart builder view” for details.

• **Database maintenance view**
  Use this view to clear records or delete histories. Refer to “About the database maintenance view” on page 4-8 for more information about this view.

• **Nav container view**
  Use this view to display all histories in the station. See “About the nav container view” on page 4-9 for more details about this view.

**About the history chart builder view**

The chart builder view displays in Workbench, in all Workbench (Wb)Web profiles, and with NiagaraAX-3.2 and later, the Default Hx, and Basic Hx profiles, as well.

*Note:* The following description discusses the Chart Builder view in terms of the Wb Web and the desktop Workbench display profiles. Stations using NiagaraAX-3.2, can display the Chart Builder view in the browser using the Default and Basic Hx (non-Java applet) profile views. Views displayed using Hx look different but behave very similarly to the Workbench view. All field descriptions apply to both views.

The Chart Builder Workbench view (also Wb Web profile view) is shown in **Figure 4-11**, the Chart Builder Hx view is shown in **Figure 4-13**. Using this view, you can select the histories (or in AX-3.5 and later History Nav Shortcuts), title, and configure the charts that you want to generate.

**Figure 4-11** Chart builder view (NiagaraAX-3.1 and later)

**Figure 4-12** Chart builder view (NiagaraAX-3.5 and later using History Nav Shortcuts)
The display of the Chart Builder view is divided into three primary areas:

- **Display configuration fields**
  - **Time Range**
    Select a time parameter option from the list, including an option that allows you to set a specific time range using the *Edit Time Range* dialog box.
  - **Title**
    Type a title for your chart in this text field.
  - **Grid Lines**
    Select Show or Hide to show or hide grid lines on the history chart.
  - **Rollup**
    Rollup (or Rollup Interval) is an interval of time that is used to determine what (and how) data is presented in your chart. Each point displayed, using the rollup, represents a designated time interval before the specified plot time. A rollup value of 1 hour will present data at a granularity level of every one hour, while a rollup value of 15 minutes will show data for every 15 minutes of logged data. Rollup options are:
    - **Average**
      This option plots the average value for the selected rollup period.
    - **Min**
      This option plots the minimum value for the selected rollup period.
    - **Max**
      This option plots the maximum value for the selected rollup period.
    - **Sum**
      This option plots the total of the values in the selected rollup period.

- **Histories pane**
  This is the lower left area of the Chart Builder view. It displays all histories that are available in your local station or any station histories that you import by means of the Niagara network or other network driver (for example, BacnetNetwork). Histories are grouped under the station by station name. Double-click (Wb Web profile) or click (Hx Web profile) on a history name to copy it to the Current Charts pane.
  
  **Note:** The histories that are displayed in this pane are the same histories that are displayed under the history space node in the Workbench nav sidebar.

- **Current Charts pane**
  This pane displays the histories that are selected to be plotted. For each history, you may select the type of chart to generate, using the chart type option list, as displayed in Figure 4-14.
  
  **Note:** NiagaraAX-3.2 has more chart type options than earlier versions.

  Adjacent to the histories in this pane are icon-type controls that allow you to reorder histories in the pane or remove histories from the pane.
• **Control buttons**
  The following control buttons are located at the bottom of the Chart Builder view:
  • **Build button**
    Click this button to build the chart using the histories that are in the selected Current Histories pane.
  • **Clear button**
    Click this button to remove all histories from the Current Histories pane.

  **Figure 4-15** shows an example of chart that displays two histories.

  ![Two different history line charts using chart builder view](image)

  **Figure 4-16**  
  History pie chart and area chart using chart builder view

  ![History pie chart and area chart using chart builder view](image)

  **About Time Zones and the Chart Builder view**
  When charting multiple histories that include different timezones, the Chart Builder uses a “zoneless” time range configuration so that it can plot each history with reference to its own timezone. This means that the resulting charts are aligned by local time. For example, if you select a time range of 8:00 AM through 5:00 PM for two histories—one in EST and another in CST—then the values at 8:00 AM align so that the 8:00 AM values may be visually compared.

  **About the database maintenance view**
  The database maintenance view is shown in **Figure 4-17**. Using this view, you can clear records and delete complete histories from your history database. Select the database maintenance view by selecting the history space node in the nav sidebar and using the view selector menu or the popup menu to choose the database maintenance menu item.
The left side of the histories area contains the available histories window. This window displays all histories that are available in your local station or any station histories that you import by means of the Niagara network or other network driver (for example, BacnetNetwork). Histories are grouped under the station by station name.

Note: The available histories are the same histories that are displayed under the history space node in the nav sidebar.

The right side of the histories area contains the targeted histories window. This window displays the histories that are affected when you click the Run Maintenance button. Move the histories that you want manage into this window using the control buttons, as described below:

Controls and options for the database maintenance view are described in the following list:

- **Add history button (right arrow)**
  Click this button to move histories that are selected in the available histories window to the targeted histories window.

- **Remove history button (left arrow)**
  Click this button to move histories that are selected in the targeted histories window to the available histories window.

- **Clear Old Records option**
  Select this option and use the Before date selector to remove records, based on date, from the histories that are in the targeted histories window.

- **Before date field**
  Use this field with the Clear old records option to set the year, month, day, and time parameters that you want to use for removing old records.

- **Clear all records**
  Select this option to delete all records from the selected history database.

- **Delete Histories**
  Select this option to delete all histories that are in the targeted histories window.

- **Run Maintenance button**
  Click this button to execute the option that you have selected on the histories in the targeted histories window.

**About the nav container view**

The nav container view is shown in Figure 4-18. This view displays a row for each station that is represented in the history space. You can double-click on any of the station icons to display the individual histories that are children to the station that is represented in the Name column of the nav container view. Double click on a history in this view to display the history in the History Chart view.
Types of history views

You can view histories in different ways in Workbench. Figure 4-19 shows a menu of views that are available using either the Workbench view selector or a view popup menu. These views are listed and described in the following sections.

Figure 4-19  History views available from popup menu

- **History Chart**
  This view shows a plotted chart of the history data. This is the default history view. Refer to “About the history chart view” on page 4-11 for more details.

- **Live History Chart**
  Starting in NiagaraAX-3.3 background and live history charting is available for history data. This feature includes the ability to display historical data (trend data) in a **Live History Chart view** that plots a range of data from a configurable start time to the current time and continues plotting as new data is generated by the source. Refer to “About the Live History Chart View” on page 4-12 for more details.

- **History Table**
  This table shows a view of history data that you can export and view in the following formats: PDF, CSV, Text. In addition, you can modify the tabular view of history data by choosing to show or hide columns and by filtering the data based on date and time. Use the **Table Options menu** in the top right corner of the history table to modify the history table view or to export the data in the view, as desired.

- **Collection Table**
  This view shows a table of any data (in this case history data) that you can export and view in the following formats: PDF, CSV, Text. Use the **Table Options menu** in the top right corner of the collection table to modify the table view or to export the data in the view, as desired.

- **History Summary**
  This view shows a summary of the history’s status and configuration properties.

- **History Editor**
  This view allows you to actually edit data and filter histories.

- **History Slot Sheet**
  Starting in AX-3.5, this view displays a standard slot sheet for a history. You can add slots, using this view and designate them as metadata slots, if desired.
Chapter 4 – About Histories

April 4, 2011

Types of history data fields

The following types of data are common to several history table views and appear as columns that may be hidden or displayed using the Table Options menu. Refer to “Table controls and options” on page 2-18 for information about using the Table Options menu.

- **Timestamp**
  This data field indicates the time that the recorded value occurred.

- **Trend Flags**
  This data field displays trend flag information about the recorded data - for trend record types. These flags provide extra context information about the record data. For example: "Start", "Out-of-Order", "Hidden", "Modified", and "Interpolated" are possible trend flags.

- **Status**
  This data field displays the status of the history’s parent component; for example, “OK” or “null”.

- **Value**
  This data field displays the record value.

About the history chart view

The history chart view plots the data of the selected history log along x and y axes. This is the default view of the history, so if you double-click on a history in the nav sidebar, the history chart view will appear. An example of the history chart view is shown in Figure 4-20.

![History chart view](image)

Figure 4-20  History chart view

The history chart view contains the standard chart controls and options to help you customize and view the data, as described in "Chart controls and options" on page 2-19. In addition to these standard controls, the history chart view has the following additional buttons (also available on the toolbar):

- **On Demand button (available starting in NiagaraAX-3.4)**
  This button initiates On Demand plotting of the history data. Also see “About On Demand history views” on page 20.

- **Delta button**
  This button initiates the plotting of Delta values. Also see, “About delta logging” on page 4-23.

Charting in the browser

Starting in NiagaraAX-3.3, the Hx charting feature is redesigned to work in the browser without using any plug-ins. The following illustration shows a History Chart in the browser using Hx (no plugin).
Hx charts essentially look and work the same in all target media except for the following differences:

- The default time range for histories is now "Time Range" which is only the bounds of the history data. This is the default in workbench, so now history charts should look the same by default. You cannot however modify this time range. The existing options (Today, Last Month, etc.) are still available.
- Pie charts do not render in Microsoft® Internet Explorer® (IE)
- You may see slower render times in IE since the <canvas> tag has to be emulated using JavaScript and VML.

**About the Live History Chart View**

Background and live history charting provides a Live History Chart view that is similar to the static History Chart view. The key feature of the Live History Chart view is that it combines the historical plot of the History Chart with a continuing live plot that updates according to a configurable sample rate.

The live history chart view plots the data of the selected history log along x and y axes. This is the default view of the HistoryPointList component, so if you double-click on a HistoryPointList in the NiagaraAX-3.3 (or later) workbench nav sidebar, the Live History Chart view displays. An example of the Live History Chart view is shown in Live_History_Chart_view, below, which highlights the features that are only available in the Live History Chart view.

The Live History Chart view contains the standard chart controls and options to help you customize and view the data. However, in addition to these controls and options (described in "Chart controls and options" on page 2-19) this view has the following additional features:

- **Item List pane**
  This pane displays all the points that are linked to the chart view. You can click to select or de-select each item to display or remove the associated item plot from the chart. You can always resize the pane by dragging the left border to widen or narrow the pane in the view.

- **Toggle Item List button**
  Click this button to display or collapse the Item List pane.
• Continuously updating view
  As new data is plotted the view continues to update. When the chart area is filled, the screen scrolls to keep showing the latest data.

Selecting the Live History Chart View
You can display the Live History Chart view as either a view of a history extension or as a view of the HistoryChartList component, as shown in the following two illustrations:

Figure 4-23   Selecting the Live History Chart view as a History Extension view

Figure 4-24   Selecting the Live History Chart view as a HistoryPointList view

Using relative history extension ords with HistoryPointList
You can use relative paths to point to history extension ords when using a HistoryPointListItem component. This allows you to create a HistoryPointList under a typical device (Air Handling Unit, VAV, or other) and then copy the device (with HistoryPointList) to other locations without having to edit the ords for each new location. In the example shown in Figure 4-25, the HistoryPointList and the proxy points (zoneTemp1, 2, 3, and so on) with their history extensions are placed at the same level (in the same folder). The HistoryPointList component takes care of resolving the ord path for each HistoryPointListItem, so the relative starting point is the HistoryPointList and not the HistoryPointListItem. In this example, the History Extension path needs to step up one level using the "/../" then includes the folder name ("zoneTemp1/numericInterval") to designate the history extension.

Figure 4-25   Relative ords to history extension in HistoryPointListItem

Note: You can also embed the History Chart view of a "relativized" history extension ord into a Px view. This allows you to use a single Px view for multiple HistoryPointList (and associated Live History Chart view) locations.

About the history table view
The history table view displays history records with columns of data that you can customize by displaying or hiding selected columns. An example of the history table view is shown in Figure 4-26.

In addition to these standard controls, the history table view has the following additional buttons (also available on the toolbar):
- **On Demand button**
  This button initiates On Demand plotting of the history data. Also see "About On Demand history views" on page 20.

- **Delta button**
  This button initiates the plotting of Delta values. Also see "About delta logging" on page 23.
  Refer to “Table controls and options” on page 2-18 for details about table controls and options that are common to many table views.

**Figure 4-26** History table view

In addition to a title bar that displays the history name and number of records in the table, the history table has the following four columns that are described in “Types of history data fields” on page 4-11.

- **Timestamp**
- **Trend Flags**
- **Status**
- **Value**

Use the **Table Options** menu in the top right corner of the history table to modify the table view or to export the data in the view, as desired. Refer to “Table controls and options” on page 2-18 for a description of the **Table Options** menu.

**About the collection table view**

The collection table view displays records with columns of data that you can customize by displaying or hiding selected columns. Refer to "Table controls and options" on page 2-18 for details about table controls and options that are common to many table views.

An example of the collection table view is shown in **Figure 4-27**.

**Figure 4-27** Collection table view

In addition to a title bar that displays the history name and number of records in the table, the history table has the following four columns that are described in “Types of history data fields” on page 4-11.

- **Timestamp**
- **Trend Flags**
- **Status**
- **Value**
Use the **Table Options** menu in the top right corner of the history table to modify the table view or to export the data in the view, as desired. Refer to “Table controls and options” on page 2-18 for a description of the **Table Options** menu.

**About the history summary view**

The history summary view is shown in Figure 4-28. This view displays the details of the history’s status and configuration properties in two groups, as follows:

**Figure 4-28 History summary view**

<table>
<thead>
<tr>
<th>Status</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Count</td>
<td>20</td>
</tr>
<tr>
<td>First Timestamp</td>
<td>02-May-2005 11:03 AM EDT</td>
</tr>
<tr>
<td>Last Timestamp</td>
<td>02-May-2005 03:10 AM EDT</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Configuration</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Id (hex)</td>
<td>Unknown</td>
</tr>
<tr>
<td>Source</td>
<td>stations/lets/1plext/1plexttable1/1plexttdelext</td>
</tr>
<tr>
<td>Time Zone</td>
<td>America/New York (-5/-4)</td>
</tr>
<tr>
<td>Record Type</td>
<td>Float</td>
</tr>
<tr>
<td>Capacity</td>
<td>100 records</td>
</tr>
<tr>
<td>Full Policy</td>
<td>Full</td>
</tr>
<tr>
<td>Intervals</td>
<td>start = 02-May-2005 11:03 AM EDT</td>
</tr>
</tbody>
</table>

- **Status parameters**
  - these parameters display data that is updated as of the time you select the history summary view.
    - Record count
      - this is the current number of total records, as of the Last Timestamp.
    - First Timestamp
      - this is the date, time and timezone information for the initial history record.
    - Last Timestamp
      - this is the date, time and timezone information for the latest recorded history record.

- **Configuration parameters**
  - these parameters display data that identifies and characterizes the specific history. Refer to “Configure history extensions” on page 4-25 (see the History Config bullet item) for a description of the configuration parameters.

**About the history editor view**

An example of the history editor view is shown in Figure 4-29. The history editor view allows you to edit data and filter histories. This view also allows batch editing (selecting multiple rows and using the popup menu or the Edit menu).

**Figure 4-29 History editor view**

The history editor view is comprised of the following main areas:

- **Title bar**
  - this area displays the history name and number of records in the history.
• **Toolbar icons**
  These icons are available on the toolbar when the history editor view is displayed. Refer to “About the history editor toolbar icons” on page A-15 for descriptions of these toolbar icons.

• **Time range options**
  This menu is located in the top left corner of the history editor view. You can select one of the pre-defined times or select the **Time Range** option that allows you to set a specific time range using the **Edit Time Range** dialog box.

• **Table options menu**
  Use the **Table Options** menu in the top right corner of the history editor view to change which columns are displayed or to export the data in the view, as desired. Refer to “Table controls and options” on page 2-18 for more information about using the **Table Options** menu.

• **Table columns**
  In addition to a title bar that displays the history name and number of records in the table, the history table has the following four columns that are described in “Types of history data fields” on page 4-11.
  - **Timestamp**
  - **Trend Flags**
  - **Status**
  - **Value**

  Use the **Table Options** menu in the top right corner of the history table to modify the table view or to export the data in the view, as desired. Refer to “Table controls and options” on page 2-18 for a description of the **Table Options** menu.

• **Control buttons**
  The following two control buttons are used to initiate record editing in the history editor view:
  - **Edit**
    this button is available when one or more records are selected in the history editor table. When you click this button, the **Edit Records** dialog box appears.
  - **Select Outliers**
    this button is available when the outlier configuration parameters are active (when the option box is selected in the **Configure Outliers** dialog box). When you click this button, the **Configure Outliers** dialog box appears.

  Use the **Table Options** menu in the top right corner of the history table to modify the table view or to export the data in the view, as desired. Refer to “Table controls and options” on page 2-18 for information about using the **Table Options** menu.

**About the history slot sheet view**

Starting with AX-3.5, a slot sheet view is available on histories. This view allows you to edit and add slots to histories, if desired. In addition, you can designate slots as “metadata slots” by assigning a metadata flag to a slot.

**Note:** Properties that have the metadata flag are designated as metadata properties. You might use metadata property values to identify the location and function of a history’s source. History sources may be filtered or organized by the values of the metadata properties. You can use the Metadata Browser view to add, edit, delete, or view metadata tags.

**Figure 4-30** History slot sheet view

To add a new property to a history using the slot sheet view, open the **Add Slot** dialog box (Ctrl+A) from the history Slot Sheet view, as shown below.
About the history property sheet view

Starting in AX-3.5, histories can have properties. Like components, histories have a property sheet view that allows you to view and edit property values. You can add properties to a history (and designate them as metadata, if desired) using the slot sheet view or the metadata browser view. An example of the history property sheet view is shown in Figure 4-32.

The history property sheet view is comprised of the default history properties, as described in "Configure history extensions" on page 4-25 and any additional dynamic properties that are added. If you change any of the editable properties in this view then the properties are changed at the actual source of the history, if the source is accessible. For example, in a history property sheet view, if you change a history Full Policy property from Stop to Roll, then, if the "source" is accessible, the history Full Policy property is changed on the appropriate history extension or History Import component (Config Overrides property).

Note: If the history is imported from a NiagaraHistoryImport descriptor or NiagaraSystemHistoryImport descriptor that was made via "export tags" (HistoryImportTag, SystemHistoryImportTag) in the source station, the next export tag Join to/from that station will "overwrite" whatever fullPolicy or other property value changes that were initiated from the history property sheet.

Consider the following examples:
Types of history views

Chapter 4 – About Histories

April 4, 2011

Example 1: History imported from remote controller to Supervisor

In a situation where histories are imported to a Supervisor from a remote controller, the source configuration for that history is available on the supervisor Import Descriptor property sheet view. If you change the fullPolicy on the history property sheet view (as shown below), then the same property is changed on that history's Niagara History Import descriptor component (under the Config Overrides property).

Figure 4-33  Example 1: History property changes Import Descriptor property

Local histories behave in the same way, since local histories and history import descriptors should always be available to the supervisor station.

Example 2: History exported to Supervisor by remote controller

Histories that are exported from remote stations may create histories on the Supervisor that have an unreachable source. In this case:

- If the source of a history is unreachable, then the history configuration properties that are modified (under the history properties view on the supervisor) may be overwritten the next time that the history is exported to the supervisor.
- History properties that are flagged as metadata properties are not overwritten or dropped when histories are exported to the supervisor. Local metadata property values are persisted as long as they do not have the same name as properties that are being exported from the remote station.

Note: In most cases, it is a better practice to add metadata properties at the remote station if you are doing history exports so that they are exported up to the supervisor station.

See also: “About the history slot sheet view” on page 4-16 and “About the metadata browser view” on page 4-18.

About the metadata browser view

Starting in AX-3.5, the metadata browser view is available for working exclusively with metadata properties on components and histories. The interface provides a convenient way to add metadata slots to one or more components or histories. Although you can add metadata slots directly to a component or a history from the slot view, the metadata browser has the ability to add metadata slots to thousands of objects in one batch job.

The interface (shown in the following image) is a view on the root station component. It allows you to filter and navigate through your histories or components so that you can selectively batch-add metadata to all the desired objects. The view runs a job for the metadata operation and reports the results in a job log. If a job runs and is unsuccessful at any point, the job log displays the reason for the failure.

Note: An example of a failure might be that you try to add a slot type to an object that does not support that particular slot type. This exception should be indicated in the job log.
The following areas comprise the main parts of the metadata browser view:

- **Job Log pane**
  This pane displays after you run any of the editing control jobs to add, edit, or remove metadata. Click the >> icon to view the job log or click the x icon to remove the most recent job log record.

- **Metadata Properties table**
  This table has two adjustable-width columns as follows:
  - **Navigation**
    This column provides a navigation tree with root nodes at the Config (station) level and at the History level. The navigation column displays an expandable tree structure representation of the selected station. Expanding a parent node displays additional rows that you can select for editing metadata.
  - **Metadata Properties**
    This column displays a summary string of the properties. The metadata property name and its corresponding value are separated by a colon (:) and individual metadata properties are separated by a bar (|). For example: country:USA|state:Alaska|city:Fairbanks

  **Note:** The history "device" object always displays an "n/a" in this column because it does not support the use of properties.

- **Editing controls pane**
  This pane contains the following buttons that open dialog boxes that you can use to add, edit, and remove metadata, as desired:

  - **Add Metadata** button
    Click this button to open the Add Metadata dialog box. Fields available in this dialog box vary according to the type of property that you select. The following fields are available for the default "string" type property:
    - **New Name**
      Enter the desired name of the property.
    - **New Type**
      Select the property type that you want to add. The default is string type.
    - **Set if exists**
      This option box allows you to choose to edit an existing property value, if it already is present in or under the selected object(s). If this option is not selected, a new property may be added but an existing property is not edited when the Add Metadata job runs.
    - **Apply to descendants of selected nodes**
      This option, when selected, allows you to run the Add Metadata job on the selected object and all of its descendant objects. If the option is not selected, only the selected object is edited.

  **Note:** You can select multiple rows in the Metadata Browser table by using the Shift or Ctrl keys to select a range or a non-contiguous set of rows, respectively.
    - **New Value**
This field allows you to set an appropriate value for the property type. For example, a string field displays for the default string type and allows you to enter the string value that is used for the property.

- **Flags:**
  In addition to the default (required) Metadata flag option, other flags are available.

- **Facets**
  Use this field to add facets to the slot, if needed, for the chosen property type and use.

**Figure 4-35 Metadata dialog box**

- **Edit Metadata button**
  This button is available only when you select an object that already has one or more metadata properties. Clicking the **Edit Metadata** button opens the **Edit Metadata** dialog box with the following property options:
  - **Property option list**
    This is an option list that displays all metadata properties assigned to the object and allows you to select the property that you want to edit.
  - **Apply to descendants of selected nodes**
    Selecting this option applies any edits you make to this property to all descendant objects under the selected object.
  - **New Value:**
    This field allows you to edit the selected metadata property by specifying a new value for it.

- **Remove Metadata button**
  This button is available only when you select an object that already has one or more metadata properties. Clicking the **Remove Metadata** button opens the **Edit Metadata** dialog box with the following property options:
  - **Property option list**
    This is an option list that displays all metadata properties assigned to the object and allows you to select the property that you want to remove.
  - **Apply to descendants of selected nodes**
    Selecting this option removes this property from all descendant objects under the selected object.

**About On Demand history views**

Starting in NiagaraAX-3.4, the On Demand history feature enables polling of both local history sources and Niagara History imports for live data when displaying history chart or history table views. This feature works in addition to, and does not replace, a standard polling schedule. For example, you would typically still have your History Import descriptors scheduled to archive at some daily interval (such as every night), even though you might be displaying On Demand history views.
The On Demand feature provides a 'Live Updates' toggle button (check box in Hx view) on both the history chart and history table views. When you click the 'Live Updates' button, it initiates a history subscription that finds the source of the history and subscribes to that source component. If the source is a history import descriptor, then that descriptor starts polling at a frequency defined by its On Demand Poll Frequency property (described below). If the source is a local History Ext, the history chart or table updates whenever the history extension appends a new record to the history.

**Note:** When the On Demand History is active, a timestamp appears in the view's status bar (lower corner) to indicate the time of the last successful update. This does not apply to Hx views.

Since histories eligible for on demand support are sourced directly from a local history extension or at a history import descriptor, On Demand History availability and update rate are both affected by parameters described below and shown in Figure 4-38:

- **On Demand History availability is affected by the following factors:**
  - On Demand History is not available if the source component is not accessible. Since histories can be categorized (for permissions levels) independently from their source components, it may be possible for a user to have access to a history, but not have access to the source component. In this case, the On Demand History feature is disabled (button is dimmed on the History Chart or Table view). Also, if the source component is no longer in existence (has been deleted) the "Live Updates" toggle button is dimmed (inaccessible).
  - On Demand History is not available if the source history import descriptor’s On Demand Poll Enabled property is set to false (see Figure 4-37). On Demand Polling may be disabled to limit bandwidth usage.

- **On Demand History rates are affected by the following property settings (see Figure 4-38):**
  - **On Demand Poll Scheduler (sources using import descriptor)**
    This property is located under the NiagaraNetwork History Policies property. You can set standard polling rate values for a Fast Rate, Normal Rate, and a Slow Rate in the fields displayed in the property sheet view. These rates are available as selection options for individual Niagara History Import descriptors under the NiagaraNetwork History Device Extensions.
  - **On Demand Poll Frequency (sources using import descriptor)**
    This property is located under the Niagara History Import property. Select one of the three options (defined in the On Demand Poll Scheduler): Fast, Normal, or Slow.
Figure 4-38  On Demand Poll frequency settings for import descriptor-sourced views

- History extension update interval
  If the On Demand history is being sourced from a local history extension, then the On Demand chart or table view updates whenever the local history extension appends a new record to the history. This function reflects the presence of a (LastRecord) property starting in NiagaraAX-3.4.

About the history process

There are essentially three steps in the “history logging” life cycle, as shown in Figure 4-39:

Figure 4-39  Simplified history process

- collect
  involves defining the parameters that specify what data will be recorded and when (or how often) it will be recorded. For example, you can collect data whenever a change of value occurs - or at a regular time interval that you specify.
  To collect history information you need to:
  - Add history extensions to a component (refer to “Add history extensions to a component”)
  - Configure the extensions (refer to “Configure history extensions” on page 4-25)
  - Use a valid history name (part of configuration, see, “About history names” on page 4-26)
  Refer to “Add history extensions to a component” on page 4-24 for more details.

- store
  involves defining the parameters of the history database file. For example, you can customize the name of the database file, define the maximum number of records to save, and choose metadata to add to the records. Refer to “Configure history extensions” on page 4-25 for more details.

- archive (transfer)
  includes importing and exporting records from one station to another station. For example, you can limit your local station records to a small number that you specify and archive all records to another station. Refer to “Archiving” on page 4-27 for more details.
  You can add extensions to a component’s property sheet in order to extend the functionality of the component. By adding a history extension, the real-time value or status of the component’s output can be collected as a time-stamped entry in the associated history table. History extensions are available in the history palette, as shown in Figure 4-40. The history table is not stored as part of the component’s data but is a separate collection of data simply referred to as the history.
About delta logging

When you are logging data, such as electric consumption (kWh) or other information that uses a running total, you may want to know the difference between consecutive timestamped values instead of the actual running total. The delta logging feature is provided for this type of calculation. For delta logging, data is logged (as normal) using the appropriate NumericChangeOfValue or NumericInterval extension. Then, in the history chart or history table view, you simply select the Delta option box (or use the toolbar icon) to display the delta values instead of the running total value, as shown in Figure 4-42. Delta values are computed by taking the difference between one numeric record and the next. The timestamp of the last record (of the two) is used as the timestamp for the delta value.

Two other parameters that apply to delta logging are related to the concept of rollover.

Rollover occurs when a running total reaches a defined maximum number and then resets to “zero” or another defined number. The defined maximum number is represented in the history extensions by the Max Rollover Value parameter. The reset value (which is often zero) is represented in the history extensions by the Min Rollover Value parameter. These parameters allow you to specify the behavior of the delta logging when the rollover occurs. If you do not know these values or if they are not specified, then select the null option for these parameters.
Consider the following example. If you are logging energy consumption with the Max Rollover Value parameter set to 999,999 and the Min Rollover Value set to 100, then when a rollover is detected, the delta logging bases its delta calculations on a maximum value of 999,999 and a subsequent initial value of 100.

Refer to “Configure history extensions” on page 4-25 for a list and short description of all the history extension parameters.

**Add history extensions to a component**

Extensions come in different types to match the data type of the component and the collection method desired. You can add history extensions by dragging them onto your property sheet or into your nav side bar pane from the history palette (see Figure 4-44). Refer to “To add an extension to a component property sheet view:” on page 10-16 for steps for adding an extension.

**Figure 4-43  History extensions in Workbench the history palette**

**Figure 4-44  History extensions in the property sheet**

Extension types include:

- **BooleanChangeOfValue**
  used to collect boolean values whenever those values change.

- **BooleanInterval**
  used to collect boolean values at specified time intervals.

- **NumericChangeOfValue**
  used to collect numeric values whenever those values change.
Chapter 4 – About Histories

Configure history extensions

When a history extension is first added to a component, it is set to be disabled by default. All that is really necessary to enable collection is to change the 'Enable' property to 'true.' Of course, you may desire some other property changes to better configure the collection to suit your actual needs.

Some configuration properties are common among all history extension types. A few properties are unique to the data type or the collection type. Following, is a list of all the properties available.

- **Status**
  read-only field that tells the user the current status.

- **Fault Cause**
  read-only field that displays a reason that the extension is not working.

- **Enabled**
  set either 'true' or 'false' to disable or enable the history extension.

- **Active Period**
  specifies the days of the week as well as start and end times for record collection.

- **Active**
  read-only value that indicates whether or not (true or false) the history collection is active (as defined by the Active Period parameters).

- **History Name**
  is a formatting convention used to provide a way to consistently name histories using a standardized formatting pattern.

  The history name format field provides a way to automatically name histories any time a new history is created. The format `%parent.name%` is the default history name format and this will create a name based on the parent object. Refer to “About history names” on page 4-26 for more details about naming histories.

- **History Config**
  These properties set up the attributes of the History record.
  - **Id**
    a unique identification for each history. The id value is the name that was automatically created by the History Name Format or manually created in the name field or rename dialog box.

  - **Source**
    a read-only field that displays the ORD of the active history extension.

  - **Time Zone**
    a read-only field that displays the time zone of the active history extension.

  - **Record Type**
    displays the data that the record holds in terms of: extension type (history) and data type:(BooleanTrendRecord, NumericTrendRecord, and so on).

  - **Capacity**
    allows you to set a finite number of records to collect or to choose to collect an unlimited number of records. If you choose the Record Count option, an additional “records” field displays. In the “records” field, type in the maximum number of records that you want to save in the history database.

  - **Full Policy - (Roll or Stop)**

For more details about extension types, refer to “Types of history extensions” on page 3-14.
allows you to choose what to do when the Capacity number is reached. The Roll option drops off the oldest record to make room for the newest record. The Stop option simply causes the history to stop recording.

- **Interval**
  a read-only field that displays the selected collection type: regular on interval.

- **System Tags**
  Available starting in NiagaraAX-3.4, the System Tags property allows you to add an additional identifier (the System Tag) to a history extension. This identifier is then available for selective import or export of histories using the Niagara System History Import or Niagara System History Export option (using the System Tag Patterns). Each System Tag is separated by a semicolon. For example: NorthAmerica;Region1;Cities. Also see "About System Tags" on page 4-29.

- **valueFacets**
  allows you to use the Edit Facets dialog box to choose how you want to display the logged data.

- **Change Tolerance**
  for COV based collections, the monitored variable has to change at least this much to be logged as a changed value.

- **Interval**
  for Interval-based collection, the cycle time, or how often the history parameters are checked. Any time you change this parameter, a new history is created (or "split-off") from the original history because histories with different intervals are not compatible.

- **minRolloverValue**
  this is a number that is used as the starting point for calculations for cumulative logging after a rollover. Rollover occurs after a running total maximum value is reached. Select the null option if a minRolloverValue is unknown. Refer to "About delta logging" on page 4-23 for more details about rollover and delta logging.

- **maxRolloverValue**
  this is a number that is used as a maximum value for calculations when a rollover is detected by the history logging process. Using this parameter and the minRolloverValue parameter helps you avoid getting negative numbers when you are logging running total data, such as energy usage. Refer to "About delta logging" on page 4-23 for more details about rollover and delta logging.

- **precision**
  this option allows you to select 32 bit or 64 bit options for the history data logging. 64 bit allows for higher level of precision but consumes more memory.

### About history names

By default, when a history extension is added to a component, a history format default string is set to the following: 

```
%parent.name%
```

This string automatically names any histories with the name of the parent component and appends a sequential number to additional names, as necessary. For example, a history extension on a NumericWritable component will, by default, create a history name “NumericWritable” - then if that component is duplicated, the name for the history will be duplicated and incremented to “NumericWritable1”. You may add a literal name in front of, or after, the “%parent.name%” string, as shown in Figure 4-46, to customize it without losing the automatic naming feature.

**Note:** If you use a literal name and not a script to name a history, you lose the automatic incrementing feature that the script provides. Duplicating extensions that have a literal name duplicates the exact literal name and therefore creates an invalid (non-unique) name. In this case, you must rename each duplicated history manually to create a unique name and avoid a fault condition.
As described in “Configure history extensions” on page 4-25, and illustrated in Figure 4-45, history names are part of the unique history extension property “Id”. When you rename a history at the history extension, you are renaming the history at its “source”. Therefore, the history configuration and the history Id both change. This concept is illustrated in Figure 4-47.

Figure 4-47  Renaming a history in the history extension

If, however, you rename a history in a “history space” view, such as under the history space node in the nav sidebar, or in the nav container view, you are changing the name of the history as it has been saved in the history space—not at the configuration (or origination) level. Therefore, the history Id is not changed and the history extension continues to produce records under the original history name as long as that history extension is active and enabled. This results in a history “split”; the newly-named history is no longer updated, as of the time of the renaming, but it contains all the records up to that time. In this scenario, a history under the original name begins with the first record after the renaming and continues recording as configured. This concept is illustrated in Figure 4-48.

Figure 4-48  Renaming a history in the history space

Renaming Summary:

- **No history split**
  If you rename a history in either the property sheet view or the history extension manager view, you are editing the actual history extension and therefore not forcing a history split.

- **History split**
  If you rename a history in either the nav sidebar view or the nav container view you are editing the name in the history space and not actually changing the history ID – the history is split.

Archiving

Archiving is the process of saving a history out to a different location (station) from where it was originated. There are two general methods (or directions) for archiving, as described below:
• **Pushing data (exporting histories)**
  is the process of exporting history data and is done using the history export manager, shown in Figure 4-49. For details about exporting histories, refer to the "Niagara History Export Manager" section in the *Drivers Guide*.

![Figure 4-49 Niagara history export manager](image)

• **Pulling data (importing histories)**
  is the process of importing history data and is done using the history import manager, shown in Figure 4-50. For details about importing histories, refer to the "History Import Manager" section in the *Drivers Guide*.

![Figure 4-50 Niagara history import manager](image)

### About editing history data

The history editor view, as described in "About the history editor view" on page 4-15, provides the ability to review and modify the history data that you have collected.

In some cases, you may want to search through the history data and look for unusual data or “outliers.” An “outlier” is a data value that is far apart from the rest of the data; an extreme value that is either much lower or much higher than the rest of the values in the data set. Outliers are known to skew means or averages, so it may be helpful to identify and edit or hide this data. This doesn't mean that the data point is necessarily bad – but in most cases the information is more helpful without the inclusion of this “unusual” data.

**Caution**

*It is possible to alter good data and miss filtering some bad data points using the history editor view.*

Workbench provides the ability to find and edit outliers based on parameters that you specify. The Configure Outliers dialog box, shown in Figure 4-51, appears when you click the **Configure Outliers** icon in the toolbar menu. Refer to "About the history editor toolbar icons" on page A-15 for a list of toolbar icons specific to the history editor view.
Configure Outliers dialog box

- **Configure Outliers check box**
  Outlier filtering is disabled by default. Select the check box to enable the outlier filtering feature and use the parameters that are displayed in the dialog box. Clear the check box to disable outlier data filtering. When outlier parameters are enabled, the **Window** and the **Percent of Std Deviation** fields are available and allow you to specify the “intensity” of the search for outliers in the data.

- **Window**
  Enter an integer in the **Window** field to define the number of surrounding data points to consider when determining whether a given point is an outlier. For example, if you use the default value of “4”, it will look at the two points before and after the point under investigation (PUI). This is a surrounding “window” of 4 points—from which a standard deviation will be calculated and used with the percentage parameter, as described, below.

- **Percentage**
  Enter a value in this field to specify the percent of standard deviation (calculated from the window of points) to apply for identifying whether or not the PUI should be considered a valid value (not an outlier). If the PUI falls outside of this valid range, then it is considered to be an outlier and its value is replaced by the linear interpolation of the surrounding 2 valid points. If the PUI falls within the range, then the data point is used and considered valid.

### About System Tags

Available starting in NiagaraAX-3.4, the System Tags property allows you to specify an additional identifier (the System Tag) to use with a history extension.

The System Tag identifier is specified as one or more string parameters under the History Config property of a History Extension (see Figure 4-52). Each string in a System Tag property must be separated by a semicolon. For example: `NorthAmerica;Region1;Cities`

This additional identifier is then available for selective import or export of histories using the Niagara System History Import or Niagara System History Export option from the Niagara History Import Manager or Niagara History Export Manager, respectively (see Figure 4-53 and Figure 4-54).
For more information about History Import and History Export, refer to the NiagaraAX Driver Guide sections: “Using System Tags to import Niagara histories” and “Niagara History Export Manager”.

### About history grouping

Available starting in AX-3.5, history grouping allows you to setup alternate navigation of your history space based on history properties.

**Figure 4-55  History Groupings component comes as part of the HistoryService in AX-3.5**

The History Groupings component, located under the HistoryService, has properties that let you specify which history properties you want to filter on for organizing a station’s history space. These alternative navigation displays are based strictly on the history properties that you select and are a departure from the “device” or “driver” centered navigation model that builds a nav tree based around networks, devices, and points. With history properties, you can use one or more HistoryGroup components to set up “geographic”, “functional”, or any other desired types of organization of your history space. You can create multiple navigation schemes and use them, as needed, or use the default history navigation structure which always remains visible. History grouping allows you to simultaneously display histories in multiple nav paths, as shown below.
About the History Group property sheet view

An example of the HistoryGroup component property sheet view is shown below.

The HistoryGroup component has the following properties available in its property sheet view:

- **Enabled**
  Select the `true` option to enable or the `false` option to disable the selected HistoryGroup.

- **History Properties To Group By**
  This property provides fields that you can use for organizing your histories. Each completed field represents a specific property name that must match exactly to a history property name that belongs to one or more histories. Add or delete additional grouping parameters using the `+` button (to add) and the `x` button (to delete) fields. For example, to filter by the country, state, and city, history properties that exist in your histories, create three Group fields and type in the exact (case-sensitive) property names. When you click the **Save** button, the corresponding navigation tree is created under the History space node, as shown below:

  **Note:** Notice in the following illustration that the order of the "history properties to group by" (in this case: "country," "state," "city") determines the sub folder ordering.

About the History Group Manager view

As the default view of the History Groupings component, the history group manager shows all history groups in the station and displays the following columns in a table view:

- **Name**
  This is the identifier for the grouping. You can select a row and **Rename** or **Edit** the group using the control buttons at the bottom of the view.
About history nav shortcuts

Starting in AX-3.5, history nav shortcuts provide convenience navigation links to histories. You can place these shortcuts anywhere in a station to provide a filtered list of individual history shortcuts. The default property values of this component are set to display links to all histories that are under the nav shortcut ancestor device's name. You can edit properties in the property sheet view to display only the histories you want. History nav shortcuts have a Nav Container view and a History Chart Builder view.

**Note:** The history shortcuts are not actual histories but links that provide convenient access to a history when you double-click on the shortcut. You cannot drag and drop the history shortcuts onto a Px page and relativize them.

The history shortcut has the following properties:

- **History Query Predicate**
  This property allows you to filter the histories by entering a value as a BQL query predicate value. For example, you could enter the following text string: `where state='Georgia'` (note the single quotes) to filter for all histories that have a `state` property with the value set to "Georgia". This property works in conjunction with the Only Display Parent Device Histories property.

- **Only Display Parent Device Histories**
  This property allows you to restrict the history shortcut filtering to those histories that match the ancestor device of the history nav shortcut component. If set to `true`, only shortcuts to histories that are identified with the history shortcuts parent device name are displayed. If set to `false`, shortcuts to all valid (those that match the "BQL query predicate value") are displayed. In cases where the parent device name is not a valid history device name, you can add a dynamic "historyDeviceName" property, as described below. This property works in conjunction with the History Query Predicate property.
Using the History Nav Shortcuts component slot sheet view, you can add a “historyDeviceName” string property to the History Nav Shortcuts property sheet. This additional property allows you to filter for an alternate history device name (in case the History Nav Shortcuts parent device's name is not a valid history device).

For example, if you place a History Nav Shortcut under a device that has a name “SqlServerDatabase” and a history ID from that RDBMS device are named “/myStation/currentTemp”, then a shortcut for this history is not displayed when the Only Display Parent Device Histories is set to true. However, if you add a historyDeviceName property to the component and set a value of “myStation” in that property, a shortcut for that history displays under the History Nav Shortcuts component.

**About nesting history shortcuts**

History Nav Shortcuts can be nested in order to build hierarchies of shortcut navigation. In the following illustration, note the following points:

- The History Query Predicate property filters to show the shortcuts in the nav tree. Since the Only Display Parent Device Histories value is set to true and the shortcut is not a child of any of the station devices (Station1, Station2, etc.) these shortcuts include histories that have a “building” property set to a value of “Headquarters” and are included anywhere in the history space. If the shortcut is placed under Station1 with these same property settings, then only the Station1 “Consumption”, “Outside-AirTemp”, and “Demand” histories would display.

- The History Nav Shortcuts named “Chemistry” shows all shortcuts to histories with a building property set to “Chemistry”.

- The History Nav Shortcuts named “Biology” shows shortcuts to histories with a building property set to “Biology”. Since the Only Display Parent Device Histories value is set to true and the shortcut does not have a parent “device” these are histories that have a “Biology” property set to a value of “Headquarters” and are included anywhere in the history space.
About alarms

Figure 5-1  Typical alarm table display

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>ID</th>
<th>Type</th>
<th>Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>30-Apr-07</td>
<td>14:11 PM</td>
<td>Normal</td>
<td>Normal</td>
<td>951 Unacked</td>
<td>PremTemp</td>
</tr>
<tr>
<td>30-Apr-07</td>
<td>14:11 PM</td>
<td>Normal</td>
<td>Normal</td>
<td>951 Unacked</td>
<td>MaxTemp</td>
</tr>
<tr>
<td>30-Apr-07</td>
<td>12:31 AM</td>
<td>Normal</td>
<td>Normal</td>
<td>127 Unacked</td>
<td>CoolDefSp</td>
</tr>
<tr>
<td>27-Apr-07</td>
<td>12:08 PM</td>
<td>OffNormal</td>
<td>OffNormal</td>
<td>5 Unacked</td>
<td>SupermanWtr</td>
</tr>
<tr>
<td>27-Apr-07</td>
<td>12:31 AM</td>
<td>Normal</td>
<td>Normal</td>
<td>14 Unacked</td>
<td>H20Temp</td>
</tr>
<tr>
<td>27-Apr-07</td>
<td>12:31 AM</td>
<td>Normal</td>
<td>Normal</td>
<td>7 Unacked</td>
<td>H20DefSp</td>
</tr>
<tr>
<td>27-Apr-07</td>
<td>12:08 AM</td>
<td>Normal</td>
<td>Normal</td>
<td>7 Unacked</td>
<td>CoolDefSp</td>
</tr>
<tr>
<td>27-Apr-07</td>
<td>12:08 PM</td>
<td>Normal</td>
<td>Normal</td>
<td>3 Unacked</td>
<td>PowerMonSrv</td>
</tr>
<tr>
<td>27-Apr-07</td>
<td>12:08 PM</td>
<td>Normal</td>
<td>Normal</td>
<td>3 Unacked</td>
<td>PowerMonSrv</td>
</tr>
<tr>
<td>27-Apr-07</td>
<td>12:08 PM</td>
<td>Normal</td>
<td>Normal</td>
<td>3 Unacked</td>
<td>LowNetWork</td>
</tr>
</tbody>
</table>
Overview of the alarming process

Each alarm is a single record in the alarm database that changes throughout its life cycle. An alarm has four general “life cycle” states that it may be in:

- **alarm**
  this is the initial state of an alarm and this state remains in effect until the alarm is acknowledged.

- **acknowledged**
  this is an alarm that has been acknowledged by the recipient. Acknowledged alarms may be normal alarms.

- **normal**
  is an alarm that has a current status of “normal”.

- **acknowledged normal alarm**
  is a normal alarm that has been acknowledged.

**Note:** An alarm is considered “open” when it is NOT (acknowledged and normal) or NOT (acknowledged and alert). Open alarms display in the alarm console. Cleared alarms do not display in the alarm console. The following table shows the conditions that result in an alarm being “open” or “cleared”.

<table>
<thead>
<tr>
<th>Alarm State</th>
<th>Acknowledge State</th>
<th>Open or Cleared</th>
</tr>
</thead>
<tbody>
<tr>
<td>Offnormal (or Fault)</td>
<td>Unacknowledged</td>
<td>Open</td>
</tr>
<tr>
<td>Offnormal (or Fault)</td>
<td>Acknowledged</td>
<td>Open</td>
</tr>
<tr>
<td>Normal</td>
<td>Unacknowledged</td>
<td>Open</td>
</tr>
<tr>
<td>Normal</td>
<td>Acknowledged</td>
<td>Cleared</td>
</tr>
</tbody>
</table>

Typically, an alarm provides some visual and audible indication that a limit or value is met or exceeded. Alarm notifications may be routed and displayed in a variety of ways, including the following:

NiagaraAX alarming is comprised of three primary actions:

- Creating alarms (refer to "About alarm sources” on page 5-3)
- Routing alarms (refer to "About the alarm service” on page 5-7)
- Managing alarms (refer to “About the alarm database maintenance view” on page 5-30)

**Figure 5-2** Simplified alarm process

Under these three processes NiagaraAX provides highly specific and flexible alarming life cycle management, including the following alarming functions:

- **creating alarms**
  Alarms are generated by components using an alarm extension (refer to "About alarm extensions and components” on page 5-3). The alarm extensions create the alarm whenever specified values are outside of “normal” range. Those alarms are then handled by the alarm service (refer to "About the alarm service” on page 5-7).

- **routing alarms**
  Alarms are handled by the alarm service which, in addition to allowing you to specify routing destinations (including archiving destinations), provides notification and acknowledgement parameters.
  - **notification**
    Alarms are routed to one or more recipients based on their alarm class. This includes notification by email, at the alarm console, a lineprinter, or at remote stations.
  - **acknowledgment**
    Alarms may require a response from those who are notified. If a required acknowledgement is not received within an optionally-specified time, alarms can be “escalated” and re-routed to other designated alarm recipients.
Chapter 5 – About alarms
April 4, 2011

• managing alarms
alarms are archived in records that are managed by the alarm database management interface.

The following list outlines the basic steps in the alarming process:
• add alarm extensions to components
Choose alarm extensions to match the component data type.
• configure alarm extensions
Configure the alarm parameters to define when a component is in an alarmed state.
• route alarms
Configure the alarm parameters to define where an alarm record is sent.
• manage the alarm archive
Use the alarm archive management tools to manage the storage of all alarms.

About alarm sources
The parameters that are set in a point’s "alarm point extension" determine when that point is in an “alarmable” condition. You use the alarm extension to configure routing options, issue alarms to the alarm service, and update the alarm to reflect a status change when the parent point goes back to a normal state. The extension also notifies the point that an acknowledgement has been received. To set up the alarm source on an object you need to:
• add a proper alarm extension to the component (see About alarm extensions and components)
• configure the alarm extension to meet your needs (see About alarm extensions)

About alarm extensions and components
To set up alarming on a component you need to add an alarm extension to the component’s property sheet. Refer to "About alarm extensions" on page 3-12 for more details about the alarm extensions. Alarm extension types must match their parent component type. For example, an OutOfRangeAlarmExt goes with a Numeric point type and a BooleanChangeOfStateAlarmExt goes with a Boolean point type. For a list of alarm extensions types and their associated point types, refer to "Types of alarm extensions" on page 3-13.
Alarm extensions are contained in the alarm Palette, as shown in Figure 5-3.

Figure 5-3 Alarm extensions in alarm palette

For details on adding extensions to a property sheet, see "To add an extension to a component property sheet view:" on page 10-16. Once the extension is added, configure the extension to meet your alarming requirements. Refer to "About alarm extension properties" on page 5-3 for more details.

About alarm extension properties
Each alarm extension has a set of configurable properties that allow you to specify the alarming conditions and certain routing options. Figure 5-4 illustrates and the following list describes each alarm extension as it appears in a component property sheet.
Chapter 5 – About alarms
April 4, 2011

Following, are the alarm extension properties descriptions:

- **Alarm Inhibit**
  
  A true value in this field prevents alarm generation due to any transition or state change. For example, if there is a true value in this field and an Off Normal value is reached, a to Off Normal status will not be communicated. When the state returns to Normal, a to Normal status will also not be communicated. A false value in this field will prevent alarms from being inhibited (even if an Inhibit Time is set).

  **Note:** The purpose of the Alarm Inhibit property is to prevent unintended alarms, such as in after-hours situations where a piece of equipment is turned off. A difference between Alarm Inhibit and Alarm Delay is that the Alarm Inhibit is a boolean value (true/false) and may be controlled by another device (for example, an ON/OFF value of a fan).

  If the Alarm Inhibit value is set to true, the Inhibit Time property qualifies the behavior.

- **Inhibit Time**
  
  The value of this property affects the length of time that the current Alarm Inhibit state will remain in effect after an Alarm Inhibit state change. For example, when an Alarm Inhibit value changes from true to false, alarm generation continues to be inhibited for a time that is specified by the Inhibit Time property value. When an Alarm Inhibit value changes from false to true, alarm generation may continue to be inhibited for a time that is dependent on the point type, as shown in Table 5-2.

  **Table 5-2 Time until Alarm Inhibit state change affects alarm generation**

<table>
<thead>
<tr>
<th>Alarm Inhibit transition</th>
<th>Point type</th>
<th>Discrete point</th>
<th>Numeric point</th>
</tr>
</thead>
<tbody>
<tr>
<td>True to False</td>
<td>Inhibit Time property value</td>
<td></td>
<td></td>
</tr>
<tr>
<td>False to True</td>
<td>3 x Inhibit Time property value</td>
<td>0 (zero)</td>
<td></td>
</tr>
</tbody>
</table>

- **Alarm State**
  
  This field displays the current alarm state of the component: Normal, Low Limit, High Limit, or Fault.

- **Time Delay**
Note: Time Delay does not affect alarms generated by a Fault. There is no delay when transitioning in or out of a Fault generated alarm.

This is the minimum time period that an alarm condition must exist before the object alarms. In other words, the object status must meet the "alarm" criteria for a continuous period equal to or greater than defined in the Time Delay property value before an alarm is generated. The general purpose of the Time Delay property is to provide a means to prevent nuisance alarms that may be caused by a momentary change in a state value (Normal, Low Limit, High Limit).

Time Delay applies to properties that transition both in and out of alarm states. Therefore, an alarm status may continue to display as Offnormal (for example) for a time (equal to the Time Delay) after the value has come back into Normal parameters. The Time Delay is the minimum time period that a normal condition must exist before the object comes out of alarm.

Note: Typically, when both Alarm Delay and Alarm Inhibit properties are used, Time Delay is less (shorter) than Alarm Inhibit.

- **Time Delay to Normal**
  This is the minimum time period that a normal condition must exist before the object may return to normal status.

- **Alarm Enable**
  Select any of the options to individually enable the generation of alarms when the following transitions occur:
  - toOffnormal
    This is the time that the offNormal event occurred.
  - toFault
    This is the time that the Fault event occurred

Note: No alarms will be generated unless an Alarm Enable option is selected.

- **To Offnormal Times**
  This property displays four pieces of information that are related to the time that the component status changed to Offnormal. A "null" value means that the event has not occurred. See Figure 5-5.
  - Alarm Time
    This property displays the time that the To Offnormal event occurred.
  - Ack Time
    This property displays the time that the alarm was acknowledged.
  - Normal Time
    This property displays the time that the To Normal event occurred.
  - Count
    This field displays the total number of Offnormal events.

  ![Figure 5-5 To Offnormal times](image)

- **To Fault Times**
  This property displays four pieces of information that are related to the time that the component status changed to a Fault state. A "null" value means that the event has not occurred. See Figure 5-6.
  - Alarm Time
    This property displays the time that the To Fault event occurred.
  - Ack Time
    This property displays the time that the alarm was acknowledged.
  - Normal Time
    This property displays the time that the To Normal event occurred.
  - Count
    This field displays the total number of To Fault events.

  ![Figure 5-6 To Fault times](image)
• **To Normal Times**
  This property displays the time that the component transitioned to a normal state.

• **Time in Current State**
  This property displays the elapsed time since the component transitioned to the current state.

• **Source Name**
  This property displays the name of the alarm source. If you use the default script setting %parent displayName%, the source name field will show the “display name” of the alarm extension parent. You can edit this script or type in a literal string to display.

• **To Fault Text**
  Enter the text in this field that you would like to display when the component is in a Fault state.

• **To Offnormal Text**
  Enter the text that you would like to display when the component is in an Offnormal state.
  **Note:** This text may be overridden in the Alarm Console display by text that you enter into the High Limit or Low Limit fields.

• **To Normal Text**
  Enter the text that you would like to display when the component is in a Normal state.

• **Hyperlink Ord**
  Use this property to enter or choose an Ord, a BQL Query or a path to a component that you would like to associate with an alarm status on the component you are configuring. When an alarm is reported in the console, the Hyperlink button is active and uses this path. Use the folder icon to browse to the file that you want to link to. Click the arrow icon to the right of the folder icon to test the Ord that you enter.

• **Sound File**
  Enter or choose the path to a sound file that will execute when the current component is in an alarm state. Use the folder icon to browse to the file that you want to use. Click the arrow icon to the right of the folder icon to test the path that you enter.

• **Alarm Icon**
  Use this property to enter or choose the path to a graphic file that will added to the display in the “timestamp” column of the alarm table in the Console Recipient view. Use the folder icon to browse to the file that you want to use. Click the arrow icon to the right of the folder icon to test the path that you enter.

• **Fault Algorithm**
  This property when available, displays fault parameters. Different options are available here, depending on the alarm extension being used.

• **Offnormal Algorithm**
  Use this property to enter high and low limit parameters for numeric components and select the alarm value (on or off) to designate the alarm state for a boolean component. Different options are available here, depending on the alarm extension being used.

• **Alarm Class**
  Use this property to select an alarm class from the option list. The alarm class specifies the alarm routing options for this component. Refer to “About alarm class” on page 5-32 for details about alarm class.

• **Meta Data**
  Use this property to enter new facets using the meta data property. See “About point facets” on page 3-7 for details about facets.

### About alarm instructions

Each alarm can have “instructions” assigned to it so that any time an alarm is generated, the instructions are presented with the alarm notification (in the Alarm Record dialog box) to provide information that may be important or helpful to the user. Instructions are created, assigned, and edited from the Instructions view. Refer to “About the Instructions Manager view” on page 5-27 for details about the Instructions view.

### About notes

Notes are simple text entries that are associated with a particular alarm. It is possible to add a Note to one alarm or to multiple alarms. Alarm records that have notes are indicated by a “note” icon. Refer to “Types of Alarm Details View dialog boxes” on page 5-38 for more information about Notes.
About the alarm service

Note: In addition to the standard file-based alarm service, described in this section, there is a memory alarm service available. These two services should not run in the same station. Refer to “About memory alarm service” on page 5-7 for details about the memory alarm service.

Each station may contain a single alarm service that coordinates the routing of alarms within the NiagaraAX framework and maintains the alarm database. The alarm service is available in the alarm palette, as shown in Figure 5-7.

Figure 5-7  Alarm service in the alarm palette

If you do not have the alarm service in your active station, you can add it by dragging and dropping a copy from the alarm palette, as shown in Figure 5-8.

Figure 5-8  Adding the alarm service

The alarm service may contain one or more alarm classes (refer to “About alarm class” for more information about alarm class). An alarm class may route alarms to one or more alarm recipient types (refer to “Types of alarm recipients” on page 5-36 for more information about alarm recipient).

The routing process includes getting alarm acknowledgements from the recipients back to the source, and alarm notifications from the source to the recipients. The default view (wire sheet view) of the alarm service makes it easy to visualize the relationships between the alarm class and the alarm recipient. These relationships are created by linking the alarm class to the alarm recipient, as described in “About alarm class” on page 5-32. In addition to the wire sheet and property sheet views, there are several other views of the alarm service. See “Types of alarm service views” on page 5-26 for a description of the alarm service views.

About memory alarm service

Note: MemoryAlarmService is an alarm service that provides an alternative to the standard file-based AlarmService. A station should have only one alarm service. Do not enable both the standard AlarmService and MemoryAlarmService on the same station.

Each station may contain a single alarm service that coordinates the routing of alarms within the NiagaraAX framework. The memory alarm service is available in the alarm palette, as shown in Figure 5-9.
If you do not have the memory alarm service in your active station, you can add it by dragging and dropping a copy from the alarm palette, as shown in Figure 5-10.

Like the alarm service, the memory alarm service may contain one or more alarm classes. An alarm class may route alarms to one or more alarm recipient types.

The routing process for the memory alarm service is the same as the standard file-based alarm service and includes alarm acknowledgements from the recipients back to the source, and alarm notifications from the source to the recipients. The default view (wire sheet view) of the alarm service makes it easy to visualize the relationships between the alarm class and the alarm recipient. These relationships are created by linking the alarm class to the alarm recipient, as described in "About alarm class" on page 5-32. The memory alarm service has the same views available as the standard alarm service.

The main distinction of MemoryAlarmService is that when you use this service, alarms are not stored persistently on the station host (typically a JACE) as they are with the standard file-based alarm service. Choosing MemoryAlarmService might be appropriate for situations where you do not want to keep a large store of alarms on your host and are looking primarily for immediate alarm notifications. Alarm records are stored in memory and therefore they are lost in the case of a power failure.

**About the On Call Service**

Available in NiagaraAX-3.5 and later, the On Call Service is a customization of the alarm service that allows you to send alarm notifications to users based on a priority list ("Contact List"). This service initiates an email (or text message) notification for designated alarms, sending the notification sequentially, as alarms escalate, to users based on their assigned priority.

As one or more users on the contact list are sent alarms, any user may acknowledge the alarm and halt the escalation process. However, after a specified time interval, if no user acknowledges the alarm then the alarm is escalated and an email or text message is sent to the next specified user. Alarms are continually escalated until they are acknowledged or until they reach the final escalation level.

**Note:** On Call Service alarm escalation is a similar concept to alarm escalation, as described in "About alarm escalation" on page 5-33. The primary functional difference is that the On Call Service allows you to set up a flexible user contact list and schedule that list using the standard scheduler interface.

The On Call Service is available in the onCall palette, as shown in Figure 5-11.
You can add the On Call Service to a station by dragging and dropping a copy from the onCall palette.
The general process for the On Call Service is as follows:

1. A designated alarm class receives an alarm notification and sends the alarm notification to an On Call Recipient.
2. The On Call Recipient sends the alarm notification to the active On Call List.

   **Note:** The "Active" On Call List is designated by the On Call List Schedule.

3. The On Call List specifies which users (On Call Contacts) are notified.
4. The On Call Contact properties include a reference to a User Alarm Recipient which specifies how the alarm notification is sent. For example, User Alarm Recipient types may include:
   - EmailRecipient (sends alarm notification by email)
   - SmsRecipient (sends alarm notification by text message)
5. Unacknowledged alarms may be escalated and sent, sequentially to other members of the On Call List.

See the following sections for related On Call Service information:

- "About the On Call List" on page 5-10
- "About the On Call List Manager view" on page 5-10
- "About the On Call Contact" on page 5-11
- "About the On Call Contact Manager view" on page 5-12
- "About the On Call User Report view" on page 5-13
- "Using Spy pages with the On Call Service" on page 5-24

### About On Call Service alarm data in the alarm console

In addition to the default alarm console alarm data columns, many On Call alarm data facets are available for optional viewing directly in the alarm console.

You can add On Call alarm data columns to the alarm console view by using the **Add Alarm Data Column** dialog box, as described in "Hide, show, add, and remove alarm data columns in the alarm console" on page 5-37.
About the On Call List

The On Call List component (AX-3.5 and later) is designed to contain a set of one or more On Call Contacts. You can create, edit, or delete unique On Call Lists from the On Call List Manager view. After creating an On Call List, it appears under the OnCallService node in the nav pane, as shown below. It is also available as an option on the Event Output property in the On Call List Schedule's Scheduler view, where you may select it as a scheduled event.

Like other scheduled outputs, you can assign more than one On Call List to a single day. The On Call List is active only during the scheduled day and time. The On Call List active status is displayed in the On Call List property sheet view as well as in the On Call List Manager view.

Note: When assigning On Call List events in the Scheduler view, make sure On Call List event times are contiguous.

The On Call List component has the following properties, visible in the property sheet view:

- **Status**
  This display-only property indicates the condition of the component. For example: ok, down, disabled are possible status conditions.

- **Active**
  This property displays either Active or Inactive, according to its current state, as defined by the On Call List Schedule. Only one On Call List is active at a time.

- **Last Fault Cause**
  This read-only field displays the reason for the latest On Call List fault, if there has been one.

- **Ordinal**
  This read-only field is a unique identifier for the particular On Call List. The OnCallService tracks the next free ordinal number.

About the On Call List Manager view

The On Call List Manager view (AX-3.5 and later) is the default view of the On Call Service. This view displays a table listing of all existing On Call lists.
You can double click on any row to display the list in the On Call Contact Manager view. By default, the following columns display in the On Call List Manager view:

- **Name**
  This column shows the unique name of the On Call List
- **Active**
  This column displays the current current state of the list as either Active or Inactive. Only one On Call List is active at a time.
- **Status**
  This column displays the current condition of the component. For example: ok, down, disabled are possible status conditions.

At the bottom of the view, the following control buttons are displayed:

- **New**
  Click this button to open the **New** dialog box. Use the **New** dialog box for creating a new On Call list.
- **Edit**
  Click this button to open the **Edit** dialog box. Use the **Edit** dialog box for editing (renaming) one or more selected On Call lists.
- **Rotate**
  “Rotating” priorities means that the Priority value of each user in the contact list is reassigned to the next user in the list in a revolving manner. All selected lists are affected when you click the **Rotate** button.

**Note:** If any OnCallContacts are added, removed, deleted, reordered, or has any of its properties modified, any alarms that the OnCallList is currently handling are resent to the contacts starting at the top of the list, by priority.

**About the On Call Contact**

The On Call Contact (AX-3.5 and later) is an entry item in an On Call Contact List and is comprised of a single User and additional configurable properties that are used for routing alarm notifications. Only users that exist as entries under the User Service are available for assignment to an On Call Contact List.

**Note:** Any time an On Call Contact property is changed, the On Call List initiates a notification cycle.

On Call Contact properties may be edited in the property sheet view or in the **Edit** dialog box that is available from the On Call Contact Manager view.

**Figure 5-17 On Call Contact Property Sheet view**

The On Call Contact has the following properties:
• **Status**
  This display-only field shows the current condition of the On Call Contact. For example, the current Status may be ok, disabled, fault, or some other condition.

• **Last Fault Cause**
  If there has been a fault, this field displays a text message indicating the possible reason for the last fault.

• **Enabled**
  This field allows you to enable or disable an On Call Contact by selecting the true or false option, respectively.

• **Priority**
  This field allows you to set an integer value for the current contact's priority. The Priority property specifies the order in which the On Call Service sends alarm notifications to the On Call Contact.

  **Note:** One or more On Call Contacts may share the same Priority number value. The On Call Service sends an identical notification to all contacts that have the same priority number.

  Highest priority On Call Contacts (alarm priority property value with least integer value) for their particular On Call Contact List receive the first alarm notification. If alarms are not acknowledged within a designated time, subsequent notifications are sent to contacts in order of increasing priority number. For example, contacts with priority 2 would be notified if a contact with priority value 1 does not acknowledge an alarm within a specified time. Contacts with priority 3 would be subsequently notified, if necessary.

• **User**
  This option list displays the currently assigned User and provides options for selecting a new User. All Users that are under the User Service are presented as options to select. To view or edit User information, open the User Manager view (the default view of the User Service).

• **User Alarm Recipient**
  This option list displays any alarm recipient options that are available for the On Call Service. The EmailRecipient or SmsRecipient are available only if they have been added under the AlarmService. The EmailRecipient component is available in the email palette and the SmsRecipient is available in the Sms palette. You must choose an alarm recipient to designate the way alarm notifications are routed to the selected On Call Contact.

---

**About the On Call Contact Manager view**

The On Call Contact Manager view (AX-3.5 and later) is the default view of the On Call List component. This view displays a table listing of all contacts in the selected On Call list.

**Figure 5-18  On Call Contact Manager view**

You can double-click on any row to display the contact in the On Call User Report view. By default, the following columns display in the On Call Contact Manager view:

• **Name**
  This column shows the unique name of the On Call Contact. The format for a contact name is always a combination of the assigned User name and the User Alarm Recipient. For example, a user “Scott” could have a Contact name of “Scott_EmailRecipient” or “Scott_SmsRecipient”.

• **Status**
  This column shows the current condition of the On Call Contact. For example, the current Status may be ok, disabled, fault, or some other condition.

• **Enabled**
  This column displays the current condition of each On Call Contact in the table — Enabled (true) or Disabled (false).
• **Priority**
  This field displays the currently assigned priority value for each contact in the table. The Priority property specifies the order in which the On Call Service sends alarm notifications to the On Call Contact.
  
  *Note:* One or more On Call Contacts may share the same Priority number value. In this case the On Call Service sends an identical notification to all contacts.

• **User**
  This column displays the assigned User for each contact in the table.
  
  *Note:* If a User is deleted, the contact displays as a {fault} state.

**Figure 5-19** On Call Contact Manager with a contact in fault state

<table>
<thead>
<tr>
<th>Database</th>
<th>4 objects</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td><strong>Status</strong></td>
</tr>
<tr>
<td>Jan_EmilRecipient</td>
<td>(ok)</td>
</tr>
<tr>
<td>Alex_EmilRecipient</td>
<td>(ok)</td>
</tr>
<tr>
<td>Andrew_EmilRecipient</td>
<td>(ok)</td>
</tr>
<tr>
<td>admin_EmilRecipient</td>
<td>(ok)</td>
</tr>
</tbody>
</table>

• **User Alarm Recipient**
  This column displays the assigned User Alarm Recipient for each contact in the table.

At the bottom of the view, the following control buttons are displayed:

• **New**
  Click this button to open the **New** dialog box. Use the **New** dialog box for creating a new On Call Contact.

• **Edit**
  Click this button to open the **Edit** dialog box. Use the **Edit** dialog box for editing the selected On Call Contact.

• **Rotate**
  “Rotating” priorities means that the Priority value of each user in the contact list is reassigned to the next user in the list in a revolving manner. All contacts in the list are affected when you click the **Rotate** button.

### About the On Call User Report view

The On Call user Report view (AX-3.5 and later) is the default view of the On Call Contact component. This view provides a tabular presentation of the details associated with any On Call List that the selected user is assigned to. The purpose of this view is to provide each On Call Contact with a configurable table of information that shows scheduled times and priorities associated with all of the On Call Contact Lists that they are assigned to. As with other tables, you can show or hide columns and use other standard table controls and options that are provided in the **Table Options** menu. The **Table Options** menu is located in the top right corner of the table and is described in “Table controls and options” on page 2-18. Also, the export function is available using the Export icon on the toolbar or by selecting **File > Export** from the main menu.

An example of the alarm class summary view is shown in **Figure 5-20**.
The On Call User Report view has the following columns:

- **On Call Recipient**
  This is the name of the On Call Recipient being used to coordinate alarms.

- **On Call List**
  This column displays the name of the On Call List that the On Call Contact is a member of. A contact may be a member of more than one contact list.

- **Priority**
  This column displays the current priority assigned to the contact.

- **Start and End**
  This column displays the scheduled active day and time for the specific On Call List.

### Exporting the On Call User Report view

You can export On Call User Reports (AX-3.5 and later) and print them or email them. To initiate a report export, select the Export icon on the toolbar or by selecting **File > Export** from the main menu.

There are two PDF output export options available:

- **On Call User Report View Pdf Exporter**
  You can use this option to immediately create a PDF file from the current view using the standard workbench export function. In this case you use the report view time range fields to set the range of the report.

- **On Call User Report Pdf Exporter**
  Use this option to export reports using the Report Service. This allows you to schedule and email reports from stations on a periodic basis, if desired. In this case you need to add the Report View ord to the Source property in the ExportSource component (using the **Export Source Wizard**).
Chapter 5 – About alarms

April 4, 2011

About the Email Alarm Acknowledger

The EmailAlarmAcknowledger component (AX-3.5 and later) provides a way for users to acknowledge alarms by sending an email reply to an email alarm notification. This component is available in the email palette and works with alarm notifications that are sent out using the On Call Service or directly from the Email Service.

Figure 5-22  Email Acknowledger locations and properties

The EmailAcknowledger properties include:

- **Status**
  This display-only field shows the current condition of the Email Acknowledger. For example, the current Status may be ok, disabled, fault, or some other condition.

- **Enabled**
  This field allows you to enable or disable an EmailAlarmAcknowledger component by selecting the true or false option, respectively.

- **Ack Alarms From Same Source**
  When you select the true option for this property, in addition to the current alarm, all previous alarms from this source are acknowledged with a single email reply. For example, a single control point may be going in and out of alarm repeatedly and have 23 unacked alarms reported and displayed in the alarm console. If you set this option to true all 23 alarms are acknowledged when the EmailAlarmAcknowledger receives a single email acknowledgement. If the false option is selected, a single alarm is acknowledged and 22 unacknowledged alarms remain.

- **Last Alarm Acked**
  This field displays the identity of the last alarm that was acknowledged.

- **Last Alarm Acked Time**
  This field displays the time that the last alarm was acknowledged by the EmailAlarmAcknowledger component.

- **Last Alarm Acked Failure Time**
  If there has been a failure in the attempt to acknowledge an alarm, this field displays a message indicating the time of the last failure.

- **Last Alarm Acked Failure Cause**
  If there has been a failure in the attempt to acknowledge an alarm, this field displays a message indicating the possible reason for the last failure.

- **Total Alarms Acked Today**
  This field displays the current number of alarms that have been acknowledged for the day. This number is reset to zero at midnight.

- **Total Alarm Acked Failures**
  This field displays the current number of alarm acknowledgement attempts that have failed for the day. This number is reset to zero at midnight.

- **Total Messages Received Today**
  This field displays the current number of email messages that have been received for the day. This number is reset to zero at midnight.

In order to use the EmailAlarmAcknowledger component, you need to do the following:

- **Setup the EmailService**
  See "About the EmailService" on page 5-16.
• **Setup the IncomingAccount**
  See "About the IncomingAccount" on page 5-19.

• **Setup the EmailAcknowledger**
  See "About the Email Alarm Acknowledger" on page 5-15.

• **Setup the EmailRecipient**
  See "About the Email Recipient (email-EmailRecipient)" on page 5-43.

In addition, note the following requirements for configuring the EmailRecipient when using the EmailAlarmAcknowledger.

• **A User is required**
  When properly configured, the EmailAlarmAcknowledger looks at incoming emails and checks to see if the sender's email address matches the email address of a User that is currently in the local UserService database. No alarm is acknowledged unless it is first determined that the acknowledgement email is sent from a matching user and email address or phone number. This validated User name is also assigned to the alarm database as the person who has acknowledged the alarm.

• **A UUID required (NiagaraAX-3.5)**
  The UUID is the unique identifier that is assigned to every alarm and is used for keeping track of the alarm. The UUID must be in the subject of the acknowledging email. To ensure this, you must enter the following text in the EmailRecipient Subject property: UUID:%uuid%.

![Figure 5-23 Adding UUID to the EmailRecipient Subject property (NiagaraAX-3.5)](image)

See, “About the Email Recipient (email-EmailRecipient)” on page 5-43 for more information about the emailRecipient.

**Note:** In NiagaraAX-3.5, the EmailService only acknowledges alarms that contain the UUID of the alarm in the subject field of the EmailRecipient property view. Use the following syntax for configuring the EmailRecipient Subject property for use with the EmailAlarmAcknowledger component: UUID:%uuid%

Starting in NiagaraAX-3.6 the message-id and reply-to email headers are used to track emails associated with an alarm. No alarm identification is required in the email subject or content.

### About the EmailService

The Email service is required whenever you specify an "EmailRecipient" in your station or application. For example, you can route both alarms and reports via email using the EmailRecipient, as shown below.

**Note:** The EmailRecipient component for alarms is located in the email palette and is different from the EmailRecipient that is used for reports (located in the ReportService palette). It is important to use the appropriate EmailRecipient component, as indicated in the illustration, below.

![Figure 5-24 Alarm EmailRecipient and Report EmailRecipient require a configured EmailService](image)

The EmailService property sheet view is shown below and includes the following properties:

![Figure 5-25 EmailService property sheet view](image)
Chapter 5 – About alarms
April 4, 2011

- **Status**
  This read-only view shows the current state of the EmailService (ok), disabled, fault, or other.

- **Fault Cause**
  This read-only field displays an error message if the EmailService is in a fault state.

- **Status**
  This field allows you to enable (true) or disable (false) the EmailService.

The default view of the EmailService, the EmailAccountManager view, is shown below. This view displays a table of all the OutgoingAccounts and IncomingAccounts. Double-click on an account in the table to display the (default) property sheet view of the account.

![Email Account Manager view](image)

### About the OutgoingAccount

The email OutgoingAccount component is required for sending emails from a station. This component is located in the email palette and should be added under the EmailService component, as shown below.

![OutgoingAccount is located in the email palette](image)

The OutgoingAccount has the following properties:
Figure 5-28  OutgoingAccount property sheet view

- **Hostname**
  This is the name of the mail server. For example, mail.acme.com could be a Hostname.

- **Port**
  This is the port number associated with the email account. Typically, email outgoing account port numbers are port "25", however, if you leave the setting at its default value of ".1" the OutgoingAccount will search for and use a valid port.

- **Account**
  This is the name of the distinct account that is authorized for access to the "Hostname" mail server. For example, if you are using an email account named "joejones@acme.com" on the host described above, the account name is simply "joejones". The Hostname in this case could be "mail.acme.com".

- **Password**
  This is the login credential for the Account specified in the previous field. Increasing the pollrate value increases the time between polls. During the time between polls, emails may be queued (up to the max queue size) until the next poll time. At the next poll time all queued emails are sent.

- **Pollrate**
  This field allows you to specify how often the account executes a send action.

- **Enabled**
  This field allows you to activate or deactivate the account by choosing true or false, respectively.

- **Status**
  This is a read-only display of the condition of service. The status displays {ok} if the account is polling successfully. Other indications include:
  - {down} which means that the polling is unsuccessful, perhaps because of an incorrect Hostname, Password, or Account name.
  - {disabled} because the Enable property is set to false

- **Last Poll Success, Last Poll Failure**
  These two properties display the time (in hours and minutes) of the last polling success and failure.

- **Last Poll Failure Cause**
  This display-only field provides an error message to indicate a reason for polling failure.

- **Debug**
  This Boolean property turns Debug mode on true or off, as desired. When Debug is turned on, you can see detailed debug information in a station’s standard output view (WorkbenchAX Platform >
Application Director view) when the Station tries to send or receive email. This can be used to troubleshoot the accounts and faults.

- **Use Ssl**
  The Ssl (Secure Socket Layer) option is available on the OutgoingAccount starting in NiagaraAX-3.5. The option list allows you to disable Ssl (false) or enable it (true). Enable Ssl for communication with a host email server that requires it.

- **Transport**
  This field allows you to select from available options for email communication. The default setting and most common is SMTP.

- **Connection Timeout**
  This configurable field setting controls how long the station waits for a response from the mail server before generating an exception and setting the fault cause. It waits for the next scheduled poll and attempts to contact the mail server again at that frequency.

- **Use Authentication**
  This property allows you to specify that login credentials are required for sending any email. Sometimes authentication is not required for emails routed to recipients in the same domain. Setting this property to true makes the login credentials mandatory for any email.

- **Reply To**
  This field specifies the contents of the "From:" field in the email that is sent.

- **Persistent, Persistent Directory**
  Setting the Persistent property to true saves each queued email as an xml file in the designated persistence directory. Once the emails are actually sent, the xml files are deleted from the directory. The purpose of this is to keep a copy of the emails in the queue which would be lost if the station was stopped prior to the emails being sent. When the station restarts, emails are loaded from the "Persistent Directory" back to the queue.

- **Email Queue Tracking Properties**
  "Queue" is where emails reside while they are waiting to be sent. Assuming that the Account Status is "ok", typically, the length of time that an email is in the queue depends on the "Pollrate" setting. The following properties relate to the queue and mail management properties:

  - **Allow Disabled Queuing**
    This property (when set to true) allows emails to reside in the queue even when the Enabled status is set to false.

  - **Queue Size**
    This property refers to how many emails are currently in the queue (waiting to be sent). You can clear the queue at any time by right-clicking on the appropriate outgoing account property and selecting **Actions > Clear Queue** from the popup menu.

  - **Max Queue Size**
    This property allows you to specify how many emails are allowed to occupy the queue.

  - **Number Sent**
    This property displays the number of emails that have been sent. You can reset this number to zero at any time by right-clicking on the appropriate outgoing account property and selecting **Actions > Reset Number Sent** from the popup menu.

  - **Max Sendable Per Day**
    This property allows you to specify how many emails may be sent in one day.

  - **Number Discarded**
    This read-only property (NiagaraAX-3.5 and later) displays a value to indicate how many emails did not successfully send.

  - **Last Discard**
    This read-only property (NiagaraAX-3.5 and later) displays a date and time value to indicate when the last email did failed to send.

  - **Last Discard Cause**
    This read-only property (NiagaraAX-3.5 and later) displays an error message that indicates the cause of the last email send failure.

**About the IncomingAccount**

The email IncomingAccount component is required for receiving emails in a station. One use of this component is for email alarm acknowledgement with the EmailAcknowledge component.

**Note:** *In order to use the EmailAcknowledge, you must set up the IncomingAccount under the EmailService and connect it's "received" slot to the EmailAcknowledge "received" slot, as shown below. More than one IncomingAccount may be connected to the EmailAcknowledge, if desired.*
This IncomingAccount component is located in the email palette and should be added under the EmailService component, as shown below.

**Caution**

With the default configuration (see Delivery Policy property, below) the incoming email account deletes all emails from the mail server when it checks the account to retrieve new email, even if the emails are already marked as read by another email client. If permanent retention of the emails is required then do one of the following: (1) change the Delivery Policy setting from Delete to Mark As Read or Mark as Unread OR (2) configure a second service account which the mail server forwards emails to and configure the station's incoming account to check the second service account.

The IncomingAccount has the following properties:

**Figure 5-31**  
IncomingAccount property sheet view

- **Hostname**
  This is the name of the mail server. For example mail.acme.com could be a Hostname.

- **Port**
  This is the port number associated with the email account. Typically email incoming account port numbers are port "110", however, if you leave the setting at its default value of "-1" the IncomingAccount will search for and use a valid port.

- **Account**
  This is the name of the distinct account that is authorized for access to the "Hostname" mail server. For example, if you are using an email account named "controls@acme.com" on the host described above, the account name is simply "controls". The Hostname in this case could be "mail.acme.com".
• **Password**
  This is the login credential for the Account specified in the previous field.

• **Pollrate**
  This field allows you to specify how often the account connects to the mail server and checks for unread mail messages. Increasing the pollrate value increases the time between polls.

• **Enabled**
  This field allows you to activate or deactivate the account by choosing true or false, respectively.

• **Status**
  This is a read-only display of the condition of service. The status displays {ok} if the account is polling successfully. Other indications include:
  - {down} which means that the polling is unsuccessful, perhaps because of an incorrect Hostname, Password, or Account name
  - {disabled} because the Enable property is set to false

• **Last Poll Success, Last Poll Failure**
  These two properties display the time (in hours and minutes) of the last polling success and failure.

• **Last Poll Failure Cause**
  This display-only field provides an error message to indicate a reason for polling failure.

• **Debug**
  This Boolean property turns Debug mode on true or off, as desired. When Debug is turned on, you can see detailed debug information in a station’s standard output view (WorkbenchAX Platform > Application Director view) when the Station tries to send or receive email. This can be used to troubleshoot the accounts and faults.

• **Use Ssl**
  The Ssl (Secure Socket Layer) option is available starting in NiagaraAX-3.5. The option list allows you to disable Ssl (false) or enable it (true). Enable Ssl for communication with a host email server that requires it.

• **Store**
  This property allows you to choose between two standards of mail retrieval. You need to choose the option that is in use by your host mail server:
  - Imap
  - Pop3

• **Delivery Policy**
  This property (available starting in NiagaraAX-3.5) provides an option list that allows you to select how the incoming email account handles incoming emails at the mail server.
  The following options are available:
  - **Delete**
    With this configuration the incoming email account deletes all emails from the mail server when it checks the account to retrieve new email, even if the emails are already marked as read by another email client
  - **Mark As Read**
    This option marks all emails as read on the mail server when it checks the account to retrieve new email
  - **Mark As Unread**
    This option marks all emails as unread on the mail server when it checks the account to retrieve new email.

---

**About the Email Recipient (report-EmailRecipient)**

The report-EmailRecipient component is found in the Report palette and contains properties that allow you to specify where the report is to be emailed.

**Note:** *The EmailRecipient component for reports is located in the reports palette and is different from the Email Recipient that is used for alarms (located in the email palette). It is important to use the appropriate EmailRecipient component.*

The property sheet view, shown in Figure 5-32, displays the properties that you configure for this function.
EmailRecipient component properties include the following:

- **To**
  This is the email address of the email recipient (person who is to receive the emailed report).

- **Cc**
  This is the email address of anyone that is to receive a copy of the email (and attached report).

- **Bcc**
  This is the email address of anyone that should receive a copy of the email (and attached report) but whose name you do not want to display in the delivered email.

- **Language**
  This is the ISO 639 language code as two lower-case letters. For a list of codes, see the following: http://www.loc.gov/standards/iso639-2/langcodes.html.

- **Email Account**
  This is an option list that allows you to choose the email account that you want to use for sending the report email.

- **Subject**
  This is a text field that allows you to manually add text to the subject line of the email or use the following default text:
  \%reportName\% from %sys().station.stationName% %time()%

- **Body**
  This is a text field that allows you manually add text to the body of the email or use the following default text:
  Attached is the \%reportName\% report from %sys().station.stationName% generated on %time()%.

### About the SmsService

The SmsService is used for sending text messages to other cellular phones. The SMS driver allows retransmitting alarm information and sending general text messages.

**Note:** The term ‘SMS’ is used to refer to the Simple Message Service technology available on GSM devices. All SMS Niagara components are referred to as ’Sms’ components. This follows the style and conventions used in naming Niagara components, similar to the ’Bacnet’ driver for BACnet.

For more details, refer to the [Sms Users Guide](#).

### About the Sms Alarm Acknowledger

The SmsAlarmAcknowledger component (AX-3.5 and later) provides a way for users to acknowledge alarms by sending a reply to a text message alarm notification. This component is available in the Sms palette.
In order to use the SmsAlarmAcknowledger component, you need to add and configure the component. The SmsAlarmAcknowledger properties include:

- **Status**
  This display-only field shows the current condition of the SmsAlarmAcknowledger. For example, the current Status may be *ok, disabled, fault,* or some other condition.

- **Enabled**
  This field allows you to enable or disable an SmsAlarmAcknowledger component by selecting the *true* or *false* option, respectively.

- **Ack Alarms From Same Source**
  When you select the *true* option for this property, in addition to the current alarm, all previous alarms from this source are acknowledged with a single text reply. For example, a single control point may be going in and out of alarm repeatedly and have 23 unacked alarms reported and displayed in the alarm console. If you set this option to *true* all 23 alarms are acknowledged when the SmsAlarmAcknowledger receives a single text acknowledgement. If the *false* option is selected, a single alarm is acknowledged and 22 unacknowledged alarms remain.

- **Last Alarm Acked**
  This field displays the identity of the last alarm that was acknowledged by the SmsAlarmAcknowledger component.

- **Last Alarm Acked Time**
  This field displays the time that the last alarm was acknowledged by the SmsAlarmAcknowledger component.

- **Last Alarm Acked Failure Time**
  If there has been a failure in the attempt to acknowledge an alarm, this field displays a message indicating the time of the last failure.

- **Last Alarm Acked Failure Cause**
  If there has been a failure in the attempt to acknowledge an alarm, this field displays a message indicating the possible reason for the last failure.

- **Total Alarms Acked Today**
  This field displays the current number of alarms that have been acknowledged for the day. This number is reset to zero at midnight.

- **Total Alarm Acked Failures**
  This field displays the current number of alarm acknowledgement attempts that have failed for the day. This number is reset to zero at midnight.

- **Total Messages Received Today**
  This field displays the current number of Sms messages that have been received for the day. This number is reset to zero at midnight.

- **Last Sms Message Received**
  This field displays the message and phone numbers associated with the last Sms message received.

In order to use the SmsAlarmAcknowledger component, you need to do the following:

- **Setup the SmsService**
  See "About the SmsService" on page 5-22.
• **Setup the SmsAlarmAcknowledger**
  See "About the Sms Alarm Acknowledger" on page 5-22. This includes linking the 'Received' topic on the SmsService to the 'Received' slot of the SmsAlarmAcknowledger, as shown, below.

![SmsService “Received” topic linked to the SmsAlarmAcknowledger “Received” slot](image)

• **Setup the SmsRecipient**
  See "About the Sms recipient" on page 5-43.

In addition, note the following requirements for configuring the SmsRecipient:

• **A User is required**
  When properly configured, the SmsAlarmAcknowledger checks incoming text messages to see if the sender's phone number matches the phone number of a User that is currently in the local UserService database. No alarm is acknowledged unless it is first determined that the acknowledgement message is sent from a matching user and phone number. When validated, the User name is assigned to the alarm database as the person who has acknowledged the alarm.

• **A UUID is required**
  The UUID is the unique identifier that is assigned to every alarm and is used for keeping track of the alarm. For the SmsRecipient, the UUID must be in the body of the Sms message, so that it is present in the "reply to" acknowledging message. Also, this requires that the cell phone device is configured to "reply to sender with original text". This original text must contain the required UUID.

For related information, refer to the *Sms Users Guide*.

**Using Spy pages with the On Call Service**

Spy Pages can provide helpful information for tracking alarms when using the On Call Service or for On Call “debugging”. Spy page views are available for the On Call Lists and the On Call Recipient. Open a Spy Page by right-clicking on the On Call List or Recipient in the nav tree and selecting **View > Spy Remote** from the popup menu, as shown below.

![Displaying an On Call List Spy Page](image)

Some of the important information provided by Spy Pages include: current On Call Priority assignment ("On Call Priority"), current On Call Contacts ("On Call Contact"), and current time remaining ("Remaining") until a notification is sent to the next On Call Contact if an alarm is not acknowledged.

**Note:** To update Spy Page information, you must reload a Spy Page by clicking the **Refresh** button.

![Example Spy Page information](image)

**Common alarm controls and indicators**

The following alarm controls and indicators are common to several alarm views:
• **Alarm control buttons**
The following buttons appear in one or more alarm views:

- **Acknowledge**
  Use the **Acknowledge** button to **acknowledge all selected alarms**.

- **Hyperlink**
  Use the **Hyperlink** button to change the current view to the hyperlinked target associated with the selected alarm. If no hyperlink is associated with the alarm, the Hyperlink button is not available.

- **Notes**
  Click the **Notes** button to display the **Notes** dialog box and add a note to the selected alarm or alarms.

- **Silence**
  Stop the audible notification associated with the selected alarm.

- **Filter**
  Click the **Filter** button to display the **Filters** dialog box for setting the filter parameters. Starting in NiagaraAX-3.4, the "Filter" text displays in the color red, as a reminder, to indicate that alarms are being filtered.

- **Close**
  Click the **Close** button to cancel the current interface actions without saving changes.

• **Alarm icons**
Alarm icons appear with color coding and symbolic images:

- **A red alarm icon in the table indicates that the current state of the alarm source is “offnormal” and “not acknowledged”.
- **An orange alarm icon in the table indicates that the current state of the alarm source is “alert” and is “not acknowledged”.
- **A yellow alarm (gold) icon in the table indicates that the current state of the alarm source is “offnormal” but is “acknowledged”.
- **A green alarm icon in the table indicates that the current state of the alarm source is “normal” and “not acknowledged”.
- **A white alarm icon in the table indicates that the current state of the alarm source is “normal” and “acknowledged”.
- **A note alarm icon (it may be any color) in the table indicates that there is a note associated with the alarm.
- **A link icon in the table indicates that the alarm has a link associated with it. When an alarm displays this icon, the **Hyperlink** button is also active.
- **An optional icon may display if it is setup in the alarm properties. If included, this graphic appears at the left end of the alarm record row.**

### About the alarm database

The alarm database typically resides in a station file system, under the station's "alarm" folder, as shown in [Figure 5-37](#).

**Figure 5-37**  *Alarm database location*

Starting in NiagaraAX-3.2, it is possible to use the rdbAlarmService and configure a relational database (RDBMS) for storage of alarm records. This alternative to the standard alarm database requires an RdbmsNetwork connection to a supported database. See the *NiagaraAX-3.x RdbmsNetwork Driver Guide* for more details.

**Note:** Use of an RDBMS to store NiagaraAX alarm records is different than exporting histories to an RDBMS. Exported histories also still reside in the station's default history database (~\history\segN\(etc\)), whereas, configuring for RDBMS storage of alarms replaces use of the station's default alarm database (~\alarm\alarm.adb).
Types of alarm service views

You can view the alarm service in different ways in Workbench. Figure 5-38 shows a menu of views that are available using either the Workbench view selector or a popup menu.

**Figure 5-38** Alarm service views available from popup menu

In addition to the standard Workbench views (Wire Sheet, Category Sheet, Slot Sheet, Link Sheet) there are several views specific to the alarm service, including the following:

- **Alarm Extension Manager view**
  The alarm extension manager is a view of the alarm service that provides a record of information about each alarm extension. See “About alarm extension manager” on page 5-26 for details.

- **Instructions Manager view**
  The Instructions Manager view provides a way to view, assign, and edit the instructions that can be assigned to alarms. See “About the Instructions Manager view” for details.

- **Alarm Class Summary**
  The alarm class summary view provides a concise list of information relative to each alarm class. Refer to “About the alarm class summary view” on page 5-29

- **Alarm Database Maintenance**
  “About the alarm database maintenance view” on page 5-30

- **Alarm Db view**
  This view provides a “read-only” display of alarm data. See “About the alarm database view” on page 5-31 for details.

- **Alarm Service Property Sheet**
  The alarm service property sheet is a typical Workbench property sheet view that shows all the alarm service slots. See “About alarm service property sheet” for details.

**About alarm extension manager**

The alarm extension manager view presents alarm extensions in a table format to make it easy for you to see all the alarm extensions that are associated with points in your station. As with other tables, you can show or hide columns and use other standard table controls and options that are provided in the Table Options menu. The Table Options menu is located in the top right corner of the table and is described in “Table controls and options” on page 2-18. Also, the export toolbar icon is available on the toolbar when the alarm extension manager view is displayed.

An example of the alarm extension manager is shown in Figure 5-39.

**Figure 5-39** Alarm extension manager

The alarm extension manager view provides the following data fields:

- **Point**
  This field indicates the point that is the parent of the listed alarm extension.
• **Extension**
  This field identifies the type of extension that is listed (for example: "OutOfRangeAlarmExt", Status-AlarmExt", or others).

• **Alarm State**
  This field displays the status of the listed alarm extension; for example, "High Limit" or "Normal".

• **toOffnormal Enabled**
  This field indicates (as True or False) if the toOffnormal parameter of the extension is enabled (true) or not (false).

• **toFault Enabled**
  This field indicates (as True or False) if the toFault parameter of the extension is enabled (true) or not (false).

• **Alarm Class**
  This field identifies the name of the alarm class that the extension is assigned to (defaultAlarmClass or other class).

**Types of extension manager display features**

Extension manager display features include:

• **Color coding**
  A colored background on a row in the alarm extension manager table indicates that the alarm state of the parent component is *not* Normal.

• **Hyperlinking**
  Double-click on any row in the Alarm Ext Manager view and the view will change to the property sheet view of the alarm extension that you clicked on.

• **Alarm extension editing (and batch editing)**
  Select one or more (for batch editing) alarm extensions and use the popup menu (shown in Figure 5-40) to edit the extension(s).

**Figure 5-40  Alarm extension manager popup menu**

![](image)

Edit alarm extensions from the alarm extension manager in the following ways:

- **toOffnormal Enabled** and **toFault Enabled** settings
  You can toggle ON and OFF the toOffnormal Enabled and toFault Enabled parameters of each selected alarm extension using the popup menu.

- **Edit Alarm Class**
  You can change the alarm class assignment of the alarm extensions. Select single or multiple (for batch editing) and from the popup menu select the Edit Alarm Class menu item. Choose the desired alarm class from the option menu and click the OK button to change the alarm class setting for the selected alarm extension(s).

**About the Instructions Manager view**

The Instructions Manager view displays a standard table-type report that provides a way to view, assign, and edit alarm instructions. The view is comprised of three primary panes:

• **Points**
  This pane is located in the left half of the Master Instructions view and displays all points that are currently available for instruction assignment or editing. These points may have instructions assigned to them or they may have no instructions—they are simply the points that are available. The “Point” column contains the name of the control point source associated with the alarm and the “Conditions” column provides the name of property that is holds the alarm instructions.

  **Note:** You can select more than one point at a time by using the Shift key or Ctrl key. If the alarm instructions for all selected points are identical, then all associated instructions display in the Point Instructions pane. If there are any differences in alarm instructions for the selected points, no instructions display.
• **Point Instructions**
   This pane is located in the top right portion of the Assign Instructions dialog box and it includes a list of instructions that are associated with the point or points currently selected in the Points pane.
   You can add, remove, reorder, or edit instructions in this pane using the following controls:
   **Note:** Always remember to click the Save button immediately after making any changes.
   • **Add**
     Clicking the Add button produces the Add dialog box that allows you to type in the text for an instruction. Once you add the instructions text to an alarm, the instructions appear in the Alarm Record dialog box (accessible from the Open Alarm Sources dialog box) for any new alarms associated with that point.
   • **Remove**
     Select an instruction then click the Remove button to delete the instruction.
   • **Edit**
     Select an instruction and then click the Edit button to open a dialog box that allows editing of the selected instruction.
   • **Save**
     Clicking the Save button commits any changes made to the point instructions. The Save action applies to all instructions and all points that are selected when the Save button is clicked.
     Changes are lost if the screen or if just the pane is refreshed before saving.
   • **Move Up and Move Down**
     Select an instruction in the point instruction window, then click either the Move Up or Move Down button to reorder the instructions in the window.

• **Master Instructions List**
   This pane is located in the lower right portion of the Instructions Manager view and it displays all master instructions that are available for adding to the Point Instructions pane. Master Instructions allow you to choose and assign a pre-listed set of instructions to one or more points.
   **Note:** You can select more than one Master Instruction at a time using the Shift key or Ctrl key. If the alarm instructions for all selected points are identical, then all associated instructions display in the Point Instructions pane. If there are any differences in alarm instructions for the selected points, no instructions display.
   To add or remove one or more Master Instruction to one or more selected points, first select the Master Instruction(s) in the Master Instructions list and then click the Add From Master List button.
   Figure 5-41 shows an example of the Instructions Manager view with one point and one master instruction selected. You can Add, Remove and Edit Master Instructions using the following controls:
   • **Add**
     Clicking the Add button produces the Add dialog box which allows entering a text instruction to the Master Instructions list. The master instructions list allows you to enter instructions that are available to be assigned to any alarms. After entering instructions in the Master Instruction list, the instructions are available to be added to individual selected point instructions by first selecting the instruction in the list and then clicking the Add From Master List button.
   • **Remove**
     Select an instruction in master instructions list and then click the Remove button to delete the instruction.
   • **Edit**
     Select an instruction and then click the Edit button to open a dialog box allowing the instruction to be modified.
Chapter 5 – About alarms
April 4, 2011

**Figure 5-41** Instructions Manager view with one point and one master instruction selected

**About the alarm class summary view**

The alarm class summary view provides a tabular presentation of data associated with all alarm classes that are assigned to the alarm service. As with other tables, you can show or hide columns and use other standard table controls and options that are provided in the Table Options menu. The Table Options menu is located in the top right corner of the table and is described in “Table controls and options” on page 2-18. Also, the export toolbar icon is available on the toolbar when the alarm class summary view is displayed.

An example of the alarm class summary view is shown in Figure 5-42.

**Figure 5-42** Alarm class summary view

<table>
<thead>
<tr>
<th>Alarm Class Summary</th>
<th>Alarm Class Summary</th>
<th>Alarm Class Summary</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Total Open In Alarm Shocked Last Alarm</td>
<td></td>
</tr>
<tr>
<td>Default Alarm Class</td>
<td>117 1 16 25 May 05 10:40 AM EDT</td>
<td></td>
</tr>
<tr>
<td>DefaultAlarmClass</td>
<td>24 0 24 25 May 05 10:26 AM EDT</td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>141 1 140</td>
<td></td>
</tr>
</tbody>
</table>

The alarm class summary view has the following data fields:

- **Name**
  This data field displays the alarm class name.

- **Open**
  This data field displays the total number of open alarms associated with the alarm class.

- **In Alarm**
  This data field displays the total number of alarms (points currently in alarm) associated with the alarm class.

- **UnAcked**
  This data field displays the total number of unacknowledged alarms associated with the alarm class.

- **Last Alarm**
  This data field displays the timestamp of the last alarm associated with the alarm class.

- **alarm.Class.priority**
  This data field lists the priority of each alarm transition type. For example, “toOffnormal=1”, “toFault=60”, “toNormal=220”, and so on.

- **To Path String**
  This data field identifies (as a string value) the path to the alarm class.

Alarm class summary view display features include:

Note: You can double-click on any row in the view and the view will change to the property sheet view of the alarm class that you clicked on. You can also use the popup menu to select a view.
About the alarm database maintenance view

The alarm database maintenance view presents alarm data in a table view to make it easy to view and edit the alarm database. As with other tables, you can show or hide columns and use other standard table controls and options that are provided in the Table Options menu. The Table Options menu is located in the top right corner of the table and is described in “Table controls and options” on page 2-18. Also, the filter icon and the notes icon appear on the workbench toolbar when the alarm database maintenance view is displayed.

An example of the alarm database maintenance view is shown in Figure 5-43.

Figure 5-43  Alarm database maintenance view

The Alarm Database Maintenance view has two main sections:

- **Alarm History table**
  This table fills the upper part of the view and contains a table of alarm history records.

- **Maintenance controls pane**
  These controls are located below the table pane and contain the following controls and parameter options:
  - **Clear Old Records option**
    allows you to clear alarm records before a certain date and time. The **Before** field is provided to allow you to set the date and time for removing old records.
  - **Clear All Before Selected Record option**
    allows you to delete all records that have a timestamp earlier than the timestamp of the record that is currently highlighted in the table.
  - **Clear All Records options**
    allows you to delete all records, regardless of the date.
  - **Run Maintenance button**
    This button initiates the maintenance action.

The alarm database maintenance view has the following properties:

- **UUID**
  This data field displays the unique universal identifier (UUID) of the alarm record.

- **Source State**
  This data field displays the status of the listed alarm source; for example, “High Limit” or “Normal”.

- **Ack State**
  This data field displays either “Acked” or “Unacked” to indicate whether the alarm has been acknowledged or not.

- **Ack Required**
  This data field displays either “True” or “False” to indicate whether or not an acknowledgement is required for this alarm.

- **Source**
  This data field displays the alarm source name.

- **Alarm Class**
  This data field identifies the name of the alarm class that the extension is assigned to (defaultAlarmClass or other class).

- **Priority**
  This data field displays the priority number of the alarm.
• **Normal Time**
  This data field displays the time that the alarm went to normal (if applicable)

• **Ack Time**
  This data field displays the time that the alarm was acknowledged (if applicable)

• **User**
  This data field identifies the name of the user that acknowledged the alarm. An unacknowledged alarm will display "unknown" in this field.

• **Alarm Data**
  This data field presents a detailed list of alarm data.

• **Alarm Transition**
  This data field displays the last transition type of the alarm.

• **Last Update**
  This data field displays the time of the last alarm update.

### About the Alarm details dialog box

You can double-click on any row in the alarm database maintenance view table and the **Alarm Details** dialog box appears, as shown in *Figure 5-44*.

*Figure 5-44  Alarm details*

The alarm details dialog box displays read-only details about the alarm that is displayed in the database maintenance view.

### Types of alarm database maintenance

The database maintenance view allows you to perform the following database maintenance actions on the alarms, using the controls located at the bottom of the view:

• **Clear Old Records**
  allows you to clear alarm records before a certain date and time. The **Before** field is provided to allow you to set the date and time for removing old records.

• **Clear All Before Selected Record**
  allows you to delete all records that have a timestamp earlier than the timestamp of the record that is currently highlighted in the table.

• **Clear All Records**
  allows you to delete all records, regardless of the date.

Refer to “Managing alarms” on page 10-21 for procedures about alarm database management.

### About the alarm database view

Starting with NiagaraAX-3.2 the alarm Db view is available, as shown in *Figure 5-45*. This view is similar to the alarm database maintenance view (see “About the alarm database maintenance view”), providing a table of history records but not allowing the operator to delete records.
The alarm database view only requires “read” access but allows operator-level personnel to view alarms in the alarm console. When a point is no longer in alarm, it is removed from the console. The primary purpose of this view is to provide operators a way to view alarms without having “admin” access to delete alarms from the alarm database.

**Figure 5-45  Alarm database view**

You can double-click on any row in the alarm database maintenance view table and the Alarm Details dialog box appears, as shown in Figure 5-44.

**About alarm service property sheet**

An example of the alarm service property sheet is shown in Figure 5-46. The property sheet view of the alarm service displays all the recipients that are part of the alarm service and also has a capacity property that is visible and editable. The alarm service capacity property limits the number of records that are stored in the alarm service database. When the capacity is reached, the alarm records “roll”. This means that the newer records overwrite the oldest records.

**Figure 5-46  Alarm service property sheet**

**Note:** For details about the alarm database manager views, refer to “About the alarm database maintenance view” on page 5-30. For details about the alarm class summary view, refer to “About the alarm class summary view” on page 5-29. For details about the alarm extension manager, refer to “About alarm extension manager” on page 5-26.

**About alarm class**

The alarm class is maintained by the alarm extension and all alarm classes available to the system are maintained as slots on the alarm service. The alarm class routes alarms with some similar set of properties along common routes and they serve as channels for like data. Alarm class manages the persistence of the alarms as needed via the alarm archive, but otherwise merely chains alarms from the alarm source via a topic. The alarm class also manages which alarms require acknowledgement and is the basis for visual grouping in the alarm console.

The alarm classes are located under the alarm service node in the nav side bar, as shown in Figure 5-47.

**Figure 5-47  Alarm class in nav side bar**

You can set up multiple alarm classes in order to have a variety of alarming and routing options available for selection from the alarm extension properties. For example, you may set up an alarm class that routes to the console recipient and station recipient, while you may use another alarm class that routes alarms only to an email recipient, as shown in Figure 5-48.
For more information about alarm recipients, refer to “Types of alarm recipients” on page 5-36. For information about configuring alarm classes, refer to “About alarm class properties” on page 5-34.

**About alarm escalation**

Alarm escalation is a feature that allows you to configure an alarm class so that unacknowledged alarms that are assigned to that class can be re-routed if they are not acknowledged within a specified amount of time. The following three levels of escalation are provided so that you can enable up to three opportunities to re-route an alarm notification as the alarm remains unacknowledged:

- Escalation Level1
- Escalation Level2
- Escalation Level3

Each level may be routed to a different alarm recipient, as shown in Figure 5-49, so that if an alarm remains unacknowledged long enough, it may be sent to as many as four different recipients (including the original recipient). However, if an alarm is acknowledged at any level, then it is not escalated to the next level.

In addition to having an Enable property, each alarm escalation level has a Delay property that allows you to set the amount of time that you want to allow an alarm to remain at any level before it is moved to the next escalation level. Refer to “About alarm class properties” on page 5-34 for more information about Alarm Class properties.
About alarm class properties

Figure 5-50  Alarm class properties

The alarm class property sheet is shown in Figure 5-50 and described in the following list:

Note: Remember that these alarm class properties are specific to their parent alarm class and therefore, the properties do not contain values that are assigned to other alarm classes.

- **Ack Required**
  Any alarm assigned to this alarm class is required to have the selected alarm transitions acknowledged when the associated option is selected (toOffnormal, toFault, toNormal, toAlert). If no option is selected, then no ack is required.

- **Priority**
  These fields allow for custom entry of priority levels for each alarm transition type. The priority levels are associated with the alarms and are indicated graphically by colors that you can set in the alarm options dialog box. Refer to “Alarm console options” on page 2-26 for details about setting priority colors.

- **Total Alarm Count**
  This property displays the total number of alarms that have been assigned to the alarm class from all sources.

- **Open Alarm Count**
  This property displays the current total number of open alarms.
  Note: An alarm is considered open when it is not (acknowledged and normal) or not (acknowledged and alert).

- **In Alarm Count**
  This property displays the total number of alarm conditions.

- **Unacked Alarm Count**
  This property displays the total number of unacknowledged alarms.

- **Time of Last Alarm**
  This property displays the time that the last alarm (assigned to this alarm class) was generated.

- **Escalation Level(\(n\)) Enable (where \(n\) is 1, 2, or 3)**
  Select the true or false option of this property to enable or disable escalation at this level.

- **Escalation Level(\(n\)) Delay (where \(n\) is 1, 2, or 3)**
  This property is the time since the alarm was generated until it is escalated. This is not the time between escalation levels. Set a time (in hours and minutes) that you want to allow an unacknowledged alarm to remain unacknowledged before you escalate it to the next level. One minute is the smallest increment that you can set for escalation level delay.

About alarm class mapping

Alarm class mapping is available using the alarm class mapper dialog box. This dialog box, shown in Figure 5-51, provides a way for you to assign one or more alarm classes to a common set of alarm-handling parameters. One benefit of this type of mapping is that you can import alarms from a variety of alarm classes and have them display, link, or sound in a common manner. You do this by creating a alarm class definitions and then “mapping” existing alarm classes to these definitions. Open the alarm class mapper dialog box by choosing Alarm Class Mapping... from the Alarm menu. You can also open this dialog box in the Alarm Console window inside the Workbench Options dialog box.
Chapter 5 – About alarms

Note: The Alarm menu is available when you are in the alarm console view.

The alarm class mapper dialog box has two primary windows, as shown in Figure 5-53 and described below:

- **Alarm Class Definitions window**
  This window is located at the top of the alarm class mapper dialog box. You can create, delete, or edit alarm mapper definitions in this window and then assign any existing alarm classes to these definitions, as shown in Figure 5-53. Click on the **Edit** button to display the **Edit** dialog box (shown in Figure 5-52) where you can configure the mapper alarm definition.

- **Alarm Class Definitions Mapping window**
  This window is located at the bottom of the alarm class mapper dialog box. You can map any existing alarm classes to alarm mapper definitions. To do this, click the **Add Mapping** button to display the **Map Alarm Class** dialog box, as shown in Figure 5-53. Choose an available alarm class in the upper option box and assign it to the mapper alarm class definition in the lower option box. Click the **OK** button to complete the assignment. The mapping appears in the lower window. Remove mapping assignments by selecting the mapping in the lower window and clicking the **Remove Mapping** button.

**Figure 5-51** Alarm class mapper

**Figure 5-52** Editing a mapper alarm class

**Figure 5-53** Alarm class mapper dialog box

**Note:** The icons, hyperlinks, and sounds in the alarm mapper definition do not override those that are assigned in the alarm extension itself. If these parameters are assigned in both the alarm extension and in the alarm class mapper definition, the alarm class mapper definition parameters are ignored.
Types of alarm recipients

Alarm recipients are linked to an alarm class (from the alarm topic on the alarm class to the routeAlarm action on AlarmRecipient), as shown in Figure 5-48. Recipients may be configured to receive alarms at certain times of the day, certain days of the week, and to receive alarms of only specified transitions. There are several subclasses of the alarm recipient, as listed below:

- Console recipient (refer to “About the console recipient” on page 5-36)
- Station recipient (refer to “About the station recipient” on page 5-41)
- On Call recipient (refer to “About the On Call Recipient” on page 5-41)
- Email recipient (refer to “About the Email Recipient (email-EmailRecipient)” on page 5-43)
- Lineprinter recipient (refer to “About the lineprinter recipient” on page 5-44)

About the console recipient

The console recipient manages the transfer of alarms between the alarm history and the alarm console. For example, the console recipient gets unacknowledged alarms from the alarm history and updates the history when they are actually acknowledged. Console recipient properties are displayed and edited in the console recipient property sheet, as shown in Figure 5-54.

Console recipient properties are described in the following list:

- **Time Range**
  allows you to set a limited period of time during a day for collection of alarms, using the following parameters:
  - **Start Time**
    a time of day to begin alarm collection, defined by hour, minute and second.
  - **End Time**
    a time of day to end alarm collection, defined by hour, minute and second.

- **Days Of Week**
  option boxes allow selection of specific days to collect alarms.

- **Transitions**
  option boxes allow selection of specific alarm transitions to display in the console. Only those transitions that are selected will be displayed in the console – even though the alarms are still saved into the alarm history.
The default view of the console recipient is the alarm console view (for details about the console view, see About the alarm console).

**About the alarm console**

The alarm console is a view of the console recipient. It allows you to see all the alarms that have been routed to the alarm console. Alarms are presented in a tabular view with columns that can be viewed or hidden using the drop-down menu in the top right corner of the column title bar.

*Figure 5-55  Alarm console*

The alarm console manages alarms on a per-point basis. Each row in the alarm console is the most recent alarm from a point. To view all the current alarms or to get more details about a particular alarm from that point, use the alarm sources view and the associated dialog box displays. The export toolbar icon is available on the toolbar when the alarm extension manager view is displayed.

To view all the current alarms from a particular point in the open alarm sources view, double click the desired row. The alarm details view appears, as shown in *Figure 5-56*.

*Figure 5-56  Open alarm sources view*

To acknowledge an alarm, select the desired alarm and click the **Acknowledged** button. An alarm is cleared from the alarm console when both of the following conditions exist:

- alarm is acknowledged
- the point is in a “normal” state

As with other tables, you can show or hide columns using the Table Options menu in the top right corner of the table (refer to “Table controls and options” on page 2-18).

**Hide, show, add, and remove alarm data columns in the alarm console**

Default alarm data types appear in each of the columns of the alarm console view. You can change the visibility of alarm data columns in the following ways:

- **Hide alarm data column**
  
  To hide an alarm data column, click on the desired data column menu item in the Table Options Menu (located in the top right corner of the table view). Selecting the menu item toggles the visibility, as indicated by the check mark to the left of data column name in the menu.
• **Show alarm data column**
  To show an alarm data column, click on the desired data column menu item in the Table Options Menu (located in the top right corner of the table view). Selecting the menu item toggles the visibility, as indicated by the check mark to the left of data column name in the menu.

• **Add alarm data column**
  Add alarm data columns to the alarm console view using the Add Alarm Data Column dialog box. To open the Add Alarm Data Column dialog box, select the Add Alarm Data Column menu item in the Table Options Menu (located in the top right corner of the table view). This opens the dialog box and allows you to enter the exact alarm data text string, as shown below.

![Figure 5-57 Adding an alarm data column](image)

**Note:** Alarm data string text displays in the “Alarm Data” column when that column is visible. When the exact case-sensitive string is entered in the Add Alarm Data Column dialog box, the new column appears in the console as a column that you can hide, show, or remove, as desired.

• **Remove alarm data column**
  Remove alarm data columns from the alarm console view using the Remove Alarm Data Column dialog box. To open the Remove Alarm Data Column dialog box, select the Remove Alarm Data Column menu item in the Table Options Menu (located in the top right corner of the table view). This opens the dialog box and allows you to select the alarm data column to remove, as shown below.

![Figure 5-58 Removing an alarm data column](image)

**Note:** Alarm data string text displays in the “Alarm Data” column when that column is visible. When the exact case-sensitive string is entered in the Add Alarm Data Column dialog box, the new column appears in the console as a column that you can hide, show, or remove, as desired.

**Types of Alarm Details View dialog boxes**

• **alarm record dialog box**
  This dialog box shows additional detailed information about a specific point alarm, as shown in Figure 5-59. It also allows you to:
  - acknowledge an alarm using the **Acknowledge** button.
  - jump directly to a point using the **Hyperlink** button.
  - add notes to the alarm record using the notes dialog box (use the **Notes** button).
Figure 5-59  Alarm record dialog box

The Filters dialog box displays parameters, as shown in Figure 5-60, that you can use to include or exclude alarms from the alarm console by selecting or deselecting parameters. This filter action only affects which alarms display in the alarm console, it does not edit any alarm record data or perform any alarm "maintenance".

Figure 5-60  Filters dialog box

You can choose, for example, to filter out any alarms in the alarm console that are currently in a "Normal" state by selecting the "Source State" check box and then selecting all states except "Normal" and clicking the OK button. This action filters out all alarm records that have "Normal" current Source States. If the source state changes or if you change the settings in the Filters dialog box, the alarm console table will update to change the display, as indicated.

Caution  It is important to remember that the settings do not reset automatically—you must remove any filters that you set in order to view all alarm records. Starting in NiagaraAX-3.4, the Filter button displays the "Filter" text in red to indicate that alarms are being filtered.

Notes dialog box

Use the Notes dialog box to add a note to one or more alarms. To add a note to all the alarms from a selected source, open the Notes dialog box directly from the alarm console view, using the Notes...
button. If the selected alarm record represents a source with multiple alarms, any note that you add is added to all the alarms associated with that alarm source. When there is more than one alarm associated with an alarm record, the Notes dialog box displays a "<Multiple Alarms>" message, as shown in Figure 5-61.

**Figure 5-61  Adding a single Note to more than alarm**

The Notes dialog box is comprised of the following:

- **Message pane**
  The message pane is located in the upper half of the dialog box. It displays the text of any notes that are already associated with the selected alarm record. If multiple alarms are associated with the selected alarm record, the message pane also displays a "<Multiple Alarms>" notice to alert you to the fact that adding a note adds the note to all the alarms associated with the selected alarm source.

- **Editor pane**
  The Editor pane is located in the lower half of the dialog box and is a text field that allows you to type the text for any note that you are adding.

- **Add Note button**
  This button saves the note to the alarm record and dismisses the Notes dialog box.

- **Close button**
  This button closes the Notes dialog box without saving any information.

You can also open the Notes dialog box from the Alarm Record dialog box. Since the Alarm Record dialog box displays single alarm records, notes are added to only one alarm at a time using this method.

**Figure 5-62  Opening the Notes dialog box from the Alarm Record dialog box**
Chapter 5 – About alarms
April 4, 2011

About the station recipient
The station recipient manages the transfer of alarms between the alarm service and a remote station. For example, a station may send alarm notifications to a “supervisor” station – or any other remote station that is defined under the NiagaraNetwork. The station recipient component provides a place to specify the location and other details about that remote station. Station recipient properties are shown in Figure 5-63. The properties on a station recipient include a field for selecting the remote station, as well as alarm collection parameters.

Figure 5-63 Station recipient property sheet

Station recipient properties are described in the following list:

- **Time Range** allows you to set a limited period of time during a day for collection of alarms, using the following parameters:
  - Start Time a time of day to begin alarm collection, defined by hour, minute and second.
  - End Time a time of day to end alarm collection, defined by hour, minute and second.

- **Days Of Week** option boxes allow selection of specific days to collect alarms.

- **Transitions** option boxes allow selection of specific alarm transitions to display. Only those transitions that are selected will be displayed – even though the alarms are still saved into the alarm history.

- **Route Acks** when this parameter is set to true, Acks are routed to this recipient; when set to false, Acks are not routed to the recipient.

- **Remote Station** option selection displays eligible remote stations. Stations appear in the option list if there is a valid network connection to the station. Alarms that are sent to a remote station are routed according to the parameters defined in the Alarm class that is selected in the Alarm component under the remote station’s NiagaraNetwork. Refer to the Drivers Guide section “NiagaraStation Alarms notes” for more information about remote station alarm routing.

About the On Call Recipient
The On Call Recipient (AX-3.5 and later) manages the transfer of alarms between the alarm service and On Call Contacts. For example, a station may send alarm notifications by email or text message to one or more contacts if they are specified in the currently assigned On Call Contact List.

Note: Stations can send email by broadband (Niagara outgoing account configuration required) and Sms messages using a GPRS modem.

The On Call Recipient component is linked to an Alarm Class component and provides a place to specify the scheduling details and other routing options.

Figure 5-64 On Call Recipient linked to an Alarm Class component

On Call Recipient properties are shown in Figure 5-65 and described in the following list:
Chapter 5 – About alarms

Figure 5-65  On Call Recipient property sheet

• **Time Range**
  This property allows you to set a limited period of time during a day for collection of alarms, using the following parameters:
  - **Start Time**
    a time of day to begin alarm collection, defined by hour, minute and second.
  - **End Time**
    a time of day to end alarm collection, defined by hour, minute and second.

• **Days Of Week**
  These option boxes allow selection of specific days to collect alarms.

• **Transitions**
  These option boxes allow selection of specific alarm transitions to display. Only those transitions that are selected will be displayed – even though the alarms are still saved into the alarm history.

• **Route Acks**
  When this parameter is set to `true`, Acks are routed to this recipient; when set to `false`, Acks are not routed to the recipient.

• **Enabled**
  When this parameter is set to `true`, the OnCallRecipient component is operational.

• **On Call List**
  This field displays the currently active On Call List and its status.

• **On Call List Schedule**
  This is a special On Call scheduling component that is contained in the On Call Recipient component. The On Call List Schedule provides a standard scheduling view that is similar to other schedule views. The unique feature of this scheduling view is that the Event Output property value is assigned either a `null` value or an On Call List value. If a null value is selected, no alarms are forwarded. If an On Call List is assigned, then alarms are forwarded to contacts, as specified in the On Call List.

• **Escalation Delay**
  This property allows you to set the amount of time to wait for an alarm to be acknowledged by an On Call Contact before escalating it to the next contact in the On Call List. The default delay time is 30 minutes.

Figure 5-66  On Call List Scheduler view
**About the Email Recipient (email-EmailRecipient)**

The Email Recipient is like other alarm recipients except that the alarm may be formatted into an email message and delivered to another destination. An example of the email message format is shown in Figure 5-67.

**Figure 5-67  Email alarm message**

![Email alarm message](image)

The properties on an email message recipient (shown in Figure 5-68) include the data for the email message fields as well as alarm collection parameters.

**Figure 5-68  Email recipient property sheet**

![Email recipient property sheet](image)

**About the Sms recipient**

The SmsRecipient component (AX-3.5 and later) acts as an alarm recipient for transmitting alarm notifications by text message. Its use is similar to the EmailRecipient component. You can specify the text for the SMS message within the body field of the property sheet view.

**Figure 5-69  Configuring the EmailRecipient for the AlarmAcknowledger**

![Configuring the EmailRecipient for the AlarmAcknowledger](image)
The properties on an SMS recipient (shown in Figure 5-70) include the data for targeted cell phone numbers, the SMS message source and text fields, and alarm collection scheduling parameters.

For including the alarm UUID, include the string: UUID: %uuid% in the Body property text field, as shown below.

**Figure 5-70** SMS recipient property sheet

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>%alertData.sourceName%</td>
</tr>
<tr>
<td>Text</td>
<td>%alertData.alertText%</td>
</tr>
<tr>
<td>UUID</td>
<td>%uuid%</td>
</tr>
</tbody>
</table>

**Note:** There is a limit of 140 characters for an SMS message. Exceeding this limit causes the body text to be truncated.

For related information, refer to the SMS Users Guide.

**About the lineprinter recipient**

The LinePrinterRecipient allows you to print alarms to line printers that are attached to a station that is running on a Win32 platform. This recipient can print to local and remote line printers.

**Note:** The station must have permission to print on any printer that is designated in the Printer field.

Alerts may be generated if the printing of an alert fails, but the lineprinter recipient does not print alarms that it generates itself. An example of the lineprinter recipient property sheet is shown in Figure 5-71.

**Figure 5-71** Lineprinter recipient properties

Lineprinter recipient properties are described in the following list:

- **Time Range**
  - **Start Time**
    - a time of day to begin alarm collection, defined by hour, minute and second.
  - **End Time**
    - a time of day to end alarm collection, defined by hour, minute and second.

- **Days Of Week**
  - option boxes allow selection of specific days to collect alarms.
Transitions
option boxes allow selection of specific alarm transitions to display in the console. Only those transitions that are selected will be displayed in the console – even though the alarms are still saved into the alarm history.

Route Acks
when this parameter is set to true, Acks are routed to this recipient; when set to false, only alarms (not Acks) are routed to the recipient.

Printer
this option list displays printers that are available for selection. Select a valid lineprinter from the list or type in the name of the desired printer.

Language
this field provides a place to enter the ISO 639 language code for the language associated with the line printer. This is a two letter code (lower-case preferred). Refer to the following link for the complete list of codes: http://www.loc.gov/standards/iso639-2/langcodes.html.

Print Format
This field has the following editable default parameters.
- Source: %alarmData.sourceName%
this parameter sends the source name of the alarm to print on the first line.
- Timestamp: %timestamp%
this parameter sends the timestamp of the alarm to print on the second line
- State: %sourceState% / %ackState%
this parameter sends the alarm state and the acknowledged state to print on the third line
- Priority: %priority%
this parameter sends the alarm priority to print on the fourth line
- Alarm Class: %alarmClass%
- Text: %alarmData.msgText%

Note: For more information about how to format data in this field, click on the help icon to the right of the field.

Alert on Failure
when this parameter is set to true, an alert is generated if the printer fails to print the alarm.
About Presentation XML (Px)

This section describes the presentation tools that are available in Niagara AX Workbench. Basic presentation concepts and AX presentation architecture principles are described in "About presentation" on page 1-13.

If you plan to visually display the control logic that you develop in Workbench (for operations or for engineering purposes) then you need to understand the basic principles of Px and understand the capabilities and limitations of your different target media. Obviously, graphics and text look different and have greater limitations on a cell phone display, when compared with a computer-based web browser. It is important to develop Px files with the target media types in mind and to test your Px views in the target media types as you develop them.

Usually, it is easier to complete the engineering of your control logic using the wire sheet and other views before beginning to design the presentation of that logic. There are features and tools in the Px Editor, such as the Make Widget wizard, that allow you to drag and drop components from the nav tree onto various panes in the Px Editor. If you have already built the logic, it should visible in the tree and available for drag and drop.

The general process of creating presentations for control logic can follow many different paths. The three major steps, shown in Figure 6-1, are provided as an example to help illustrate the process.

Figure 6-1  Simplified presentation process

- **Create view**
  When you create a view, you are creating a relationship between a Px file and a component. The Px file defines the view and that view may be associated with one or more components of various types, such as folders and points.
  Refer to the following sections for information related to Px views:
  - "About Px views" on page 6-2
  - "About Px files" on page 6-3
  - "About Px viewer" on page 6-4

- **Bind data**
  After creating a view with a Px file, you add graphic visualizations (called widgets) to the file and pass data to these widgets using data binding. The bound data from the control objects animates and updates the widgets.
  Refer to the following sections for information related to widgets and data binding:
  - "About Px Editor" on page 6-5
  - "About Widgets" on page 6-12
  - "About the PxInclude Widget" on page 6-15
  - "Animating Graphics" on page 6-20
  - "About Px target media" on page 6-29
  - "About Web Profiles" on page 6-30
  - "About the Make Widget wizard" on page 6-36
  - "Make Widget wizard: examples" on page 6-37
• Create a Nav file
In order to easily find and navigate between views, a special file type (".nav" file) is available for creating a customizable navigation tree. Edit the Nav File using the Nav File Editor and assign a particular Nav File to a user in the user’s profile (using the User Manager view). Refer to the following sections for information related to the Nav file:
• "About the Nav file" on page 6-52
• "About the Nav File Editor" on page 6-54

About Px views

A Px view is a custom graphical view that you define in a Px file. The purpose of a Px view is to provide a visualization of information in a rich, dynamic format that is easy to create and to edit. By using the Px Editor to build Px files, you can create the desired visualization of your control logic without having software "programming" skills. When attached to a component, the Px view becomes the default view for the component.

Looking at an object’s Px view in the property sheet (where it may be edited) helps illustrate what a Px view is. A Px view is comprised of the following parts, as shown in Figure 6-2:

• Icon
Assign or change the icon file that appears to the left of the Px view display name. After assigning this icon to the view, it appears in the view selector menu, the nav tree side bar, and in the property sheet view.
Note: Icon graphics must be linked into your view from a module (for example, use the following path to find a "folder" icon: "module://icons/x16/folder.png"). Icon graphics are not supported outside of modules.

• Px File
Assign the Px file that is associated with active Px view. See "About Px files" on page 6-3 for more about Px file.

• Required Permissions
Assign or edit the Operator and Admin permissions that are applicable when the view is active: Read (r), Write (w), Invoke (I).

• Media
Edit the target media of the Px view: workbench or html. See "About Px target media" on page 6-29 for details about target media types.

Figure 6-2  Px view in a component property sheet

Px views as slot properties
The Px view is attached to a component as a dynamic slot property of the type "baja:PxView." One way to create a new Px view is to add it directly to a slot sheet (refer to "To add a new slot" on page 10-18, for details about adding new slots). Figure 6-3 shows three Px views in a single component slot sheet.

Figure 6-3  Three Px views as slot properties
The Px view highest on the slot sheet is the default view. You can reorder Px views to change the default Px view of a component. For an active component, all Px views (if any) appear in the view selector, as shown in Figure 6-4.
About the New Px View wizard

You can create and delete Px views using the Slot Sheet view, as described in “Px views as slot properties” on page 6-2. However, the easiest way to create a new Px view on a component is to use the New Px View wizard. Start the New Px View wizard by selecting New View from the popup menu or from the View Selector menu.

This wizard, shown in Figure 6-5, is a single dialog box that allows you to assign the view name, view icon, and target media properties, as described in “About Px views” on page 6-2. The wizard creates a new Px file and assigns it a default name unless you specify a name. You may choose to assign an existing Px file to the view instead of creating a new one.

Figure 6-5  New Px View wizard

After completing the fields in the New Px View wizard, click the OK button to finish. The new Px view is displayed in the Px Editor. If you choose to have the wizard create a new Px file, it will be a simple default file, as shown in Figure 6-6 on page 3.

About Px files

The Px file defines the content and presentation of a Px view. The Px file is a special XML file that describes the components in a database and can be any collection of components, up to a complete database. All views (wire sheet view, property sheet view, category sheet view, and so on) can be used on components in a Px file. This means that a Px view can be used to provide a complete variety of options in the development of dynamic user interfaces.

The contents of a very basic Px file is shown in Figure 6-7, as it appears in the Text Editor. This file simply contains an empty canvas pane nested in a scroll pane.
As you add more objects to the file, (typically using the Px Editor) the file looks more like the snippet shown in Figure 6-7. The graphic components, value bindings, and their container elements and attributes are all referenced in the Px file.

**Figure 6-7** Px file in Text Editor View and in Px Editor View

The elements in the Px file are also graphically represented in the Widget Tree side bar pane.

**Note:** Starting in NiagaraAX-3.2, two types of Px files are available. The standard Px file (includes a scroll pane at the root with a canvas pane) or the ReportPxFile (contains a report pane at the root).

- For information about the Px Editor, refer to “About Px Editor” on page 6-5.
- For information about the Widget Tree side bar, refer to “About the widget tree side bar” on page 2-10.
- For more information about the Text Editor, refer to “workbench-TextFileEditor” on page 12-24.

**Shared Px files**

A single Px file may be used as part of one or more Px views. Since the bindings within a Px file are always resolved relative to the current ORD, you can reuse the same Px file across multiple components by specifying bindings with relative ORDs. This allows you to create a single presentation and use it in views that are assigned to components that can use identical graphic layout. The obvious advantage of this file sharing is that you only need to create and edit one Px file for many views, thus saving time and ensuring consistency among similar applications. However, it requires that you understand the following caution:

**Caution** Editing a Px file affects all views that use that particular Px file:

- Any time that you view a component in the Px Editor you have its Px file open for editing.
- If the Px file is shared with other Px views, then all of those Px Views are changed.

**About Px viewer**

The Px viewer presents Px in a non-editable display. The Px viewer allows the user (with required permissions) to view information and invoke actions on controls in the display. Any time you select a Px view from the right-click menu or from the View Selector menu, the Px viewer displays the active component’s view, as shown in Figure 6-8. Use the Px editor to edit the Px file (as described in “About Px Editor” on page 6-5).
About Px Editor

When you select the Px Editor view of a component, or of a Px file, the Px Editor displays the Px file in the Workbench view pane. Figure 6-9 shows a Px View of a component with several items selected.

The default view of the Px Editor comprises three main areas:

- **Canvas**
  The largest area of the Px Editor (by default) is the canvas pane. Typically, you place widgets on the canvas and edit them using one or more of the three side bars and additional dialog boxes. If you want to change the default size of the canvas pane that appears in new Px files, then edit the canvas pane that is in the "/workbench/newfiles/PxFile.px" file (under your NiagaraAX installation ("My Host > My File System > Sys Home") directory. Refer to "About Widgets" on page 6-12 for more information about widgets.

- **Side bar pane**
  The Px Editor side bar pane appears on the far right side of the view pane only when the Px Editor is active. Refer to "About the side bar panes" for more information about side bar panes. Use the Px Editor toolbar menu to hide or display individual side bars or to show or hide the Px Editor side bar pane. Refer to "Types of side bars" on page 2-3 for more information about individual side bars.

- **Px Editor toolbar**
  The Px Editor toolbar displays above the view pane when the Px Editor is active. Refer to "Px Editor toolbar icons" on page A-14 for more information about individual Px Editor toolbar icons.
**About the Px Editor Canvas**

The Canvas, shown in Figure 6-10, is a graphic editor interface pane that defines the visual boundaries of the graphic page that you produce in the Px Editor. The Canvas is also your work area for previewing the Px file as you develop it using the tools in the Px Editor. The Canvas provides a view of the widgets (see “About Widgets” on page 6-12) as you add them and bind data to them. Most of the time, the Canvas provides a live view of any widgets that are added–without having to return to the Px Viewer. However, some graphic features may only appear in the Px Viewer. See “About Px viewer” on page 6-4 for more information about the Px Viewer.

The Canvas has the following optional work aids:

You can change the default settings of many of the Px Editor display features in the Px Editor view of the Options dialog box (select **Tools > Options** from the Workbench menu bar).

- **Grid**
  
  This is a visual aid for graphical alignment. The grid lines display vertical and horizontal lines as well as define the visible area of the page. Toggle the grid on or off using the Px Editor menu.

- **Show Hatch**
  
  Hatching is an area of light-gray diagonal lines that define the boundaries of items that are placed on the Px Editor Canvas. Toggle the hatching on or off using the Px Editor menu.

- **Snap**
  
  This feature is an aid to precise placement when you are using the mouse to drag an object to a particular location. Snap pulls the item to the nearest grid line or nearest object for a matching vertical or horizontal alignment. Toggle Snap on or off using the Px Editor menu.

---

**Figure 6-10  Px Editor Canvas**

---

**About Widget sizing in the Px Editor**

In order to resize a widget on the canvas pane you must be in edit mode. Click and drag on one of the widget bounding box handles, as shown in Figure 6-11, to resize the widget as desired. Starting in NiagaraAX-3.3, you can easily maintain the aspect ratio of the widget (maintain the widget's height-versus-width proportion) during resizing by pressing the Ctrl key before selecting and dragging the widget bounding box.

---

**Figure 6-11  Resizing a widget while maintaining aspect ratio**
**About Px Properties**

Starting with NiagaraAX-3.3, you can use Px Properties to facilitate graphic view design in the Px Editor view. Px Properties are entities based on a Px file markup convention that provide stylesheet-like control for properties in a Px file. You work with Px properties using a Px Properties palette and a widget’s context-sensitive popup menu to “link” properties to Px objects in the appropriate object properties field. The following figure shows an example of two Px properties that are defined in the Px Properties palette.

*Figure 6-12  Px Properties palette with two defined properties*

Px Properties can set values for widget properties such as font family, font size, color, background image, and others. After you create a property, you link the property to one or more specific widget properties. This gives you a single source for setting all linked property values on a page. You can use these to easily theme and update your graphics (colors, font types, font sizes, etc.) on a single Px view, as needed.

Use the PxEditor Sidebar icon (located on the main menu bar) to display or hide the Px Properties palette in the Px Editor side bar pane.

*Note: Px properties are not “globally” applicable; they work only on the local Px page where they are defined. However, you can copy and paste the content of the <properties> xml elements from one Px file to another using the Text File Editor view.*

*Figure 6-13  Select the Px Properties palette from the Px Editor Side Bars option menu*

**Px Property concepts**

Px Properties provide a convenient way to apply property values to Px file properties. When you create a Px property, a <properties> tag pair is entered into the Px file code to hold all property definitions. Each property that is created is defined by a set of parameters (such as "name", "type", and "value") and enclosed in a pair of <property> tags.
These property parameters are assigned to or removed from individual Px object properties through a process of Linking or Unlinking. When an object property is assigned a Px Property (using the Link popup menu item), the property sheet displays the Px Property name in the property value field with a light green background shading.

### About the Px Property palette

The Px Property palette works just like other Px palettes and has similar controls and displays. The following illustration shows an example Px Properties palette.

#### Using Px Properties

Typically you work with Px properties in the following ways:

- **Create Px Properties**
  - Click the Add New button to open the Add dialog box. In the Add dialog box, you can name the property and choose property types from drop down lists.
• **Edit Px Properties**  
In the Properties palette Value column, click on the value select 🔄 and edit 📐 buttons to edit a selected existing property values.

• **Delete Px Properties**  
Click the Delete button ❌ to delete a selected property.

• **Link Px Properties**  
With a Px object selected, right-click on the desired object property and select the Link menu item ⤵️ from the popup menu. Under the "Link" submenu, select the property item to apply.

**Note:** The popup menu is context sensitive. Px Properties that are not appropriate for the selected object property are not available (dimmed).

• **Unlink Px properties**  
With a Px object selected, right-click on the linked property and select the Unlink 📐 menu item from the popup menu.

**Example use of Px Properties**
The following steps describe a simple use of the Px Properties feature to assign a background color to a widget that has a background property.

1. Open the Px Properties palette, if necessary.  
If the Px Properties palette is not displaying on the right-hand Px Editor Side Bar, select it from the Px Properties Side Bar option icon 🤖 on the main Workbench menu.

2. Create a new Px Property.  
In the Px Properties palette, click the Add button ⚡ to create and name a new property using the Add dialog box. For example, use the Type: “gx” and “brush” to specify a color of “red” and save the property with the name “backgroundColor”.

3. Assign the Px Property to a widget property.  
Double-click on the target widget to open the widget’s Properties dialog box.  
In the Properties dialog box, right-click on the background property, select Link from the popup menu and choose the "backgroundColor" option. The color is applied to the background of the selected widget.

**About Px Layers**
Starting with NiagaraAX-3.5, you can use Px Layers to help with graphic design work in the Px Editor view. Px Layers allow you to group objects in the Px Editor view by assigning them to a common “layer”. The following list describes some of the things you can do with layers.

• **Select all objects assigned to a layer**  
You can select all objects in a layer by selecting the desired layer in the Px Layers palette. This simply saves you from having to individually select each item in the layer. When objects are selected using the Px Layers palette, most Px Editor "edit" actions work the same way as if you had selected the objects individually. For example, when you right-click on a layer in the Px Layers palette, choosing the Rename or Remove popup menu items renames or deletes the selected layer (not the objects). However, the Cut, Copy, Paste, Duplicate, and Delete (and other) menu items perform actions on the selected objects, not the layer.

**Figure 6-17**  
Selecting a layer

• **Lock objects assigned to a layer**  
You can lock all layer objects by selecting the Locked option in the Px Layers palette Status column. Locked objects display normally but you cannot select them on the Px Editor canvas (you can still select them in the Widget Tree). This is convenient for working with stacked or overlapping objects.  
**Note:** Locked object property values cannot be edited and display with a gray background in the Properties palette.
• **Hide objects assigned to a layer**
  You can hide all layer objects by selecting the *Invisible* value in the Px Layers palette Status column. When objects are invisible you cannot select them on the Px Editor canvas but you can still see and select them in the Widget Tree.

  **Note:** *Hidden object property values cannot be edited and display with a gray background in the Properties palette.*

Px Layers work using a Px file markup convention that adds a `<layer>` element to the Px file to define each new layer and a `<LayerTag>` element to each each object that is assigned to the layer. Normally, you work with Px layers directly in the Px Editor canvas as described in “Using Px Layers” on page 6-10.

**About the Px Layers palette**
The Px Layers palette works just like other Px palettes and has similar controls and displays. The following illustration shows an example Px Layers palette.

*Figure 6-18  Px Layers palette*

Note the following about the Px Layers palette:
- Palette controls are located across the title bar and work like other Px palette controls.
- The Add button opens the Add dialog box for adding a new Px layer.
- The Delete button deletes any currently selected layer.
- Layer names are displayed in the left column of the palette table.
- Layer status values (*Normal, Locked, Invisible*) are displayed in the right Status column of the table.
- The value select button is located to the right side of each layer value.

**Using Px Layers**
Typically you work with Px Layers in the following ways:
- Create a layer (see “Add a new Px Layer in the Px Editor view” on page 6-10)
- Assign or unassign objects to a layer (see “Add, remove or change a Px Layer assignment in the Px Editor view” on page 6-10)
- Rename a layer (see “Rename a Px Layer” on page 6-11)
- Delete a layer (see “Remove a Px Layer” on page 6-11)

**Add a new Px Layer in the Px Editor view**
You must have layers in the Px Layers palette before you can assign any objects to a layer. Objects do not display a layer property until at least one layer exists. This procedure describes how to create a new layer.

Step 1 In the Px Editor, on the Px Layers palette, click the Add button .
  The Add dialog box displays.

Step 2 In the Add dialog box type a name for the new layer and click the OK button.
  The new layer displays in the Px Layers palette and all editable objects have a new "layers" property value option available.

**Add, remove or change a Px Layer assignment in the Px Editor view**
This procedure describes how to add, change or remove an object’s layer assignment.

Step 1 Right-click on the desired object on the Px Editor canvas (or in the Widget Tree palette) and select Edit Properties from the popup menu.
  The Properties dialog box displays.

Step 2 In the Properties dialog box, click the value select button .
  The property value options display in the option list.

Step 3 From the option list, choose one of the following:
  - a named layer value option to add or change the object’s layer assignment
  - the empty (top) option to remove any object-layer assignment
Note: Instead of using the popup menu, you can select an object and change the layers value using the Properties palette.

Step 4 In the Properties dialog box, click OK button.

The dialog box closes and the object-layer assignment is changed or removed.

**Rename a Px Layer**

This procedure describes how to change the name of a Px Layer.

Note: Renaming a layer does not affect the layer assignments of the objects currently assigned to that layer. For example, if Object A is assigned to Layer1 when Layer1 is renamed to Layer2, ObjectA remains assigned to the layer (now named “Layer2”).

Step 1 In the Px Editor’s Px Layers palette, right-click on the layer that you want to rename and select the Rename command from the popup menu.

The Rename dialog box displays.

Step 2 In the Rename dialog box type the desired new name and click the OK button.

The layer name is changed.

**Remove a Px Layer**

This procedure describes how to delete a Px Layer.

Note: Removing a layer deletes the layer from the Px Layers palette but does not delete any objects or affect any object properties other than the “layer” property for any assigned objects. The layer property value is removed from any objects assigned to the deleted layer.

• In the Px Editor’s Px Layers palette, right-click on the layer that you want to delete and select Remove from the popup menu.

The layer is deleted and no longer appears in the Px Layers palette.

**View Source XML dialog box**

The View Source XML dialog box allows you to view the source XML of a Px file in a separate read-only window. Although you cannot edit the Px file in this dialog box, you can copy and paste text from the window into the Text File Editor—or any other text editor, such as Notepad.

The View Source dialog box, shown in Figure 6-19, is a simple window with an OK button that closes the window when you click it.

![View Source XML dialog box](image-url)

*Figure 6-19  View Source XML dialog box*
About Widgets

Widgets are components that provide visualization. You can use the Px Editor to work with widget properties in defining user interface functions for control and information display. User widgets can process input in the form of mouse, keyboard, and focus events. User events are grouped into these same event categories. The bajaui module, the kitPx module, and the kitPxHvac module all contain widgets that you can use for building rich user interfaces. You can find these widgets by opening them under the palette side bar, shown in Figure 6-20, or you can find them using the Make Widget wizard.

- refer to "Using the palette side bar" on page 10-9 for instructions about using the palette side bar.
- refer to "About the Make Widget wizard" on page 6-36 for details about the Make Widget wizard.

Figure 6-20  Widgets in the bajaui palette

The widget tree side bar provides a good illustration of the hierarchy structure of all widgets in a Px file (refer to "About the widget tree side bar" on page 2-10 for a summary of the widget tree side bar).

Some complicated widgets have mini-frameworks all to their own, such as the table widget, tree widget, treeTable widget, and textEditor widget. Refer to the "Baja Widget Toolkit" in the NiagaraAX Developer Guide for more details about these types of widgets and for developer-level information about widgets.

The following sections discuss some of the primary characteristics of widgets, including:

- Widget layout
- Types of panes
- Widget painting
- Commands
- About widget properties

Widget layout

A tree-type hierarchy of Px elements defines widget relationships and physical layout, in a structure where parent-child relationships exist between components. All widgets occupy a rectangular area that is defined by a position and a size. The position of a widget is defined by its x, y coordinates relative to its parent’s coordinate system and each widget may have a default (or preferred) size. The size of the widget is defined by the width and height properties. Figure 6-21 shows a simple layout of a widget (C), held by a parent widget (B), that is the child object of a widget (A).

Note: If either of the child objects are positioned outside of the view area of the parent, they will be clipped and not be totally visible.
Some widgets are designed specifically to be container widgets that hold other widgets. These widgets are called panes. Figure 6-22 shows the pane hierarchy in the widget tree and on the Px editor canvas. Refer to “Types of panes” for a list of commonly used panes.

**Types of panes**

Widgets that are designed to be containers for child widgets are called panes. Different types of panes provide different functions. The following list is a summary of some commonly used panes:

- **CanvasPane**
  used for absolute positioning.
- **BorderPane**
  used to wrap one widget and provide margin, border, and padding similar to the CSS box model.
- **EdgePane**
  supports five potential children: top, bottom, left, right, and center. The top and bottom widgets fill the pane horizontally and use their preferred height. The left and right widgets use their preferred width, and occupy the vertical space between the top and bottom. The center widget gets all the remaining space. See Figure 6-23 for an example.
- **GridPane**
  lays out its children as a series of columns and rows. Extra space in the rows and columns is configurable a number of ways using the pane’s properties.
- **SplitPane**
  supports two children with a movable divider between them.
- **TabbedPane**
  supports multiple children - only one is currently selected using a set of tabs.
  **Note:** Even though only one tab is visible at a time, all tabs must be loaded on the page, even if they are not visible. If many tabs, with a lot of information, are on a single page, the page may load very slowly.
- **ScrollPane**
  supports a single child that may have a preferred size larger than the available bounds. The scroll pane provides a set of scroll bars for viewing areas of the child widget that go outside of its bounds.
- **ReportPane**
  supports headers and footers in report PDFs. The ReportPane allows its content to span multiple pages, and allows each page to have a common logo as well as a page number and timestamp.
  **Note:** Report panes should be at the root of a Px file. If you place a report pane inside a scroll pane, then page-spanning is disabled.

Figure 6-23 illustrates the edge pane layout using borders and labels.
Widget painting

Painting defines how widgets present themselves graphically (using: colors, transparencies, and so on), as well as clipping. Graphics are always translated so that the origin 0,0 is positioned at the top, left corner of the widget. The graphic’s clip (visible area) is set to the widget’s size. Alpha and transparent pixels blend with the pixels already drawn. Widgets are drawn in property order, the first widget is drawn first (at the bottom), and the last widget drawn last (on the top). Effective z-order is reverse of property order.

Commands

Widgets can have user commands that are commonly used with buttons and menu actions. Toggle commands are commonly used with a checkbox, radio button, and other items. Menu commands are available and used on fans, coils, and other widgets, as shown in Figure 6-24.

Figure 6-24  Widget commands

For more information about commands, refer to the “Baja Widget Toolkit” in the NiagaraAX Developer Guide.

About widget properties

Widget properties define many of the features, behaviors and appearance characteristics of widgets. By editing widget properties, you set or change the widget attributes. In the Px Editor, you can edit widget properties using the properties side bar or properties dialog box and their secondary dialog boxes. Many of the properties (those that appear with the ellipsis icon) have these secondary dialog boxes that display when you click a property field. The secondary dialog box provides more detailed property fields and options.

Figure 6-25 shows the property side bar fields for a bound label. In this example, the text property of the bound label is "bound" to the "slot:temp" value, as shown in the text property field. The binding of this value allows the dynamic presentation of the temperature information in the Px view.
About the PxInclude Widget

The PxInclude is a widget located in the NiagaraAX-3.3 bajaui palette, as shown in the following illustration.

This widget provides a way for users to embed a single Px file in another Px file. The key benefit of this feature is the ability to create reusable Px views and embed them into one or many other Px views. The following sections describe the NiagaraAX-3.3 widget:

- PxInclude Widget Concepts
- Types of PxInclude Widget Properties
- Using the PxInclude Widget (including “About ORD Variables”, “General Procedure for Using the PxInclude Widget and ORD Variables”, and “Examples Using PxIncludes and ORD Variables”)

PxInclude Widget Concepts

Depending on the design of a Px file, a single "parent" Px file may contain many "child" Px files by using many PxInclude widgets. The PxInclude widget may have a single Px file associated with it, providing one "include" per widget, however, you can put more than one PxInclude widget in a Px file.

The following diagram illustrates the basic concept of embedding one Px file in one or more other Px files.
Note the following about the Px files represented in this diagram:

- Px files X, Y, and Z are included in other Px files
- Px files X, Y, and Z may display as independent views, as well as be embedded using the PxInclude widget.
- Px file Y is included in both Px file A and Px file B.
- Changes to files X, Y, or Z are displayed in their parent Px files (A or B), via the PxInclude, when the parent view is refreshed.

PxIncludes work by defining an ord property value that points to the "included" file, as shown in the following illustration.

**Figure 6-28**  PxInclude points to the file to be embedded

![PxInclude points to the file to be embedded](image)

This example shows the "inc1.px" file embedded in another Px file. The embedded filename is visible in both the Properties dialog box and in the Widget Tree.

When PxIncludes are added to a Px file, the "include" markup appears as follows in the Px code (visible in the "Text File Editor" view).

**Figure 6-29**  Simple PxInclude markup in a parent Px file

```xml
<px version="1.0" encoding="UTF-8"/>
<!DOCTYPE Niagara Presentation XML -->
<px version="1.0" module="workbench:nbdev01a">
  <import>
    <namespace name="cetus"/>
    <trans name="baseu"/>
    <trans name="base"/>
    <trans name="baseR"/>
    <trans name="cetus"/>
    <trans name="cetusR"/>
  </import>
  <report>
    <scrollPane>
      <CanvasPane name="canvas" viewWidth="600.0,400.0">
        <PxInclude layout="109,109,356,250" ord="file:px/inc1.px"/>
      </CanvasPane>
      </scrollPane>
    </report>
  </content>
</px>
```

**Types of PxInclude Widget Properties**

The PxInclude Widget has the following properties:

- **enabled**
  This property has two options: true and false. Setting the option to false causes the widget to stop working. Values may display but are not reliable and do not update.

- **ord**
  The value of this property (an ORD) identifies the Px file that is linked using the PxInclude widget. See an example in **Figure 6-30**, below.

- **variables**
  This optional property identifies the value of any variables in the Px file specified by the ord property. Clicking on the variable field displays the variables dialog box, where you can define the variable value. See an example in the **Figure 6-30**, below. Also see “About ORD Variables” on page 6-18.

- **layout**
  This property contains parameter fields for values that prescribe PxInclude widget size and location.

- **visible**
  This property has two options: true and false. Setting the option to false causes the widget to not display.
Figure 6-30  Example PxInclude Properties Palette in the Px Editor

Note the following about this illustration:

• The "ord" property: ^px/aircraft/inc_performance.px specifies to include the Px file named "inc_performance.px". This file is located in the station's (^) "px/aircraft" folder.

• The "variables" property value indicates that the included file has a single variable named "target" and that this variable is defined as "slot/Simulator/Performance".

• The "visible" property value is set to the default value "true".

Using the PxInclude Widget

Like other widgets, you can add a PxInclude to the Px Editor canvas in several ways, including the following:

• Drag (cut and paste) the widget from a palette
  This method simply drops a widget onto the Px Editor canvas, adding the widget to the current Px file. After adding the widget to the Px canvas, you must edit the ord property to add the desired Px file.

• Drag (cut and paste) a Px file from the workbench nav tree
  This method adds a PxInclude widget to the current Px file with a Px file already connected to the PxInclude ord property.

• Drag (cut and paste) a component from the nav tree
  This initiates the Make Widget Wizard: This method allows you to use the Make Widget Wizard to select the desired Px file and choose which variables to bind.

  Note: Only the ord variables that are selected in the bottom left window of the Make Widget Wizard are available for configuring after the PxInclude file is imported. See About_ORD_Variables.

  Note: For the Px file that you are including, you probably want to remove the root scroll pane that comes with the default Px file. Just use a canvas pane as the root, as shown in Figure 6-31. The scroll pane has a property called border policy, which is set to 'always' by default. This border is visible when the include is viewed in its parent Px file.

Figure 6-31  Remove the scroll pane from a Px Include to avoid displaying a border
When you complete the Make Widget Wizard, you may have the PxInclude widget configured fully, or edit it further, if needed.

**About ORD Variables**

ORD variables are optional portions of an "ORD binding" that you can create in order to provide more flexibility or "reusability" in your Px files. You can use a variable for the complete ORD or identify a variable part of an ORD by using the following special syntax in a bound component ord property field.$(var)

Where:
- \$ is a special character used to identify an ORD variable
- (var) is a named variable (may be any text string) inside a set of parentheses. The name in parentheses is the name that is substituted by a literal text string in the ord Variables dialog box after the child Px file is included in the parent Px file.

The following illustration shows the general relationships between Px files that use ORD variables in PxInclude widgets.

**Figure 6-32   Adding a PxInclude Using the Make Widget Wizard**

**Figure 6-33   PxIncludes Allow Px File Reuse With Variable ORDs**

Note the following about this example:
- Px File Y uses two ORD variables: $(var1) and $(var2).
- Px File Y is embedded in two different Px files using PxInclude widgets.
- In Px File A, var1 is defined as "A", resulting in a binding "ord=A". The "ord=A" value binds the widget to a "Point A", so a value from that "Point A" is displayed in the parent view (Px File A).
- In Px File B, var1 is defined as "C", resulting in a binding "ord=C". The "ord=C" value binds the widget to a "Point C", so a value from that "Point C" is displayed in the parent view (Px File B).
- Similar to the descriptions above, in Px files A and B, var2 is defined as ord=B and ord=D, respectively, resulting in different point values displayed in Px Files A and B.
**General Procedure for Using the PxInclude Widget and ORD Variables**

The following is a general sequence of steps that you can take to use the PxInclude widget:

**Step 3** Create (or open an existing) Px file that you want to use as an "included" or "child" Px file. This is the file that may be embedded in "parent" Px files using the PxInclude widget.

**Step 4** Design the child Px file, as desired. If you are using any bound variables, consider whether or not to use an ORD variable for the "ord" property value of any bindings that you may want to assign only at the parent Px file level.

**Step 5** Create any ORD variables using the $(var) syntax.

**Step 6** Save the child Px file in the desired location.

**Step 7** Create (or open an existing) parent Px file. This is the file that uses the PxInclude widget to embed the child Px file.

**Step 8** Add a PxInclude widget to the parent Px file using one of the following methods:
- Drag (cut and paste) the widget from a palette and edit the ord property to add the child Px file.
- Drag (cut and paste) the child Px file from the workbench nav tree to add the widget to the parent Px file with the child Px file already defined in the PxInclude ord property.
- Drag (cut and paste) a component from the nav tree to initiate the Make Widget Wizard. Use the Make Widget Wizard to select the child Px file and choose which variables to bind.

**Step 9** Select the PxInclude widget and edit the following properties, as required:
- enabled, layout, and visible - leave set to default values.
- ord - click the value field and define or browser to select the child Px file. If you used the Make Widget wizard, this field may already be defined.
- variables - click the value field to open the Variables dialog box. Use the editor field to define an ord value for each variable that appears. Notice the After column to verify the correct ORD path for each variable.

**Step 10** Click the OK button to close the Variables dialog box.

**Step 11** Save the parent Px file and attach it as a view to a component, if desired.

**Step 12** Verify that the variable ORD paths are set correctly by viewing the parent Px file from the component view (if used).

**Examples Using PxIncludes and ORD Variables**

The following sections show examples cases of using PxIncludes and ORD Variables:

- **Example: Using a PxInclude Widget with a Single ORD Variable**
- **Example: Using PxInclude Widgets with Multiple ORD Variables**

**Example: Using a PxInclude Widget with a Single ORD Variable**

Figure 6-34 shows an example of the Variables dialog box with one variable assigned.

**Note:** The Variables dialog box displays when you double-click on the "variables" field in a PxInclude widget. This dialog box has an editor field that allows you to assign literal text strings to replace each variable that has been set in the child Px file.

![Variable Dialog Box Example](image)

Note the following about this example:

- The top half of the dialog box comprises an "editor" field. This is where you can type a text string in the "Value" column to substitute for the variable.
- This example shows a single variable that is used in four instances. Each instance of the variable ORD has a different point appended to the variable.
- The bottom-left area of the dialog box displays each instance of the variable, as defined in the child.
Px file, in a Before column.

- The bottom-right area of the dialog box displays the results of any edits entered in the editor field in an After column. This is the literal ord value that is used in the Px file.

**Example: Using PxInclude Widgets with Multiple ORD Variables**

*Figure 6-35* shows a Px Editor view of a Px file. This Px file has a PxInclude Widget with multiple variables defined, as shown in the PxInclude Widget properties, and Variables dialog box.

*Figure 6-35  Variable Dialog Box Example*

![Variable Dialog Box Example](image)

Note the following about this example:

- The PxInclude widget is placed in the bottom left corner of the Px Editor view of a parent Px file (displaying 3 of the 4 included ORD variables).
- The ORD variables are defined by typing in the editor field Value column of the Variables dialog box. The variable values display in the After column in the lower half of the Variables dialog box.
- Defined variables display in the PxInclude Properties dialog box (or Properties palette) with multiple variables displaying in the "variables" property value field separated by commas.
- Values display in the PxInclude widget area only after the variable is defined (using the Variables dialog box).

**Animating Graphics**

Animated graphics are graphics that change, or "update", based on data values that come from object sources that are connected (or “bound”) to them. A "graphic" can be as simple as a single word of text ("ON") or a number ("72"), or it can be an animated image (rotating fan). Widgets provide the graphic visualization of data in Workbench, so animated graphics are comprised of one or more widgets assembled in a Px file, available for display using the Workbench display media types. Widgets are animated by binding any widget properties to a legitimate data source. This means that you can connect numeric values to widget properties that use numeric values and you can connect binary values to objects that can use binary values. By animating the properties of a widget, you can control text and image appearance as well as a change a widget’s location on the page and even its visibility.

The following sections describe the different concepts that relate to animating graphics:

- **Data binding**
- **Types of bindings**
- **Types of binding properties**
- **Relative and absolute bindings**

**Data binding**

All widgets may be bound to data sources using data binding. Bindings are established between a widget and an object using an ORD. A single binding consists of a single widget–object relationship. A binding’s ORD property identifies the location of the object that updates and animates the widget.
For example, the most common type of binding, the value binding, provides some of the typical functions that are associated with building real-time information for presentation as both text and graphics. This includes support for mouse-over status and right-click actions. Additionally, it provides a mechanism to animate any property of its parent widget using converters that convert the target object into property values. Figure 6-36 shows a value binding to a fan widget as viewed in the Edit Binding dialog box.

**Figure 6-36  Widget data binding**

![Diagram of Widget data binding](image)

Figure 6-37 illustrates the object-to-widget property binding concept. In this example, a widget has three separate data bindings. This means that each binding is coming from a different object and therefore each binding has a different ORD that defines its binding. Each binding provides access to an object’s values so that they may be used, as required, to animate the widget properties.

**Figure 6-37  Widget with three bindings**

![Diagram of Widget with three bindings](image)

**Types of bindings**

There are different types of bindings that may be used with widgets. Some bindings work with only a certain type of widget (for example, a bound label binding) and other binding types may be used with several types of widgets (for example, a value binding). Figure 6-38 shows bindings as they appear in a Workbench options list.

**Figure 6-38  Types of bindings**

![Diagram of Types of bindings](image)

Following, is a list and short description of each binding type.

- **Action binding**
  
  invokes an action on the binding target component when an event is fired by the parent widget. See “About action bindings” on page 6-26 for details.
• **Bound Label binding**
  connects a value to a bound label widget. See “About bound label bindings” on page 6-24 for details.

• **Field Editor binding**
  used to bind field editor components to an object. See "About field editor bindings" on page 6-27 for details.

• **Popup binding**
  used to display a Px view in an additional "popup" window that you can specify and configure. See “About Popup Bindings” on page 6-27 for details.

• **Setpoint binding**
  used to display the current value of a "setpoint" and also to provide the ability to modify it. See “About spectrum setpoint bindings” on page 6-26 for details.

• **Spectrum binding**
  used to animate a widget’s brush (color) property. See "About spectrum bindings" on page 6-25 for details.

• **Spectrum setpoint binding**
  used in conjunction with a spectrum binding. See "About spectrum setpoint bindings" on page 6-26 for details.

• **Table binding**
  used to bind table data in a bound table. See "About table bindings" on page 6-26 for details.

• **Value binding**
  used to bind to values that are typically under a component. See “About value bindings” on page 6-24 for details.

**Types of binding properties**

One or more of the following properties may be included with various binding types.

• **actionArgument**
  This property is used with certain widgetEvents to specify the action to take when the widgetEvent is triggered. For example, a mouseEvent (such as a "click") on a widget can change a boolean status from "true" to "false" or prompt the user to select a setting. Argument options, like the widgetEvents, themselves, are context sensitive, depending on widget and binding type.

• **degradeBehavior**
  Starting in NiagaraAX-3.1, this option allows you to specify how the object behaves when binding communications are not available. If a binding is not usable, then this property allows the designer to choose how the UI is gracefully degraded. For example, if the user doesn’t have permission to invoke a specific action, then a button that is bound to that action can be dimmed or hidden entirely. To preserve backward compatibility, the default degradeBehavior is none.

• **extent**
  This spectrum binding property represents the total range of the bound value which maps from low to high.

• **highColor**
  This spectrum binding property specifies the color that is used for the highest value assignment for a spectrum color binding. The high color displays when the bound target is greater than setpoint+extent/2. As the bound value decreases below the maximum value specified, the color approaches the color set by the Mid Color property.

• **hyperlink**
  This property provides a link to another object. When the field is completed, the hyperlink is active in the browser or in the Px viewer.

• **icon**
  This property value specifies an icon, if desired, to appear in the top left corner of a popup window. Starting in NiagaraAX-3.4, and the introduction of the modal property (allowing for a modal popup window option), the icon property is not available with the popup binding.

• **increment**
  This property is a value that can be set to increment (increase) or decrement (decrease) a current value by the assigned amount. A positive number in this property field increments a value; a negative number in this field decrements a value.

• **lowColor**
  This spectrum binding property specifies the color that is used for the lowest value assignment for a spectrum color binding. The low color displays when the bound target value is less than setpoint-extent/2. As the value bound to this property increases above the minimum value specified, the color approaches the color set by the Mid Color property.
• **midColor**
  This spectrum binding property specifies the color that is used for the middle value assignment for a spectrum color binding. This color is displayed when the bound value is exactly at the setpoint. As the binding value increases above this point, the displayed color approaches the color set by the High Color property. As the bound value decreases below this point, the displayed color approaches the color set by the Low Color property.

• **modal**
  This property is available starting in NiagaraAX-3.4 and applies to Popup Bindings (see “About Popup Bindings” on page 6-27). When the modal property is set to true, the popup window associated with the Popup Binding is a modal window.

  *Note:* A modal window is a child (or secondary) window that appears in front of a parent window and typically does not allow interaction with the parent window. The modal window created using this property is always on top but does not prevent a user from interacting with the parent window.

• **ord**
  This property specifies the ORD that is bound to the widget. This field must have a value if you want the widget to be bound. In a Popup binding this is the path that designates the component view that is displayed in the popup window.

• **popupEnabled**
  This property has `true` or `false` options and allows you to specify if you want to allow a secondary popup (right-click) menu (see Figure 6-39) to appear when a user clicks on this label from a browser or Px viewer.

  *Figure 6-39  Example popup (right-click) menu*

  ![Example popup (right-click) menu](image)

  If the option is set to `false` then the popup action menu is not available. You may use this if you want to prevent actions from being executed at a control point from a specific Px graphic while still allowing access to the action from a different Px graphic or property sheet.

  *Note:* Other ways to make actions unavailable include:

  – Hiding the action slot on the component makes the action unavailable but it would apply to every point of access in the station.
  – Actions can also be assigned operator or admin permission requirements to limit the access.

• **position**
  This property is used to designate an initial screen position for a popup window.

• **setpoint**
  This binding property specifies the value that is used for displaying the Mid Color. For example, if you set this value to “70”, then the color that you define for Mid Color will be displayed when the bound value is “70”.

• **size**
  This property is used to designate an initial screen size for a popup window.

• **statusEffect**
  This property provides the following three options for enabling or disabling status effects:

  – **Color**
    choose this option to enable a background color change when the bound value status changes.

  – **Color and blink**
    choose this option to enable a background color change and a blinking effect when the bound value status changes.

  – **None**
    choose this option to disable any effects based on bound value status changes.

• **summary**
  This property allows you to specify a display name for the widget in text or by means of a script.

• **title**
  This property value specifies the text that appears in a popup window title bar.
About bound label bindings

Bound label bindings are used exclusively for connecting a value to a bound label widget. Bound labels, which are located in the kitPx module, have properties that you can edit and access from the Px Editor properties side bar. The properties pane for the bound label binding is shown in Figure 6-40.

Figure 6-40  Bound label binding properties

Bound label binding properties include the following:

- ORD
- Hyperlink
- Summary
- Popup Enabled
- Status Effect

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

About value bindings

Value bindings are used to bind to values that are typically under a component. Widget properties may be overridden by creating dynamic slots of the same name with a converter that maps the bound target object into a property value. This capability is what allows animation of any widget property. Value bindings support features such as real-time graphics, mouse-over, and right-click actions.

The properties pane for the bound label binding is shown in Figure 6-41.

Figure 6-41  Value binding properties

Value binding properties include the following:

- ORD
- Hyperlink
- Summary
- Popup Enabled

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

Refer to “Types of Converters” for a list of converter types.

Types of Converters

Converters are used to change data from one type to another so that the data can be used to communicate with a particular widget property value. In most cases, when you animate a property, the correct data converter appears, by default, at the top of the list, as shown in Figure 6-42.
The following types of converters are available when using a value binding:

- Fixed Simple
- I Numeric to I Simple
- I Status to Simple
- Object to String

**About spectrum bindings**

This binding is used to animate a widget’s brush (color) property by mapping a numeric value into a color range defined by lowColor, midColor, and highColor properties. The properties pane for the spectrum binding properties is shown in Figure 6-43.

**About setpoint bindings**

This binding is used to display the current value of a “setpoint” and also to provide the ability to modify it. A setpoint is typically a status value property such as fallback. The setpoint binding ORD must resolve down to the specific property that is being manipulated. If it is bound to a component or to a read-only property, then the binding attempts to use a "set" action to save.

The properties pane for the spectrum setpoint binding is shown in Figure 6-44.

**Setpoint properties include the following:**

- ORD
- Hyperlink
- Summary
- Popup Enabled
- Widget Event
- Widget Property

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.
**About increment setpoint bindings**

This type of setpoint binding is used increment or decrement a numeric value. The properties pane for the increment setpoint binding is shown in Figure 6-46.

![Figure 6-45 Increment setpoint binding properties](image)

Spectrum setpoint properties include the following:
- ORD
- Hyperlink
- Summary
- Popup Enabled
- Widget
- Increment

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

**About spectrum setpoint bindings**

This binding is used in conjunction with a spectrum binding to animate the midColor properties. The properties pane for the spectrum setpoint binding is shown in Figure 6-46.

![Figure 6-46 Spectrum setpoint binding properties](image)

Spectrum setpoint properties include the following:
- ORD
- Hyperlink
- Summary
- Popup Enabled

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

**About action bindings**

This type of binding invokes an action on the binding target component when an event is fired by the parent widget. The ORD of an action binding must resolve down to a specific action within a component. Examples of actions include: “active”, “inactive”, “override”, and other commands. The properties pane for the action binding is shown in Figure 6-47.

![Figure 6-47 Action binding properties](image)

Action binding properties include the following:
- ORD
- Widget Event
- Action Arg

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

**About table bindings**

This type of binding is used to bind table data in a bound table. Table bindings can bind to any “collection” using a BQL, SQL, or History ORD binding. For example, a table binding ORD might look like the following:

```plaintext
station:|slot://|bql:select toPathString,toString from control:BooleanPoint
```

The properties pane for the table binding is shown in Figure 6-48.
Table binding properties include the following:

- ORD

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

About field editor bindings

Field editor bindings are used to bind field editor components to an object. A field editor is a component that is designed to view and edit an object property. Field editors are designed to be laid out on panes and are built with standard widgets like buttons, text fields, check boxes, and so on.

The properties pane for the field editor binding is shown in Figure 6-49.

Field editor binding properties include the following:

- ORD

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

About Popup Bindings

The Popup Binding is a type of binding that may be used to open a Px view in an additional "popup" window that you can specify and configure in terms of size, location, and content. The binding is attached to a Px object (such as a button) and configured using the Popup Binding properties. Figure 6-50 shows the Popup Binding listed in the Add Binding dialog box.

The Popup Binding has the following properties:

- ord
- Degrade behavior
- title
- icon (NiagaraAX-3.3 and earlier)
- position
- size
- modal (NiagaraAX-3.4 or later)

Refer to “Types of binding properties” on page 6-22 for a description of the binding properties.

Using the Popup Binding

Typically, a Popup Binding is added to an object that serves as a hyperlink for the Popup window. After adding the Popup Binding, you configure the properties to specify the Px view and Popup Window parameters that you want. The following illustration shows an example of a Popup Binding on a Px Button widget.
Relative and absolute bindings

Since ORDs can be relative or absolute and widgets are bound to data sources using an ORD, data binding can be relative or absolute, as shown in Figure 6-52.

This is a particularly important point to remember if you want to design Px files that are used in multiple views on a local station or even possibly for use across different stations. When you use the Px Editor tools to bind data, the ORD is usually supplied in an absolute format, by default. The ORD is relative to the station, such as: \texttt{station:|slot:/Logic/HousingUnit/AirHandler/DamperPosition}. This absolute path ensures that the data always resolves to a single unique component (“DamperPosition”) in the location that is specified by the ORD, regardless of where the Px file or the parent component is located. If the same Px file is attached to a view that belongs to a different component, the ORD will still resolve to the original “DamperPosition” component because of the absolute path. However, if you make data binding relative, then the path will resolve relative to its current parent ORD. This relative path makes the Px file resolve data bindings correctly to identically named components that reside in different locations, thus making one Px file usable in many views.

You can open the \texttt{Relativize ORDs} dialog box from the Bound ORDs palette, as shown in Figure 6-53. This Px Editor tool provides a convenient way to change absolute ORDs to relative ORDs.
About Px target media

When you work in the Px Editor you have two client-side target media technologies to consider.

- **Web Workbench**
  This technology allows the standard Workbench software to run inside a web browser using the Java Plugin. Web Workbench uses a small applet to download modules as needed to the client machine and to host the Workbench shell. These modules are cached locally on the browser’s hard drive.

- **Hx**
  In addition to Web Workbench, a suite of technology called Hx is available. The Hx framework is comprised of a set of server side servlets and a client side JavaScript library. Hx allows a real-time user interface to be built without use of the Java Plugin. It requires only web standards: HTML, CSS, and JavaScript. If you are developing for a target media that is limited to browsers with HTML and CSS with no applet plugins available, be sure to test your Px views often in the appropriate browser as you proceed in your development. The goal of Hx is to satisfactorily present your Px views in non-applet browsers, however, due to the difference in display technologies, you should verify that the Px view displays in the browser as you expect it.

  **Note:** The capabilities of Hx technology are often enhanced with successive releases of NiagaraAX-3.x. An example of this is the “visible” property that can be bound in many widgets. Note the following enhancements to this property that are provided in NiagaraAX-3.3.
  
  - The visible property now functions in Hx exactly as it functions in Px. Previous versions of NiagaraAX did not fully support the visible property in Hx.
  - Direct children of Tabbed panes cannot have a hidden visibility (visible = false).
  - Direct children of Scroll panes cannot have a hidden visibility (visible = false).
  - The visible property updates every 5 seconds.

Px files may be targeted for a specific media type, as described in “About presentation media” on page 1-14. You can specify the target media in the property sheet view of a Px view, as shown in Figure 6-54.

**Figure 6-54** Specifying the target media

This allows the Px Editor to advise you if you use any features in your Px file that are not supported by the target media that you have designated.

About profiles

  **Note:** In Workbench, the concept of Profiles pertains to the different ways that Workbench is displayed while using either the Java plugin or using Hx technology. In this context, it does not refer directly to security settings or personal preferences.

Profiles provide NiagaraAX software engineers with the ability to customize both the desktop Workbench and the Web Workbench interface. In addition, the type of profile used to login to the station can result in certain views being inaccessible even if the user has permissions to access the view.
Note: If you include a workbench view (wb view) as part of a Px page, then from a user-profile perspective it is just a Px page which is allowed. The user permissions to that included workbench view (component) in the station determines whether it displays in the px page or not.

Using NiagaraAX, the software engineer can create customized Workbench applications that provide different functionality. Refer to NiagaraAX Developer Guide for more information about custom user interface development. Workbench comes with the following two categories of profiles that have specific profile types available:

- Web Profiles (refer to "About Web Profiles")
- Kiosk Profiles (refer to "About Kiosk Profiles")

About Web Profiles

Custom user interface design, at the browser level, allows for different views that may include or exclude features such as sidebars, navigation trees and other tools that are provided through the interface. Web profiles are used to identify these different web interfaces. You can assign a single Web profile to each user that is listed in the User Manager. Refer to “UserService” on page 7-14 for details about assigning web profiles to users.

The following standard Web profile options are provided:

- **Default Wb Web Profile**
  Includes all Workbench functions (refer to "Default Wb Web Profile" on page 6-30)

- **Simple Admin Wb Web Profile**
  Reduced feature set in Workbench interface but with admin access available (refer to “Simple Admin Wb Web Profile” on page 6-31)

- **Basic Wb Web Profile**
  Reduced feature set in Workbench interface (refer to "Basic Wb Web Profile" on page 6-31)

- **Default Hx Profile**
  No Java plugin (refer to "Default Hx Profile" on page 6-32)

- **Basic Hx Profile**
  No Java plugin with reduced feature set interface (refer to "Basic Hx Profile" on page 6-32)

- **Default Touchscreen Profile**
  This profile uses Hx technology and provides a real-time user interface without the Java plugin download.

- **Basic Touchscreen Profile**
  This profile uses Hx technology to provide a real-time user interface without the Java plugin download.

- "Handheld Touchscreen Profile" on page 6-33
  This profile uses Hx technology to provide a set of features that are optimized for viewing on a handheld touchscreen device.

**Default Wb Web Profile**

This profile provides all the features of the Web Workbench, using the full Java plugin download. An example of the Default Wb Web Profile is show in Figure 6-55.

**Figure 6-55** Default Wb Web Profile example

Major features of the Default Wb Web Profile include:
Chapter 6 – About Presentation XML (Px)

April 4, 2011

About Web Profiles

• **Dropdown menu list**
  This menu includes the following submenus: File, Edit, Search, Tools, SideBars, PxEditor. These menus provide commands that are explained in “Types of menu bar items” on page A-2.

• **Side Bar**
  You may show or hide this pane. It may include the nav side bar and the palette side bar. The nav side bar displays the navigation hierarchy that is defined by the nav file.

• **Locator Bar**
  This interactive graphic bar appears across the top of the view area and functions as explained in “About the locator bar” on page 2-14.

• **Real-Time Data**
  Data is displayed in real-time using the Java plugin.

• **View selector**
  Provides the same view selection options that are available in the desktop Workbench views. Refer to “About the view selector” on page 2-15 for details.

### Simple Admin Wb Web Profile

This profile provides all the access of the Default Wb Web Profile, without using the full Java plugin download. It provides the same user interface as the Basic Wb Web profile but allows the full admin access as the Default Wb Web profile. An example of Simple Admin Wb Web Profile display is shown in Figure 6-56.

![Simple Admin Wb Web Profile example](image)

Major features of the Simple Wb Web Profile include:

• **Access**
  Access to all views (as allowed by user permissions).

• **Locator Bar**
  This graphic bar appears across the top of the view area – it is not restricted to the nav file.

• **Real-Time Data**
  Data supplied in real time using the Java plugin.

### Basic Wb Web Profile

This profile uses a reduced set of features but provides a rich user interface using the Java plugin download. An example of the Basic Wb Web Profile is shown in Figure 6-57.

![Basic Wb Web Profile example](image)

Major features of the Basic Wb Web Profile include:
• **Locator Bar**
  This graphic bar appears across the top of the view area.

• **Real-Time Data**
  Data supplied in real time using the Java plugin.

### Default Hx Profile

This profile uses Hx technology (described in "About Px target media" on page 6-29) and provides a real-time user interface without the Java plugin download. An example of the Default Hx Web Profile is shown in Figure 6-58. Also see "NiagaraAX-3.3 Hx profile-related updates" on page 6-33.

**Figure 6-58** Default Hx Profile example

![Default Hx Profile example](image)

Major features of the Default Hx Profile include:

• **Locator Bar**
  This graphic navigation bar appears across the top of the view area and displays links that are defined by the nav file.

• **Real-Time Data**
  Data is displayed in real time using Hx technology instead of the Java plugin.

• **View Selector**
  This dropdown option list provides a set of alternative views for the active object.

### Basic Hx Profile

This profile uses Hx technology (described in "About Px target media" on page 6-29). It provides a reduced set of features but includes real-time user interface without the Java plugin download. An example of the Basic Hx Profile is shown in Figure 6-59. Also see "NiagaraAX-3.3 Hx profile-related updates" on page 6-33.

**Figure 6-59** Basic Hx Profile example

![Basic Hx Profile example](image)

Major features of the Basic Hx Profile include:

• **Locator Bar**
  This graphic navigation bar appears across the top of the view area and displays links that are defined by the nav file.

• **Real-Time Data**
  Data supplied in real time without using Hx technology instead of the Java plugin.

### Default Touchscreen Profile

Starting in NiagaraAX-3.4, this profile uses Hx technology (described in "About Px target media" on page 6-29) and provides a real-time user interface without the Java plugin download. An example of the Default Touchscreen Web Profile is shown in Figure 6-60. Also see "NiagaraAX-3.3 Hx profile-related updates" on page 6-33.

**Figure 6-60** Default Touchscreen Profile example

![Default Touchscreen Profile example](image)
Major features of the Default Touchscreen Profile include:

- **Locator Bar**
  This graphic bar appears across the top of the view area and displays links that are defined by the nav file. The Default Touchscreen profile includes the Config, Files, and History space links, in addition to links specified by the assigned nav file.

- **Real-Time Data**
  Data is displayed in real time using Hx technology instead of the Java plugin.

- **View Selector - touchscreen-friendly**
  When touched, this control provides an option dialog box of alternative views for the active object.

See *NiagaraAX Touchscreen Profile* Engineering Notes document for more details about this profile.

**Basic Touchscreen Profile**

Available, starting in NiagaraAX-3.4, this profile uses Hx technology (described in "About Px target media" on page 6-29). It provides a reduced set of features but includes real-time user interface without the Java plugin download. An example of the Basic Touchscreen Profile is shown in Figure 6-61.

Major features of the Basic Touchscreen Profile include:

- **Locator Bar**
  This graphic bar appears across the top of the view area and displays links that are defined by the nav file.

- **Real-Time Data**
  Data is displayed in real time using Hx technology instead of the Java plugin.

See *NiagaraAX Touchscreen Profile* Engineering Notes document for more details about this profile.

**Handheld Touchscreen Profile**

This profile uses Hx technology (described in "About Px target media" on page 6-29). It provides a set of features that are optimized for viewing on a handheld touchscreen device.

See *NiagaraAX Touchscreen Profile* Engineering Notes document for more details about this profile.

**NiagaraAX-3.3 Hx profile-related updates**

Starting in NiagaraAX-3.3, the following updates apply to Hx profiles:

- "NiagaraAX-3.3 Hx Pathbar" on page 6-34
- "NiagaraAX-3.3 "visible" property" on page 6-34
- "Charting in the browser" on page 4-11
NiagaraAX-3.3 Hx Pathbar  In NiagaraAX-3.3 the HxPathBar provides a default set of links between the three root spaces: Station (Config), Files, and History. Users can fully navigate a station in Hx without having to manually type in URLs.

Figure 6-62  Comparing the HxPathbar and the WbApplet Nav Tree

Note the following about the HxPathbar:

- The root file node displays the same as in WorkbenchAX (uses a drive icon called 'Files').
- The root history node displays the same as in WorkbenchAX (uses a history database icon).

NiagaraAX-3.3 "visible" property  Starting in NiagaraAX-3.3, the "visible" property displays and behaves the same in Hx profiles and WbWeb profiles (using the WbApplet). An example of this is the "visible" property that may be bound and controlled in some widgets and the true/false values set to show or hide a widget based on the "visible" property value. An example of binding and using the "visible" property is shown in the following illustration.

Figure 6-63  The visible property value bound to a "value binding"

The example above shows the "visible" property animated using a value binding. The value binding is linked to a writable point that passes its "true" or "false" value to the visible property so that it is "visible" (true) or "hidden" (false).

Note the following visibility characteristics:

- The visible property functions in Hx exactly as it functions in Px.
- Direct children of Tabbed panes cannot have a hidden visibility (visible = false).
- Direct children of Scroll panes cannot have a hidden visibility (visible = false).
- The visible property updates every 5 seconds.

The following illustration gives a comparison of how a simple use of the "visible" property displays in a browser using the WbApplet and using Hx (no applet).
Note the following about this example:

- The ARM and SAFE buttons write to a boolean point.
- The ARMED and SAFE labels have a "visible" property that is bound to and animated by the value of the boolean point.
- Clicking the ARMED button sets the boolean point value to "true"
- Clicking the SAFE button sets the boolean point value to "false"
- The "true" boolean point value sets the ARMED label "visible" property to "true" and the SAFE label "visible" property to "false" as defined by their respective "visible" properties using the visible dialog box.
- The "false" boolean point value sets the ARMED label "visible" property to "false" and the SAFE label "visible" property to "true" as defined by their respective "visible" properties using the visible dialog box.
- The behavior of the "visible" property is the same in both Px (WbApplet) and Hx rendered views in the browser.

**About Kiosk Profiles**

Kiosk mode provides a way to run a NiagaraAX workbench station so that it fulfills many of the needs of a stand-alone operator workstation as well as many needs of a touchscreen interface. In order to automatically start Kiosk mode, you must have a locally connected display.

**Note:** The Kiosk profile is not invoked or displayed by remote browser clients. You cannot use a remote computer with a touchscreen and expect to get the same Kiosk interface.

While Kiosk mode is not limited to touchscreen applications, it does provide advantages that make it well suited for use in a touchscreen application. Kiosk profiles provide unique interface designs and include the following:

- **Basic Kiosk profile**
  This profile is designed for normal operators to use a workbench in Kiosk mode. It displays a read-only locator bar as a "bread crumb trail" and provides Back, Forward, and Logoff buttons. This profile disables:
  - all side bars
  - the entire menu
  - the entire toolbar
  - all non-admin views

- **Default Kiosk profile**
  This is the default workbench profile used in Kiosk mode. It supports all the features of a normal desktop workbench profile except for:
  - File>Close command
  - File>Exit command
  - Tools>Credentials Manager

- **Handheld Kiosk profile**
  This profile provides a reduced display that is designed to help handheld users view and navigate the application.
Px Editor workflow

There are various ways to work with the Px Editor. Some work sequences may depend on the type of control logic you are working with and some may depend on your Px target media. The following sections describe workflow patterns that may be used in some situations but may not be optimal—or even possible with others. The Px Editor tools provide many ways to perform a single task. For example, you can edit widget properties in the Properties side bar, or you may double-click on a widget to display a Properties pane in a separate dialog box. Both means of editing the properties have the same effect.

About the Make Widget wizard

The Make Widget wizard is a convenient aid for quickly adding widgets to the Px file. The Make Widget wizard is available when Px Editor is the active view. The wizard, shown in Figure 6-66, automatically displays when you drag a component onto the Px Editor canvas.

**Note:** The wizard does not display when you drag a widget object from a palette to the canvas.

**Figure 6-66** Make Widget wizard

The following list describes the primary areas of the Make Widget wizard:

- **Title Bar**
  This area displays a reminder that you are creating a widget that has a value that is bound to the ORD of the object that you just dragged into the Px Editor. Double-click on the ORD area to browse for a different component, if desired.

- **ORD**
  This area displays the ORD of the object that you dragged into the Px Editor. You can double click on this line and browse to select a different slot (for example: “out” or “value”) in the current ORD or to bind to a different component.

- **Source**
  This area provides context-sensitive options for choosing the type and source of widget that you want to bind to the ORD. Depending on the type of value that you want to link, the wizard displays a variety of options in this area. For example, the Chart widget option would be available for a History Log object but it would appear dimmed (unavailable) if you dragged a Boolean Point object onto the canvas.

  The Widget Source option that you choose will change the display in the Property Options area and the Property Sheet area.

- **Secondary view**
  The secondary view area changes depending on what option is chosen in the Source area:
  - Property Options (Bound Label only)
This area appears when you select Bound Label in the Widget Source options. It provides a set of convenience options that allow you to set some of the commonly used label properties, by selecting a check box. You may also use the property sheet area of the wizard or later use the property fields in the property sheet dialog box or property sheet side bar to edit these properties.

- Module browser
  This area appears when you select the From Palette option in the Source view and allows you to browse for the desired widget.
- Sheet selector
  This area appears when you select the Workbench View option in the Source view and allows you to choose the Workbench view that you want to display for the object you just dragged into the Px Editor.
- Property options
  This area appears when you select the Properties option in the Source view and allows you to choose options that relate to the properties of the object that you just dragged into the Px Editor.

*Note:* The Secondary view does not appear when the Actions option is selected in the Source area.

- **Property Sheet**
  This area provides context-dependent options for you to select from (depending on the object that you drop onto the Px Editor).
  - Property Sheet
    The complete property sheet view displays when you use the Bound Label, From Palette, or Workbench View option.
  - Properties List
    A complete list of component properties (for the component you are dropping on the Px Editor canvas) is listed in this area.
  - Actions
    A list of available actions is displayed here when you select the Actions option.

### Make Widget wizard: examples

There are many ways to use the Make Widget wizard. The following procedures provide examples of one way to use the Make Widget wizard to perform the following tasks:

- Create a bound label widget
- Create a widget using a palette kit module
- Create a widget with a Workbench view
- Create a widget using a component properties option
- Create an action widget
- Create a Time Plot widget
- Create a Chart widget

#### Create a bound label widget

To create a bound label widget using the Make Widget wizard, do the following:

**Step 1**
Open the nav side bar and expand the tree to locate the component that you want to add to the Px Editor canvas.

**Step 2**
Drag and drop the desired component onto the canvas, as shown in Figure 6-67.

*Figure 6-67*  Dropping a component on the Px Editor canvas

The Make Widget wizard displays, as shown in Figure 6-68.

*Note:* The ORD for the selected component displays in the ORD area. Double click the ORD to browse for a different slot in the component (for example: “out” or “value”) or to bind to a different component, if desired.
Step 3 Select the Bound Label option in the Source options list as shown in Figure 6-68.

**Figure 6-68 Selecting Make Widget wizard options**

The Secondary view area displays a list of property options that are available.

Step 4 In the Secondary view area, select the options that you want and set their properties, as desired, using the adjacent property options lists, as shown in Figure 6-69.

**Figure 6-69 Selecting Make Widget secondary view properties**

Note: The Make Display Label option creates a separate unbound label that appears directly beside the bound label when the widget displays on the canvas. Edit the display label properties using the properties side bar after completing the Make Widget wizard.

Step 5 In the Properties sheet area, shown in Figure 6-70, edit the bound label properties.
Chapter 6 – About Presentation XML (Px)

Make Widget wizard: examples

April 4, 2011

About Kiosk Profiles

Figure 6-70  Editing Make Widget properties

Note: Some of the options in the Secondary view area are also editable in the Properties sheet area. It is possible to override an option by changing it in the properties sheet area.

Step 6  Click the OK button to complete the wizard. The Make Widget wizard disappears and the new bound label appears on the Px Editor canvas as shown in Figure 6-71.

Figure 6-71  Completed bound label on Px Editor canvas

Step 7  Toggle the view using the View/Edit Mode toolbar icon to display the widget in the Px Viewer, as shown in Figure 6-72.

Figure 6-72  Completed (commandable) bound label in Px Viewer

Create a widget using a palette kit module

To create a palette kit-based widget using the Make Widget wizard, do the following:

Step 1  Open the nav side bar and expand the tree to locate the component that you want to add to the Px Editor canvas.

Step 2  Drag and drop the desired component onto the canvas, as shown in Figure 6-73.
The Make Widget wizard displays, as shown in Figure 6-74.

Note: The ORD for the selected component displays in the ORD area. Double click the ORD to browse for a different slot in the component (for example: “out” or “value”) or to bind to a different component, if desired.

Step 3 Select the From Palette option in the Source options list as shown in Figure 6-74.

The Secondary view area displays the palette side bar view.

Step 4 All palettes that are currently open in the palette side bar are available under the module option selector arrow. Other palettes may be opened by clicking on the folder icon.

In the Secondary view area, expand the module tree to find and select the desired widget template, as shown in Figure 6-75.
Step 5 In the Properties sheet area, shown in Figure 6-76, edit the widget template properties, as desired.

Figure 6-76  Editing widget template properties

Step 6 Click the OK button to complete the wizard. The Make Widget wizard disappears and the new widget appears on the Px Editor canvas as shown in Figure 6-77.

Figure 6-77  Completed widget on Px Editor canvas
Step 7  Toggle the view using the View/Edit Mode toolbar icon to display the widget in the Px Viewer, as shown in Figure 6-78.

**Figure 6-78**  Completed (commandable) widget in Px Viewer

Create a widget with a Workbench view

You can create a Px view that duplicates the Workbench view of a component. To create a Workbench view-based widget using the Make Widget wizard, do the following:

Step 1  Open the nav side bar and expand the tree to locate the component that you want to add to the Px Editor canvas.

Step 2  Drag and drop the desired component onto the canvas, as shown in Figure 6-79.

**Figure 6-79**  Dropping a component on the Px Editor canvas

The Make Widget wizard displays, as shown in Figure 6-80.

Note: The ORD for the selected component displays in the ORD area. Double click the ORD to browse for a different slot in the component (for example: “out” or “value”) or to bind to a different component, if desired.

Step 3  Select the Workbench View option in the Source options list as shown in Figure 6-80.

**Figure 6-80**  Selecting Make Widget wizard options

The Secondary view area displays a list of view options that are available for the selected component.

Step 4  In the Secondary view area, select the desired component view to add, as shown in Figure 6-81.
The **Properties** sheet area displays the component properties.

**Step 5** In the **Properties** sheet area, shown in [Figure 6-82](#), edit the widget template properties, as desired.

**Figure 6-82  Editing widget template properties**

Step 6  Click the **OK** button to complete the wizard. The Make Widget wizard disappears and the new widget view appears on the Px Editor canvas as shown in [Figure 6-83](#). Use the handles on the widget view to expand the view to the desired size or edit the Layout field in the properties side bar. Scroll bars will appear if the widget view is larger than the canvas view area.

**Figure 6-83  Completed widget on Px Editor canvas**
Step 7  Toggle the view using the View/Edit Mode toolbar icon to display the widget in the Px Viewer, as shown in Figure 6-84.

**Figure 6-84**  Completed (commandable) widget in Px Viewer

The view is fully functional in the Px viewer, where you can edit properties, invoke commands, or make other edits to a component, just as if you are editing in the Workbench view.

**Create a widget using a component properties option**

To create a widget based on a component property using the Make Widget wizard, do the following:

Step 1  Open the nav side bar and expand the tree to locate the component that you want to add to the Px Editor canvas.

Step 2  Drag and drop the desired component onto the canvas, as shown in Figure 6-85.

**Figure 6-85**  Dropping a component on the Px Editor canvas

The Make Widget wizard displays, as shown in Figure 6-86.

**Note:** The ORD for the selected component displays in the ORD area. Double click the ORD to browse for a different slot in the component (for example: “out” or “value”) or to bind to a different component, if desired.

Step 3  Select the Properties option in the Source options list as shown in Figure 6-86.
Step 4 In the Secondary view area, select one or more options from the list, as shown in Figure 6-87.

**Figure 6-87  Selecting Make Widget secondary view properties**

- **Make Display Name Labels**
  Choosing this option displays a separate unbound label that appears directly beside the bound label when the widget displays on the canvas. Edit the display label properties using the properties side bar after completing the Make Widget wizard.
- **Make Field Editors**
  Choosing this option displays an area that allows you to edit the property in the Px viewer (or in a browser).
- **Make from palette**
  This option displays the palette side bar view in the wizard and allows you to find and use a suitable widget template from any available palette.
- **Ord and Property Layout options (By Row or By Column)**
  These options affect how the fields will be arranged on the canvas when you complete the wizard. Your choice of layout is optional and you may rearrange the layout after you place the items on the canvas.

Step 5 In the Properties sheet area, select the properties that you want to bind to the widget. Hold down the Ctrl key to select more than one property, as shown in Figure 6-88.
Step 6  Click the **OK** button to complete the wizard. The Make Widget wizard disappears and the new property widgets appear on the Px Editor canvas as shown in Figure 6-89.

**Figure 6-88  Editing Make Widget properties**

![Figure 6-88](image1.png)

Step 7  Toggle the view using the View/Edit Mode toolbar icon to display the widgets in the Px Viewer, as shown in Figure 6-90.

**Figure 6-89  Completed bound label and field editor widgets on Px Editor canvas**

![Figure 6-89](image2.png)

**Create an action widget**

To add an action widget to a Px File using the Make Widget wizard, do the following:

Step 1  Open the nav side bar and expand the tree to locate the component that you want to add to the Px Editor canvas.

Step 2  Drag and drop the desired component onto the canvas, as shown in Figure 6-91.
The Make Widget wizard displays, as shown in Figure 6-92.

**Note:** The ORD for the selected component displays in the ORD area. Double click the ORD to browse for a different slot in the component (for example: “out” or “value”) or to bind to a different component, if desired.

Step 3 Select the **Action** option in the **Source** options list as shown in Figure 6-92.

The **Properties** view area displays actions that are available for creating the new widget.

Step 4 In the **Secondary view** area, select one or more actions from the list, as shown in Figure 6-93.

Step 5 Click the **OK** button to complete the wizard. The Make Widget wizard disappears and the new property widgets appear on the Px Editor canvas as shown in Figure 6-89.
Step 6  
Toggle the view using the View/Edit Mode toolbar icon to display the widgets in the Px Viewer, as shown in Figure 6-90.

**Figure 6-95**  
Using completed action widgets in Px Viewer

Create a Time Plot widget

To add a time plot widget to a Px File using the Make Widget wizard, do the following:

Step 1  
Open the nav side bar and expand the tree to locate the component that you want to add to the Px Editor canvas.

Step 2  
Drag and drop the desired component onto the canvas, as shown in Figure 6-96.

**Figure 6-96**  
Dropping a component on the Px Editor canvas

The Make Widget wizard displays, as shown in Figure 6-97.

**Note:**  
The ORD for the selected component displays in the ORD area. Double click the ORD to browse for a different slot in the component (for example: "out" or "value") or to bind to a different component, if desired.

Step 3  
Select the **Time Plot** option in the **Source** options list as shown in Figure 6-97.

**Figure 6-97**  
Selecting Make Widget wizard Time Plot option

The **Secondary view** area displays Minimum Value and Maximum Value fields.

Step 4  
In the **Secondary view** area enter the desired minimum and maximum values that you want to display in the Time Plot widget, as shown in Figure 6-98.
Figure 6-98  Entering Minimum and Maximum Time Plot Values

Step 5  Click the OK button to complete the wizard. The Make Widget wizard disappears and the new Time Plot widget appears on the Px Editor canvas as shown in Figure 6-99.

Figure 6-99  Completed Time Plot widget on Px Editor canvas

Step 6  Edit the widget, if desired, by doing one or both of the following:
- Resize the widget, as desired to allow the plot to display completely.
- Edit the Time Plot widget properties (header, lines, fonts, and so on) using the Widget Tree and Properties palettes, as shown in Figure 6-100.

Figure 6-100  Editing Time Plot widget properties in the Px Editor

Step 7  Toggle the view using the View/Edit Mode toolbar icon to display the widgets in the Px Viewer, as shown in Figure 6-101.
Create a Chart widget

Step 1  Open the nav side bar and expand the tree to locate the component that you want to add to the Px Editor canvas.

Step 2  Drag and drop the desired component onto the canvas, as shown in Figure 6-102.

The Make Widget wizard displays, as shown in Figure 6-103.

Note:  The ORD for the selected component displays in the ORD area. Double click the ORD to browse for a different slot in the component (for example: "out" or "value") or to bind to a different component, if desired.

Step 3  Select the Chart option in the Source options list as shown in Figure 6-103.

The Secondary view area displays fields that allow you to choose the data for the x and y axes of the chart and the Time Range.

Step 4  In the Secondary view area enter the value source for column 0 and for column 1. Also, choose the desired range from the time range option list, as shown in Figure 6-104.
Step 5  Click the **OK** button to complete the wizard. The Make Widget wizard disappears and the new Chart widget appears on the Px Editor canvas as shown in Figure 6-105.

**Figure 6-105**  Completed Chart widget on Px Editor canvas

Step 6  Edit the widget, if desired, by doing one or both of the following:

- Resize the widget, as desired to allow the plot to display completely.
- Edit the Chart widget properties (header, lines, fonts, and so on) using the Widget Tree and Properties palettes, as shown in Figure 6-106.
About the Nav file

The Nav file is a special xml file that resides on the file system—not in the station database. You can create as many Nav files as you want, however, a client may display only one Nav file at any time. This means that any time you are viewing a station you can only see one nav file in the nav tree (or locator bar) but since a station may be serving many clients, each client may be using different nav files concurrently—based on their nav file assignment. The Nav file is user-specific, so when a user logs into a station, the Nav file for that user is displayed in the nav tree or locator bar.

You can match a Nav file to a user by using the Workbench User Manager view. Refer to “UserService” on page 7-14 for details about the User Manager.

You can create new nav files using the right-click menu, as shown in Figure 6-108. Refer to “Creating a new Nav file” on page 10-25 for details about creating a new nav file.

Add details to your nav file and customize the hierarchy of your nav tree using the Nav File Editor, as described in “About the Nav File Editor” on page 6-54.
**Figure 6-108** Creating a new Nav file

Figure 6-109 shows three Nav files in the nav folder. Notice that the Nav side bar displays a tree hierarchy of links directly under the station node. Each node of the tree has a context-appropriate icon to help the user recognize the target link of each node in the tree. You can specify icons for the tree nodes, as described in “About the Nav File Editor” on page 6-54.

**Figure 6-109** Creating a new Nav file

**Nav file elements**

When you create a new nav file, in addition to the xml declaration, the file includes two default elements, as listed below and illustrated in Figure 6-110:

- **<nav> element**
  a single opening and closing set of <nav> elements hold all the nodes in the tree

- **<node> element**
  the default <node> element includes an ORD path that points to the station root directory:
  ord='station:|slot:/'

You can edit these nodes directly in the Text Editor or you can use the tools provided in the Nav File Editor (refer to “Nav File Editor” on page 6-54).

**Figure 6-110** Default nav file with home node only

```xml
<xml version='1.0' encoding='UTF-8'>

<navigation>
  <node name='Home' ord='station:|slot:/'>
    <icon>modules/icons/x16/home.png</icon>
  </node>
</navigation>
```

Figure 6-111 shows what the elements in your nav file look like (when viewed in a text editor) once you add a few nodes to your tree.
Figure 6-111  Simple nav file with home node only

```xml
<xml version="1.0" encoding="UTF-8">
  <nav xmlns="http://www.w3.org/1999/xhtml">
    <node name="Home" ord="10">
      <node name="Logic" ord="20">
        <node name="PertCausal" ord="10">
          <node name="NewZoneA" ord="10">
            <node name="NewZoneB" ord="10"/>
            <node name="NewZoneC" ord="10"/>
            <node name="NewZoneD" ord="10"/>
          </node>
          <node name="NewStation" ord="10"/>
        </node>
        <node name="NewFloor" ord="10"/>
      </node>
    </node>
  </nav>
</xml>
```

Figure 6-112 shows what the elements in a nav file look like in the nav tree and in the Nav File Editor once you add a few nodes to your tree.

Figure 6-112  Nav file viewed in nav tree and in Nav File Editor (Result Tree)

About the Nav File Editor

The Nav File Editor view provides a simple way for you to view and edit Nav files. When you select the Nav File Editor view of a file, the Nav File Editor displays in the Workbench view pane.

The default view of the Nav File Editor comprises three main areas, as shown in Figure 6-113, and described below:

Figure 6-113  Nav File Editor

- **Source objects pane**
  
  This resizable pane displays in the top half of the Nav File Editor when you toggle **ON** the **Show Components** button or the **Show Files** button on the control pane. The pane disappears when you toggle the buttons **OFF**. Refer to “Nav File Editor source objects” on page 6-55 for details about source objects.

- **Result tree pane**
  
  This pane displays whenever the Nav File Editor is open. The pane appears in the bottom half of the Nav File Editor when you toggle **ON** the **Show Components** button or the **Show Files** button on the control pane and fills the view (above the control buttons) when the **Show Components** button or the **Show Files** are toggled **OFF**. Refer to “Nav File Editor result tree” on page 6-55 for details about the result tree.
Controls
These buttons are always displayed horizontally across the bottom of the Nav File Editor. Refer to “Nav File Editor buttons” on page 6-55 for more information about the functions of each Nav File Editor control button.

Nav File Editor source objects
Nav File source objects are those objects that may be used for creating your nav file. In order to appear in the source object pane, the “source object” must be a Px file or a component with a Px view assigned to it. The source objects populate the pane view based on the position of the Show Components and Show Files buttons, as described in “Nav File Editor buttons” on page 6-55.

Figure 6-114  Source objects available in the source pane

To use the source objects pane for creating the nav file structure, you drag components or files from the source objects pane down to desired tree location in the result tree pane. Refer to “Nav File Editor result tree” on page 6-55 for details about the result tree pane.

Nav File Editor result tree
The result tree pane is where you build the nav file structure. You can drag and drop components and files from the source objects pane to create new nodes in your tree. You can also create nodes directly, using the New button or by using the popup menu directly in the result tree pane. Refer to “Editing a Nav file in the Nav File Editor” on page 10-26 for procedures about editing nav files.

Figure 6-115  Result tree pane

Figure 6-116 shows an example of a source object being dragged to a specific location in the nav tree. The result tree shows the exact hierarchy of your nav tree and allows you to set the indent levels by where you drop the component.

Figure 6-116  Dragging a source object to the result tree pane

Nav File Editor buttons
The Nav File Editor buttons are aligned horizontally across the bottom of the Nav File Editor. They include controls that you use to create, edit, delete, and rearrange nodes in the nav file. The following list describes each of the of the Nav File editor buttons.

• New
This button displays the New Node dialog box that allows you to create a new node in the nav file tree by specifying a name, target ORD and icon for the node. The new node is created as a child node to the active point in the tree (the one you have selected).
About the reporting process

The process of creating and sending a report can be performed in a variety ways. The following points are provided as an example to help illustrate the major parts of the reporting process.

Setup the reporting service
Add the ReportService and child components (ExportSource and EmailRecipient) from the Reporting palette into your station Services folder.

Layout report data in a ComponentGrid.
Add a ComponentGrid component (from the Reporting palette) onto the desired location in your nav tree. Using the Grid Editor view, drag and drop points from the nav tree or use the popup menu or main menu icons to add rows and columns to the ComponentGrid.

Create a Px page display of the report
Using the Px editor, add the ComponentGrid to a ReportPxFile page and design the report layout using ReportWidgets available from the Report palette.

Configure ExportSource component
In the ExportSource property sheet, identify the report Px file and schedule the report delivery.

About Reporting

The Reporting function in NiagaraAX helps you design, display, and deliver data to online views and to printed pages. Table layout features and report widgets are used in designing the reports. The report service and the report export feature allow you to schedule and distribute reports by email at any time. NiagaraAX Workbench views and services help you create and route reports. Figure 6-117 shows the primary views that facilitate the reporting process.

Figure 6-117 Primary views used in creating and routing reports

The following topics describe the major concepts and views associated with reporting.

• "About the reporting process"
  This section describes the major points in the reporting process.

• "Types of report components"
  This section describes components that are located in the Reports module and available in the Reports palette.

• "About the Grid Table view"
  This section provides a description of the Grid Table view of the ComponentGrid.

• "About the Grid Label Pane view"
  This section provides a description of the Grid Label Pane view of the ComponentGrid.

• "About the Grid Editor view"
  This section provides a description of the Grid Editor view of the ComponentGrid.

About the reporting process

The process of creating and sending a report can be performed in a variety ways. The following points are provided as an example to help illustrate the major parts of the reporting process.

Setup the reporting service
Add the ReportService and child components (ExportSource and EmailRecipient) from the Reporting palette into your station Services folder.

Layout report data in a ComponentGrid.
Add a ComponentGrid component (from the Reporting palette) onto the desired location in your nav tree. Using the Grid Editor view, drag and drop points from the nav tree or use the popup menu or main menu icons to add rows and columns to the ComponentGrid.

Create a Px page display of the report
Using the Px editor, add the ComponentGrid to a ReportPxFile page and design the report layout using ReportWidgets available from the Report palette.

Configure ExportSource component
In the ExportSource property sheet, identify the report Px file and schedule the report delivery.

About Reporting

The Reporting function in NiagaraAX helps you design, display, and deliver data to online views and to printed pages. Table layout features and report widgets are used in designing the reports. The report service and the report export feature allow you to schedule and distribute reports by email at any time. NiagaraAX Workbench views and services help you create and route reports. Figure 6-117 shows the primary views that facilitate the reporting process.

Figure 6-117 Primary views used in creating and routing reports

The following topics describe the major concepts and views associated with reporting.

• "About the reporting process"
  This section describes the major points in the reporting process.

• "Types of report components"
  This section describes components that are located in the Reports module and available in the Reports palette.

• "About the Grid Table view"
  This section provides a description of the Grid Table view of the ComponentGrid.

• "About the Grid Label Pane view"
  This section provides a description of the Grid Label Pane view of the ComponentGrid.

• "About the Grid Editor view"
  This section provides a description of the Grid Editor view of the ComponentGrid.
Types of report components

Report components are found in the Report palette, shown in Figure 6-118.

Figure 6-118  Report palette

Types of report components include the following:

- **ReportService**
  Refer to “About the ReportService component” on page 6-57 for details.

- **ExportSource**
  Refer to “About the ExportSource component” on page 6-58 for details.

- **EmailRecipient**
  Refer to “About the EmailRecipient” on page 6-58 for details.

- **FileRecipient**
  Refer to “About the FileRecipient component” on page 6-59 for details.

- **BqlGrid**
  Refer to “About the BqlGrid component” on page 6-59 for details.

- **ComponentGrid**
  Refer to “About the ComponentGrid component” on page 6-60 for details.

- **ReportPane**
  Refer to “About the ReportPane component” on page 6-61 for details.

- **SectionHeader**
  Refer to “About the SectionHeader component” on page 6-61 for details.

**Note:** For more information about using BFormat scripting, refer to the Engineering Note document, BFormat (Baja Format) Property Usage.

About the ReportService component

ReportService is the parent, or container, for the ExportSource, EmailRecipient, and ComponentGrid, and FileRecipient components. In order to use the report service, copy the ReportService component from the Report module to the Services folder in the Workbench nav tree, as shown in Figure 6-119.
Figure 6-119 Copy the report service to the services directory and add report components

You can use the ReportService wire sheet view to link generated reports to the desired recipients, as shown in Figure 6-120.

Figure 6-120 ReportService component Wire Sheet view

About the ExportSource component

The Export Source component should be located in the ReportService container. It allows you to define a report display source (typically a Px file) for exporting and it allows you to schedule a time that you want to export it. The property sheet view, shown in Figure 6-121, contains the properties that you configure for these functions.

Figure 6-121 Export Source component property sheet view

• Schedule
  This property contains standard scheduling options that allow you to choose different options for timing the delivery of your report. It also displays a “Last Trigger” and “Next Scheduled Trigger” field.

• Source
  This property specifies the report display that you want to email. An arrow button located at the right end of the property display opens the Export Source Wizard dialog box. This dialog box provides two steps that assist you in assigning source location and selecting a PDF export or an oBix driver export for your report.

About the EmailRecipient

The report-EmailRecipient component is found in the Report palette (do not confuse this component with the email-EmailRecipient found in the Email palette) and contains properties that allow you to specify where the report is to be emailed. The property sheet view, shown in Figure 6-122, displays the properties that you configure for this function.
EmailRecipient component properties include the following:

- **To**
  This is the email address of the email recipient (person who is to receive the emailed report).
- **Cc**
  This is the email address of anyone that is to receive a copy of the email (and attached report).
- **Bcc**
  This is the email address of anyone that should receive a copy of the email (and attached report) but whose name you do not want to display in the delivered email.
- **Language**
  This is the ISO 639 language code as two lower-case letters. For a list of codes, see the following: http://www.loc.gov/standards/iso639-2/langcodes.html
- **Email Account**
  This is an option list that allows you to choose the email account that you want to use for sending the report email.

About the FileRecipient component

The file recipient component allows you to save a report to a location under a station file system. This component contains a single property that allows you to specify a location (file directory) for saving the report. The property sheet view, shown in Figure 6-123, displays the property that you configure for this function.

Caution

Saving excessively to a flash drive can reduce drive life prematurely. Do not "overschedule" report saves to a flash drive. Saving to a hard drive does not have such limitations.

FileRecipient component properties include the following:

- **Ord**
  This property provides a text field that allows you to specify the directory for saving the generated report file.

About the BqlGrid component

Starting in NiagaraAX-3.4, the BqlGrid component provides a means for using a Bql Query and the BFormat syntax to define a dynamic table layout. Use the BqlGrid component to specify an OrdTarget and columns of values to build a dynamic Grid Table or Grid Label Pane view. The BqlGrid component subscribes to the specified values for dynamic updating.

Note: This does not work with histories.
In addition to the standard wire sheet, category sheet, slot sheet, and property sheet views, the BqlGrid-Component property includes a Grid Table and Grid Label Pane view, as shown in Figure 6-124.

**Figure 6-124**  BqlGrid Label Pane view

The BqlGrid component property sheet view is shown in Figure 6-125 and described below.

**Figure 6-125**  BqlGrid property sheet view

- **Query**
  This single property is used to define a TargetOrd using a Bql query. Every column in the resultant row points to the same Ord. A value for each desired column in the row is provided by using BFormat syntax to point to the corresponding column from the Bql query. This is different from the ComponentGrid component (see “About the ComponentGrid component” on page 6-60) where each table cell is its own OrdTarget.

  **Note:**  For more information about using BFormat scripting, refer to the Engineering Note document, BFormat (Baja Format) Property Usage.

**About the ComponentGrid component**

The component grid allows you to define and design your report content (typically in the Grid Editor view). Use the component grid to link and layout the data that you want to put into your report.

**Figure 6-126**  ComponentGrid property sheet view

The component grid has most of the standard Workbench views, such as Property Sheet view (shown in Figure 6-126), wire sheet, category sheet, slot sheet, and link sheet. Unique ComponentGrid views include the following:

- **Grid Table**
  This view displays your linked data in a typical Workbench table format. Refer to “About the Grid Table view” on page 6-61 for details.

- **Grid Label pane**
  This view displays your linked data in a tabular view that uses the GridLabelPane widget for displaying the report data. Refer to “About the Grid Label Pane view” on page 6-62 for details.
• **Grid Editor**
  This is the view that you use to specify row and column data for your report. Refer to "About the Grid Editor view" on page 6-63 for details.

**About the ReportPane component**

The ReportPane widget, shown in Figure 6-127, is located in the ReportWidgets folder and provides a container for layout of Px page report views. The ReportPane has the standard Visible, Enabled, and Layout properties, but also has the following unique properties:

![Figure 6-127 ReportPane property sheet view](image)

- **Logo**
  This property supports the linking of a graphic to the ReportPane component. When displayed in a Px page, or a Report, the graphic originates at the top left corner of the page. Type or browse to the desired graphic to set the file path in the property field. If no logo is used, the default value of “null” should be set in the property field.

- **Page#**
  When this property value is set to True, page numbering displays on each Report page.

- **Timestamp**
  When this property value is set to True, a timestamp is displayed in the bottom right corner of the report pages.

**About the SectionHeader component**

The SectionHeader component is used to put a title or heading at the top of a report.

![Figure 6-128 Section header property sheet](image)

**About the Grid Table view**

The Grid Table view is a view of the ComponentGrid component. This view provides a tabular display of all the points that are assigned to the ComponentGrid. In the Grid Table view, you can write to points (issue commands) using the popup menu, if you have write permissions. Points in the table also display color-coded status, as shown in Figure 6-129.
About the Grid Label Pane view

The Grid Label Pane view is a view of the ComponentGrid component. This view provides a tabular display of all the points that are assigned to the ComponentGrid. In the Grid Table Pane view, you can write to points (issue commands) using the popup menu, if you have write permissions. Points in the table also display color-coded status, as shown in Figure 6-131.

Figure 6-131  Grid table view of the GridComponent

In the Px Editor view, you can use the GridLabelPane widget to layout the table on a Px page and edit the properties of the display properties, as shown in Figure 6-132. These properties allow you to change the font-type and color, as well as set the text alignment of the table cells, table heading, and first column properties.

Figure 6-129  Grid Table view

The table controls and options are similar those that are used in most Workbench table controls (see “Table controls and options” on page 2-18.

When you use a GridTable view in a Px page, the editable table properties are accessed in the Properties dialog box, as shown in Figure 6-130 and listed below:

Figure 6-130  Grid Table properties in Px Editor

- **Enabled**
  When set to `true`, the table in the Px page interface is commandable using the popup menu. When this property is set to `false`, the display is still visible but not commandable.

- **Visible**
  When set to `true`, the table in the Px page interface is visible. When this property is set to `false`, the display is not visible.

- **Ord**
  This Ord is the link binding the display to the GridComponent that defines the table.

- **Degrade Behavior**
  These options specify how the table behaves when the binding communications are not available.

### About the Grid Label Pane view

The Grid Label Pane view is a view of the ComponentGrid component. This view provides a tabular display of all the points that are assigned to the ComponentGrid. In the Grid Table Pane view, you can write to points (issue commands) using the popup menu, if you have write permissions. Points in the table also display color-coded status, as shown in Figure 6-131.

**Figure 6-131 Grid table view of the GridComponent**

In the Px Editor view, you can use the GridLabelPane widget to layout the table on a Px page and edit the properties of the display properties, as shown in Figure 6-132. These properties allow you to change the font-type and color, as well as set the text alignment of the table cells, table heading, and first column properties.
GridLabelPane properties include the following:

- **Cell Align**
  This property provides options for setting the alignment of cell content (left, right, center, fill).

- **Cell Brush**
  This property specifies the color of the content (for example, font color) within the table cells.

- **Enabled**
  When set to `true`, the table in the Px page interface is commandable using the popup menu. When this property is set to `false`, the display is still visible but not commandable.

- **First Column Align**
  This property provides options for setting the alignment of cell content (left, right, center, fill) for the first column in the table.

- **First Column Brush**
  This property specifies the color of the content within the first column table cells.

- **Header Align**
  This property provides options for setting the alignment of cell content (left, right, center, fill) for the top row of the table (the table “heading”).

- **Header Brush**
  This property specifies the color of the content within the table heading cells.

- **Header Font**
  This property allows you to set the font-type and font properties for the table heading.

- **Layout**
  This property allows you to specify the size and location of the table in relation to its parent (X, Y, coordinates, height and width). Alternatively, you can select a “fill” option to have the table expand to the limits of its parent container.

- **Visible**
  When set to `true`, the table in the Px page interface is visible. When this property is set to `false`, the display is not visible.

### About the Grid Editor view

The Grid Editor view is a view of the ComponentGrid component. This view provides a layout display that you use to assign points that you are going to use in a report. Figure 6-133 shows the Grid Editor view with and without points assigned.
In the Grid Editor view, you can assign components to areas using the **Add Column** and **Add Row** commands from the popup menu or from the Workbench main menu. You can edit existing rows or columns by double-clicking on them to display the **Edit Row** or **Edit Column** dialog box, as shown in Figure 6-134.

- **Columns area**
  This area extends across the top of the Grid Editor view. Columns specify the slot path that identifies the point data that goes in the table cell. Add columns *after* you have defined a template row in the template area.

- **Template area**
  This area is just below the column area and displays as yellow, with a caution message when it is empty. The template row is used as a reference for picking columns, and therefore, there must be a template row defined before you can add and save a column in the Grid Editor view. Double-click on the template area to add a row using the **Edit Template** dialog box. If you add a row without first adding a Template Row, then the first row you add becomes the Template Row by default and automatically populates the template area.

- **Row area**
  The row area extends across the lower part of the Grid Editor view. Add rows to define any point data that goes in the table row. Rows work in conjunction with the columns to present data in a table format.

About the Report **Edit Row and Edit Column** dialog boxes

The **Edit Row** or **Edit Column** dialog boxes, shown in Figure 6-134, display when you add a new row or column—or when you choose to edit an existing row or column in the Grid Editor view.

The following fields are associated with these edit dialog boxes:
• **Name**  
  This field is associated with the *Edit Column* dialog box. Type in a literal name to assign a display name or title to the column.

• **Format**  
  This field is associated with the *Edit Column* dialog box. You can use literal text and BFormat scripting to assign a value to the column.

• **Ord**  
  This field displays in both the *Edit Column* dialog box and the *Edit Row*. Designate a point by browsing to or typing the Ord of the component that holds the value that you want to display.  
  *Note:* For assigning rows, you can drag and drop a point onto the Grid Editor view and the Ord automatically appears in the Ord field.

### About ReportPxFile

ReportPx files are available from the *New* menu item on a popup menu when you right-click on an appropriate container for a Px file. The ReportPxFile is a regular Px file that has been "pre-loaded" with a ReportPane widget, as shown in Figure 6-135.

*Figure 6-135 Creating a new ReportPxFile*
About Security

This section explains security for any NiagaraAX station. Station security means access by a person using either Workbench or a web browser, or station access by another station. Security determines if a station connection is allowed, what can be accessed, and what operations can be performed. In the case of individual users, it also typically determines navigation options and overall appearance.

A station’s security is based upon users and object categories, with each user’s permissions within any category defined with specific permission levels. All configuration is stored in the station database, using services, components, and component views.

Note: Niagara platform security is a different topic altogether. For more details, see the sections “About a platform connection” and “Update Authentication” in the Platform Guide.

The following main sections provide more station security details:

- Security model overview
- UserService
- CategoryService

Security model overview

A station’s security is determined by the combination of categories, users, and permissions, as shown in Figure 7-1.

Note: In general, you create needed categories first, then assign objects to them. Then create users, to which you assign permissions. However, you can engineer security in any order you want.

Figure 7-1  Station security includes categories, users, permissions

The following sections explain the various aspects of station security:

- Categories and security
- Users and security
- About User prototypes
- Permissions and security
- About permission levels
- UserService security notes
- About user audits
- Multi-station security notes
- Alarm ack permission notes
Categories and security

Categories are integral to station security. A station’s CategoryService (under Services container) provides a CategoryManager view for you to add, delete, and edit categories, as shown in Figure 7-2.

Figure 7-2  CategoryService and CategoryManager view

Each Category is really just an index (Category 1, Category 2, and so on), however, you typically name them to reflect some logical grouping. For example, you could have “Lighting” and “Floor 3” categories, and assign some objects to both, and others to just one category (or neither of these).

Note: By default, a new station (created using the New Station wizard) has no existing categories. However, category slots (Category 1—8) exist, with all objects defaulting to slot 1.

As shown in Figure 7-3, you typically use the CategoryBrowser (default view of the CategoryService) to assign objects in the station to different categories. Every object must be assigned to at least one category.

Figure 7-3  CategoryBrowser (CategoryService default view)

In the CategoryBrowser, you use an expandable tree to navigate to objects of interest, and click in table cells to add or remove category assignments. As an alternative to explicitly assigning one or more categories to an object, you can have it “inherit” the assigned categories of its parent. This affects appearance in the CategoryBrowser, where:

- Yellow rows are objects explicitly assigned into one or more categories.
- Dimmed rows represent objects inheriting their parent’s category or categories.

Note: You can also review and assign components to categories individually at the component level, using any component’s CategorySheet view. Included is a convenience link back to the CategoryBrowser (CategoryService). See “CategorySheet” on page 7-26.

By themselves, categories have little security meaning. Only when you set a user’s permissions do you reference categories. For more details on categories, see “CategoryService” on page 7-23 and “Category caveats” on page 7-24.

Users and security

Note: This section describes Users under the baja UserService, the standard service container for station users. By default, the UserService is included in the Services container of any new station created using the New Station tool in Workbench. Note that some installations may use RSA SecurID security or LDAP or Active Directory integration, where another user service (RsaUserService or LdapUserService or ActiveDirectoryUserService) is required to replace the standard UserService.

For details on RSA integration, see the NiagaraAX RSA SecurID Authentication Guide. For the other user services, refer to the LDAP User Service Guide.
Users define possible connections to the station. Under the station’s Service container, a UserService provides a default User Manager view (Figure 7-4) for you to add, delete, and edit users.

**Figure 7-4 UserService and default UserManager view**

![UserService and default UserManager view](image)

Typically, each user represents a specific person who uses Workbench or a web browser (or both) to connect to the station. Properties for any user include various settings, including several affecting mostly browser access, including Facets, Nav File, and Web Profile, as shown in Figure 7-5.

However, a user can be for one or more remote NiagaraAX stations to use (for client connection), in order to share data and import/export histories and schedules. If a “station-type” user, in any remote NiagaraAX station, you reference this user when adding that NiagaraStation device (under its Fox Client Connection properties).

**Figure 7-5  User properties**

![User properties](image)

Two important security aspects are “built-in users,” and the authentication method used by a station.

- **About built-in users**
- **About authentication**

For further details on the UserService, including descriptions of service properties and views, as well as properties of child (User) components, see “UserService” on page 7-14.

**Note:** Since AX-3.3, the concept of “network users” is also important for any multi-station job. For an overview, see “Network users” on page 7-4.


**About built-in users**

Any station has two built-in users that you can neither delete nor rename: **admin** and **guest**.

**User admin** User "admin" is unique from all other users in that you cannot disable it, set it to expire, or assign permissions (it is always super user, meaning all permissions). This ensures every station always has at least one super user.

When using the New Station Wizard tool to create a station, the wizard prompts for the password for the admin user. In a typical “sandbox” environment, you could simply leave the password fields blank (no password). However, **never** deploy any real station this way—that station would be vulnerable to anyone with only a passing knowledge of NiagaraAX.

In general, it may be best to guard the password for the admin user from almost everyone, as well as use it infrequently. If desired, you can duplicate the admin user, then rename, assign password, reassign permissions, and so forth. If each person has their own (unique) user account, this also makes audit information more valuable. See “About user audits” on page 7-9 for more details.

**User guest** User "guest," if enabled, provides station access from a browser with no login required (no authentication). Initially, any browser pointed to the host sees “home” in the Nav file assigned to guest. The browser operator can then navigate in the normal fashion, providing that guest has read permissions for objects. Access of an object lacking guest permissions produces the login prompt, whereby the operator must login (as a non-guest user) to proceed.

*Note:* Password assigned to guest (if any) is ignored when accessing the station via a browser. However, if opening the station in Workbench as user guest, password for guest is checked.

By default, the guest user is **disabled**. Whenever guest is disabled, all station access requires **authentication**, meaning a browser user is always prompted for user name and password. In this case, station login as "guest" is not available (using either browser or Workbench).

**About authentication**

For a station connection attempt, the user’s login credentials (user name, password) are checked against those users under the station’s UserService. This process is called **authentication**. The actual process (and authentication **mechanism** used) can differ, where the three authentication points are:

- **Workbench-to-station (FoxService)**  
  Typically, the Workbench user is prompted for user name and password, such as whenever opening a station from the File menu in Workbench. Fox authentication is used, which is configurable via the FoxService (under the NiagaraNetwork) as either basic or digest. Digest (the default) is the preferred mechanism, since the password is never passed in clear text. However, if using LDAP, then basic authentication must be configured.

  It is also possible for a Workbench user to open one station from another station without being re-prompted for credentials. Such stations must be configured to use the same “realm,” and the user must also exist (with the identical credentials) in each station. See “Workbench single sign-on (SSO) realm” on page 7-13 for further details.

- **HTTP browser-to-station (WebService)**  
  Again, the user is prompted for user name and password. The authentication mechanism used is specified under the station’s WebService, as either cookie (the default), basic, or as Cookie Digest (available in NiagaraAX-3.5 and later). Cookie is required if you have users configured for browser-based Workbench (e.g., Basic Wb Web Profile), and/or are using the Domain-wide cookies authentication feature.

  *Note:* If the guest user is enabled, browser access can occur without login (authentication).

- **Station-to-station (FoxService)**  
  A preconfigured user name and password is used (stored under NiagaraStation.clientConnection), which must correspond to an existing user—typically, with super user permissions. Again, Fox authentication is used, the same as with a Workbench to station connection.

  In general, it is recommended you leave authentication mechanisms (FoxService and WebService) at default settings, unless the station is configured for LDAP (LdapUserService).

**Network users**

Starting in AX-3.3, additions were made in the UserService (baja module) and NiagaraNetwork (niagaraDriver module) that permit “centralized management” of users in a multi-station system. This section provides an overview, summarizing the Challenge, User Service changes, and NiagaraNetwork changes.
Challenge

In any NiagaraAX station database, station users are represented as individual User components, located under the station’s UserService. Typically, you use the User Manager view of this service to add, modify, and delete users. Historically you have always been able to manually copy user components from one station to other stations. However, this “user copy” method does not provide change coordination. If an edit is needed for such a user (say, for that user’s password), the same change has to be made to that user in each (separate) station. This has proven to be an inefficient process.

Solution: Stations are configurable to allow users to be added or modified (or deleted) in one station, and then have that user change automatically replicated (or “synchronized”) in other stations. The term “network user” applies to these users. Related are configurable user “prototypes.” When adding users, prototypes can be used in network user “strategies” between station. Note that while all these station user changes are standard, they are also optional—accomplished with additional slots on existing components. Default property values provide the same functionality as existed prior to AX-3.3.

To provide this functionality, there are two main areas of change in anAX-3.3 and later station:

- User Service changes
- NiagaraNetwork changes

User Service changes

Since AX-3.3, every User component (user) in the station has 2 additional configuration properties: Network User (boolean) and Prototype Name (string). Currently, prototype name matters only if the user is network user, as this can be used in a “sync strategy” for distributing changes to network users.

Related to this, the UserService has a frozen child container slot User Prototypes, with a frozen child “Default Prototype” user component. If establishing network users, you can duplicate and edit additional user prototypes. User prototypes currently have the same properties as users, and are seen in the Nav tree and in the property sheet of the UserService—but are not listed in the User Manager view. Instead, when you add a User, the new property “Prototype Name” provides a selection list of available prototypes.

Note: In the User Manager view of any station, whenever you manually add a New user, property values in the Default Prototype are always used as defaults, regardless of whatever Prototype Name you may select in the Add dialog.

For more details on User Service changes, see:

- “Network user related properties” on page 7-20
- “About User prototypes” on page 7-22

NiagaraNetwork changes

Since AX-3.3, each NiagaraStation under the station’s NiagaraNetwork has a Users device extension (in addition to other standard device extensions like Points, Histories, Schedules, and Alarms). The Users extension contains properties that enable/configure network user synchronization “in” and “out” of this station, in relation to the station with its NiagaraNetwork. There is no special view (apart from property sheet) on this Users device extension, nor is it a container for other components.

Associated with this change is a new view on the parent NiagaraNetwork: the User Sync Manager. This tabular view provides an aggregate look at all Users device extensions (one for each NiagaraStation). Each row represents a station, and columns lets you see every station’s Users properties for sync configuration, sync status, sync “strategy,” and so on. You can select any or all rows for an edit dialog to make configuration changes, or issue manual sync commands.

For more details on Niagara Network changes, see the following sections in the Drivers Guide:

- “About the Users extension”
- “About the User Sync Manager”

Permissions and security

Permissions define what rights a user has within each of the categories in the station. There are two Niagara permission levels: operator and admin. Within both levels, separate options exist for read access, write access, and invoke (action) access. See “About permission levels” on page 7-6.

When you add a user, a Permissions field is available for you to set that user’s permissions, using a Permissions popup dialog (permissions map), as shown in Figure 7-6.
The built-in admin account has all possible rights for every category (super user). When logged in as the admin user or another “super user” (or any user with admin-Write permissions on the UserService), you can assign super user rights to any available user, via the Super User checkbox. Or, you can use the Permissions dialog to assign specific rights to select categories for that user, such as shown in Figure 7-6.

To review and compare permissions among all users, the UserService provides a PermissionsBrowser view, as shown in Figure 7-7. Typically, you use this view to adjust permissions for any user.

In the PermissionsBrowser, columns represent individual users defined in the station. An expandable tree lets you navigate to objects of interest to review current permissions, shown in table cells using abbreviations (for read, write, and invoke). Operator level is small case; admin level is UPPER case.

Row coloring in the PermissionsBrowser provides the same data as in the CategoryBrowser, where:

- Yellow rows are objects explicitly assigned into one or more categories.
- Dimmed rows represent objects inheriting their parent’s category or categories.

You can double-click in any column to access that user’s permissions map. See “PermissionsBrowser” on page 7-20 for more details.

About permission levels

Once a user has been authenticated (see “About authentication” on page 7-4), that user is granted or denied permissions for each protected object in the system using the user’s “permissions map” (a category-based matrix, for an example see Figure 7-25 on page 21).

Depending on object type, permission meanings vary as follows:

- Component permission levels
- File permissions
- History permissions

Component permission levels

Note: By design, the UserService component enjoys a special permission scheme. See "UserService security notes" on page 7-8 for details.

Each slot in any component is assigned to one of two permission levels, called operator and admin. This level is determined by whether the “Operator” config flag is set for that slot.
• If set (checked), the slot can be accessed by a user with a minimum of operator-read permissions.
• If cleared (unchecked), a user requires at least admin-Read permissions to access the slot.

With admin-Write permissions, you can see and change slot flags from the slot sheet of any component, as shown in Figure 7-8. By default, most slots are admin level (“out” is typically operator level).

Figure 7-8  Slot is admin level unless Operator flag is set

Permissions To control user access from a permission level, six permissions are derived, as follows:

• Operator-read — Allows the user to view operator-level information.
• Operator-write — Allows the user to modify operator-level information (if not read-only).
• Operator-invoke — Allows the user to view and invoke operator-level operations (actions).
• Admin-Read — Allows the user to view admin-level information.
• Admin-Write — Allows the user to modify admin-level information (if not read-only).
• Admin-Invoke — Allows the user to view and invoke admin-level operations (actions).

When you assign a user’s permissions, higher-level permissions automatically “include” lower-level ones. For example, as shown in Figure 7-9 if you enable admin-level write (W), admin-level read (R) is automatically enabled, as well as operator-level read and write (r and w).

Figure 7-9  Lower-level permissions include automatically

Ancestor permissions Often, you may wish to grant a user permissions to components using categories not included in their parent components, such that permissions to a component’s “ancestor tree” are not explicitly granted. In this case, the system automatically grants “Operator-read” access to all “ancestor” components in the component tree. Otherwise, a user would be unable to navigate to target components in the Nav tree.

This “automatic ancestor permission” assignment is done by the station periodically, but you can force it at any time with a right-click “Update” action on the CategoryService.

File permissions Largely, permissions given to categories used by files and folders are “operator-keyed,” as follows:

• Files
  Files require operator-read access to view, and operator-write permissions for editing (if applicable).
  For instance, a user with operator-write permissions to an .html file can modify it using the Text File Editor in Workbench.

• Folders
  Folders (directories) require operator-read access to list and to copy child files, and operator-write access to create new (or delete existing) child files.

A few views for files require admin-write permissions to access, such as the Nav File Editor for a “nav file.” There are also other special case file permissions.

Special case file permissions These additional rules apply to file system access from station access:
• Files in any NiagaraAX module are automatically granted operator-read.
• If a user is not a “super user,” all access outside of the station’s home directory is denied.

History permissions
Currently, histories require only operator-read permission to access all available views (e.g. History Chart, Collection Table, History Table). In addition, the ability to rename a history is included.

UserService security notes
In order to facilitate user management, a special permissions scheme applies to the UserService (only), where permissions are inherited by child users (unless a user is assigned to a different category) as follows:

• A user with only operator-read permissions (r) has read-only access to operator-level properties of their own user account (all other users are hidden).
• A user with operator-write permissions (rw) has read/write access to operator-level properties of their own user account (all other users are hidden).
• A user with admin-Read (rR) permissions has read-only access to all properties of all available users.
• A user with admin-Write permissions (rwRW) has read/write access to all properties of all available users. Moreover, they have access to the UserManager, so can add new users (including “super users”) and also delete users. In addition, the PermissionsBrowser view of the UserService is available.

Note: Consider assigning the UserService to a single reserved category (possibly named “UserService”), and limiting permissions for any “non super user” to not include admin-Write permissions. Otherwise, a user with these permissions can easily re-assign any available user any permissions, add new users (including super users), and delete users as well.

By default, operator properties of User are Password and Facets (time format and unit conversion). If needed, from the slot sheet of User(s) you can edit config flags to change which slots are operator versus admin. For example, you might change the email slot to operator.

This simplified scheme is useful when you want to let each user reassign their own password, but not have access to other users. In this case, assign the UserService to a category where all “non-super” users are given operator-write (rw) permissions only. Remember, any user granted super user permissions has all access to all objects. And as mentioned in the Note above, any user with admin-Write permissions on the UserService can promote any available user to be a super user, add and delete users, and so on.

Notes on user permissions and category assignments
In the simplified model previously described, all users under the UserService simply inherit the same category assigned to the UserService. If you assign all users only operator-write permissions (rw) to that category, this may be a workable solution—providing that users do not need to view or modify their own admin-level properties, such as “Full Name”, “Email”, or possibly others.

However, it may be needed to provide one or more users “admin-level” property access to their own account, without revealing details on all other user accounts, or to the few “admin-level” properties of the UserService (“lock out” related properties, or “require strong passwords”). Or, to provide this ability without access to the UserService’s admin-level views (UserManager, PermissionsBrowser). In this case, consider assigning users to a separate category from the one recommended to be assigned only to the UserService.

For example, if you have a separate category (possibly named “Managers”) and assign a User admin-Write permissions to it, that user will then be able to access and modify all properties of their own user account (as well as any other users assigned to that category)—regardless if they have permissions to the parent UserService. Note this includes access to their “Permissions” map, including the “Super User” checkbox.

In summary:
• Permissions to the UserService are not required for a user to be able to view/edit their own account information. They simply need sufficient permissions to the category to which their user account is assigned.
• A user requires admin-Write (rwRW) access to the UserService in order to access the UserManager and PermissionsBrowser. In the UserManager, not all users may be available to them—for example, there may be users assigned to one or more categories for which they have no permissions. Note this means it is possible for a user to be assigned to a category for which they have no permissions themselves, yet still be assigned admin-Write permissions on the UserService (have UserManager access). However, there is nothing to prevent them from creating a new user with full (super user) permissions and then logging in with that user account to modify their other primary account.
About user audits

An important aspect of station security is an audit trail to record user activity. Any NiagaraAX station can be configured for user audits through use of the AuditHistoryService. While enabled, this service creates a history of user-initiated changes to components in the station.

**Note:** If this service is not already in your station’s Services container, open the history palette and drag or copy the AuditHistoryService into your station’s Services folder.

The following sections provide more details:

- AuditHistoryService configuration
- AuditHistory content
- AuditHistory station login activities

AuditHistoryService configuration

AuditHistoryService configuration is simplified by having only the following writable properties:

- **Enabled**
  Either true (default) or false (disabled). Typically, you always leave this enabled.

- **History Config**
  Contains some read-only status properties and a few writable properties, including the following:
  - **Capacity**
    Either: Record Count **nnn** records (default is 500) or Unlimited. Typically, unlimited is recommended for Supervisor stations, while JACE stations are set to some finite count. If a JACE station, the resulting AuditHistory is typically exported to a Supervisor station for archives.
  - **Full Policy**
    Either Roll (default) or Stop. In almost all cases, you leave full policy at roll to ensure latest user actions are recorded.
  - **System Tags**
    (Use optional). Allows using the System Tag feature for importing or exporting Niagara histories. For more details, see "About System Tags" on page 4-29.

AuditHistory content

The AuditHistory records user-initiated changes to property values, invoked actions, as well as any slots that are added, deleted, reordered, and renamed. Each record appears as a row that includes the timestamp of the change and the operation, plus other details including the responsible station user.

Using standard history views, you can review and resort data columns in the AuditHistory as needed to analyze user activity. Figure 7-10 shows an AuditHistory displayed in the HistoryTable view. In this view (as shown), you can double-click any row for a popup dialog displaying record details.

**Figure 7-10  AuditHistory in station Histories**

Standard fields in an AuditHistory record include the following:

- **Timestamp**
  Timestamp of when the operation on the slot became effective.
• **Operation**
  Type of user operation, which may include one of the following:
  - Added — Added a slot (typically a point or extension)
  - Changed — Changed a property (slot) value
  - Invoked — Issued a command to an action slot
  - Removed — Removed a slot (typically a point or extension)
  - Reordered — Reordered one or more slots

• **Target**
  Path to the container of affected slot, relative to the station root.

• **Slot Name**
  Name of the affected slot.

• **Old Value**
  Value of slot before a change.

• **Value**
  Value of slot after the change.

• **User Name**
  User name that initiated the operation.

**AuditHistory station login activities**

Station login activities are included in a station’s AuditHistory. The following login-related events by either a Workbench (fox) user or a browser user appear in the station’s AuditHistory as records, as one of the following operations:

• **Login** — valid user name and password supplied
• **Logout** — close connection if Workbench, or explicit “/logout” submission if browser
  **Note:** If a browser user simply closes the browser window, a logout audit record is not collected. Thus, a corresponding logout may not appear for every browser login, unless an explicit “/logout” is always forced.
• **Login Failure** — valid user name, but invalid password supplied

In any case, audit records are not produced for any disabled users (including users that are “locked out”) and for any unknown users.

Figure 7-11 shows various login-related records in an AuditHistory displayed in the HistoryTable view. As shown, you can double-click any row for a popup dialog displaying record details.

Specific to a security (station login-related) event, fields in a record are used as follows:

• **Timestamp**
  Timestamp of when the login/logout action occurred.

• **Operation**
  The security action that occurred, as either “Login”, “Logout”, or “Login Failure”.

![Figure 7-11 Login related records in station's AuditHistory](image-url)
• **Target**
  Depending on if a Workbench (fox) or browser (WebService) user connection, the path as either:
  - Workbench - Path to fox session, usually as /Drives/NiagaraNetwork/FoxService/etc.
  - Browser - Path to the web service were validated, typically as /Services/WebService

• **Slot Name**
  The remote host that attempted login/logout, typically by IP address.

• **Old Value**
  Not used.

• **Value**
  Not used unless the Operation is “Login Failure”, in which case the value indicates the number of
  consecutive failed login attempts (1—5). After 5 consecutive failed login attempts, if lockout is
  enabled, the user is locked out for some period of time. Subsequent login attempts during that period
  are not audited. Also see “Lockout notes” on page 7-16.

• **User Name**
  User name supplied during the attempted login/logout.

### Multi-station security notes

Some installations have multiple stations. Typically, this means a Supervisor station plus one or more
JACE stations. In this scenario, often the same user(s) need to access different stations. In addition, you
typically create a special "station-to-station user" in each station for use in the NiagaraNetwork. Please
note the following:

• By convention, a station-to-station user can be named something memorable (perhaps "m2m"), but
  you should carefully guard its password—as you typically assign it "super user" permissions. When
  adding this User, properties that apply to browser access are inconsequential, for example, Facets,
  Nav File, and Web Profile. You reference this user in another station, when adding a NiagaraStation
  device under a NiagaraNetwork. Refer to the “Station Add notes” section in the Drivers Guide
  for related details.

• If an AX-3.3 or later job, you can use the “network user” feature to automatically replicate users
  among stations, and keep them centrally managed. Configuration involves two different areas of sta-
  tions: UserService and NiagaraNetwork. For an overview, see “Network users” on page 7-4.

• If a pre-AX-3.3 job, you can copy users under the UserService in one station into the UserService of
  another station. Note that the permission map for each user is included—typically, this is ok if you
  created the same categories (by index number) in each station, and are using the same basic security
  scheme.

• If you copy categories from station to station, the index property in each copied category is reset to
  0, and the category has a disabled status (until you reassign the index).

• Often, a user that has already logged into a station is re-challenged for login (authentication) again.
  This can happen when navigating from one station to another station. Depending on whether a
  browser user or a (full) Workbench user, it may be possible to configure stations such that a user
  needs to be authenticated only once (upon initial station connection).
  - If a browser user (Web Workbench or Hx access), and Niagara hosts are installed on a DNS do-
    main, you can configure stations such that browser users are authenticated only once. See Do-
    main-wide cookies authentication.
  - If a Workbench user, and the Niagara hosts are running AX-3.3 or later, you can configure sta-
    tions such that the user is authenticated only once. See Workbench single sign-on (SSO) realm.

#### Domain-wide cookies authentication

This feature is available for multi-station jobs where all Niagara hosts are installed on the same DNS
domain. It allows for stations that have the same user accounts (matching user credentials) to be accessed
by any such user using a “domain-specified” browser connection and a single, initial, login.

### To configure domain-wide cookies authentication

Perform the following in any station that may provide the initial browser connection.

To configure domain-wide cookies authentication, do the following:

**Step 1**
Open the slot sheet of the **WebService** component (in the station’s Services container).

**Step 2**
Add a new slot, naming it "cookieDomain", leaving other fields at defaults (type baja:String).

See “Using the slot sheet” on page 10-18 for details on adding a slot.

**Step 3**
Go to the property sheet of the WebService.

In the new cookieDomain property, enter your DNS domain name (see Figure 7-12 for example).
Step 4 Verify that the WebService’s property Authentication Scheme is set to Cookie.
Step 5 Save this configuration of the WebService.

Figure 7-12  Example configured WebService

Now, if a user points his or her browser to this Niagara host using the full DNS name (for example: supervisor.metropolis.net), after station login, they can navigate using links to other stations without need for login. The credentials used in the initial login are used in other station connections.

Note: To support the domain-wide cookies authentication feature in browsers, hyperlinks to views in other stations must reference “hostname.domain” in either an “ip ord” format or “full url” format. Using a numerical IP address instead of “hostname.domain” in hyperlinks results in a login rechallenge.

Examples using “hostname.domain” (jace1.metropolis.net):
- ip ord
  ip:jace1.metropolis.net|fox:|station:|slot:/PxHome
- full url
  http://jace1.metropolis.net/ord?station:|slot:/PxHome

Providing that the WebService in the target station is using the standard HTTP port (port 80), using the “ip ord” format in hyperlinks may be best, as it works in both Workbench and web browsers. Whereas, the “full url” format works in web browsers, but produces a “Cannot display page” exception in Workbench. However, the “full url” format is required if the target station is running a non-standard HTTP port. For example, if the target station is using an httpPort of 8080, an example hyperlink would look like:
- full url (specifying port)

Notes on using Hosts files for domain-wide cookies authentication A private network of JACEs and/or Supervisor may be installed on a LAN without a domain controller or local DNS server. In this case, when configuring the WebService in stations, you can specify a “virtual” (fictional) domain name. Then, in order to provide domain-wide cookies authentication, you must manually edit the “hosts” file on each LAN-connected PC at the job that needs browser access to the Niagara system. In each PC’s hosts file, you associate the same virtual domain name with the actual IP address for each Niagara host.

Note: On most Windows PCs, the hosts file (no file extension) resides under the subdirectory "$SYSTEMROOT\SYSTEM32\DRIVERS\ETC", eg. C:\WINDOWS\system32\drivers\etc.

The hosts file is a simple text file you can edit and save with Notepad or similar editor.

For example, in the WebService of your Supervisor station you added the cookieDomain slot, and entered a virtual domain of golly.net. You also did the same thing in the station running on each of three JACEs. The static IP addresses for these four Niagara hosts are:
- Supervisor 192.168.1.99
- JACE A 192.168.1.85, JACE B 192.168.1.86, JACE C 192.168.1.87

So the contents of the hosts file on each PC (that needs browser access to the system) should include entries like:

```
127.0.0.1 localhost
192.168.1.99 supervisor.golly.net
192.168.1.85 jace1.golly.net
192.168.1.86 jace2.golly.net
192.168.1.87 jace3.golly.net
```

Once the hosts file is edited on a PC, you should be able to start a browser session with the URL pointed to a Niagara host by its domain name (for example: supervisor.golly.net). After initial user login, “hostname.domain” links to views in other stations should occur without being rechallenged for login again, providing of course that the same user and password exists in the target station.
Note: It is not necessary to edit the hosts file on any Niagara platform, unless it is a PC that is also used for browser access of stations.

**Workbench single sign-on (SSO) realm**

Starting in AX-3.3, a multi-station “realms” feature was added. This allows a Workbench user to open one station (fox), then have Workbench access to other stations, without re-prompting for credentials. For example, a Px view in a station may contain widgets with hyperlinks to views in other stations.

This feature requires that the user has an account (with same credentials) on each station in the realm. Otherwise, the user will still be prompted to login. Therefore, this feature works well with the new “network user” feature, also starting in AX-3.3 (see “Network users” on page 7-4 for details).

Note: The “SSO realm” feature works only for a “full Workbench” (Fox) connection to a station. It does not apply to “Web Workbench” connections, that is browser access to a station via the WebService and wbapplet.

**To configure station’s realms for Workbench single sign-on**

In a multi-station job, perform the following in each AX-3.3 and later station, where each station must have the same “realm” name.

To configure a station’s realm, do the following:

**Step 1** Open the property sheet of the root-level Config component in the station.

**Step 2** In the “Sys Info” property, click the Facets control (>>) for the Config Facets editor.

The Config Facets editor appears.

**Step 3** Add a key named “realms” of type String, with the string value (whatever desired) for the realm name.

To do this in the Config Facets dialog:

1. Click the Add control.
2. In the row for the added facet, double-click the word key and type (replace) as realms.
3. In that same facet row, ensure that “Type” is String, and click in the “Value” field and type the name of the realm. Note this realm value has no literal meaning, but must be the same for all stations.
4. Click OK to add the facet.

See Figure 7-13 for an example of the realm “shazam” being added.

**Step 4** Repeat this procedure for every station in the job.

**Figure 7-13** Add key named “realms” in Facets for “Sys Info” property of the root-level Config component

Now, if a user opens a station in Workbench (enters their credentials), they can navigate using links to other stations in this realm without need for login. The same credentials used in the initial login are used in other Workbench station connections.
Alarm ack permission notes

When assigning permissions to station users, keep in mind that all alarm ack (acknowledgement) rights in NiagaraAX are determined only by a user’s permissions on AlarmClass components (and not on the points with alarm extensions, which “generate” alarms). Alarm classes are under a station’s AlarmService. As needed, you link alarm classes to alarm consoles, to define alarm routing in the station.

Specifically, a user requires “admin write” permissions on any alarm class in order to acknowledge alarms or events routed by it. This is mentioned because this is a different alarm ack scheme than was used in the older Niagara (r2) systems. Note that in a scenario where many “user-divided” ack rights are needed, you may need to create additional alarm class objects, assigning them to different security categories.

For more details about alarming in general, and also AlarmClass components in particular, see “About alarms” on page 5-1, and “About alarm class” on page 5-32.

UserService

**Note:** The UserService is included in the Services container of any new station created using the New Station tool in Workbench. Note that some installations may use RSA SecurID security or LDAP or Active Directory integration, where another user service (RsaUserService or LdapUserService or ActiveDirectoryUserService) is required to replace the standard UserService. However, the basic operation of Users and security remains the same in these cases.

For details on RSA integration, see the NiagaraAX RSA SecurID Authentication Guide. For the other user services, refer to the LDAP User Service Guide.

The UserService is found under a station’s Services container. You use a station’s UserService to add, edit, and delete users. If you have already configured categories in the station, you can use it to assign users permissions as well.

**Note:** For an overview of station security and users, see “Security model overview” on page 7-1 and “Users and security” on page 7-2.

Before working with users, you should review the UserService properties. After setting properties as needed in the service, the following UserService views are your primary access to users:

- **UserManager** to add Users
- **PermissionsBrowser**

Also see “UserService security notes” on page 7-8.

**UserService properties**

Right-click the UserService and choose Views > Property Sheet, as shown in Figure 7-14.

Figure 7-14 UserService property sheet access

UserService configuration properties are described as follows:

- **Require Strong Passwords**
  Either false (default) or true. If enabled (true), any future user additions (or edits of a user’s password) will require entry of a “strong password,” otherwise an “error” popup dialog results.
  A strong password must meet these requirements:
  - Minimum of 8 characters
  - At least 1 character is a numeral (0—9) or special, such as “!”,”@”, “#”, “$”, or “%”.

- **Lock Out Enabled**
  Either false (default). If enabled (true), then a number of consecutive authentication failures will temporarily “lock out” login access to that user account, for the duration of the lock out period (next property). Using lock out makes it difficult to automate guessing of passwords.
  **Note:** Each user also has a “Clear Lock Out” action. See “Lockout notes” on page 7-16.
- **Lock Out Period**
  Default is 10 seconds, adjustable to any duration in hours, minutes, seconds. If lock out is enabled, then this is the period of time a user account is locked out before being reset. While locked out, any login attempt (even a valid one) will be unsuccessful.

- **Max Bad Logins Before Lock Out**
  Default is 5, adjustable from 1 to 10. If lock out is enabled, in conjunction with the "Lock Out Window", this specifies the number of consecutive failed login attempts that trigger a lock out for a user.

- **Lock Out Window**
  If lock out is enabled, and the number of "Max Bad Logins Before Lock Out" occurs within this window of time, the user is locked out for the "Lock Out Period" duration. The lock out window default is 30 seconds, and is adjustable to any duration up to 1 day.

  **Note:** Changes to lock out properties are enforced on the next login attempt for any user. For example, suppose "max bad logins" is set to 5, and user "SFree" has failed to log in 4 times within the lock out window. Suppose an admin-level user now changes "max bad logins" to 3. This does not lock out user "SFree"; user SFree still has one more chance to log in before getting locked out. If that login attempt fails, SFree will be locked out, since 5 failed attempts is greater than or equal to the max bad logins setting (3).

**UserManager**

Double-click the UserService for the UserManager (default view when you have admin-Write access), as shown in Figure 7-15.

**Figure 7-15  UserManager is table based view**

Rows in the UserManager table represent existing users, where you can edit by either double-clicking a single user, or clicking to select and then clicking the **Edit** button.

**Note:** As in other table-based manager views, you can select multiple rows (users) for edit. This can be useful for a mass change to a property like Facets or Web Profile. However, be careful when doing multiple user edits of things like Permissions and Passwords.

See subsections “Lockout notes” on page 7-16 and “Network user notes” on page 7-16 for additional information about working in a station’s User Manager.

To add a new user, click the **New** button. This produces the New User dialog, as shown in Figure 7-16.

**Figure 7-16  New (user) dialog**

You can create multiple users by typing in a number in “Number to Add.” When you click **OK**, the Add dialog includes that number of user rows in the top table (Figure 7-17).
As needed, click to highlight a single user row before entering unique user properties such as User Name, Full Name, Permissions, and so on. For properties you wish to enter identically for all users (for example, Facets), hold down Shift and click to select all user rows, then enter property value.

**Note:** For a listing of all the User properties, see “User” on page 7-17.

When you click OK, the user(s) are added with the property values you entered. Users appear as rows in the User Manager, and as child components under the UserService container.

**Lockout notes**

If you have lockout enabled in the UserService, a user will be locked out after several unsuccessful attempts to login (login using their user name, but with incorrect password). A locked-out user is indicated with a red row in the User Manager, as shown in Figure 7-18.

**Figure 7-18** Locked out user is indicated by red

The User component that represents each user has a boolean “Lock Out” slot that provides read-only status of whether that user account is currently locked out (true) or not (false). If needed, you can link it to other logic in the station.

If locked out, a user will be unable to login into the station until the lockout period expires, as specified in the UserService. Also during a lockout, any attempted login activity for that user will not appear in the station's AuditHistory (see “AuditHistory station login activities” on page 7-10). After the lockout period expires, the user displays in the User Manager as normal.

As administrator, be aware that each user has an action “Clear Lock Out,” that you can invoke to clear any lockout in progress. Access this command with a right-click on a user, either selected in the Nav tree or in the User Manager, as shown in Figure 7-19.

**Figure 7-19** Clear lockout action for any user

**Network user notes**

When a network user is replicated (sync'd) to a “user receiving” station, it is accessible in that station’s User Manager just like any local “non network” user. This may be confusing if attempting an edit of that user from the User Manager, as currently the Edit dialog accepts property changes. That is, property fields appear writable (as in user’s Edit dialog on the source station, for example Figure 7-5 on page 3).
However, note that any changes made to such a proxied network user (received from another station) will be overwritten upon the next user synchronization from the source station. This applies to both the source-user derived properties (most properties) as well as the "local override" properties from the (local) User Prototypes. As a workaround, note that property sheets for "proxied network users" do show properties as read-only, as shown in Figure 7-20.

**Figure 7-20  Property sheet for proxied network user**

In addition, note that the property sheet for a proxied user includes additional properties (near the bottom) useful in determining the original source of the user. See Figure 7-21.

**Figure 7-21  Special status properties in property sheet for proxied network user**

- **Version** -- Source station name: (last sync timestamp in milliseconds). This information is used in the synchronization process.
- **syncExt (containing Source Station)** -- Shows the ord to the NiagaraStation that proxies the station with the source User.

**User**

All available user properties, as seen in the New or Edit user dialog (Figure 7-5 on page 3), are described as follows:

- **Name**
  Unique name of the user, as known to the station. Used in login credentials (along with Password), also appears in audits of changes made by the user (see "About user audits" on page 7-9).
- **Full Name**
  Full formal name of the user, or any descriptive name needed.
- **Enabled**
  Either true (default) or false. Determines if the user account is operational. If disabled (false), login attempts are blocked. By default, user guest is disabled.
- **Expiration**
  Either "Never Expires" (default) or "Expires on <date>". After the expiration date, login attempts are blocked.
• **Permissions**
  Either “Super User” (all permissions) or a specific permissions map (click “>>” control). Permissions are category-based. For an overview, see “Permissions and security” on page 7-5 and also “About permission levels” on page 7-6.

• **Network User**
  See the next section “Network user related properties”.

• **Prototype Name**
  See the next section “Network user related properties”.

• **Language**
  To specify a lexicon (typically two character language code, such as “fr” or “de”), as needed for language support or other customizing.

• **Password**
  Password entered by user in login credentials (along with user Name). Two entry fields are provided, both entries must match. Can be any combination of alphanumeric characters. **Note:** If the UserService is configured for strong passwords (property Require Strong Passwords), the password must be a minimum of 8 characters, with at least one character being a numeral (0—9) or any other special character, such as “!”, “@”, “#”, “$”, or “%”.

• **Email**
  User’s email address. Informational, and also used in EmailService (and/or OnCallService) handling of incoming alarm acknowledgments via the “EmailAlarmAcknowledge” component, to verify the user. For related details, see “About the Email Alarm Acknowledger” on page 5-15.

• **Cell Phone Number**
  User’s cell phone number. Informational, and also used in SMS (Short Message Service) handling of incoming alarm acknowledgments via the “SmsAlarmAcknowledger” component, to verify the user. For related details, see “About the Sms Alarm Acknowledger” on page 5-22.

• **Facets**
  Includes two separate settings, as follows:
  • **Time Format**
    How timestamps are formatted in property sheets, and so on. The default time format is sourced from Baja lexicon.
  • **Unit Conversion**
    Selectable as either None (default), Metric, or English. Primarily affects value display of “out” slots on control points.

• **Nav File**
  To specify a Nav file that provides custom navigation for the user, defining locator bar content and home page. Click the folder control for a File Chooser dialog to navigate to the location of the station’s .nav files (by convention, a “Nav” folder under the station directory). For more details, see “About the Nav file” on page 6-52. **Note:** If guest is enabled, all browser connections to the host start using this Nav file.

  Nav File also includes two settings for station “auto logoff,” as follows:
  • **Auto Logoff Enabled**
    Either true (default) or false. If true, a browser-connected user will be automatically disconnected from the station after the “auto logoff period” expires, providing that no user activity was detected during that time (changing views, expanding/contracting containers, and so on). If disabled (false), this browser-connected user is never automatically disconnected.
  • **Auto Logoff Period**
    Any number of hours, minutes, seconds needed (default is 15 minutes). Specifies the time period used by the auto logoff routine (“inactive user time”), if auto logoff is enabled for the user.

• **Web Profile**
  Specifies the user’s expected type and level of HTTP browser access, by “Type”. Also, starting in later builds of AX-3.5, providing that Type is any of the Web Workbench (Wb Web) selections, two additional properties are available. These may be useful in the handling of the Web Workbench applet (WbApplet) in a browser’s Java plugin. These properties include:
  • **Type**
    Specifies the user’s expected type and level of HTTP browser access. For more details on profile types, see “About Web Profiles” on page 6-30. A few of the available types include the following:
    – **Basic Hx Profile**
      Lowest level and simplest browser requirements (browser with Java plug-in not required). Provides locator bar, ability to access properties and graphics (Px views).
- Default Hx Profile
  Provides more navigation controls with simple browser requirements (browser with Java plug-in not required). Provides locator bar, access to property sheets and graphics (Px views), plus a view selector. Access to slot sheets is included, as well as PDF creation from property sheets or graphics.

- Basic Wb Web Profile
  Requires browser to have Java plug-in. Provides Workbench station access within a browser (Firefox connection), but without top menu bar or ability for side bars. View access is limited to property sheets and Px views.

- Default Wb Web Profile
  Requires browser to have Java plug-in. Allows nearly full Workbench station access within a browser (Firefox connection), including top menu bar and side bars (palettes and Nav tree). View access includes property sheets, wire sheets, category sheets, slot sheets, link sheets and Px views.

Note: If the same user might need to access the station differently, that is from a simple browser as well as from Workbench or a browser with Java plug-in support, you should create two user accounts for that person, each with a different Web Profile. For example, create a user with “Default Wb Web Profile” and another user with “Default Hx Profile.”

The simplest way to do this is to duplicate that user, then change the Web Profile type. That person will need to login differently (unique user name) according to their access method.

- Applet Reload On Hyperlink
  Available only if Type is one of the Workbench (“Wb Web”) selections, where the default value is true. The WbApplet reloads on a hyperlink—meaning when you change the current Workbench view. This is the historic behavior; however, it has resulted in issues in the “next generation” of Java plugins, where errors or memory leak issues could result.
  If set to false, the WbApplet is not reloaded upon a hyperlink to a new Workbench view. Note the following additional hyperlink behaviors if this property is set to false:
  - Just the current Workbench view changes.
  - The browser URL remains the same, meaning it does not change.
  - Refresh of the browser takes the user back to their original home page.
  - The Back and Forward buttons in the browser no longer function (as the URL remains the same when hyperlinking to a new Workbench view).
  - Changing Workbench views is much quicker!
  - Memory leaks, thought to originate with bugs in the Java plugin, should not occur—as the WbApplet is not reloading.
  - Tunneling is the exception where the WbApplet still reloads.

To summarize, there are both positives and negatives regarding this option. To help with one of the less intuitive behaviors, another property (below) can be set from defaults.

- Show Back And Forward Buttons
  Available only if Type is one of the Workbench (“Wb Web”) selections, where the default value is false. If set to true, and the user Type is either “Basic Wb Web Profile” or “Default Wb Web Profile”, this shows some extra “browser like” Back and Forwards buttons.
  - If “Applet Reload On Hyperlink” is true, the extra back and forward buttons call the browser’s back and forward commands. Note that these buttons are never disabled, as the browser’s history is unknown to the WbApplet.
  - If “Applet Reload On Hyperlink” is false, the extra back and forward buttons call the Workbench history back and forward commands.

As a consequence, this also fixes the kitPx backwards and forwards buttons so each works in a browser (following the above behavior).

Note that for handheld Workbench profiles, the station designer needs to supply their own form of navigation, which could include the backwards and forwards buttons.
Network user related properties
Starting in AX-3.3, among User component properties are two that apply to the “network users” function.

Figure 7-22  User properties related to network user

These properties are described as follows:

- **Network User**
  A boolean that specifies whether this user can be made available in other stations. When using the UserManager to add new users, this defaults to “false”. Leave or set to false whenever you wish this user to be local to this particular station only. For an overview of this feature, see “Network users” on page 7-4.

- **Prototype Name**
  Pick from a selection list showing available local User Prototypes. Blank or no selection is effectively the same as the frozen Default Prototype. Currently, this property setting matters only if the Network User property is “true”. See “About User prototypes” on page 7-22 for related information.

PermissionsBrowser
From the UserManager, use the view selector to select the PermissionsBrowser, as shown in Figure 7-7 on page 6. By default, the PermissionsBrowser shows the three object types collapsed into just three rows in the tree: station (components), file, and history.

As needed, expand and contract the object tree to find objects that have been explicitly assigned into one or more categories, and scroll across to see each user’s permissions for those objects.

Again, displayed row color provides the same data as in the CategoryBrowser, where:

- Yellow rows are objects explicitly assigned into one or more categories.
- Dimmed rows represent objects inheriting their parent’s category or categories.

You can also use Show Configured to automatically fully expand the tree.

Show Configured
Select Category Browser > Show Configured from the menu, or click the icon, as shown in Figure 7-23. The PermissionsBrowser tree expands to show all explicitly assigned objects.
In each cell intersecting a user (column) and object (row), that user’s permissions are shown with abbreviations—see Permissions abbreviations. For any user, you can access permissions.

Permissions abbreviations
Permissions for each object are shown in each of the user columns using abbreviations (Figure 7-23).

Full permissions are "rwiRWI", where the capital RWI is for admin-level read, write, invoke. It is possible for a user to have no permissions for some objects (blank cell), if those objects are assigned to a category the user does not even have operator read “r” permissions for. See “About permission levels” on page 7-6 for more details.

Access permissions
Double-click anywhere in a column to access a user’s permissions. This produces the same Permissions dialog as from the user’s properties, only user name shows in the window title bar (Figure 7-25).

Note: If you double-click on any user with “super user” rights, a popup warning reminds you that you cannot modify permissions, as shown in Figure 7-26.
If you could see the permission map for any super user, it would simply be all possible permissions checked for all possible categories (rows).

As shown in Figure 7-27, remember to Save after making any user permissions changes.

See the following about User Prototypes in a station’s UserService.

- **Properties of User Prototypes**
- **Naming User Prototypes**

### Properties of User Prototypes

User prototypes under a station’s UserService have the same properties as User components (see the section “User” on page 7-17 for User property descriptions). The importance of user prototypes can be divided between the frozen “Default Prototype”, and any Additional (non-default) User Prototypes you add, for example by duplicating and renaming. Currently, non-default user prototypes are only used when synchronizing network users between different stations. In this case, (identically-named) prototypes in both the source station and receiving station can be used in a “sync strategy” of “Prototype Required.”

**Default Prototype** Among User Prototypes, the “Default Prototype” is important in any station, as it is always the default source of User property values whenever you use the User Manager view of a station’s UserService to add a New user to the station. In this regard, all of its properties can be considered important—with one exception: “Prototype Name.” This property applies only when adding a User (not a user prototype), and may be hidden in user prototypes in some future build.

Additionally, in a multi-station job where you are using a user “sync strategy” of “Use Default Prototype,” the default prototype (in each station receiving network users) specifies the “local properties” that override the received properties of any network user. Note that only 3 properties are “local override” types: Permissions, Nav File, and Web Profile. See the next section for more details.

**Additional (non-default) User Prototypes** The importance of properties in an additional (non-default) User Prototypes vary among stations that are either sending or receiving network users:
• In a user-sending station (e.g. Supervisor) non-default user prototypes are important only in “name”, where you can simply duplicate the “Default Prototype” and rename each duplicate uniquely. Property values in these replicated prototypes are not used in any users—whether a user is local only to the Supervisor, or specified as a network user with this “Prototype Name.”
• In a user-receiving station (e.g. JACE) non-default user prototypes are important both in “name”, where matching prototype names in “user sending” stations provide sync strategy options, and also in three “local override” properties, described below.
  • Permissions - (either a permissions matrix of local categories and rights, or a “Super User”)
  • Nav File - (referencing a specific nav file under the local station's file structure)
  • Web Profile - (using the auto-logoff enable/period time and profile “type” local to the station)
When a network user is added or modified in a “user sending” station, the three properties above are used in the “user receiving” station, instead of those same properties in the source network user.

Naming User Prototypes
If creating additional User Prototypes (apart from the “Default Prototype”), it is recommended that you name them using descriptive text that can be logically associated with groups of station users, such as AdminHvac, GenOperations, LtgAndAlarms, and so on. You pick from these names when adding a new user and selecting a “Prototype Name.”
Keep in mind that in a multi-station job, if you choose a network “sync strategy” based upon the “Prototype Required” scheme, network users in the “user sending” station are replicated/sync’ed in the “user receiving” stations only if the UserService in each remote station has an identically named user prototype. Note there is also an alternative “Use Default Prototype” sync strategy you can use instead. For related details, refer to the “About Users sync strategy” section in the Drivers Guide.

CategoryService
The CategoryService is found under a station’s Services container. You use a station’s CategoryService to add categories and assign objects (components, files, and histories) to those categories.

Note: For an overview of station security including categories, see “Security model overview” on page 7-1, and “Categories and security” on page 7-2.

Apart from being the container for child categories, the CategoryService has only two slots:
• Update Time
  A property that sets the interval at which ancestor permissions are automatically assigned. Default value is one (1) minute. If assigned a zero value, this feature is disabled.
• Update
  An action to manually force ancestor permissions to be assigned to objects in the station.

Note: Typically, you leave the service's update time at default, and use the update action only if needed while testing (while actively assigning categories and/or changing permissions).
The two views of the CategoryService are:
  • CategoryManager
  • CategoryBrowser
The CategoryBrowser is the default view, and typically where you spend more time after initially creating categories.

Note: In the case of components, you can also make category assignments directly from any component’s CategorySheet view. See “CategorySheet” on page 7-26.

CategoryManager
You use the CategoryManager to add, edit, or delete categories. As shown in Figure 7-2 on page 2, you can access the CategoryManager using the view selector from any CategoryService view.
Rows in the CategoryManager table (Figure 7-29) represent existing categories, where you can edit by double-clicking one. Typically, you edit only the category name, to clarify some logical grouping. All categories must have both a unique name and index.

To add a new category, click the **New** button. This produces the New dialog, as shown in Figure 7-30.

![New (category) dialog](image)

You can create multiple categories by typing in a number in “Number to Add.” When you click **OK**, the Add dialog includes that number of category rows in the top table (Figure 7-31).

![Adding multiple categories](image)

As needed, click to highlight a single category row before entering a unique Name. For a listing of all the category properties, see “Category properties” on page 7-24.

When you click **OK**, the categories are added with the names you entered, and appear as rows in the CategoryManager and as child components under the CategoryService container.

**Note:** While in theory unlimited categories could be created, in general it is recommended to limit the number of categories to as few logical divisions as needed. Included are performance reasons, as well as other considerations. See “Category caveats” on page 7-24.

**Category properties**

As shown in the New or Edit dialog (Figure 7-31), there are only 2 properties for a category, as follows:

- **Index**
  Unique index number for the category, as it is known to the station.
- **Name**
  Any descriptive name needed, typically to reflect some logical grouping.

**Category caveats**

Please note the following about using categories:

- Performance-wise, too many categories can consume excess station memory, as each object must maintain a bitmap for category membership. With the default 8 categories, this is only 1 byte, but increments another byte for each additional 8 categories added (9—16, then 17—24, and so on). Therefore, you should limit categories to the fewest needed, and keep them indexed contiguously.
- If you delete a category (using the CategoryManager), you may notice it still appears listed in users’
permission maps, with default "Category n" name instead of its former user-assigned name. This underscores that categories are simply indices to the station. Each category Name is simply "metadata" (data about data).

Moreover, when you assign an component to one or more categories (e.g. using the CategoryBrowser), that component's category bitmap is updated—as part of its configuration. If you copy that component to another station or save it in a bog for reuse, please note that its category bitmap (to category indices) is included.

**CategoryBrowser**

The CategoryBrowser is the default view of the CategoryService. By default, this view shows the three object types **collapsed** into just three rows in the tree: station (components), file, and history. In this view, the columns represent **categories** in the station.

Again, displayed row color provides the same data as in the PermissionsBrowser, where:

- Yellow rows are objects explicitly assigned into one or more categories.
- Dimmed rows represent objects **inheriting** their parent’s category or categories.

To automatically fully expand the tree, use **Show Configured**.

**Show Configured**

Select **Category Browser > Show Configured** from the menu, or click the icon, as shown in **Figure 7-23**. The tree expands to show all objects explicitly assigned into one or more categories.

**Figure 7-32**  **Show Configured in CategoryBrowser**

Objects in dimmed rows have a check mark in the first column (Inherit), meaning that they **inherit** the category or categories of their parent container. As needed, in any object row, click either:

- In any category column to explicitly assign an object to a category, or again (toggle) to remove the object from that category.
- In the Inherit column to return category assignments to match the object’s parent.

**Note:** **With the exception of the three “root” objects (station, files, history), each object must either belong to at least one category or inherit its parent's category assignments. The three root objects cannot inherit—they must belong to one or more categories.**

As shown in **Figure 7-33**, remember to **Save** after making any needed category assignment changes.

**Figure 7-33**  **Save category assignment changes**
CategorySheet

Included for every component in the station database is a CategorySheet view, which you can access using the right-click View menu (Figure 7-34) or by using the view selector.

Figure 7-34  Accessing CategorySheet view

This view lists all categories in the station, and shows a check mark beside any that are assigned to this component.

In addition, the view’s right side offers various controls, as follows:

• **Inherit (checkbox)**
  Click to toggle. While checked, this component inherits category assignments from its parent component. While cleared, you can make explicit category assignments for this component.

• **Select All**
  Effective if Inherit is cleared. Click to assign component to all categories in the station.

• **Deselect All**
  Effective if Inherit is cleared. Click to remove all category assignments for this component.

  **Note:** Either click again to assign the component to at least one category, or else click Inherit. Otherwise, you receive an error when you try to Save (must be assigned to one category).

• **Category Service**
  Click to go to the CategoryBrowser view. See "CategoryBrowser" on page 7-25.

  **Note:** Remember to click **Save** after making any needed category assignment changes.
About Scheduling

Schedules in NiagaraAX are done using schedule components, as found in the schedule palette (Figure 8-1). You place these components in a station, configure, and link as needed to provide scheduling control of other components. Each schedule component has a "scheduler" view, which you use to define events.

Figure 8-1  schedule palette

The following main sections provide more details:

- About the scheduling model
- About weekly schedules
- About calendar schedules (holidays)
- About trigger schedules
- About ScheduleSelector components
- Using schedules (schedule-related tasks)

About the scheduling model

NiagaraAX scheduling is summarized in the following sections:

- Schedule component categories
- Schedule component views
- Schedule component links
- Schedule special events
- Schedule exports and imports (master/slave)

Schedule component categories

Schedule components may be categorized as follows:

- Weekly schedules
  These schedules define regular, repeating, events by "time-of-day" and "day-of-week." Also, any number of "special events" are configurable. Typically, these are the most used schedule components. Four different types vary by data category (Boolean, Numeric, Enum, and String). Each is identical except for input/output. For more details, see "About weekly schedules" on page 8-4.

- Calendar schedule
  A CalendarSchedule component is available to define specific days. Typically, you use them to define days with scheduling exceptions (e.g. holidays), and reference them in the "special events" setup of weekly schedules. For details, see "About calendar schedules (holidays)" on page 8-14.

- Trigger schedule
  ScheduleSelector components provide an easy way for users to select a schedule to use for controlling a particular component. As needed, you typically link its output to an action of a control point or extension. For more details, see "About trigger schedules" on page 8-19.
• **Schedule selectors**
  A TriggerSchedule component is used to schedule the firing of topics. With a set of pre-configured schedules and the ScheduleSelector component, you can simply choose from a list of valid schedules to setup or change the schedule of a device. For more details, see "About trigger schedules" on page 8-19.

**Schedule component views**
The default view for any schedule component is its "scheduler" view, where you define related days and events.

- The **Weekly Scheduler view** for any weekly schedule component provides four *tabs*, as follows:
  - Weekly Schedule — Specifies Sunday-through-Saturday (weekly) event times/values.
  - Special Events — All exceptions to the defined weekly schedule, as special events.
  - Properties — Important properties such as default output, schedule effective times, special event cleanup operation, and schedule facets.
  - Summary — For any selected day, provides summary of all schedule events, with source.
In addition, any weekly schedule component provides a “Current Day Summary” view, providing a simple *linear* 24-hour graph of schedule event times and values for the current day.
- The **Calendar Scheduler view** for a CalendarSchedule provides a “calendar” where you add, edit, or delete calendar days and establish relative priorities.
- The **Trigger Scheduler view** for a TriggerSchedule provides a two-part view combining a "day picker" and an event “time picker” for specifying when topics are fired on those days.

At the bottom of any scheduler view are buttons **Refresh** and **Save**, described as follows:

**Refresh**
The **Refresh** button is always available.
When you click Refresh, one of two things happens:
- If the Save button is not available (no unsaved changes), clicking it re-synchronizes the view with the component’s current configuration.
- If the Save button is available (unsaved changes), clicking it produces a dialog (Figure 8-2).

**Figure 8-2**  Refresh confirmation if unsaved changes

Your refresh confirmation dialog choices are as follows:

- **Yes**
  Save all changes made in the view since last save. Equivalent to clicking **Save**.
- **No**
  Clear all changes made in the view *since last save* (effective reset).
- **Cancel**
  Cancels refresh, all unsaved changes remain as unsaved.

**Save**
The **Save** button is available only if you have made unsaved changes in the component’s scheduler.
Clicking it downloads your changes to the schedule component’s configuration. Immediately following, the Save button is unavailable again.

**Note:**  For weekly schedules (tabbed Weekly Scheduler view), you typically save while working in each tab, even though any save applies to changes made on all tabs.

**Schedule component links**
To use weekly schedules and the trigger schedule, you link the component’s “Out” slot (as source) to a slot on another component. The same schedule can be linked this way to *many* target components.

- **Weekly schedule links**
- **Trigger schedule links**

Typically, you *do not link* a CalendarSchedule. Instead, you *reference* one or more CalendarSchedules from a weekly schedule, in its “special events” setup. This allows global editing of day definitions.
Weekly schedule links

Typically, you link a weekly schedule to one or more “writable” control points. For some examples, you could link the Out slot of weekly schedule types as follows:

- BooleanSchedule to a BooleanWritable that is a proxy point for a Binary Output object in a BACnet device.
- NumericSchedule to a NumericWritable that is a proxy point for setpoint NVI in a LON device.

By convention, when linking to a target writable point (with 16-level priority array), you select “In16” among its different priority array inputs. However, you are free to select any available input level.

In a few cases, you may wish to “chain” weekly schedules from “Out” slot to “In” slot. This technique is typically useful only if one of the chained schedules is “effective” during any period in time. In this case, the Default Output value of all schedule components (except last in chain) must be null.

Trigger schedule links

Typically, you link a trigger schedule to an action of a control point or perhaps even more often, an action of a point extension. For example, you could link a TriggerSchedule to the “ResetElapsedActiveTime” action of a DiscreteTotalizerExt, a point extension for a BooleanPoint used to accumulate runtime. If the trigger schedule was configured to fire only on the first day of every month (at 12:00am) that extension could be used to hold the current month’s runtime.

Schedule special events

Special events apply to weekly schedules only, and are considered any exception to the (normal) weekly schedule. Special events can be “one-time” only event changes or recurring event changes, such as holidays. Configuration includes both day(s) of occurrence and related time-of-day events.

In the time-of-day event definitions of special events, you can have them “intermingle” with regular weekly events, or completely override the weekly schedule. In addition, you visually prioritize special events, via list order. This allows any overlapping special events to occur in an ordered fashion.

Each weekly schedule component has its own special events, configured on a Special Events tab in its scheduler view. Event times (and values) entered for any special event apply to that schedule only.

Note: If the special event is a “reference” type, days of its occurrence are specified in the CalendarSchedule component that is referenced. This allows you to globally change the days that special events occur in weekly schedules, by editing one or more referenced CalendarSchedules. For more details, see “Calendar-Schedule Usage” on page 8-14.

Special events permission change

Starting in AX-3.3, it became possible to provide different permissions for the special events of a weekly schedule (BooleanSchedule, NumericSchedule, etc.) than for the rest of the schedule’s configuration, using advanced techniques. Previously, operator Write access for the schedule was required to have write ability on any of the four tabs in its Weekly Scheduler view (including Special Events).

Note: Also, there is now automatic “read-only” access to all tabs of the Weekly Scheduler view for a user with only “operator Read” permissions on a schedule. Previously, such a user could only see the Summary tab.

To configure a schedule to allow special events access separately, you must “unhide” its Composite-Schedule slot (named Schedule) working from the schedule component’s slot sheet (Figure 8-3).
Now that the child CompositeSchedule is unhidden, you can expand it in the schedule's property sheet (Figure 8-4).

Figure 8-4  Expand unhidden CompositeSchedule on schedule's property sheet

As shown, this “Schedule” slot contains child slots, including a “specialEvents” schedule and a “week” schedule. Now, you can assign the child “specialEvents” CompositeSchedule to a different category that the top-level schedule (right-click the “specialEvents” slot, then choose Views > Category Sheet).

In this case, you would deselect the “Inherit” option and clear that category, assigning a different category—one that a user could have “operator Write” permissions on, versus only “operator Read” as on the parent schedule component. This would allow such a user to have read access to all the tabs on this schedule’s Weekly Scheduler view, but write access only for managing special events—and not the regular weekly schedule (or other properties).

For related details on security, including permissions and categories, see “About Security” on page 7-1.

**Schedule exports and imports (master/slave)**

Using the NiagaraAX driver architecture, you can create “master/slave” schedules in order to share schedule configuration between devices. This allows you to globally update the configuration of any slave schedule by simply making changes to its master schedule.

The typical application of this is in a multi-station Niagara network, where you:

- **Import** a schedule component from another station. Typically, you do this in a JACE station, importing a schedule component that resides in a Supervisor station. This creates a local copy that you can use and link into control logic, but cannot otherwise configure (change events, and so on). When you import a NiagaraAX schedule, a “schedule export descriptor” is automatically created on the sending (master) station, under the NiagaraStation component that represents the receiving side. This allows for “sending-side” management of configuration synchronization. For more details, refer to the section “Station Schedules import/export notes” in the Drivers Guide.

If using the Bacnet driver, the same basic architecture is available. You can import BACnet Schedule and Calendar objects from a BACnet device, and model them as NiagaraAX schedule components.

For more details, see the following topics in the Drivers Guide:

- “About the Schedules extension”
- “About Schedules extension views”

**Note:** The Bacnet driver lets you export NiagaraAX schedules from the station to existing BACnet Schedule and Calendar objects in a BACnet device, acting as the “master” source. Also, you can expose Niagara schedule components as BACnet Schedule or Calendar objects for access by any networked BACnet device. You do this through configuration of the “Export Table” under the BacnetNetwork’s “Local Device.” For more details, see the Bacnet Users Guide.

**About weekly schedules**

The following sections explain weekly schedule concepts:

- Types of weekly schedule components
- Weekly schedule output processing
- Weekly Scheduler view
Types of weekly schedule components

Each component type varies only by data value category, meaning its Out slot (generally called "output") and its In slot (generally called "input"). For data category concepts, see “About data value categories” on page 3-2. The schedule’s output and input are “Status<Type>” according to schedule component type, for example, StatusBoolean if a BooleanSchedule, StatusEnum if an EnumSchedule.

The four weekly schedule component types are:

- BooleanSchedule
- EnumSchedule
- NumericSchedule
- StringSchedule

In typical use, only outputs of schedules are linked to other components for scheduling control, such as “writable” points of the same type. Figure 8-5 shows a BooleanSchedule and NumericSchedule, each linked to two writable points. See "Schedule component links" on page 8-2 for more details.

About the BooleanSchedule

The BooleanSchedule is typically the most used weekly schedule. Use it directly for schedule control of BooleanWritable points (typically proxy points). If needed, it also has application for linkage to slots in extensions. For example, using an intermediate kitControl object (say, a “Not” logic-type object) use a BooleanSchedule for linkage to the Enabled slot of an alarm extension.

About the EnumSchedule

The EnumSchedule allows schedule control of EnumWritable points (typically proxy points). For example, link it to an EnumWritable that proxies a BACnet Multistate Output object, or to an EnumWritable that proxies a LON NVI (using an enumerated SNVT).

To properly use an EnumSchedule, first define its Facets to match those in linked EnumWritable(s).

About the NumericSchedule

The NumericSchedule allows schedule control of NumericWritable points (typically proxy points), which may represent setpoints, limits, or any number of other variables.

About the StringSchedule

The StringSchedule allows schedule control of StringWritable points (possibly proxy points).

Weekly schedule output processing

For any weekly schedule (BooleanSchedule, EnumSchedule, NumericSchedule, StringSchedule), output recalculation occurs upon any of the following:

- any saved change to its configuration
- any change at its input
- station startup
- any change to the system clock

Each component has an Out slot and an Out Source slot. In addition, Next Time and Next Value slots are available. By default, all of these slots are “pinned” on the component’s shape on the wire sheet, as shown in Figure 8-5. Upon any output change, all of these slots are updated.

Out slot

A schedule’s output value is determined by the following, in highest-to-lowest priority:
1. To any "non-null" value at its In slot (if linked)
   This value is immediately passed to its output. Otherwise (if null), processing continues.
2. If the schedule is not effective, the output goes to the default output value.
   If the schedule is effective, the output goes to the (highest priority) active special event (if any).
3. To the active weekly schedule event (if any).
4. To the default output value.

For more details on effective schedules, see “Effective Period” on page 8-12.

Out Source slot
Out Source provides a string ”source description” of the current output, as one of the following:
- Input
- Special Event: <SpecialEventName>
- Week: <day_of_week>
- Default Output

Examples might appear as "Week: monday" or "Special Event: Christmas Break”

Next Time and Next Value slots
These slots provide "look-ahead" data: the next known schedule output value, and its time of change.
- Next Time — Displays in Baja AbsTime format, for example: 03-Feb-05 5:00 PM
- Next Value — The next scheduled output value.

Typical application is for informational display. If needed, slots can be linked into control logic. For example, TimeDifference and CurrentTime objects (kitControl, Timer) provide AbsTime slots too.

Weekly Scheduler view
Double-clicking any weekly schedule in Workbench produces its Scheduler view (Figure 8-6).

Figure 8-6 Scheduler view for weekly schedule

There are four tabs: Weekly Schedule, Special Events, Properties, and Summary, as described ahead.

Note: Buttons Refresh and Save apply to all tabs in the Scheduler view (not just the one displayed).

Weekly Schedule
Use this tab in the Weekly Scheduler view to enter regular schedule events, that is "normal schedule events" that repeat from week to week, based on the day of the week and the time of day. By default, any existing events appear as greenish blocks, while unscheduled (default output) time appears in white.

Use is mostly straightforward, to add a new event simply click in a day at the approximate event start time, and drag down to define the start and finish time (Figure 8-7). The event remains selected (by default, dark blue) when you release the mouse button.

Note: If an EnumSchedule, you should define its range facet from the Scheduler's Properties tab before adding events. See "Facets" on page 8-12 for more details.
As needed, click again and drag on the event’s top or bottom to change its start or finish time (in broad increments).

Additional details about the Weekly Schedule tab are as follows:

- **Event time “tuning”**
- **Output value**
- **Right-click menus**

**Event time “tuning”** With any event selected, “fine tune” its start and finish time using the controls, selecting the hours portion or minutes portion (Figure 8-8). Or, click and type values in directly.

**Output value** For any event, you can select the “null” checkbox (the schedule’s calculated value is null for that event). However, you typically select or type a value instead, as follows:

- If a Boolean or EnumSchedule select the event value in the output field, see Figure 8-9, left.
  
  **Note:** If an EnumSchedule, first specify its facets (on Properties tab) before entering values. This allows selection of possible values.

- If a NumericSchedule or StringSchedule, you type the value in the output field, then press Enter to register it in the event block, as shown in Figure 8-9, right.

**Right-click menus** Right-click in the weekly schedule area for an event menu. If you have any event selected, this menu provides the most commands, as shown in Figure 8-10.
Event menu options are straightforward, and may include the following:

- **Delete Event** — Deletes the selected event.
- **Paste Day** — Appears only if copy day option was used first. Copies all events into selected day.
- **All Day Event** — Makes currently selected (or last entered) event extend to entire day.
- **Apply M-F** — Copies all events in the selected day to Mon, Tue, Wed, Thu, and Fri (and overwrites any existing events on those days).
- **Copy Day** — Copies all events in the selected day, to use with paste day option.
- **Clear Day** — Clears all events in the selected day.
- **Clear Week** — Clears all events in the entire weekly schedule.

### Special Events

Use this Weekly Scheduler view tab to enter all exceptions to the schedule's weekly schedule, broadly called “special events.” For general information, see “Schedule special events” on page 8-3.

As shown in Figure 8-11, existing special events (if any) are listed in the table by name and summary. When you select a special event, its day(s) of occurrence are highlighted in the monthly calendars at the top of the view, and its associated event actions are displayed in the right-side column.

**Figure 8-11** Special Events tab in weekly Scheduler

Additional details about the Special Events tab are as follows:

- **Adding special events**
- **Event times and output values**
- **Special event priorities**
- **Right-click menus and other controls**

**Adding special events** Click the **Add** button to add a new special event. An Add dialog appears, as shown in Figure 8-12.
Dialog options are described as follows:

- **Name** — Your descriptive name for special event, perhaps “Christmas_Break” or “Half_Day.” The default value is simply “Event.” You can change this later, if needed.
- **Type** — Determines selection criteria for day or days, with the following choices:
  - **Date** — (default) By various combinations of weekday, numerical date, month or month combinations, and year.
  - **Date Range** — By start and end range, using for each a combination of day, month, year.
  - **Week and Day** — By combination of day of week, week in month, month.
  - **Custom** — By various combinations of day, month, weekdays, and year.
  - **Reference** — By reference to a specific CalendarSchedule component in the station.

For details on most Type selections, see “Calendar day selections” on page 8-16. If you select type **Reference**, a second Add dialog appears, as shown in Figure 8-13. It lists all CalendarSchedules (Calendars) available in the station, by slot path. Select any one for the day(s) portion of this special event.

After you have a name and type selected (and defined as needed), click **OK** to add it to this schedule’s special events. It remains selected for further editing, except for type.

**Event times and output values** — A newly-created special event has no events defined. With the special event selected, click in the right-side events column and enter events as necessary. Start, finish, and output controls work the same as in the Weekly Schedule tab. See “Event time “tuning”” on page 8-7 and “Output value” on page 8-7 for details.

You can also right-click in the column for an event menu, as shown in Figure 8-14. This is useful to add an all-day event or set the entire day to the schedule’s default value.
Figure 8-14 Special event schedule actions

Note: You must specify events for any special event to occur. Where nothing is scheduled, the special event relinquishes control back to any lower-priority schedule events, and finally “intermingles” with the weekly schedule. To completely override the weekly schedule, configure a special event for the entire day.

Special event priorities All special events take priority over regular weekly events. Among special events, you define relative priorities by the order of listing in the Special Events table, as follows:

- **Highest** priority is at **top** of list. Events in this special event, when active, always occur.
- **Lowest** priority is at **bottom** of list. Events occur only if not overlapped by other special events active during the same period.

Change a special event's priority by selecting it and using the priority arrow buttons (Figure 8-15).

Right-click menus and other controls Right-click in the special events table for a menu. If you have any special event selected, this menu provides the most commands, as shown in Figure 8-16.

Figure 8-16 Right-click menu with event selected

Special event menu options are straightforward, and may include the following:

- **Add** — Add a new special event (same as using Add button).
- **Edit** — Edit day(s) selection criteria (but not changing special event type). Same as Edit button.
- **Rename** — Rename selected special event (same as using Rename button).
- **Priority (up)** — Move special event up in priority list (same as using Priority button).
- **Priority (down)** — Move special event down in priority list (same as using Priority button).
- **Delete** — Removes selected special event from the schedule component.

Note: When you delete a special event, a confirmation dialog appears as shown in Figure 8-17.
Figure 8-17  Delete special event confirmation

Click Yes to delete the special event, or No to keep it.

When you first access the Special Events tab, the current day is highlighted in the left-most calendar month at the top of the view. As needed, click on Next Month and Prev Month, or Next Page and Prev Page to traverse the calendar ahead or back in time.

When you select a special event in the table, if it occurs in any currently displayed month, its associated day or days are highlighted as shown in Figure 8-18.

Figure 8-18  Special event highlights in calendar block

Note: A special event must have at least one defined event action to be highlighted in a calendar.

Return to the current calendar month and day by clicking the Today button.

Properties

As shown in Figure 8-19, this tab in Weekly Scheduler view is where you specify the schedule’s:

- Effective Period
- Default Output
- Facets
- Cleanup Special Events action

Figure 8-19  Properties tab in weekly Scheduler
Effective Period  By default, a weekly schedule added from the schedule palette is always effective. Whenever a schedule component is not effective, its output (Out slot) goes to its default output value, regardless of its weekly schedule or any special events.

In most cases, you leave weekly schedules as always effective. However, if you have an application for a schedule effective only at certain times, use the “start” through “end” range fields to limit the effective period. When you Save the changes, only effective days in the calendar months are shown highlighted green.

Default Output  Whenever a schedule event (special or weekly) is not defined, the schedule component’s output (“Out” slot) is this value. The white area in listed events indicates where the default value is used and displays the current default value, as shown in Figure 8-20. The default output value is also used whenever the schedule is not effective.

Figure 8-20  Default output is white area in schedule events

Note that “null” is an available choice—depending on control logic, this may be a valid choice.

As copied from the schedule palette, the default “Default Output” varies by schedule type, as follows:

- BooleanSchedule — false
- EnumSchedule — null
- NumericSchedule — null
- StringSchedule — null

Facets  The schedule component’s facets determine how its output value is formatted for display. For example, instead of “true” and “false” for a BooleanSchedule, you may need “On” and “Off” instead. Assigned facets appear in scheduler views when adding events, displaying summary data, and so on. For complete details, see “About point facets” on page 3-7.

Note: Facets are especially important for EnumSchedules. You need to define “range” facets before you add weekly schedule events (in order to pick an event’s enumerated value). Range facets should match those used in any controlled (output-linked) EnumWritables. For related details, see “Facets importance for Enum points” on page 3-8.

In the case of StringSchedules (as for all string-type components) facets have no application.

Figure 8-21 shows output selections for an EnumSchedule with its range facet defined as “lonworks:LonOccupancyEnum,” one of the available frozen facets.
By default, facets for schedule components as copied from the schedule palette are as follows:

- **BooleanSchedule** — trueText: true, falseText: false
- **EnumSchedule** — range: <not defined>
- **NumericSchedule** — units: (null), precision: 1
- **StringSchedule** — (not applicable)

**Cleanup Special Events** This property is either true (default) or false.

- If true, “one-time” special events that have occurred (and will not be effective again) are automatically deleted. When a special event is deleted, a message is sent to the schedule log, and that special event no longer appears in the **Special Events** tab.
- If false, “one-time” special events are retained, even though they will not occur again.

**Summary**

The summary tab in the Weekly Scheduler view shows a summary listing of all scheduled events for any one selected day in a weekly schedule (Figure 8-22). Events may be from the normal weekly schedule, special events, or a combination of both. Unlike with other tabbed views, this one is read-only.

**Figure 8-22  Summary tab shows all events for any selected day**

In the top calendar month area:

- Days with schedule events are shown highlighted green.
• Days without schedule events (only default output) are shown in white. As needed, click on Next Month and Prev Month, or Next Page and Prev Page to traverse the calendar ahead or back in time.
• Click any day to see its events.
• Click Today (at top) to see the current day’s events.

The table lists each event’s start timestamp, the schedule’s output value, and the event source. See “Out Source slot” on page 8-6 for how event source information appears.

About calendar schedules (holidays)

Calendar schedules (CalendarSchedule component) specify entire days, using the following four types of day event selections:
• Date
• Date Range
• Week and Day
• Custom

You can add as many day events as needed in the same CalendarSchedule. The following sections provide more details:
• CalendarSchedule Usage
• Calendar Scheduler view
• Calendar day selections
• CalendarSchedule slots and other notes

CalendarSchedule Usage

Instead of linking CalendarSchedules, you typically “reference” them from the “special events” configuration of one or more weekly schedules. Each referenced CalendarSchedule defines the “day portion” of a special event. Then, you configure time-of-day events in each special event, as needed.

Figure 8-23  Example referenced CalendarSchedules

For example, Figure 8-23 shows a BooleanSchedule and a portion of its special events tab, listing five special events. Three of these are “Reference” types, meaning their calendar day(s) are defined remotely in the configuration of the referenced CalendarSchedules. Although all components are shown here in the same container, quite often CalendarSchedules are located elsewhere in the station.

CalendarSchedule usage by “special event reference” allows global changing of day definitions, where multiple weekly schedules can reference one or more CalendarSchedules. Any edit of a Calendar-Schedule affects all weekly schedules containing a special event that references it.

Calendar Scheduler view

Double-click a CalendarSchedule to see its default Calendar Scheduler view, as shown in Figure 8-24.
As shown in Figure 8-24, existing calendar events (if any) are listed in the table by name and summary. When you select a calendar event, its day(s) of occurrence are highlighted in green in the monthly calendars at the top of the view.

Additional Calendar Scheduler topics include:

- Adding calendar events
- Right-click menus and other controls

**Adding calendar events**

Click the **Add** button to add a new calendar event. An Add dialog appears, as shown in Figure 8-25.

**Figure 8-25  Special Events Add dialog**

Dialog options are described as follows:

- **Name** — Your descriptive name for the calendar days, perhaps "Thanksgiving_Break" or "Cleaning_2." The default value is simply "Event." You can change this later, if needed.
- **Type** — Determines selection criteria for day or days, with the following choices:
  - **Date** — (default) By various combinations of weekday, numerical date, month or month combinations, and year.
  - **Date Range** — By start and end range, using for each a combination of day, month, year.
  - **Week and Day** — By combination of day of week, week in month, month.
  - **Custom** — By various combinations of day, month, weekdays, and year.

For details on Type selections, see "Calendar day selections" on page 8-16.

After you have a name and type selected (and defined as needed), click **OK** to add it to this calendar's days. It remains selected for further editing, except for type.
Right-click menus and other controls
Right-click in the calendar events table for a menu. If you have any calendar event selected, this menu provides the most commands, as shown in Figure 8-26.

**Figure 8-26** Right-click menu with event selected

![Right-click menu with event selected](image)

**Note:** Priority selections (right-click menu or in bottom buttons) only affect the list order for events in a CalendarSchedule—true priority applies only to special events (in weekly schedules).

Calendar event menu options are straightforward, and may include the following:

- **Add** — Add a new calendar event (same as using Add button).
- **Edit** — Edit day(s) selection criteria (but not changing calendar type). Same as Edit button.
- **Rename** — Rename selected calendar event (same as using Rename button).
- **Priority (up)** — Move calendar event up in display list (same as using Priority button).
- **Priority (down)** — Move calendar event down in display list (same as using Priority button).
- **Delete** — Removes selected calendar event from the schedule component.

**Note:** When you delete a calendar event, a confirmation dialog appears as shown in Figure 8-27.

**Figure 8-27** Delete calendar event confirmation

![Delete calendar event confirmation](image)

Click Yes to delete the calendar entry, or No to keep it.

When you first access the Calendar Scheduler, the current day is highlighted in the left-most calendar month at the top of the view. As needed, click on Next Month and Prev Month, or Next Page and Prev Page to traverse the calendar ahead or back in time.

Return to the current calendar month and day by clicking the Today button.

**Calendar day selections**

When adding calendar days in a CalendarSchedule, a special event in a weekly schedule, or a trigger event in a trigger schedule, the following “Type” selections are available:

- **Date** — see “Date selection notes” on page 8-16
- **Date Range** — see “Date range selection notes” on page 8-17
- **Week and Day** — see “Week and day selection notes” on page 8-17
- **Custom** — see “Custom selection notes” on page 8-18

**Date selection notes**

As shown in Figure 8-28, Date calendar selection has 4 criteria: weekday, day-of-month, month-of-year, and year.

**Figure 8-28** Calendar selection by date

![Calendar selection by date](image)

You can make only one selection in each criteria.
Each criteria offers an “any” selection, in addition to a specific selection (weekday, day-of-month, month-of-year, year). In addition, the month-of-year criteria provides an “every other month” selection, as one of the following:

- Jan-Mar-May-Jul-Sep-Nov
- Feb-Apr-Jun-Aug-Oct-Dec

Result of selections is by “ANDing” all criteria. For example, if you select weekday of Tuesday, day of month as 5, and remaining criteria “any,” the event is specified only on Tuesday, the fifth of any month in any year. If a month does not have Tuesday the fifth, then there is no event that month.

**Date range selection notes**

As shown in Figure 8-29, Date Range calendar selection has a start range and end range, each with 3 criteria: day-of-month, month-of-year, and year.

![Figure 8-29 Calendar selection by date range](image)

You can make only one selection in each criteria. Each criteria offers an “any” selection, in addition to a specific selection (day-of-month, month-of-year, year). In addition, the month-of-year criteria provides an “every other month” selection, as one of the following:

- Jan-Mar-May-Jul-Sep-Nov
- Feb-Apr-Jun-Aug-Oct-Dec

In each date range, result is from “ANDing” the criteria. In addition, the start day can be after the end date. For example, as shown in Figure 8-29, the start day can be in December and the end date in March. This event occurs December, January and February.

**Week and day selection notes**

As shown in Figure 8-30, Week and Day calendar selection has 3 criteria: weekday, week-in-month, and month-of-year.

![Figure 8-30 Calendar selection by week and day](image)

You can make only one selection in each criteria. Each criteria offers an “any” selection, in addition to a specific selection (weekday, week-in-month, month-of-year). In addition, the following criteria offer additional selections, as follows:

- week-in-month: last 7 days
- month-of-year:
  - Jan-Mar-May-Jul-Sep-Nov
  - Feb-Apr-Jun-Aug-Oct-Dec

The result is from “ANDing” the criteria. For example, as shown in Figure 8-30, if selections are for weekday as Monday, the month as February, and the week as 3, the event occurs only on the third Monday in February.
Custom selection notes

As shown in Figure 8-31, Custom calendar selection has 5 criteria: day-of-month, month-of-year, weekday, week-in-month, and year.

Figure 8-31  Calendar selection by custom

Unlike with other calendar types, you can make multiple selections within each criteria (except if you select “any,” which allows only that selection). To select multiples, first select something other than “Any,” then hold down the Ctrl or Shift key while you select more values.

Each criteria offers an “any” selection, in addition to a specific selection. In addition, the following criteria offer additional selections, as follows:

- day-of-month:
  - Last Day
  - Last 7 Days
- week-in-month: Last 7 Days

Within any criteria, selections are “OR’ed.” The overall result is from “AND’ing” all criteria. For example, Figure 8-31 shows a custom selection for U.S. General Election Day, which must be configured as the “first Tuesday after the first Monday in November.”

CalendarSchedule slots and other notes

The CalendarSchedule has a StatusBoolean input and output (slots “In” and “Out”). In most applications they are left unlinked.

- Output is true during any configured calendar day(s), otherwise it is false.
- Input overrides the calendar schedule calculation (if linked). Any non-null input (true or false) is immediately passed to the output.

By default, for any CalendarSchedule copied from the schedule palette, the following additional slots are pinned on the component’s glyph (shape on wire sheet):

- Next Time
  Time of next scheduled output change for the CalendarSchedule. If more than a year away, this value is null.
- Next Value
  The next scheduled output value, at “Next Time”. Value is meaningless if Next Time is null.

From the CalendarSchedule’s property sheet, you can access and change the following additional slots:

- Cleanup Expired Events
  Either true (default) or false.
  If true, calendar events of type “Date” and “Date Range” that have already occurred, and cannot occur again (as configured), are automatically deleted after they occur. This is recorded in the schedule log, and you no longer see them in the Calendar Scheduler view.
  If false, all calendar events are retained, even if they cannot occur again (as configured).
- Facets
  Facets applied to the input and output, which by default are simply “true” and “false.”
About trigger schedules

TriggerSchedules are special-purpose schedules, providing scheduling control for either linked actions or topics of other components. Figure 8-32 shows a simple example of a TriggerSchedule linked to an action slot of a DiscreteTotalizerExt, which was “composited” in the parent BooleanWritable.

Figure 8-32  Example TriggerSchedule

This schedule is configured to simply fire once at midnight on the first day of every month. The trigger at the “ResetElapsedActiveTime” slot zeroes the runtime accumulated from the previous month.

The following sections provide more TriggerSchedule details:

• Trigger Scheduler view
• TriggerSchedule slots and other notes

Trigger Scheduler view

Double-click a TriggerSchedule to see its default Trigger Scheduler view, as shown in Figure 8-33.

Figure 8-33  Trigger Scheduler view

As shown in Figure 8-33, the Trigger Scheduler has two sides:

• Calendar (left) side — where you add events. It operates like the Calendar Scheduler view.
• Time picker (right) side — where you add trigger times for the schedule to fire its trigger output. Included is the ability to add repeating intervals.

Note: Trigger times, as set in the time picker, apply to all calendar events (if more than one).

Existing trigger events (if any) are listed in the table by name and summary. When you select a trigger event, its day(s) of occurrence are highlighted in green in the monthly calendars at the top of the view. Trigger times are listed in the time picker area.

Additional Trigger Scheduler topics include:

• Adding trigger events
• Adding trigger event times
Adding trigger events
Click the **Add** button to add a new trigger event. An Add dialog appears, as shown in Figure 8-34.

**Figure 8-34** Trigger Event Add dialog

Dialog options are described as follows:

- **Name** — Your descriptive name for the trigger events, perhaps “FirstDOM” or “Each_WorkHr.” The default value is simply “Event.” You can change this later, if needed.
- **Type** — Determines selection criteria for day or days, with the following choices:
  - **Date** — (default) By various combinations of weekday, numerical date, month or month combinations, and year.
  - **Date Range** — By start and end range, using for each a combination of day, month, year.
  - **Week and Day** — By combination of day of week, week in month, month.
  - **Custom** — By various combinations of day, month, weekdays, and year.

For details on Type selections, see “Calendar day selections” on page 8-16.

After you have a name and type selected (and defined as needed), click **OK** to add it to this calendar’s days. It remains selected for further editing, except for type. Typically, you add one or more trigger event **times** on the time picker side. See “Adding trigger event times” on page 8-20.

Adding trigger event times
By default, a single “midnight” trigger time already exists (you can delete it if desired). To add other trigger times, use the controls at the bottom of the time picker side, as shown in Figure 8-35.

**Figure 8-35** Trigger time picker controls

Set the desired time in the **hour:minute** editor, either by clicking up/down controls or typing in times directly. Click the **Add** button to add a trigger at that time, which adds it to the list. You can also enter multiple triggers simultaneously, using the **Range option**.

**Range option** To add multiple triggers that occur at a repeating interval, select the **Range** checkbox. This enables the **Range End** and **Range Interval** fields for entering values, as shown in Figure 8-36.
When entering a trigger range, note that the top (hour:minute) editor acts as the first (or Range Begin) trigger time. By default, the Range Interval is set to one hour ("+00001h 00m 00.000s"). You can set this to whatever interval is needed.

To delete a trigger time, click to select, then click the Remove button. To select multiple trigger times, hold down the Ctrl or Shift key while you select.

**Right-click menus and other controls**

The time picker (right side) has no right-click menu—simply use the bottom controls to configure trigger times. The calendar (left side) has an available right-click menu. If you have any calendar event selected, this menu provides the most commands, as shown in Figure 8-37.

**Note:** Priority selections (right-click menu or in bottom buttons) only affect the list order for events in a Trigger-Schedule—true priority applies only to special events (in weekly schedules).

Event menu options are straightforward, and may include the following:

- Add — Add a new calendar event (same as using Add button).
- Edit — Edit day(s) selection criteria (but not changing calendar type). Same as Edit button.
- Rename — Rename selected calendar event (same as using Rename button).
- Priority (up) — Move calendar event up in display list (same as using Priority button).
- Priority (down) — Move calendar event down in display list (same as using Priority button).
- Delete — Removes selected calendar event from the schedule component.

**Note:** When you delete a calendar event, a confirmation dialog appears as shown in Figure 8-38.

Click **Yes** to delete the calendar entry, or **No** to keep it.
When you first access the Trigger Scheduler, the current day is highlighted in the left-most calendar month at the top of the view. As needed, click on **Next Month** and **Prev Month**, or **Next Page** and **Prev Page** to traverse the calendar ahead or back in time.

Return to the current calendar month and day by clicking the **Today** button.

### TriggerSchedule slots and other notes

By default, for any TriggerSchedule copied from the schedule palette, the main “Trigger” output slot is pinned on the component’s glyph (shape on wire sheet), as well as the following additional ones:

- **Enabled**
  
  Either true (default) or false. While false, firing of trigger outputs is disabled. If linking, note that this slot uses simple Boolean, you may need a StatusBooleanToBoolean (kitControl) component.

- **Last Trigger**
  
  Timestamp of the last firing of the trigger output.

- **Next Trigger**
  
  Next scheduled trigger firing time.

From the TriggerSchedule’s property sheet, you can access the following additional slots:

- **Next Trigger Search Limit**
  
  How far into the future to search for the next trigger. It is possible a poorly-configured schedule will never fire a trigger. This setting prevents an infinite search. Default is one year (8760 hours).

- **Last Modified**
  
  (read only) Timestamp of last configuration change.

- **Status**
  
  (read only) Status of the schedule component, typically “{ok}.”

### Trigger Missed slot

In addition to the “main” Trigger output slot, the TriggerSchedule has “Trigger Missed” slot, also a topic type slot. If the station was not running when a scheduled trigger was to occur (appeared previously in “Next Trigger” property), upon station startup the Trigger Missed slot fires once.

**Note:** Trigger Missed always fires only once, no matter how many triggers may have been missed.

### About ScheduleSelector components

ScheduleSelector components provide an easy way for users to select a schedule to use for controlling a particular component. For example, you can use a ScheduleSelector component to link a pre-configured schedule to a component that is controlling equipment, a door schedule, or setpoint temperature. With a set of pre-configured schedules and the ScheduleSelector component, users can simply choose from a list of valid schedules when they want to setup or change the schedule of a device. Users do not have to actually configure schedule properties.

Each ScheduleSelector component contains a property that allows you to target a single location or “container” that holds all the schedule components that you want to offer as options for the ScheduleSelector component. After you define the container location, the ScheduleSelector component populates the “Schedule” property option list with all valid schedule components. You can choose any of the options - or leave the property set to the default “null” value. When you select a schedule, the ScheduleSelector component creates a link between the selected schedule and the component that is linked to the output of the ScheduleSelector.

### Types of ScheduleSelector components

There are four types of ScheduleSelector components available in the Schedule palette, representing each of the four data types:

- **BooleanScheduleSelector**
- **NumericScheduleSelector**
- **StringScheduleSelector**
- **EnumScheduleSelector**

ScheduleSelectors may only provide links between schedules and control components that are of the same data type. For example, a BooleanScheduleSelector component only links a BooleanSchedule component to a control component of the Boolean data type. An EnumScheduleSelector links between an EnumSchedule component and a control component of the Enum data type. The same relationship applies to Numeric and String schedule selectors.
Chapter 8 – About Scheduling
April 4, 2011

Figure 8-39  Schedule Selector Components in the Schedule Palette

If you have schedules of different data types in the same container, the ScheduleSelector only displays the valid schedule components in the "Schedule" property options list.

Types of ScheduleSelector component properties
All ScheduleSelector components have the following properties:

• Container
  This property provides a text field that uses an ORD to specify the location of the available schedules. Use the component chooser at the right side of the field to browse to and choose the desired schedule container.

• Schedule
  This option list displays all available schedule components of the appropriate data type.
  • Selecting and saving a schedule using this property's option list automatically creates a link from the "out" slot of the selected schedule to the "in" slot of the ScheduleSelector component.
  • Selecting "null" for this property causes the "out" property to generate a null value, and automatically removes any link from a schedule component to the "in" slot of the ScheduleSelector component.

• Facets
  This property does not require configuration. Facets are automatically inherited from whatever schedule is currently selected.

• In
  Whenever the ScheduleSelector component has been used to select a schedule, the schedule's output supplies this value (via the automatic link) to this slot. The default setting of this slot is the null value, produced when no schedule is selected.

• Out
  This is the output value (from the linked schedule) that is passed to whatever is controlled (linked to) this slot.

Example ScheduleSelector configurations
Example 1: Using a NumericScheduleSelector component
The following illustration shows an example of a NumericScheduleSelector:

Niagara AX-3.6
User Guide
Notice the following points about this configuration:

- The container property is set to the "station:sloT:/Logic/HousingUnit" ORD. This is the container that holds the three numeric schedules.
- The Schedule property option list has three numeric schedules available for selection. Notice that the schedules are the same ones shown on the wire sheet view of the folder component labeled "HousingUnit".
- The link (visible in the Wire Sheet view) is connected from the numeric schedule Out to the schedule selector In.
- The linked value (67.0 in this example) is passed from the NumericScheduleSelector component Out to the AirHandler device Setpoint input.

Example 2: Using a BooleanScheduleSelector component

The following illustration shows an example of a BooleanScheduleSelector configuration.

Notice the following points about this configuration:

- The BooleanScheduleSelector Container property is linked to the "Schedules" container (see nav tree).
- Three BooleanSchedule components are in the container and are available as options in the Schedule property option list.
- On the wire sheet view, the BooleanScheduleSelector shows a "knob" link from the selected schedule to the schedule selector In.
- The BooleanScheduleSelector Out is linked to three device inputs.
Using schedules

The following main sections provide common tasks for working with schedules in NiagaraAX:

- Adding a schedule or calendar
- Configuring schedules and calendars
- Linking schedules
- Importing schedules

**Adding a schedule or calendar**

In your station, you can copy a default schedule component directly from the schedule palette, or copy a pre-configured schedule component from a saved bog file or other station database.

**Note:** Once in your station and configured, you can also duplicate schedule components (see “To duplicate a component (property sheet, nav side bar, or wire sheet view)” on page 10-15.

**To add a component from the schedule palette**

You can add (copy) a new schedule component from the schedule palette, dragging onto a container in the Nav tree view or into the wire sheet view.

**Step 1** Open the schedule palette. See “Using the palette side bar” on page 10-9 for general details. When the palette is open, schedule components are listed, as shown in Figure 8-1 on page 1.

**Step 2** Drag the component needed from the palette to either:

- In the Nav tree, onto a folder in your station.
- In the view pane, into the wire sheet of a folder in your station.

A Name dialog appears.

**Step 3** In the Name dialog, type the desired name and click OK.

The schedule or calendar is now in your station, with default values.

**To copy an existing, saved (configured) schedule component**

You can add (copy) a new schedule component from one previously configured, dragging onto a container in the Nav tree view or into a folder’s wire sheet view. To add a new schedule component as a copy of an existing saved component, do the following:

**Step 1** In the Nav tree, expand My File System and navigate to the saved bog file or station config.bog file. See “Editing components” on page 10-12 for more details.

**Step 2** When you locate the desired schedule component, right-click and select Copy.

**Step 3** Paste the copied component doing a right-click Paste from either:

- In the Nav tree, on a folder in your station
- In the view pane, in the wire sheet of a folder in your station.

A Name dialog appears.

**Step 4** In the Name dialog, type the desired name and click OK.

The schedule or calendar is now in your station, with pre-configured values.

**Configuring schedules and calendars**

Typically, you perform most configuration of any schedule component from its default “scheduler” view. For an overview, see “Schedule component views” on page 8-2.

- Configuring weekly schedules
- Configuring calendar schedules
- Configuring trigger schedules

**Configuring weekly schedules**

Weekly schedules (BooleanSchedule, EnumSchedule, NumericSchedule, and StringSchedule) are among the most used schedule components.

**To configure a weekly schedule**

You use the Weekly Scheduler view to configure a weekly schedule. There are many ways you can approach configuration, the following procedure is only one way.

**Step 1** Double-click the weekly schedule component.

The Weekly Scheduler displays, as shown in Figure 8-6 on page 6.

**Step 2** Configure important properties. See “To configure a weekly schedule's properties” on page 8-26.
Step 3 Configure the normal weekly schedule. See “To configure the weekly (normal) schedule” on page 8-26.
Step 4 Configure special events, if any. See “To add and configure special events” on page 8-26.
Step 5 Review all configuration. See “To review a weekly schedule's configuration” on page 8-26.

**To configure a weekly schedule's properties**

To configure a weekly schedule's properties, do the following:

**Step 1** In the Weekly Scheduler view, click the Properties tab, and configure the following:
- Facets — This is critical if an EnumSchedule, and optional if a BooleanSchedule or NumericSchedule. Note that facets do not apply if a StringSchedule.
- Default Output — This is the schedule's output whenever an event (either weekly or special event) is not active. It is also used whenever the component is “not effective.” Typically, you leave other properties at default values.

**Step 2** Click Save.

**To configure the weekly (normal) schedule**

To configure the normal weekly schedule, do the following:

**Step 1** In the Weekly Scheduler view, click the Weekly Schedule tab.
**Step 2** In the events table, click and drag to add an event, and enter its output value.

*Note:* If a Boolean or EnumSchedule, select output value from the drop-down control.
If a Numeric or StringSchedule, type the output value and press Enter.

**Step 3** Right-click the event and use whatever menus are needed.
For details, see “Right-click menus” on page 8-7.
**Step 4** Continue to add, delete, or adjust events as needed.
**Step 5** When the weekly schedule is what you want, click Save.

**To add and configure special events**

Special events are exceptions to the normal weekly schedule, and typically include recurring holidays and “one-time” events. For more details, see “Schedule special events” on page 8-3.

**Step 1** In the Weekly Scheduler view, click the Special Events tab.
**Step 2** Click the Add button for a dialog to add a special event.
In the Add dialog, specify:
- Name — Type a unique, identifiable name.
- Type — Select the calendar type, and enter specific day criteria (according to type).

For details, see “Adding special events” on page 8-8 and “Calendar day selections” on page 8-16.
**Step 3** After naming, selecting the event type, and entering the selection criteria, click OK.
The special event is listed in the special events table, with your assigned name.
**Step 4** Click the special event to select it.
**Step 5** In the right-side events column, you can either:
- Click and drag to enter events that override (yet “intermingle” with) normal weekly events.
- Right-click and select an all-day event or default output value. This negates the normal weekly schedule.

For more details see “Event times and output values” on page 8-9.
**Step 6** Continue to add, edit, rename, or delete special events as needed. See “Right-click menus and other controls” on page 8-10, and “Special event priorities” on page 8-10.
**Step 7** When special events are like you want, click Save.

**To review a weekly schedule's configuration**

Use the read-only Summary tab to review a weekly schedule's configuration.

**Step 1** In the Weekly Scheduler view, click the Summary tab.
The calendar shows the current day with its schedule events, including output and output source.
**Step 2** Click any day on any calendar month to see its schedule events.
**Step 3** If adjustments are necessary, click the Weekly Schedule, Special Events, or Properties tab as needed, and make changes. Click Save when done.
Configuring calendar schedules
Calendar schedules let you globally specify holidays and other special days in the system. For details, see “About calendar schedules (holidays)” on page 8-14.

To configure a calendar schedule
You use the Calendar Scheduler view to configure a CalendarSchedule.

Step 1 Double-click the CalendarSchedule component.
The Calendar Scheduler displays, as shown in Figure 8-24 on page 15.

Step 2 Click the Add button for a dialog to add a calendar event.
In the Add dialog, specify:
• Name — Type a unique, identifiable name.
• Type — Select the calendar type, and enter specific day criteria (according to type).
For details, see “Calendar day selections” on page 8-16.

Step 3 After naming, selecting the event type, and entering the selection criteria, click OK.
The calendar event is listed in the events table, with your assigned name.

Step 4 Continue to add, edit, rename, or delete calendar events as needed. See “Right-click menus and other controls” on page 8-16.

Step 5 When calendar events are like you want, click Save.

Configuring trigger schedules
Trigger schedules provide scheduling control for actions of linked components or their child extensions. For details, see “About trigger schedules” on page 8-19.

To configure a trigger schedule
You use the Trigger Scheduler view to configure a TriggerSchedule.

Step 1 Double-click the TriggerSchedule component.
The Trigger Scheduler displays, as shown in Figure 8-33 on page 19.
This view has a calendar side (left) and time picker (right side).

Step 2 Click the Add button for a dialog to add a trigger event.
In the Add dialog, specify:
• Name — Type a unique, identifiable name.
• Type — Select the calendar type, and enter specific day criteria (according to type).
For details, see “Adding trigger events” on page 8-20 and “Calendar day selections” on page 8-16.

Step 3 After naming, selecting the event type, and entering the selection criteria, click OK.
The event is listed in the (calendar-side) events table, with your assigned name.

Step 4 Click an event to select it.
Step 5 In the right-side time picker area, add one or more triggers, as needed.
Note the following:
• By default, a “midnight” trigger may exist (00h:00m); you can delete it if needed.
• Using the Range option, you can add multiple triggers at some repeating interval.
• Triggers apply to all trigger events (calendar-side entries).
For more details see “Adding trigger event times” on page 8-20.

Step 6 Continue to add, edit, rename, or delete trigger events as needed. See “Right-click menus and other controls” on page 8-21.

Step 7 When trigger events and triggers are like you want, click Save.

Linking schedules
As needed, you link weekly schedules and (if used) trigger schedules to other components to provide scheduling control. For an overview, see “Schedule component links” on page 8-2.

• Linking weekly schedules
• Linking trigger schedules

Linking weekly schedules
You can link the output (Out slot) of a weekly schedule to any component with a like “Status<Type>” input. For example, you might link the output of a BooleanSchedule to a BooleanWritable point.
• To link a weekly schedule using the wire sheet
• To link a weekly schedule using the Nav tree

**To link a weekly schedule using the wire sheet**

To link a weekly schedule to a component *in the same wire sheet*, do the following:

**Step 1**
In the wire sheet, mouse over the weekly schedule’s “Out” slot until highlighted.

**Step 2**
Click and drag the link wire from the weekly schedule to the bottom of the target component, and release the mouse button.

A **Link** dialog appears. The source (left) side shows the schedule's Out slot preselected.

**Step 3**
In the target (right) side of the **Link** dialog, click on the desired slot of the target component.

**Note:** By convention, if linking to a priority array input of a writable point, “In16” is used for schedule level control. However, you can select any available level desired.

**Step 4**
With both source and target sides selected in the **Link** dialog, click **OK**.

The target point or component is now linked to the weekly schedule.

---

**To link a weekly schedule using the Nav tree**

Often, a weekly schedule is in a different container than the target component. In this case, the easiest way to link is using the Nav tree.

**Step 1**
Expand the Nav tree to locate the source weekly schedule, noting its name.

**Step 2**
Right-click the weekly schedule. From the **popup** menu select **Link Mark**.

**Step 3**
Expand the Nav tree to locate the target component.

**Step 4**
Right-click the target component. From the **popup** menu select **Link From "<weekly schedule name>"**.

A **Link** dialog appears.

**Step 5**
In the source (left) side of the **Link** dialog, click the schedule's “Out” slot.

**Step 6**
In the target (right) side of the **Link** dialog, click the desired slot of the target component.

**Note:** By convention, if linking to a priority array input of a writable point, “In16” is used for schedule level control. However, you can select any available level desired.

**Step 7**
With both source and target sides selected in the **Link** dialog, click **OK**.

The target point or component is now linked to the weekly schedule.

---

**Linking trigger schedules**

You can link the output (Trigger slot) of a TriggerSchedule to an action (or topic) of any component (point or extension) with such a slot. For example, you might link a trigger schedule to the “ResetChangeOfStateCount” action of a DiscreteTotalizerExt child of BooleanPoint.

**Note:** Often, you link trigger schedules to point extensions, not directly to a parent container point or component. In this case, before linking you could first composite the target container component, selecting to expose the extension's action up in the parent point. Although optional, this can help reusability and link clarity. For details, see “About composites” on page 3-21.

**Note:** Target actions or topics, unlike target property slots, can accept multiple link sources. In some cases, you may wish to link the “Trigger Missed” slot of the trigger schedule to the same target. For details, see “Trigger Missed slot” on page 8-22.

You can use either of these methods to link trigger schedules:

• To link a trigger schedule using the wire sheet
• To link a trigger schedule using the Nav tree

**To link a trigger schedule using the wire sheet**

To link a trigger schedule to a component *in the same wire sheet*, do the following:

**Step 1**
In the wire sheet, mouse over the trigger schedule's “Trigger” slot until highlighted.

**Step 2**
Click and drag the link wire from the trigger schedule to the bottom of the target component, and release the mouse button.

A **Link** dialog appears. The source (left) side has the trigger schedule's Trigger slot preselected.

**Step 3**
In the target (right) side of the **Link** dialog, click on the desired slot of the target component.

**Step 4**
With both source and target sides selected in the **Link** dialog, click **OK**.
The target component (point or extension) is now linked to the trigger schedule.

**To link a trigger schedule using the Nav tree**

Often, a trigger schedule is in a different container than the target component. In this case, the easiest way to link is using the Nav tree.

**Step 1** Expand the Nav tree to locate the source trigger schedule, noting its name.

**Step 2** Right-click the trigger schedule. From the **popup** menu select **Link Mark**.

**Step 3** Expand the Nav tree to locate the target component. (In some cases, the target may be an extension of a point or other component.)

**Step 4** Right-click the target component. From the **popup** menu select **Link From “<target schedule name>”**.

A **Link** dialog appears.

**Step 5** In the source (left) side of the **Link** dialog, click the trigger schedule’s “Trigger” slot.

**Step 6** In the target (right) side of the **Link** dialog, click the desired **action** of the target component.

**Step 7** With both source and target sides selected in the **Link** dialog, click **OK**.

The target component (point or extension) is now linked to the trigger schedule.

**Importing schedules**

If the station is part of a multi-station NiagaraAX network, you can import NiagaraAX schedule components between stations. You do this using the NiagaraAX driver architecture, specifically, views of the **Schedules extension** under a NiagaraStation (device-level) component.

If the Bacnet driver is used, you can also import BACnet Schedules and Calendars (as NiagaraAX schedule components) from a BACnet device. The same basic architecture and methods are used.

**Note:** Under a BacnetNetwork, you can also export NiagaraAX schedules to a specific BACnet device (to configure existing BACnet Schedules and Calendar objects).

For a brief overview, see “Schedule exports and imports (master/slave)” on page 8-4. For more complete details, refer to the **Drivers Guide**, in sections “About the Schedules extension” and “Station Schedules import/export notes”.

**Importing NiagaraAX schedules or Bacnet Schedules**

Often, you import a NiagaraAX schedule when working in a JACE station, where the source (master) schedule resides in a remote Supervisor station. BACnet Schedules and Calendars are also typically imported into a JACE station (unless a BACnet Supervisor).

**To import a NiagaraAX schedule or BACnet Schedule or Calendar**

To import a NiagaraAX schedule or BACnet Schedule or Calendar, do the following:

**Step 1** In the Nav tree, expand the **Drivers** folder of the station to receive the imported schedule.

**Step 2** Expand the network, either **NiagaraNetwork** or **BacnetNetwork**.

**Step 3** Expand the device that contains the source schedule (**NiagaraStation** or **BacnetDevice**). In the Nav tree, the device’s children include: Points, Histories, Alarms, and Schedules.

**Step 4** Double-click **Schedules**. The Niagara or Bacnet Schedule Import Manager displays. Any existing schedules (already imported) from this device are listed.

**Step 5** Click **Discover**. The manager view splits into two panes and a schedule discovery job is started. When complete, schedules available for import appear in the top pane.

**Step 6** In the top pane, click to select one or more schedules, then click **Add**. An **Add** dialog allows you to edit the name of the schedule (as it appears in this station) and several other properties. Refer to the section “Schedule Import properties” in the **Drivers Guide** for details.

**Step 7** After editing name and properties to suit, click **OK**. NiagaraAX schedule components are created for the selected items, reside under that device’s Schedules extension. You can link into station logic like any other schedules, but cannot configure these imported schedules (add, delete, or change events or other properties).
About Workbench tools

This section describes some of the standard “tools” available in Workbench. These tools provide Workbench interfaces that are designed to facilitate specific tasks – from managing credentials to monitoring alarms. All of the tools described in this section are available from the Tools menu. However, as shown in Figure 9-1, navigational links to some of the tools also appear in the nav side bar and in the nav container views.

**Note:** The nav side bar and nav container views do not display the tool icons until you initially open them using the Tools menu.

**Figure 9-1  Workbench tools**

Some, but not all of the tools that are available under the Tools menu appear in the nav side bar when you select them. When you first open Workbench, the “My Tools” node will not be present in the nav tree. Therefore, if you configure a tool, such as the BACnet service tool, all the configuration data will be lost when you close the current session of Workbench. Tools, such as the Alarm Portal, BACnet service, Lonworks service, and the Workbench Job Service are available in Workbench when you do not have a station open. This is provided as a convenience and may only be useful in a limited number of situations. For example, you would probably more typically use the Job Service, BACnet service, and Lonworks Service under the “Services” node of a specific station.

Refer to “Types of Workbench Tools” for a list of the tools that are available from the Tools menu.

**Types of Workbench Tools**

The following tools are available in Workbench:

- **Alarm portal**
  Explains the options that appear in the alarm portal. Refer to “Alarm portal” on page 9-2.

- **Bacnet service**
  Explains the options that appear in the Bacnet service. Refer to “Bacnet service” on page 9-4.

- **Color chooser**
  Explains the options that appear in the color chooser. Refer to “Color chooser” on page 9-4.
• **Lexicon editor**
  Explains the options that appear in the lexicon editor. For more details, see "Lexicon editor" on page 9-5. For information about the lexicon installer, refer to the "Lexicon Installer" section of the Platform Guide.

• **Local license database**
  Explains the Workbench License Manager view. Refer to "Local license database" on page 9-8.

• **Lonworks service**
  Explains the options that appear in the lonworks service manager. Refer to "Lonworks service" on page 9-10.

• **Lon Xml Tool**
  Describes the Lon Xml Create view. Refer to "Lon Xml Tool" on page 9-9.

• **Manage Credentials**
  Explains the options that appear in the credentials manager. Refer to "Credentials manager" on page 9-10.

• **New driver wizard**
  Explains the options that appear in the new driver wizard. Refer to "New driver wizard" on page 9-11.

• **New module wizard**
  Explains how to modify the attributes of a new module. Refer to "New module wizard" on page 9-11.

• **New station wizard**
  Explains the options in the new station wizard how to change the default attributes of a new station. Refer to "New station wizard" on page 9-12.

• **Request license**
  Explains the options that appear in the license request dialog box. Refer to "Request license" on page 9-12.

• **Resource estimator**

• **Sedona Installer**
  Provides a wizard to install a “Sedona bundle” distribution, which enables Workbench to work with Sedona powered devices, including integration into NiagaraAX stations.
  **Note:** Future document revisions will cover Sedona-enabled Workbench topics, including this installer. Note that if a Sedona bundle is installed, additional Workbench tools (views) related to Sedona will also be available. These tools include a Jennic Serial Port Tool, New Jennic Wireless Adapter, and Sedona Manifest Manager. Again, these tools will be covered in future Sedona-related documents.

• **Time Zone Database Tool**
  Provides ways to explore the contents of the local timezones.jar available to Workbench (if a station is running locally, say on a Supervisor, it uses these time zone definitions as well). Refer to "Time Zone Database Tool" on page 9-14.

• **Todo list**
  Explains the options that appear in the todo list dialog box. Refer to "Todo list" on page 9-15.

• **Workbench job service**
  Explains the options that appear in the Workbench job service view. Refer to "Workbench job service" on page 9-15.

• **Workbench service manager**
  Explains the options that appear in the service manager screen. Refer to "Workbench service manager" on page 9-16.

### Alarm portal

The alarm portal tool allows you to view and acknowledge alarms from many different stations using a single viewer (portal). The alarm portal, shown in Figure 9-2, is divided into two resizable panes, and a set of buttons along the bottom of the alarm portal window: You can add alarm consoles from different stations by right-clicking in the Alarm Console Monitor (top pane) and choosing the Add Alarm Console menu selection to initiate the Add Alarm Console wizard.

From the Alarm Portal, double click on any alarm listed in the Open Alarm Sources pane to see the Alarm Details dialog box and the alarm record dialog box, as described in “About the alarm console” on page 5-37.
• Alarm Console Monitor
This pane displays information about the consoles that are being monitored and contains the following information areas:
  • Title bar
    Displays “Alarm Console Monitor” title on the left and the number of consoles that are connected to the alarm portal on the right side of the title bar.
  • Column headings
    Displays the title of each of the columns that are displayed in the alarm console monitor.
  • Alarm console list
    Each row in the alarm console listing contains information about alarm consoles that are currently listed as available to monitor from the alarm console. Station identity information is displayed, as well connection status (connected or disconnected) and connect and disconnect times.

• Open Alarm Sources
This pane displays information about individual alarm sources, as described below. If you double-click on a single alarm source, the Open Alarm Sources view opens. This view is described in "About the alarm console" on page 5-37.
  • Title bar
    Displays “Open Alarm Sources” title on the left and the total number of points that are displayed in the list on the right side of the title bar.
  • Column headings (click column heads to sort)
    Displays the title of each of the columns in the open alarm sources list, as follows:
    - Timestamp displays the latest time that the point generated an alarm.
      - Source State displays the current state of the point (for example, Normal or Offnormal).
      - Ack State displays how many alarms have been generated at the point and how many of those alarms have been acknowledged.
      - Ack Required displays "true" or "false" indicating that an acknowledgement is or is not required for that alarm.
      - Source displays the path to the point that is generating the alarm.

• Alarm portal buttons
  • Acknowledge
    Acknowledges all alarms at the selected source when an alarm is selected in the alarm source pane.
  • Hyperlink
    is active when an alarm extension property (refer to “About alarm extension properties” on page 5-3) is set to allow hyperlinking. When clicked, displays the alarm source.
  • Notes
    displays a dialog box that allows you to add notes to an alarm record (see “About the console recipient” on page 5-36 for more details about alarm record notes).
  • Silence
when clicked, this button quiets the alarm sound for the selected point.

- **Filter**
  displays the alarm filter dialog box for limiting the alarms that are displayed. See "About the alarm console" on page 5-37 for more details about the alarm filter dialog box.

The alarm portal tool, when enabled, also places the alarm icon in your system tray and an alarm popup window, as shown in Figure 9-3.

You can set options for the alarm portal in the Tools Options menu, as described in "Alarm portal options" on page 2-28

**Figure 9-3  Alarm portal popup window**

![Alarm portal popup window](image)

---

**Bacnet service**

Figure 9-4 shows an example of the Bacnet service property sheet. Select Tools > BACnet Service from the Workbench main menu to add this service to the "My Tools" node of the nav tree. The default view is the property sheet view.

**Figure 9-4  Bacnet service property sheet view**

![Bacnet service property sheet view](image)

**Note:** You can use this Workbench Tools service to configure a local Bacnet device in the same way as you would under a station, as described in the Bacnet Guide. However, any configuration that you do using the Workbench Bacnet Service (under the "My Tools" node) will be lost when you close Workbench. Use Bacnet Service under a station to save your Bacnet Service settings to a database.

Refer to the Bacnet Guide for a detailed description of the Bacnet service.

---

**Color chooser**

Figure 9-5 shows an example of the color chooser dialog box. This tool allows you define and save custom colors or use the default colors provided. You can add custom colors to your custom color palette located in the lower left area of the color chooser tool. Your custom color settings will then be available in other tools, such as the Px Editor.
Lexicon editor

For general information on lexicons, see “About lexicons” on page 1-19. For details on installing (edited) lexicons in remote JACE platforms, see the Platform Guide section “Lexicon Installer.”

For information about using the lexicon editor tool refer to the following sections:

- Lexicon Report view
- Lexicon Editor view
- Lexicon display options
- Notes on English (en) lexicon usage

Lexicon Report view

When selecting the lexicon editor from the Tools menu, the default view is the “Lexicon Report,” as shown in Figure 9-6. The left side of this view lists all lexicons (/lexicons/lexiconDir) installed on your PC. Each lexicon (and its directory) is typically known by a two-letter name, such as “de” for German or “fr” for French. As needed, you click a lexicon to select it.

Note: To initially view the default English lexicon in the Lexicon Report view, click the New Lexicon button and type in “en” in the text field of the New Lexicon dialog box. Click the Ok button and the lexicon appears in the Lexicon Report view. After this initial display, the “en” name is always listed in the lexicon pane unless you use the Delete Lexicon button to remove it.
Selecting a lexicon in report view shows various status parameters about each lexicon (broken down by module) in columns on the right side. These status parameters include the following:

- **Module**
  Each Niagara module that contains a lexicon file (moduleName.lexicon).

- **Module Last Modified**
  Timestamp of when the lexicon in the module (JAR file) was last modified.

- **Missing**
  Number of keys that are missing values (in the lexicon for that module).

- **Lexicon Last Modified**
  Timestamp of when any lexicon file (!lexicons/lexiconDir/mODULENAME.lexicon) for the selected lexicon was last modified. This field is blank if there is no lexicon file for that module. However, you can still edit that module’s lexicon and Save, which creates the lexicon file and updates this timestamp field.

  **Note:** Check boxes at the top of report view allow you to "hide" values that could affect "missing" status counts, as described in "Lexicon display options".

From this view you can also add (new) lexicons or delete unwanted lexicons. In addition, you can launch the Lexicon Editor view by clicking any module row, which shows that lexicon file.

**Lexicon Editor view**

The lexicon editor lets you view and edit the contents of a module’s individual lexicon for a lexicon installed on your Workbench PC. Typically, you access the editor from the Lexicon Report view view with a lexicon selected, by double-clicking a selected row on the right side.
A lexicon in the lexicon editor shows a table listing all defined keys for that module, with columns for mapping to a localized value, as follows:

- **Key**
  - Niagara interface entity, constant in that module from lexicon to lexicon.
- **Default**
  - Default character value, used if no value is defined for that key (English equivalent).
- **Value**
  - Localized character value.

**Note:** Check boxes at the top of report view allow you to “hide” values that could affect “missing” status counts, as described in “Lexicon display options”.

As needed, you can resort columns to find information needed, and simply click any row to select that key. At the bottom of the editor, a Value edit field allows modifying (or adding) a value to the currently selected key.

### Lexicon display options

Both lexicon views (Lexicon Report view and Lexicon Editor view) use a type of tabular presentation with the standard table features and options, as described in “Table controls and options” on page 2-18. Lexicon-specific controls and options are displayed at the top of both the Lexicon Editor and Lexicon Report. These controls and options are shown in Figure 9-8 and described below:

**Figure 9-8**  Lexicon display options

- **Hide Ords**
  - If enabled, it filters out any referenced based entries, such as `modules://icons/x16/alarm.png`
- **Hide Accelerators**
  - If enabled, it filters out entries that define keyboard accelerators.
- **Hide Colors**
  - If enabled, it filters entries that define colors, such as those defined by hexadecimal code `#FFFF0000`.
- **Hide Fonts**
  - If enabled, it filters entries that define fonts.

In addition, on the **Lexicon Editor**’s pull-down menu, there are two “Show Only” settings, as shown in Figure 9-9 and described below. You can clear both of these, but set only one “Show Only” option.

**Note:** The two “Show Only” settings are mutually exclusive.

**Figure 9-9**  Lexicon Editor menu bar “Show” options

- **Show Missing Only**
  - This shows only entries without any assigned values—entries will be the “red” orb ones only.
- **Show Completed Only**
  - This shows only entries that do have assigned values—entries will be the “green” orb ones only.

**Note:** The default settings for these display options are set in the Options dialog box, as described in “Lexicon editor options” on page 2-28. However, these controls allow you to override those Workbench defaults.

### Notes on English (en) lexicon usage

An important use of lexicons is for non-English language support. However, you can also modify the English (en) lexicon to provide a “global default” change for display of items seen in workbench, or served by a running station to client web browsers. This could be a possible alternative to working from the slot...
sheet for multiple points to make the same type of interface or "display name" change (for related details, see "Modifying default actions" on page 3-5), or from making similar changes using the Batch Editor view of the ProgramService.

The English language serves as the default Workbench lexicon. As such, it is not included as a separate lexicon "en" distribution subfolder with module.lexicon files. However, using the Lexicon Editor view in Workbench you can still edit and add lexicon keys in different modules for English usage. These act as "default overrides", saved as module.lexicon files under an !lexicon/en folder. After restarting Workbench, such changes are used when opening any station (including one on your Workbench PC, if applicable). Typically, you also install this modified en lexicon into remote JACE platforms, such that stations running on them serve up the same changed descriptions to browser clients.

**Example edit of the English (en) lexicon**

This example shows how to change the default right-click descriptors for actions "active" and "inactive".

To edit the English (en) lexicon:

**Step 1** From the Tools menu, select Lexicon Editor.
The Lexicon Report view (Figure 9-6) displays all lexicons currently installed.

**Step 2** If an "en" lexicon is not listed in the left pane, click the New Lexicon button at the bottom.
An en entry is added to the list of lexicons.

**Step 3** Select the "en" lexicon, which populates the right pane with the different modules in which you can change or add lexicon keys.
In this example, you need to work in the control module.

**Step 4** Double-click the control module, to load a list of existing key-value pairs in the Lexicon Editor.
By default, there are no existing keys shown for actions active and inactive, so they must be added.

**Step 5** Select the "Add New Key" check box at the bottom far right in the view, which enables the Key field.

**Step 6** Type the slot name in the Key field (in this case, type slot name active), and in the Value field type in the desired text, for example: ON manual
Click the Change button to add the new key-value pair.

**Step 7** Repeat the previous step to add another key-value pair, editing text in the Key field to: inactive and editing the desired text in the Value field, for example: OFF manual
Deselect the "Add New Key" check box after adding this second key-value pair.

**Step 8** Click the Save button on the toolbar when done with lexicon changes for this module.
This creates (or updates) a lexicon file under your !lexicons/en folder, here control.lexicon.
In this example, after restarting Workbench, when you open a station and right-click a writable point to issue actions, the new default values (ON manual and OFF manual) will replace the old defaults (Active and Inactive).

**Note:** If working on a Supervisor (hosting a station), note that following a station restart, such lexicon changes become effective defaults to web browser clients connecting to the station.

**Note also that any "display name" changes for slots on a component override any lexicon values, including any modified in this manner. For example, if a BooleanWritable has the Display Name of its "active" action slot edited to "Start Pump", that command text will always appear when issuing this action, whether from client browser access or from Workbench access.

---

**Local license database**

Starting in AX-3.3, the Workbench License Manager view is available via the Workbench Tools menu, by selecting Local License Database.
As shown in Figure 9-10, this view lets you browse and manage the contents of your “local license database.”

This view provides a two-pane window into all the license files and parent “host ID” folders, where:

- Left pane provides tree navigation, where you can expand folders and click (to select) license files.
- Right pane shows the text contents of any selected license file.

Buttons at the bottom of this view provide a way to manage the contents of your local license database, and are described as follows:

- **Import File**
  Always available, this allows you to add license file(s) from a local license file or license archive (.lar) file.

- **Export File**
  Always available, this allows you to save all licenses (or any selected licenses) locally, as a license archive file.

- **Delete**
  This allows you to delete licenses from your Workbench local license database.

- **Sync Online**
  Typically available if you have Internet connectivity. This lets you update all licenses (or any selected licenses) in your local license database with the most current versions, via the online licensing server.

**Note:** For more complete details about the license database, see “Workbench license manager” in the NiagaraAX-3.x Platform Guide.

### Lon Xml Tool

The **Lon Xml Tool** is available from the Tools menu. The Lon Xml Create view helps you make your own Lon XML (.lnml) file for a device, using the source .xif file and (if necessary) other resource files, as available from the device’s manufacturer. The tool’s dialog (Figure 9-11) provides the necessary input fields.

**Figure 9-11  Lon Xml Create tool view**
Lonworks service

The Lonworks Service is applicable if your Workbench PC has a Lonworks adapter. You can view it by selecting Lonworks Service from the Tools menu. It provides the identical "LonNetwork" access as if you had a local (PC) station running (Figure 9-12).

Figure 9-12  Lonworks Service tool in Workbench

For example, you can use the Lon Device Manager to discover, add, and upload Lon devices, examine nvs and ncis as LonComponents, and even perform writes and do other configuration (make bindings between devices, commission devices, etc.).

Caution  Any configuration you perform is not stored (persisted) in a station database, as this is "station-less" access (modeled completely in RAM). When you close Workbench, all modeling is lost—consider the Lonworks Service like a "hand held device" in this respect.

For this reason, do not use this tool to access a Lonworks network already managed by a station, but instead open that station, and access its LonNetwork.

Refer to the NiagaraAX-3.x Lonworks Guide for more details.

Credentials manager

The Manage Credentials tool, or "Credentials Manager" provides a dialog box to access and open any previously "remembered" (cached) connections from your Workbench, including both platform and station connections.

Figure 9-13  Manage Credentials dialog (credentials manager)
You can also remove or reset any cached credentials. Note that your credentials cache is populated whenever you have the login (Authentication) dialog option “Remember these credentials” (check box) enabled, as shown in Figure 9-13. For any initial platform or station connection, this option is enabled by default.

**Figure 9-14**  Authentication defaults (Remember credentials)

The default caching of credentials is a convenience feature, such that you can simply open the platform or station later by entering only the IP address, or simply clicking on that host’s dimmed platform or station in the Nav tree of Workbench, or going to the credentials manager. Then, the login authentication dialog (Figure 9-14) has the cached credentials already entered, and you simply click OK.

If you want tighter security for any platform or station connection from your Workbench PC, you should clear this check box whenever opening (logging on) a platform or station. Furthermore, you should remove any related entries using the credentials manager (Figure 9-13). This way, that platform or station connection always requires full entry of both user name and password.

**New driver wizard**

The New Driver Module Wizard is available when you select Tools > New Driver from the main menu. The first of four wizard dialog boxes is in Figure 9-15.

**Figure 9-15**  New driver wizard

This wizard is provided as a convenient way to perform some of the steps necessary for creating a driver module. The four wizard dialog boxes allow driver developers to specify some basic driver module options and finish with the wizard creating a set of folders and files under a station directory that you assign during the wizard process. Also see the NiagaraAX-3.x Developer Guide for more detailed information about building modules.

**New module wizard**

The new module wizard is available when you select it from the Tools > New Module from the main menu. The wizard presents a series of dialog boxes, as shown in Figure 9-16, that help you create and save a new module.
This wizard creates a set of folders and files under a station directory that you assign during the wizard process. After creating these files, you need to finish the process, as described in “Working with modules” on page 10-27. Also see the NiagaraAX-3.x Developer Guide for more detailed information about building modules.

New station wizard

The new station wizard is available when you select Tools > New Station from the main menu. The wizard presents two dialog boxes, as shown in Figure 9-17, that help you create and save a new station.

New Station Wizard fields include the following:

- **Station Name**
  This name is the name that is assigned to your station. The station folder will have this name.

- **Station Directory**
  This read-only field specifies the location where the station folder is created (under the “Stations” folder).

- **Admin Password**
  This field allows you to assign an administrative level password for the station. You must type in the password again in the Confirm Password field.

- **Fox Port**
  This field allows you to assign a port for Fox communications. The default port is port 1911.

- **HTTP Port**
  This field allows you to assign a port for HTTP communications. The default port is port 80.

Request license

The “Request License” item on the Workbench Tools menu (Figure 9-18 on page 13) simply opens a “license request form” in your Workbench PC’s default browser. By default, the only pre-filled field in this form is the host ID of your Workbench PC. See Figure 9-18.

Typically, your Workbench PC is already licensed. Otherwise, you would not be able to successfully start Workbench, and then select Request License from the “Tools” menu.
However, you could use this as a quick method to request a license for another PC on which you have installed NiagaraAX. In that case, you could substitute (type in) the host ID for the other PC in this form, along with other pertinent information.

Note: For more information about the licensing, see “Appendix A. License Tools and Files” in the NiagaraAX-3.x Platform Guide.

**Figure 9-18** License request form in browser (from Workbench, Tools > Request License)

### Resource estimator

The resource estimator tool is available from the **Tools** menu. Use it as a worksheet to help you estimate the total number of station resources that you will use in a projected station implementation. The resource estimator view is as shown in Figure 9-19.

**Figure 9-19** Resource estimator view
Time Zone Database Tool

The Time Zone Database Tool, available since AX-3.5, provides several ways to explore the local timezones.jar on the Workbench host. This jar file is the "historical time zone database".

If the Workbench host is running a station (e.g. is a Supervisor), this is also the time zone database used by that station. Using this tool, you can see what time zones are available, see the past and current behaviors for any time zone, and in some cases the future behaviors as well.

**Note:** For additional time zone details, refer to the Platform Guide appendix “Time Zones and NiagaraAX”.

**Figure 9-20  Time Zone Database Tool in Workbench AX-3.5 or later**

As shown in Figure 9-20, the Time Zone Database Tool has four available tabs.

- **Manifest Info**
- **Time Zone Database**
- **Daylight Savings Time Calculator**
- **Time Zone Calculator**

**Manifest Info**

This tab in the Time Zone Database Tool shows you the timezone.jar file version, and which "Olsen Time Zone DB" version the file is based upon. The “Min Year” says how far back historically time zones are guaranteed to behave correctly. Conversely, “Max Year” is how far forward behavior should be correct.

The main view is a tabbed breakdown of all time zone definitions by world region, where the list of time zones in each region is listed alphabetically.

**Time Zone Database**

This tab in the Time Zone Database Tool lets you see how any selected time zone behaves.

**Figure 9-21  Time Zone Database tab in Workbench Time Zone Database Tool**

For example, what is the current time? (note that a refresh is required for update)
Is this a "historical zone"? (meaning have time zone “rules” changed for this zone at some point?) Note that if “Yes”, there will be multiple “era” tabs in the lower definition area, each with the parameters for things like UTC offset, DST (daylight savings time) changeover, and so on—specific to that time era.

**Daylight Savings Time Calculator**

This tab in the Time Zone Database Tool shows when the DST changeover occurs for any year.

**Figure 9-22  Daylight Savings Time Calculator tab in Workbench Time Zone Database Tool**

To use, select a time zone and type in a year in the *Year* field. Press Enter to update the “DST Starts” and “DST Ends” time fields.

**Time Zone Calculator**

This tab in the Time Zone Database Tool lets you compare the time between any two time zones.

**Figure 9-23  Time Zone Calculator tab in Workbench Time Zone Database Tool**

To use, select a source time zone and a target time zone, and specify a source time (initial default is the current time).

**Todo list**

The todo list is available when you select it from the Tools menu. This tool is provided to help you with organizing, prioritizing and tracking tasks in Workbench. The Todo list view is shown in Figure 9-24.

**Figure 9-24  Todo list view**

The Todo list is a tabular view with standard table controls and options, as described in “Table controls and options” on page 2-18. You can use this tabular list to create new lists or edit, group and rearrange existing lists and items in your lists. In addition, you can use the filter fields at the top of the display to filter what you see in the table, based on your summary description or group.

**Workbench job service**

The Workbench job service view, shown in Figure 9-25, is available when you select it from the Tools menu. This job service tool keeps track of all Workbench jobs—these are jobs that are not initiated under a specific station, but initiated by the Workbench environment.
**Figure 9-25**  Job service nav tree and property sheet view

Note: Workbench jobs are jobs that are initiated and run under the Workbench - not under a station. Jobs that are run under a station are monitored and displayed in the Station Job Service (under the station Services node in the nav side bar).

**Workbench service manager**

The service manager view is available when you select it from the **Tools** menu. The service manager view, shown in Figure 9-26, is used to manage the life cycle and configuration of all services.

**Figure 9-26**  Workbench service manager view

The Workbench service manager is a tabular view with standard table controls and options, as described in “Table controls and options” on page 2-18. From this view you can Start, Stop, or configure any of the listed services to Auto-Start.
Performing Workbench tasks

Workbench provides a complete user interface to the Niagara Framework. It can directly access a station and perform any action that the system supports. You can view and control any component using any of the supported views.

Common Workbench tasks include the following:

- Starting and exiting Workbench
- Getting started with stations
- Using the side bar pane
- Using bookmarks
- Using the help side bar
- Using the nav side bar (tree)
- Using the palette side bar
- Using the view pane
- Editing components
- Using alarms
- Creating a Live History Chart
- Using the Px Editor
- Using the Nav File Editor
- Working with modules

Starting and exiting Workbench

Tasks involved with starting and exiting Workbench, include the following:

- To start Workbench
- To close a Workbench window
- To exit Workbench

To start Workbench

To start Workbench do one of the following:

- From the Windows Start menu, choose Programs > Niagara 3.x.xx > Workbench. The Workbench GUI will appear.
- From a console command line, type wb.
  
  Note: If you use a DOS command line, instead of the Niagara command line, you must type the full path to the workbench directory.

  The Workbench GUI will appear. For more information about the console, see "About the console" on page 2-13.

To close a Workbench window

Note: Closing all Workbench windows will exit the Workbench GUI.

To close a Workbench window do one of the following:

- From the File menu, select the Close command.
  
  The Workbench window will close.
- From the Niagara Workbench menu (located in the top left corner of the window title bar), select the Close command.
  
  The Workbench window will close.
- Click the close icon (located in the top right corner of the window title bar).
The Workbench window will close.

**To exit Workbench**
You can exit Workbench by using the Exit command (which will close all Workbench windows) or by closing all Workbench windows.

To exit Workbench, do one of the following:
- From the File menu, select the **Exit** command. The Workbench GUI will close.
- Close all Workbench windows. The Workbench GUI will close when the final Workbench window is closed.

## Getting started with stations

In order to communicate with a station, the station must be running and accessible. The following procedures provide information about basic tasks that are required to start, stop, and communicate with stations:

- To open a platform using Workbench GUI
- To connect to a platform using Workbench GUI
- To close a platform using Workbench
- To disconnect from a platform using Workbench
- To start a station using Workbench
- To stop a station using Workbench
- To open a station
- To close a station using Workbench
- To connect to a station using Workbench
- To disconnect from a station

### To open a platform using Workbench GUI

To open a platform, do the following:

**Step 1**
- From the menu bar, select File > Open > Open Platform.
  The Open Platform dialog box appears.

**Step 2**
- Complete the fields in the Open Platform dialog box as follows:
  - **Host**
    Select the IP or dialup option and type in the address of the computer that is running the platform that you wish to access.
  - **Port**
    Select the IP or dialup option and type in the address of the computer that is running the platform that you wish to access.
  - **Password**
    Select the IP or dialup option and type in the address of the computer that is running the platform that you wish to access.
  - **Remember these credentials**
    Select the IP or dialup option and type in the address of the computer that is running the platform that you wish to access.

- Click the OK button to accept all settings.
  The platform opens with the Nav Container View displaying in the view pane.

### To connect to a platform using Workbench GUI

**Note:** You cannot connect to a platform unless it is "open". An open platform may be visible in your Workbench nav side bar, but appear dimmed. If there is no platform icon in the nav side bar, you need to open the platform before connecting (see "To open a platform using Workbench GUI" on page 10-2).

To connect to a platform, do the following:

**Step 1**
- In the nav side bar (refer to "Using the nav side bar (tree)" on page 10-8, if necessary) right–click on the platform icon and select the **Connect** command from the popup menu.
  The Authentication dialog box appears.

**Step 2**
- Enter the credentials information as follows:
Note: Be sure to use the correct platform username and password – not the credentials information for the station.

- **Username**
  Enter the username for the platform.

- **Password**
  Enter the password for the platform.

- **Remember these credentials option**
  Select the “Remember these credentials” option if you want to have Workbench remember the platform username and password for this platform.

**Step 3**

Click OK to accept all settings.

If the platform credentials were correct, the platform is connected, the platform icon appears in the side bar pane and the default Nav Container View appears in the view pane. If the platform credentials were not correct, you are prompted to enter them again.

---

**To close a platform using Workbench**

To close a platform, do the following:

**Step 1**

In the nav side bar (refer to “Using the nav side bar (tree)” on page 10-8, if necessary) right–click on the platform icon and select the Close command from the popup menu.

The Close dialog box appears.

**Step 2**

In the Close dialog box, click OK to close the platform.

The platform is closed and the platform icon is removed from the nav side bar.

---

**To disconnect from a platform using Workbench**

To disconnect from a platform, do the following:

**Step 1**

In the nav side bar (refer to “Using the nav side bar (tree)” on page 10-8, if necessary) right–click on the platform icon and select the Disconnect command from the popup menu.

The Disconnect dialog box appears.

**Step 2**

In the Disconnect dialog box, click OK to disconnect.

The platform is disconnected and the platform icon is dimmed.

---

**To start a station using Workbench**

Note: Most station–platform functions can be performed from the Application Director (Station Director, NiagaraAX-3.2 and earlier) view of a platform, however, you must connect to the platform where a station is hosted before you can perform these tasks.

To start a station using Workbench, do the following:

**Step 1**

Connect to the station's platform (see "To connect to a platform using Workbench GUI" on page 10-2 for details, if necessary).

**Step 2**

In the nav side bar, expand the platform node in the nav tree by clicking on the plus sign (+) next to the platform icon in the tree.

The contents of the platform node displays in the tree.

**Step 3**

In the nav side bar, double click on the Application Director icon (Station Director, NiagaraAX-3.2 and earlier).

The Application Director view appears in the view pane.

**Step 4**

In the Application Director view, select the desired station.

The desired station is highlighted in the table region of the view pane.

**Step 5**

In the Application Director view, select the following options, as desired:

- Select the Auto-Start option if you want the station to automatically start any time the station host computer is re-booted. Clear the Auto-Start option to disable auto-start.
- Select the Restart on Failure option if you want the station to automatically attempt a restart any time it fails. Clear the Restart option to disable automatic restart.

**Step 6**

In the Application Director view, do one of the following:

- Select the desired station in the station table and click Start.
- Right click the desired station in the station table and select Start from the popup menu.

The station starts.
To stop a station using Workbench

**Note:** Most station–platform functions can be performed from the Application Director (Station Director, NiagaraAX-3.2 and earlier) view of a platform, however, you must connect to the platform where a station is hosted before you can perform these tasks.

To stop a station using Workbench, do the following:

**Step 1** Connect to the station’s platform (see “To connect to a platform using Workbench GUI” on page 10-2 for details, if necessary).

**Step 2** In the nav side bar, expand the platform node in the nav tree by clicking on the plus sign (+) next to the platform icon in the tree.

   The contents of the platform node displays in the tree.

**Step 3** In the nav side bar, double click on the Application Director icon.

   The Application Director view appears in the view pane.

**Step 4** In the Application Director view, select the desired station.

   The desired station is highlighted in the table region of the view pane.

**Step 5** In the Application Director view, do one of the following:

- With the desired station selected station table, click **Stop**.
- Right click the desired station and select **Stop** from the popup menu.

   The station stops.

To open a station

To open a station, do the following:

**Step 1** From the **File** menu, select Open > Open Station (Fox)

   The **Open Station** dialog box appears.

**Step 2** Enter the host and credentials information as follows:

   **Note:** Be sure to use the correct station username and password – not the credentials information for the platform.

   - **Host [connection type]**
     Select the IP option if you are using an IP connection to connect to the station.
     Select the dialup option if you are using a dialup connection to connect to the station.
   - **Host [ID]**
     Enter the Host ID (if necessary) or select it from the dropdown menu, if available.
   - **Port**
     Enter (or change, if necessary) the Port port number that you will use to connect.
   - **Username**
     Enter the username for the station.
   - **Password**
     Enter the password for the station.
   - **Remember these credentials option.**
     Select the “Remember these credentials” option if you want to have Workbench remember the station username and password.

**Step 3** Click **OK** to accept all settings.

   If the station credentials were correct, then the station connects, the station icon appears in the side bar pane and the Nav Container View (or Station Summary View) appears in the view pane. If the station credentials were not correct, you are prompted to enter them again.

To close a station using Workbench

To close a station, do the following:

**Step 1** In the nav side bar (refer to “Using the nav side bar (tree)” on page 10-8, if necessary) right–click on the station icon and select the Close command from the popup menu.

   The **Close** dialog box appears.

**Step 2** In the **Close** dialog box, click **OK** to close the station.

   The station is closed and the station icon is removed from the nav side bar.
**To connect to a station using Workbench**

To connect to a station, do the following:

**Note:** You cannot connect to a station unless it is "open". An open station may be visible in your Workbench nav side bar, but it appears dimmed. If there is no station icon in the nav side bar, you need to open the station before connecting (see “To open a station” on page 10-4).

To connect to a station, do the following:

**Step 1** In the nav side bar (refer to “Using the nav side bar (tree)” on page 10-8, if necessary) right-click on the station icon and select the **Connect** command from the **popup** menu.

The **Authentication** dialog box appears.

**Step 2** Enter the credentials information as follows:

- **Username**
  Enter the username for the station.

- **Password**
  Enter the password for the station.

- **Remember these credentials option**
  Select the "Remember these credentials" option if you want to have Workbench remember the station username and password for this station.

**To disconnect from a station**

To disconnect from a station, do the following:

**Step 1** In the nav side bar (refer to “Using the nav side bar (tree)” on page 10-8, if necessary) right-click on the station icon and select the **Disconnect** command from the **popup** menu.

The **Disconnect** dialog box appears.

**Step 2** In the **Disconnect** dialog box, click **OK** to disconnect.

The station is disconnected and the station icon is dimmed.

**Using the side bar pane**

The side bar pane displays all open side bars. The pane may be shown or hidden by selecting a command from the Windows menu, as described in “To open the side bar pane” on page 10-5.

Following, are some facts about the behavior of side bars and the side bar pane:

- If you open a side bar, the side bar pane (if currently closed) will automatically open to display that pane.
- When you open Workbench, the side bar pane returns to its last previous state (displayed or hidden).
- When you show the side bar after all side bar panes have been closed (causing the side bar pane to hide) the side bar pane will be empty
- When you close all side bars, the side bar pane will close
- When you open Workbench, it will display the side bars that were open (if any) when the last session was closed.
- When more than one side bar is open in the side bar pane, side bars may be resized vertically, maximized, or restored to their previous size using the title bar controls.
- Side bars always expand to fill the side bar pane horizontally.

**To open the side bar pane**

To open the side bar pane, do the following:

- From the menu bar, select **Window > Side Bars > Show Side Bar** command.
  The side bar will appear.

**To open the bookmarks side bar**

To open the bookmarks side bar, do the following:

- From the menu bar, select **Window > Side Bars > Bookmarks**.
  The bookmarks side bar appears in the side bar pane.
To open the help side bar
To open the help side bar, do the following:
• From the menu bar, select Window > Side Bars > Help.
  The help side bar appears in the side bar pane.

To open the nav side bar
To open the nav side bar, do the following:
• From the menu bar, select Window > Side Bars > Nav.
  The nav side bar appears in the side bar pane.

To open the palette side bar
To open the palette side bar, do the following:
• From the menu bar, select Window > Side Bars > Palette.
  The palette side bar appears in the side bar pane.

To close a side bar
To close the side bar pane, do the following:
• From the side bar title bar dropdown menu (left side), select the Close command.
  The side bar pane closes.

To close the side bar pane
The side bar pane toggles on or off by selecting or deselecting the Show Side Bar command, as described below. The side bar pane also closes when all palettes are closed.

To close the side bar pane, do the following:
• From the menu bar, select Window > Side Bars > Show Side Bar.
  The side bar pane closes.

To vertically resize a side bar
To vertically resize a side bar, do the following:
• Click on the title bar and drag vertically.
  The side bar will adjust to any size that fits in the side bar pane.

To restore a side bar to a previous size
To restore a side bar to it's previous size, do the following:
• Click on the restore icon on the title bar.
  The side bar will change to its previous state.

To maximize a side bar
To maximize a side bar, do the following:
• Click on the restore icon on the title bar.
  The side bar will expand to its maximum size in the side bar pane.

Using bookmarks

Bookmarks are simply linked “shortcuts” or “favorites” to help you quickly find views in just a couple of clicks. The bookmark side bar provides a convenient place in the side bar pane to add, manage, edit, and remove bookmarks. You can also do these “bookmarking” tasks using the Bookmarks menu on the menu bar. For an overview of the bookmark side bar, see “About the bookmark side bar” on page 2-4.

This section describes the following tasks that are associated with the bookmark feature:
• To add a bookmark
• To manage bookmarks
• To edit a bookmark
• To remove a bookmark
To add a bookmark

To add a bookmark, do the following steps:

Step 1 Make sure that the view you want to bookmark is showing in the view pane, and then do one of the following:

- From the menu bar, select Bookmarks: Add to Bookmarks.
- From the popup menu in the palette side bar, select Add to Bookmarks.

Step 2 In the Add to Bookmarks dialog box, type a name for the bookmark, in the Name field.

Step 3 Optional: In the Add to Bookmarks dialog box, click the New Folder button to add a new folder, if desired.

The New Folder dialog box appears. There you can name your new folder and click OK to save it.

Step 4 In the Add to Bookmarks dialog box, select the folder where you want to locate the bookmark and click OK.

The bookmark is added.

To manage bookmarks

To manage your bookmarks, do the following steps:

Step 1 Do one of the following:

- From the menu bar, select Bookmarks: Manage Bookmarks.
- From the popup menu in the palette side bar, select Manage Bookmarks.

Step 2 In the Manage Bookmarks dialog box, click on one of the following buttons:

- New Folder buttons
  To create new folders to organize your bookmarks
- New Bookmark button
  To create new bookmarks
- Copy to button
  To copy bookmarks to another location
- Move to button
  To move bookmarks to another location
- Remove button
  To delete the selected bookmark
- Edit button
  To rename a selected bookmark
- Move Up or Move Down button
  To move bookmarks up or down in the bookmark tree view

To edit a bookmark

To edit a bookmark, do the following steps:

Step 1 In the bookmarks side bar, right-click the bookmark that you want to change and select Edit from the popup menu.

The bookmark Edit dialog box will appear.

Step 2 In the Edit dialog box, type the desired name for your bookmark in the Name field.

Step 3 In the Edit dialog box, type the ORD path or scroll Name field.

To remove a bookmark

To remove a bookmark, do the following:

- In the bookmarks side bar, right-click the bookmark that you want to change and select Remove from the popup menu.

The bookmark is deleted from the bookmark list.

Using the help side bar

When you open the help side bar for the first time, the help side bar is empty except for the Load Help button. The Load Help button will reappear any time any module's timestamp is changed or when a new module is added or removed. When you click the Load Help button, Workbench searches through all the available modules to create the help directory. The Help Sidebar provides a view of the available Help.
To search for topics in the help side bar:

After you enter one or more words in the Find window, pressing the Search button creates a list of documents that contain one or more occurrences of the words you have entered. The results show those document's containing any of the words, not all of the words. The ranking order is based on how many times any of the words appear in a given document.

To search for topics in the help side bar, do the following steps:

Step 1 In help side bar, click on the Search tab. The search display appears.
Step 2 In the Find field, type the word or phrase that you are looking for and click the Search button.
Topics that match your search word(s) will appear in side bar below the text field.
Step 3 Double-click on a topic to display the topic in the view pane.

Using the nav side bar (tree)

The nav side bar provides a hierarchical view of the system in a nav—tree presentation. Components that appear in the tree may be acted on in various ways depending the component type:

The following sections describe how to use Nav side bar actions and the following procedures:

• To refresh a nav side bar tree node
• To refresh a nav side bar tree node

Nav side bar actions

• Expand
  Click the plus sign next to an icon to expand a branch of the tree and show any child nodes.
• Collapse
  Click the minus sign next to an icon to collapse a branch of the tree.
• Select
  Click a node in the tree to select it.
• View
  Double—click the minus sign next to an icon to collapse a branch of the tree and hide its child nodes.
• Use popup menu
  Right—click the desired node to use the context—sensitive popup menu. Refer to "About the nav side bar popup menu items" on page A-9 for details about the nav side bar popup menu.
• Use file menu
  With a node selected, choose a menu item from the File menu. Refer to "About the File menu" on page A-2 for details about the file menu.

To refresh a nav side bar tree node

Refreshing a nav side bar tree node, updates the view to reflect any changes to the files of that node.

To refresh a nav side bar tree node, do the following steps:

Step 1 Click the node to select it.
Step 2 Do one of the following:
• From the File menu, select Refresh.
  The tree node refreshes.
• From the popup menu, select Refresh Tree Node.
  The tree node refreshes.

To Go Into a nav side bar tree node

The Go Into command allows you to re-root the nav tree at any arbitrary node. This will make that node the new root of the tree and give you a new tree in the nav side bar window. You can get back to the original tree by selecting it from the All the nodes you have "gone into" are persistently saved as a special type of Bookmark. Use the pulldown to switch between them. This feature is quite handy when working with multiple Stations or deep File systems and Databases.

To refresh a nav side bar tree node, do the following steps:

Step 1 Click the node to select it.
Step 2 Do one of the following:
• From the File menu, select Refresh.
  The tree node refreshes.
• From the popup menu, select Refresh Tree Node.
Chapter 10 – Performing Workbench tasks

April 4, 2011

The tree node refreshes.

Using the jobs side bar

The Jobs side bar provides a place to view and manage current jobs. Once a job has completed you are notified via the async notification feature. You can also view job details using the ">>" button.

This section explains how to do the following:

• To view job details
• To cancel a job from the jobs side bar
• To dismiss a job

To view job details

To view job details from the jobs side bar, do the following:

• On the desired job, click the details (">>") button.
  The job log details dialog box appears.

To cancel a job from the jobs side bar

To cancel a job from the jobs side bar, do the following:

• On the jobs side bar, click the cancel button.
  The job is cancelled.

To dismiss a job

Once a job has been completed, you are notified via the async notification feature. You may then dismiss the job from the jobs side bar, if desired.

To dismiss a job, do the following:

• From the Jobs side bar click the close button on the job that you want to dismiss.
  The selected job is closed.

Using the palette side bar

The palette side bar provides a place to open, view, and access components in modules. For an overview of the palette side bar, see "About the palette side bar" on page 2-8.

This section explains how to do the following:

• To open a palette
• To close a palette
• To create a palette
• To add a new component to a palette (PaletteFile.palette)
• To add a new component to a palette (module.palette)
• To copy a component to a palette

To open a palette

You can open one or more palettes in the palette side bar. Refer to “To open the palette side bar” on page 10-6 for details on how to open the palette side bar.

To open a new palette in the palette side bar, follow these steps:

Step 1  On the palette toolbar click the open palette button.
  The Open Palette dialog box appears.

Step 2  In the Open Palette dialog box select one or more palettes from the list, as desired. The text field at the top of the dialog box allows you to filter the displayed palettes by typing in the name of the desired palette. Also, you can use the Browse button to locate palettes in alternate locations.

  Note: Hold down the Ctrl or Shift key to make multiple selections.

Step 3  Click OK.
  The palette(s) opens in the palette side bar pane.
To close a palette
You can close any of the palettes that are open in the palette side bar. When you close all the palettes, the palette side bar closes.

To close a palette, follow these steps:

Step 1 From the Drop-down palette selector, choose the palette that you want to close.
The selected palette displays in the side bar pane.

Step 2 Click the Close palette button.
The palette closes.

To create a palette
Palettes allow you to save copies of your work for future use. Palette files may reside under a station file system or as part of a module. This procedure describes how to create a palette that resides in a station file system. Refer to “Working with modules” on page 10-27 for information about creating a palette file that is part of a module (jar file).

Note: For convenience and good organization, it is a good idea to create a “palette” folder on the file system to hold all your custom palette files.

To create a palette, follow these steps:

Step 1 In the nav tree, right-click on (or under) the station file system node, in the desired location (see note, above).
The popup menu appears.

Step 2 From the popup menu, select New > PaletteFile.palette.
The File Name dialog box appears with a default name.

Step 3 In the File Name dialog box, type the desired name for the new Palette file and click OK.
The File Name dialog box disappears and the new Palette file appears in the nav tree.
For more information about palette files, refer to “About the Nav file” on page 6-52. For information about using the Nav File Editor, refer to “About the Nav File Editor” on page 6-54.

To add a new component to a palette (PaletteFile.palette)
You can add a new component to any of your own custom palettes, store the palette files on your file system and view them in your palette side bar. The palette files must reside on the file system, not in the station database. However, the components that you add to your palette file may reside in the station database.

Note: For convenience and good organization, it is a good idea to create a “palette” folder on the file system to hold all your custom palette files.

To add a new component to a palette using the wire sheet view, follow these steps:

Note: To add a new component using a view other than the wire sheet view, refer to the information in “Working with components” on page 10-14.

Step 1 In the nav tree, double-click on the palette file that you want to open.
The default (Wire Sheet) view appears.

Step 2 Add a component to the wire sheet view using one of the following methods.
• Right click on the wire sheet view and select a new component from the New menu.
• Drag and drop a component from the nav side bar directly onto the wire sheet.

Step 3 Select File > SaveBog from the main menu.
The palette file is updated to contain the new component.

Note: If the updated palette is currently being viewed in the palette side bar, you must close and reopen the palette after saving the station (SaveBog).

To add a new component to a palette (module.palette)
You can add new components to any of your palettes that have module.palette files associated with them. A single module.palette file may be associated with each module that is stored in the modules directory. You change a module.palette file by first making the desired changes to a module.palette file that resides in a module “build” directory under your file system and then using the build process to recreate the module that includes the changed palette file.

To add a new component to a palette (module.palette file), follow these steps:
Step 1  Double click on the desired module.palette file. It should be located in a module directory on your station file system.
       The default (Wire Sheet) view appears.

Step 2  Add a component to the wire sheet view using one of the following methods:
       • Right click on the wire sheet view and select a new component from the New menu.
       • Drag and drop a component or container from the nav side bar directly onto the wire sheet.

Step 3  Select File > SaveBog from the main menu.

Step 4  From the console command line (press F3 to open console window) navigate to the working directory and type the build command followed by a space and then the name of the module folder. For example:

   C:\Niagara\Niagara-3.x.xx\workingDirectory> build moduleName

   Press the Return key to initiate the build process. If the build is successful, the updated jar file is built and overwrites the old jar file located in the modules folder. If the build is not successful, no jar file is built and error messages are generated to help you troubleshoot the problem.

Step 5  Refer to “To create a new module” on page 10-28 for more detailed instructions about creating a module.

To copy a component to a palette

You can copy components to any of your own custom palettes, store the palette files on your file system and view them in your palette side bar. The nav files must reside on the file system, not in the station database. However, the components that you add to your palette file may reside in the station database. The components that you add to your palette are copies and not connected to the original components that you are copying.

Note:  For convenience and good organization, it is a good idea to create a “palette” folder on the file system to hold all your custom palette files.

To copy a component to a palette, using the Wire Sheet view, follow these steps:

Step 1  In the nav tree, double-click on the file palette file that you want to open.
       The default (Wire Sheet) view appears.

Step 2  From the nav side bar, palette side bar, or other source, drag and drop the desire component to the wire sheet.
       The copied component is added to the palette file.

Step 3  Select File > SaveBog from the main menu.
       The palette file is updated to contain the new component.

Note:  If the updated palette is currently being viewed in the palette side bar, you must close and reopen the palette in the palette side bar in order to see the new items.

To add a side bar preview using the compPreviewWidget property

Palette previews display in the palette when components have images configured either as the default image property or as the image assigned to the compPreviewWidget property. If no preview is associated with a component, in AX-3.5 and later, you can add a compPreviewWidget property to a widget in order to display an image in the preview pane of the palette side bar.

To add a palette preview image to a component, do the following:

Step 1  Right-click the desired component in the palette side bar and select Views > Slot Sheet from the popup menu. The Slot Sheet view displays.

Step 2  In the slot sheet view, right-click in an empty area of the view and select Add Slot from the popup menu. The Add Slot dialog box displays.

Step 3  In the Add Slot dialog box, enter the following information:

   • Name
     Type compPreviewWidget in this text field.
   • Type
     Select bajaui and Label from the two option lists respectively.

Step 4  Click the OK button. The compPreviewWidget slot is added to the component.

Step 5  Right-click the desired component in the palette side bar and select Views > Property Sheet from the popup menu. The Property Sheet view displays.

Step 6  In the property sheet view, edit properties under the compPreviewWidget to add text and an image, as desired and click the Save button.
Using the view pane

The view pane can display any component view that you choose (see "About views" on page 1-19 for an introduction to views). Different views of components can provide different editing options. Most component editing is done in the view pane, however, many editing functions also involve the nav tree pane as well. The following sections describe some of the basic tools provided in Workbench for editing components. These tools are context-sensitive and may be used in several – but not all – views and with several – but not all – types of components.

For more details about viewing components, refer to “Viewing a component” on page 10-13

Editing components

Editing components in Workbench typically involves:

- Selecting a component
- Viewing a component
- Working with components
- Editing component data

The following sections describe these tasks.

Selecting a component

By selecting an item, you are defining the scope of your actions. In other words, the only components that are directly affected by your edits are those that are “selected” during your edits. Of course, other components may be influenced by the change in a component that communicates with it. It is also important to remember the hierarchical nature of the component tree. If you delete or move a component that contains other components, then you are deleting or moving all items that are contained in that container component.

When items are selected, they appear in one of the following ways:

- In the nav tree view, the component text is changed to a white on purple highlight.
- In the wire sheet view, selected components have a red border with red handles.
- In the wire sheet view, selected links turn red.

For more information about views, refer to "About views" on page 1-19.

To select a component

To select a component, do one of the following:

- In the nav tree view or the wire sheet view, left-click the desired component. The component is selected.
- In the nav tree view or the wire sheet view, right-click the desired component. The component (or link) is selected.
- In the wire sheet view, drag around the desired component. The component (or link) is selected.

To select multiple components in the nav tree

To select more than one component in the nav tree do the following:

Step 1 Select a single component or link, as described in “To select a component”.
Step 2 Hold down the Shift key or Ctrl key and select additional items. Multiple components (or links) are selected.
Step 3  Optional: In the wire sheet view, drag around the group of elements that you want to select. Hold down the Shift key or Ctrl key and select additional items to select or deselect them.
Multiple components (or links) are selected.

To select a multiple components in the wire sheet
To select more than one component in the wire sheet do the following:

Step 1  Select a single component or link, as described in “To select a component”.
Step 2  Hold down the Shift key or Ctrl key and select additional items.
Multiple components (or links) are selected.

Viewing a component
Each component that you select (in a view or in the nav tree) has a "default" view that appears in the view pane. You can select a different view of the component using the view selector or the popup (right–click) menu. The last view of an object becomes its default view during a Workbench session. If Workbench is closed and restarted, default views are reset to the original default views.

For details on selecting component views, see “To select a component view” on page 10-13.
In addition to having different views, you can edit the way views display information. For details about customizing a view, refer to the following procedures:
“To reorder components (in a component container)” on page 10-13
“To create a composite view” on page 10-14

To select a component view
To select a component view, do one of the following:
- Double-click on a component in the nav side bar.
  This will display the default view of the component.
- Right–click a component and choose a view from the Views submenu.
- With a component selected, choose a view from the view selector menu

To reorder components (in a component container)
You can reorder the components that are contained in a "container" component using the property sheet view, the nav tree view, or the wire sheet view.

To reorder components, do the following:

Step 1  Right–click the desired component.
The popup menu appears.
Step 2  From the popup menu, select Reorder.
The Reorder dialog box appears.
Step 3  In the Reorder dialog box, use the sort buttons, as follows:
- Move Up button
  Select one or more items in the component list (use the Ctrl or Shift key to select multiples) and click this button to move selected item(s) up (one position per click) in the list.
- Move Down button
  Select one or more items in the component list (use the Ctrl or Shift key to select multiples) and click this button to move selected item(s) down (one position per click) in the list.
- Sort by Name button
  Click this button to sort all items in the list in alphabetical order, by name. Each click toggles the sort order between ascending and descending sort order.
- Sort by Type button
  Click this button to sort all items in the list in order by component type. Each click toggles the sort order between ascending and descending sort order.
- Reset button
  Click this button to set the components in the list back to the order that they were in when the Reorder dialog box was opened.
The components are sorted according to button selected.
To create a composite view

Composite views are available in the wire sheet view and in the property sheet view. Creating a composite view of a component allows you to expose one or more child slots (that you designate) at the parent–view level. For more information about composite views, refer to “About composites” on page 3-21.

To create a composite view, do the following:

Note: The component that you select in the following step must have a child component to be a legitimate parent component. If no valid child component is available, then there cannot be a composite.

Step 1 In the wire sheet view or in the property sheet view, right–click on the desired parent object. The popup menu appears.

Step 2 From the popup menu, select the Composite command. The Composite Editor appears.

Step 3 In the Composite Editor, expand the tree to find and select the desired points to add to the parent component. Select multiple points (if desired) by holding the Ctrl or Shift keys when selecting.

Step 4 With the desired point(s) selected, click the Add button to add one or more points to the right column of the Composite Editor.

Step 5 Optional: Use the Composite Editor control buttons to do the following, if desired:

• Reverse
  Reverse the chosen side (“in” or “out”) of a point that is being composited.

• Rename
  Provide a custom name for the new slot created by composited point.

• Remove
  Removes the composited item (slot) from right side of the Composite Editor.

• Move Up
  Sort all selected points by moving them up in the Composite Editor list (one position per click).

• Move Down
  Sort all selected points by moving them down in the Composite Editor list (one position per click).

Step 6 Click the OK button. The component composites are set.

Working with components

The following procedures describe basic tasks that are used when working with components:

• To add a new component (property sheet, nav side bar, or wire sheet view)
• To delete a component (property sheet, nav side bar, or wire sheet view)
• To rename a component (property sheet, nav side bar, or wire sheet view, slot sheet)
• To duplicate a component (property sheet, nav side bar, or wire sheet view)
• To paste a component (property sheet, nav side bar, or wire sheet view)
• To drag a component to the property sheet, nav side bar, or wire sheet (left–click method)
• To drag a component to the property sheet, nav side bar, or wire sheet (right–click method)

To add a new component (property sheet, nav side bar, or wire sheet view)

You can add (create) a new component to a container using the property sheet view, the nav tree view or the wire sheet view. To add a slot refer to “To add a new slot” on page 10-18.

To add a new component, do the following:

Step 1 Right–click in the container where you want to place the new component. This can be a component in the nav tree view, the wire sheet view or the property sheet view. A popup menu appears.

Step 2 From the popup menu, choose the New command and select the desired type of component:

• Folder
• IconFolder
• TextBlock
• BooleanWritable
• NumericWritable
• EnumWritable
• StringWritable
The Name dialog box appears.
Step 3 Type the desired name for the new component in the text field and click the OK button. The new component appears in the property sheet.

**To delete a component (property sheet, nav side bar, or wire sheet view)**
You can delete a component from a container, using the property sheet view, the nav tree view or the wire sheet view. To delete a component using the slot sheet view, refer to "To delete a slot" on page 10-19.

To delete a component, do the following:

**Note:** If you delete a component that contains other components, all components in that container component are deleted as well.

Step 1 Right-click the desired component.
A popup menu appears.
Step 2 From the popup menu, select the Delete command.
The component is deleted.

**To rename a component (property sheet, nav side bar, or wire sheet view, slot sheet)**
You can rename a component in the property sheet view, the nav tree view, the wire sheet view, or the slot sheet view.

To rename a component, do of the following:

Step 1 In the desired view, right-click the component to rename.
The popup menu appears.
Step 2 From the popup menu, select the Rename command.
The Rename dialog box appears.
Step 3 In the Rename dialog box, type the desired name in the text field and click the OK button.
The component is renamed.

**To duplicate a component (property sheet, nav side bar, or wire sheet view)**
You can duplicate a component from the property sheet view, the nav tree view, or the wire sheet view.

To duplicate a component, do of the following:

Step 1 In the desired view, right-click the component to duplicate.
The popup menu appears.
Step 2 From the popup menu, select the Duplicate command.
The Name dialog box appears.
Step 3 In the Name dialog box, type the desired name in the text field (or use the default name) and click the OK button.
The component is duplicated.

**To paste a component (property sheet, nav side bar, or wire sheet view)**
You can add a component to a container by pasting it to a container displayed the property sheet view, the nav tree view, or the wire sheet view.

To add a component by pasting it, do the following:

Step 1 In the desired view, select the desired component and use the Copy (to duplicate) or Cut (to remove) command to copy the component to the clipboard.
Copy and Cut commands are available on the popup (right-click) menu, the Edit menu, or from the toolbar.
Step 2 Right-click in the container where you want to place the new component. This can be a component in the nav tree view, the wire sheet view or the property sheet view.
The popup menu appears.
Step 3 From the popup menu, select the paste command.
The Name dialog box appears.
Step 4 Type the desired name for the new component in the text field and click the OK button.
The new component is added to the targeted container.
To drag a component to the property sheet, nav side bar, or wire sheet (left–click method)

You can drag a component to the displayed property sheet view, the nav tree view, or the wire sheet view, by using a right–click drag or by using a normal, left–click drag.

**Note:** A left–click drag always creates a copy of the original.

To drag a component using the left–click drag method, do the following:

**Step 1**
In the desired view, left–click the component to copy and drag it to the target container.

When you release the mouse button, the **Name** dialog box appears.

**Step 2**
Type the desired name for the new component in the text field and click the **OK** button.

The new component is added to the targeted container.

To drag a component to the property sheet, nav side bar, or wire sheet (right–click method)

You can drag a component to the displayed property sheet by using a right–click drag or by using a normal, left–click drag.

**Note:** A right–click drag always prompts you to choose a **copy**, **move**, or **cancel** command.

To drag a component to a property sheet by using the right–click drag method, do the following:

**Step 1**
In the desired view, right–click the component that you want to move (or copy) and drag it to the property sheet.

When you release the right mouse button, a **popup** menu appears.

**Step 2**
From the **popup** menu, choose one of the following commands:

- **Copy** – this command makes a duplicate of the component to paste onto the property sheet.
  The **Name** dialog box appears.
- **Move** – this command removes the original component and prepares to paste in onto the property sheet.
  The **Name** dialog box appears.
- **Cancel** – this command will stop the process, and the **popup** menu will disappear.

**Step 3**
Type the desired name for the new component in the text field and click the **OK** button.

The new component appears in the property sheet.

**Editing component data**

Many component editing functions in Workbench work the same, or similarly, in all component views. However, some editing functions are restricted to particular component views. For information about the standard edit commands (such as cut, copy, and paste), refer to “Types of edit commands” on page A-13.

The following sections describe some of the basic component editing procedures.

- Using the property sheet
- Using the wire sheet
- Using the slot sheet
- Using the link sheet

**Using the property sheet**

The property sheet view is displayed in the view pane by selecting **Property Sheet** from the **view selector** menu (see “About the view selector” on page 2-15) or by using one of the other methods described in “About the view pane” on page 2-12.

For information about creating new components, deleting components, duplicating components, and so on, refer to “Editing components” on page 10-12.

**To add an extension to a component property sheet view:**

For more information about extensions, refer to “Extension process overview” on page 3-10 or “About point extensions” on page 3-10

**Note:** The following procedure may also be performed directly in the nav side bar tree (refer to “Using the nav side bar (tree)” on page 10-8) for more information.

**Step 1**
Display the component property sheet view, as follows:

- In the nav pane tree, select the desired component.
- From the right–click **popup** menu (or from the view selector), select the component property sheet view.
Chapter 10 – Performing Workbench tasks

Using components

April 4, 2011

Using the wire sheet

The following are common tasks associated with the wire sheet

- To pin a slot
- To paste a component onto the wire sheet
- To drag a component to the wire sheet (left–click method)
- To drag a component to the wire sheet (left–click method)
- To drag a component to the wire sheet (right–click method)

To pin a slot

By default, some slots are visible in the wire sheet view of the slot. However, you can have any – or all slots visible on the wire sheet by "pinning" open the slot(s).

To pin a slot:

Step 1 In the wire sheet view, right–click on the desired component.
The popup menu appears.
Step 2 From the popup menu, select the Pin Slots command.
The Pin Slots dialog box appears.
Step 3 In the Pin Slots dialog box, click to the left of all slots that you want to pin open.
A pin icon appears next to each icon you click.
Step 4 Click the OK button.
The slots are pinned and appear on the wire sheet with a knob next to the slot name.

**To paste a component onto the wire sheet**

You can add a component to the displayed property sheet by pasting it onto the property sheet or by dragging it onto the property sheet.

To add a component to a property sheet by pasting it to the property sheet, do the following:

1. Select the desired component and use the *Copy* (to duplicate) or *Cut* (to remove) command to copy the component to the clipboard.

   *Copy* and *Cut* commands are available on the *popup* (right–click) menu, the Edit menu, or from the toolbar.

2. Right–click on the property sheet.

   The *popup* menu appears.

3. From the *popup* menu, select the paste command.

   The *Name* dialog box appears.

4. Type the desired name for the new component in the text field and click the *OK* button.

   The new component appears in the property sheet.

**To drag a component to the wire sheet (left–click method)**

You can drag a component to the displayed property sheet by using a right–click drag or by using a normal, left–click drag.

To drag a component to a property sheet by using the *left–click* drag method, do the following:

1. Select the desired component using a left–click and drag it to the property sheet.

   When you release the mouse button, the *Name* dialog box appears.

2. Type the desired name for the new component in the text field and click the *OK* button.

   The new component appears in the property sheet.

**To drag a component to the wire sheet (right–click method)**

You can drag a component to the displayed property sheet by using a right–click drag or by using a normal, left–click drag.

To drag a component to a property sheet by using the *right–click* drag method, do the following:

1. Right–click the desired component and drag it to the property sheet.

   When you release the right mouse button, a *popup* menu appears.

2. From the *popup* menu, choose one of the following commands:

   - *Copy* – this command makes a duplicate of the component to paste onto the property sheet.
     The *Name* dialog box appears.
   - *Move* – this command removes the original component and prepares to paste in onto the property sheet.
     The *Name* dialog box appears.
   - *Cancel* – this command will stop the process, and the *popup* menu will disappear.

3. Type the desired name for the new component in the text field and click the *OK* button.

   The new component appears in the property sheet.

**Using the slot sheet**

The following are common tasks associated with the slot sheet:

- To add a new slot
- To delete a slot

**To add a new slot**

To add a new slot, perform the following steps:

1. In the slot sheet view, right–click in the pane.

   The *popup* menu appears.

2. From the *popup* menu, select the *Add Slot* command.

   The *Add Slot* dialog box appears.
Step 3 In the Add Slot dialog box, enter the following information:
- Name: type in a name for the slot.
- Type: Select the component property type from the drop-down option lists.
- Choose the desired slot options from the Flags field.

Step 4 Click the OK button.
The slot is added to the slot sheet.

To delete a slot
To delete a slot, perform the following steps:

Step 1 In the slot sheet view, right-click on the slot that you want to delete.
The popup menu appears.
Step 2 From the popup menu, select the Delete command.
The slot is deleted.

Using the link sheet
The following are common tasks associated with the link sheet
- To delete a link using the link sheet view
- To edit a link using the link sheet view

To delete a link using the link sheet view
To delete a link using the link sheet view, perform the following steps:

Step 1 In the link sheet view, right-click on the link that you want to delete.
The popup menu appears.
Step 2 From the popup menu, select the Delete command.
The link is deleted.

To edit a link using the link sheet view
To edit a link using the link sheet view, perform the following steps:

Step 1 In the link sheet view, right-click on the link that you want to edit.
The popup menu appears.
Step 2 From the popup menu, select the Edit command.
The edit dialog box appears.
Step 3 In the edit dialog box, edit the following fields, as desired
- Source Ord
  Type in (or browse to) the ORD for the desire source of the link.
- Source Slot Name
  Type in a name for the Source.
- Target Slot Name
  Type in a name for the Target Slot
- Enabled
  Choose True or False from the Enable option list. True enables the link and False disables the link.

Step 4 In the edit dialog box, click the OK button.
The edit dialog box disappears and the edits are saved.

Using alarms
The following are common tasks associated with setting up and working with alarms in NiagaraAX:
- Creating alarms
- Routing alarms
- Managing alarms

Creating alarms
To create an “alarmable” control point, you must add an appropriate alarm extension to a control point and configure it to define your alarm condition requirements:
To set up alarm conditions for a control point

Note: Just as there are different types of control points (refer to “Types of control points” on page 3-1), there are different types of control point extensions (refer to “Types of point extensions” on page 3-11). When adding an alarm extension to a control point, you must add the proper type of extension to match the point, as described in “Types of alarm extensions” on page 3-13.

To set up alarm conditions for a control point, do the following:

Step 1 Add an alarm extension to the control point property sheet as described in “To add an extension to a component property sheet view:” on page 10-16. The alarm extension must match the control point type (for example, BooleanChanegOfStateAlarmExt fits with a Boolean Writable point – and a EnumChangeOfStateAlarmExt would not).

Step 2 Configure the alarm extension properties as desired. Refer to the “About alarm extension properties” on page 5-3 for details about the alarm extensions properties.

Note: The Alarm Enable property options are not selected by default. You must select an AlarmEnable option in addition to setting your alarm extension properties.

Routing alarms
The alarm service handles the routing of alarms by using alarm classes to coordinate the transfer of messages between alarm sources and alarm recipients. Refer to “Types of alarm recipients” on page 5-36 for more information about alarm recipients.

To add an alarm class to the alarm service

For more information about alarm service, refer to “About the alarm service” on page 5-7. For more information about alarm class, refer to “About alarm class” on page 5-32.

To add an alarm class to the alarm service, do the following:

Step 1 Right–click the AlarmService node in the nav side bar.

The popup menu appears.

Step 2 From the popup menu, select Views > WireSheet.

The alarm service Wire Sheet view appears.

Step 3 From the alarm palette, drag an AlarmClass component onto the wintersheet.

The Name dialog box appears.

Step 4 Type the desired name for the new alarm class in the text field and click the OK button.

The new alarm class appears in the wiresheet and is ready for configuration.

To add a console recipient to the alarm service

For more information about alarm service, refer to “About the alarm service” on page 5-7. For more information about console recipient, refer to “About the console recipient” on page 5-36.

To add a console recipient to the alarm service, do the following:

Step 1 Right–click the AlarmService node in the nav side bar.

The popup menu appears.

Step 2 From the popup menu, select Views > WireSheet.

The alarm service WireSheet view appears.

Step 3 From the alarm palette, drag a ConsoleRecipient component onto the wiresheet.

The Name dialog box appears.

Step 4 Type the desired name for the new console recipient in the text field and click the OK button.

The new console recipient appears in the wiresheet and is ready for configuration.

To add a station recipient to the alarm service

For more information about alarm service, refer to “About the alarm service” on page 5-7. For more information about station recipient, refer to “About the station recipient” on page 5-41.

To add a station recipient to the alarm service, do the following:

Step 1 Right–click the AlarmService node in the nav side bar.

The popup menu appears.

Step 2 From the popup menu, select Views > WireSheet.
The alarm service Wireshet view appears.

Step 3 From the alarm palette, drag a StationRecipient component onto the wireshet.
The Name dialog box appears.

Step 4 Type the desired name for the new station recipient in the text field and click the OK button.
The new station recipient appears in the wireshet and is ready for configuration.

To add an email recipient to the alarm service
For more information about alarm service, refer to “About the alarm service” on page 5-7. For more information about email recipient, refer to “About the Email Recipient (email-EmailRecipient)” on page 5-43.

To add an email recipient to the alarm service, do the following:

Step 1 Right-click the AlarmService node in the nav side bar.
The popup menu appears.

Step 2 From the popup menu, select Views > WireSheet.
The alarm service Wireshet view appears.

Step 3 From the email palette, drag an EmailRecipient component onto the wireshet.
The Name dialog box appears.

Step 4 Type the desired name for the new email recipient in the text field and click the OK button.
The new email recipient appears in the wireshet and is ready for configuration.

Managing alarms

To acknowledge alarms from the alarm console view

Note: Alarms are not removed from the alarm console until both the following conditions exist:
- alarm acknowledged
- alarm source is in a normal (not alarm) state

You can acknowledge alarms from the alarm portal as well as from the alarm console. To acknowledge alarms from the alarm portal, refer to “To acknowledge alarms from the alarm portal” on page 10-21.

To acknowledge alarms from the alarm console view, do the following:

Step 1 Right-click on the ConsoleRecipient node in nav side bar pane.
The popup menu displays.

Step 2 From the popup menu, select Views > Alarm Console.
The alarm console view appears with all alarm sources displayed in a tabular view.

Step 3 In the alarm console view, select alarm sources that you want to acknowledge. Select multiple alarms, if desired, using the Shift or Ctrl key.

Note: Each record that appears in the alarm console table represents one alarm source and one or more alarms from that source. You may acknowledge either the latest (most recent) alarm or acknowledge all alarms that are reported from that source by choosing either the “Acknowledge” command or the “Acknowledge All” command, as described in the following step.

Step 4 Acknowledge selected alarm(s) by doing one of the following:
- From the Alarm menu, select Acknowledge (to acknowledge the latest alarm only)
The latest alarm from each selected choice is acknowledged.

OR
- From the Alarm menu, select Acknowledge All (to acknowledge all alarms reported from that source). Alternatively, you may click the Acknowledge All button (located at the bottom of the dialog box).
All alarms from each selected alarm source are acknowledged.

To acknowledge alarms from the alarm portal

The alarm portal must be running and configured to include all desired alarm consoles before it can be used to acknowledge alarms. Refer to “Alarm portal” on page 9-2 for details about the alarm portal. Refer to “Alarm portal options” on page 2-28 for details about alarm portal display options.

Note: Alarms are not removed from the alarm console (or portal) until both the following conditions exist:
- alarm acknowledged
- alarm source is in a normal (not alarm) state
You can acknowledge alarms from the alarm console as well as from the alarm portal. To acknowledge alarms directly from the alarm console, refer to “To acknowledge alarms from the alarm console view” on page 10-21.

To acknowledge alarms from the alarm portal, do the following:

Step 1  From the Tools menu, select Alarm Portal.

The Alarm Portal view displays in the view pane.

Step 2  If the desired Alarm Console does not appear in the Alarm Console Monitor table (top portion of the Alarm Portal view) right-click in the Alarm Console Monitor area.

The popup menu, appears.

Step 3  Select Add Alarm Console.

The Add Alarm Console wizard appears.

Step 4  Complete the Add Alarm Console wizard by entering the following information:

- Host address information, as needed (IP or dialup)
- Credentials information (username and password)
- Choose the desired console, by Ord (if more than one is present at the host address)

Step 5  Click the Finish button to complete the Add Alarm Console wizard.

The alarm console appears in the Alarm Console Monitor table (top portion of the Alarm Portal view). Any alarms will appear in the Open Alarm Sources table (bottom portion of the Alarm Portal view).

Step 6  In the Open Alarm Sources table, select alarm sources that you want to acknowledge. Select multiple alarms, if desired, using the Shift or Ctrl key.

Note: Each record that appears in the Open Alarm Sources table represents one alarm source and one or more alarms from that source. You may acknowledge either the latest (most recent) alarm or acknowledge all alarms that are reported from that source by choosing either the “Acknowledge” command or the “Acknowledge All” command, as described in the following step.

Step 7  Acknowledge selected alarm(s) by doing one of the following:

- From the Alarm menu, select Acknowledge (to acknowledge the latest alarm only)

  The latest alarm from each selected choice is acknowledged.

  OR

- From the Alarm menu, select Acknowledge All (to acknowledge all alarms reported from that source). Alternatively, you may click the Acknowledge All button (located at the bottom of the dialog box) or use the popup menu to acknowledge the alarm(s).

  All alarms from each selected alarm source are acknowledged.

To delete alarm records

The Alarm Database Maintenance view provides three ways to delete alarm records from the alarm database. To delete old alarm records, do the following:

Step 1  In the Alarm Database Maintenance view, select one of the following three options:

- **Clear Old Records option**

  to clear alarm records before a certain date and time. The Before field is provided to allow you to set the date and time for removing old records. The Before field is not available when you select either of the other options.

- **Clear All Before Selected Record option**

  to delete all records that have a timestamp earlier than the timestamp of the record that you select in the Alarm History pane table. The selected record is not deleted.

- **Clear All Records options**

  to delete all records that appear in the Alarm History pane table, regardless of the date.

Step 2  Click the Run Maintenance button to initiate the delete action.

The Confirm Clear dialog box displays to clarify that you are about to delete records and that the operation cannot be “undone”.

Step 3  If the information in the Confirm Clear dialog box confirms that you are deleting the desired alarm records, click the Yes button (otherwise click the No button).

The alarm records are deleted and removed from the Alarm History table in the Alarm History pane.
Chapter 10 – Performing Workbench tasks

Creating a Live History Chart

The Live History Chart view is available directly from the history extension component and also from a view on the HistoryPointList component. The history extension view displays the single point in a live chart plot, while the HistoryPointList component, when configured, displays all List Points that it contains.

The following procedures describe how to setup these views.

- Live History Chart view from a History Extension
- Live History Chart view from a HistoryPointsList Component

**Live History Chart view from a History Extension**

**Note:** Use this direct "history extension method" to display a single live charting point. If you need to view several points plotted simultaneously, then use the HistoryPointList component and the steps in the section, Live_Chart_view_from_a_HistoryPointsList_Component.

To display a Live Chart view in workbench using only a history extension, do the following:

**Step 1** Right-click the desired history extension component in the workbench nav tree. The popup menu displays.

**Step 2** From the popup menu, select Views>Live History Chart. The Live History Chart view displays.

**Live History Chart view from a HistoryPointsList Component**

To display a Live Chart view in workbench using the HistoryPointsList component, do the following:

**Step 1** From the History palette, add a HistoryPointList component to your station in an appropriate location (you can add the component anywhere in the station).

**Step 2** For each desired data plot, add a HistoryPointList Item to the HistoryPointList using one of the following methods:

- Drag and drop the component from the History palette, then link the history extension and configure the component using the property sheet view.
- Right click on the HistoryPointList container, choose Actions>AddItem from the popup menu. Using the List Item dialog box, link the history extension and configure the component.

**Step 3** Double-click on the HistoryPointList component to display the Live History Chart view. When the Live History Chart view displays, select or clear selections in the Item List View pane, as desired.

Using the Px Editor

The following are common tasks associated with setting up and working with the Px Editor in NiagaraAX:

- Making widgets
- Binding widgets
- Editing widget properties
- Animating widget properties

**Making widgets**

It is possible to make new widgets in several ways:

**To make a new widget using the Make New Widget wizard:**

**Note:** For more information about the Make Widget wizard, see the following:

- For a description of the Make Widget Wizard interface, refer to “About the Make Widget wizard” on page 6-36.
- For examples of procedures using the Make Widget Wizard interface, with different types of bindings, refer to “Make Widget wizard: examples” on page 6-37.

When you create a widget with the Make Widget Wizard, the wizard dialog box provides fields for creating the widget bindings. To make a new widget using the Make New Widget wizard, do the following:

**Step 1** From the nav side bar, drag and drop a widget onto the Px Editor canvas.

The Make Widget Editor appears, with the ORD for the selected component displaying in the ORD area. You can double-click the ORD to change it, if desired.
Step 2  From the Source options list, select the desired type of binding (choose from: Bound Label, Properties, Actions, and others).

**Note:** *Binding options that are dimmed indicate that they are not valid options for the selected component.*

The Secondary view area displays fields and options that are related to the selected Source option.

Step 3  In the Secondary view area, choose a widget template, formatting options for display labels, or views, as appropriate for your Source option.

Step 4  In the Properties sheet area, edit the properties or actions, as desired.

Step 5  Click the OK button to complete the wizard. The Make Widget wizard disappears and the new widget appears on the Px Editor canvas.

Step 6  Toggle the view using the View/Edit Mode toolbar icon to display the widget in the Px Viewer.

**Binding widgets**

There are different ways to add a binding to a widget. You can add a binding to a widget using the Make Widget wizard or you can add a binding to a widget that is already on the Px Editor canvas.

**To bind a value to a widget**

Step 1  In the Px Editor canvas, select the desired widget.

Step 2  In the Properties side bar, click the Add Binding toolbar icon.

The Add Binding dialog box appears.

Step 3  Select a binding type from the options list and click the OK button.

The binding type properties are added to the “binding” area at the bottom of the widget property sheet.

Step 4  Under the binding type properties, click the ORD property field.

The ORD dialog box appears.

Step 5  In the ORD dialog box, type or browse to the value that you want to bind to the widget and click the OK button.

The ORD is added to the binding area of the widget property sheet.

**Editing widget properties**

**To edit a widget property**

To edit a widget, do the following:

Step 1  In the Px Editor canvas, select (or double-click) the desired widget.

The widget properties display in the properties side bar (or in properties dialog box, if you double-clicked).

Step 2  In the Px Editor properties side bar (or dialog box) edit the widget properties, as desired:

- To edit a widget property: add, change, or remove a property value from the desired property field in the properties side bar.
- To add a binding, click the Add Binding icon in the properties side bar (see “To bind a value to a widget” on page 10-24).
- To animate a widget property, from the palette side bar, right-click in the properties field and select **Animate** from the popup menu (refer to “Animating widget properties” for details).
- To delete a binding, click the Close icon (X) in the top right corner of the properties side bar.

Step 3  If you are working in the properties dialog box, click the OK button.

The edits are made and the widget properties are changed.

**Animating widget properties**

**To animate a widget property**

“Animating” a property means to link a widget property to a bound data component value, so that the widget can display any change in value, as it happens. For more information about animating graphic views, refer to “Animating Graphics” on page 6-20.

**Note:** *Before you can animate a widget property, you must add a binding from the desired component to the target widget. The binding must exist before the property can be animated. Refer to “Binding widgets” on page 10-24 for details about adding a binding to a widget.*

To animate a widget property, do the following:

Step 1  In the Px Editor canvas, select (or double-click) the desired widget that you want to animate.
Chapter 10 – Performing Workbench tasks

April 4, 2011

Creating a new Nav file

The widget properties display in the properties side bar (or in properties dialog box, if you double-clicked).

**Step 2** In the Px Editor properties side bar (or dialog box) right-click on the properties field of the property that you want to animate and select *Animate* from the popup menu.

The *Animate* dialog box appears. If you have more than one binding associated with the widget, all bindings will be available in the *Binding* options list.

**Step 3** From the *Binding* options list, select the binding that is associated with the component value you want to link to.

**Step 4** From the *Converter Type* options list, select the binding that is associated with the component value you want to link to.

**Note:** The converter type that is selected by default is based on the component that you have selected and most of the time will be the converter type that you want to use. For more information about converter types, refer to “Types of Converters” on page 6-24.

The *Animate* dialog box displays different fields, based on the type of value (and thus, converter) that you animating.

**Step 5** Complete the binding to the value using the controls in the *Animate* dialog box and click the *OK* button.

The Animate dialog box disappears and the binding appears in properties side bar (or dialog box).

**Step 6** Click the OK button to close the properties dialog box, if necessary.

The property value is animated.

**Using the Nav File Editor**

The following tasks are commonly associated with setting up and working with the nav files in NiagaraAX:

- Creating a new Nav file
- Editing a Nav file in the Nav File Editor

**Creating a new Nav file**

You may have more than one nav file associated with a station. The nav files must reside on the file system, not in the station database.

**Note:** For convenience and good organization, it is a good idea to create a "nav" folder on the file system to hold all your nav files.

For more information about nav files, refer to “About the Nav file” on page 6-52. For information about using the Nav File Editor, refer to “About the Nav File Editor” on page 6-54.

**To create a new nav file:**

To create a new nav file, do the following:

**Step 1** In the nav tree, right-click on (or under) the file system node.

The popup menu appears.

**Step 2** From the popup menu, select New > NavFile.nav.

The File Name dialog box appears with a default name.

**Step 3** In the File Name dialog box, type the desired name for the new Nav file and click OK.

The File Name dialog box disappears and the new Nav file appears in the nav tree.

**To delete nav file (Delete Key):**

To delete a nav file using the Delete key, do the following:

**Step 1** In the nav tree, select the nav file that you want to delete.

**Step 2** On the keyboard, press the Delete key.

The nav file is deleted.

**To delete nav file (popup menu):**

To delete a nav file using the popup menu, do the following:

**Step 1** In the nav tree, right-click on the nav file that you want to delete.

The popup menu appears.
Using the Nav File Editor

Chapter 10 – Performing Workbench tasks

April 4, 2011

To rename a nav file:
To rename nav file, do the following:

Step 1 In the nav tree, right-click on (or under) the file system node.
The popup menu appears.

Step 2 From the popup menu, select Rename.
The Rename dialog box appears with the current name in the text field.

Step 3 In the Rename dialog box, type the desired name for the nav file in the text field and click OK.
The nav file is renamed.

Editing a Nav file in the Nav File Editor
You can edit nav files in the Text Editor or in the Nav File Editor. The following procedure describes how to edit a Nav File in the Nav File Editor.

For more information about nav files, refer to “About the Nav file” on page 6-52. For information about the Nav File Editor, refer to “About the Nav File Editor” on page 6-54.

The following procedures describe tasks involved with editing nav files:

• To open a nav file in the Nav File Editor:
• To add nodes to a nav file using the Nav File Editor:
• To delete nodes from a nav file:
• To edit the node hierarchy (tree structure) in a nav file:
• To edit nodes in a nav file:

To open a nav file in the Nav File Editor:
To open a nav file in the Nav File Editor, do one of the following:

Note: The nav file resides on the file system, not in the station database. You may keep all station nav files in a "nav" folder to improve or simplify file organization on your station.

Step 1 In the nav side bar, find the nav file that you want to open, and do one of the following:
• Double-click on the desired nav file. OR
• Right-click on the Nav File and select View > Nav File Editor from the popup menu.
The Nav File Editor will open and display the file in the Result Tree pane.

Step 2 Edit the nav file, as desired.

Step 3 Click the Save icon on the toolbar or select File > Save to save changes to the nav file.

To add nodes to a nav file using the Nav File Editor:
There are several ways to add nodes to a nav file using the Nav File Editor.

To add nodes to a nav file do the following:

Step 1 Open the desired nav file in the Nav File Editor (refer to “To open a nav file in the Nav File Editor:”, if necessary).

Step 2 Add a node to the Result Pane using any of the following methods:

• Copy and paste
Copy a component or Px file from the nav side bar and paste it into the Result Tree pane. The new node appears in the Result Tree as a child node of the node that you target when pasting.

• Drag and drop (from nav side bar)
Drag a component or Px file from the nav side bar and drop it onto the Result Tree pane. A new node appears in the Result Tree as a child node of the node that you target when dropping it.

• Popup menu
Right-click on the component that you want to add and select Copy from the popup menu. Right-click the desired target area in the Result Tree, and select Paste from the popup menu. A new node appears in the Result Tree as a child node of the node that you target when pasting.

• New button
Click the New button on the bottom of the Nav File Editor pane. The New Node dialog box appears. Edit the Display Name, Target Ord, and Icon fields, as desired and click the OK button. A new node appears in the Result Tree as a child node of the node that is selected.

• Drag and drop (from Source Tree)
Step 3 Click the **Save** icon on the toolbar or select File > Save to save changes to the nav file.

---

**To delete nodes from a nav file:**

To delete nodes from a nav file, do the following:

1. Open the desired nav file in the Nav File Editor (refer to “To open a nav file in the Nav File Editor:”, if necessary).

2. In the Result Tree, find the node that you want to delete, and then do one of the following:
   - Select the node that you want to delete and click the Delete button. OR
   - Select the node that you want to delete and press the Delete key on the keyboard. OR
   - Right-click on the node that you want to delete and select **Delete** from the popup menu. OR

   The node will disappear from the Result Tree pane.

3. Save changes to the nav file by clicking the **Save** button on the toolbar or select Save from the File menu.

   The nav file changes are saved.

4. Click the **Save** icon on the toolbar or select File > Save to save changes to the nav file.

---

**To edit the node hierarchy (tree structure) in a nav file:**

To edit the node hierarchy in a nav file, do the following:

1. Open the desired nav file in the Nav File Editor (refer to “To open a nav file in the Nav File Editor:”, if necessary).

2. In the nav tree, find the nav file that you want to edit, and then do any of the following:
   - Drag and drop the desired tree node from one location to another location in the tree.
   - Select one or more tree nodes and use the **Move Up** or **Move Down** buttons to raise or lower the node in its parent node.

   **Note:** The **Move Up** and **Move Down** buttons will move nodes only within their parent node. To move a node to a different parent, you must cut and paste the node.

   The Nav File Editor displays the new node location in the Result Tree pane.

3. Click the **Save** icon on the toolbar or select File > Save to save changes to the nav file.

---

**To edit nodes in a nav file:**

To edit a new nav file, do the following:

1. Open the desired nav file in the Nav File Editor (refer to “To open a nav file in the Nav File Editor:”, if necessary).

2. In the nav tree, find the node that you want to edit, and then do one of the following:
   - Double-click on the desired node. OR
   - Select the desire node and click the **Edit** button.
   - Right-click on the node File and select **Edit** from the popup menu.

   The **Edit** dialog box will open and display the node properties.

3. In the **Edit** dialog box, edit the node Display Name, Target Ord, and Icon properties, as desired and click the **OK** button.

   The node properties are changed.

4. Click the **Save** icon on the toolbar or select File > Save to save changes to the nav file.

---

**Working with modules**

You can create and customize your own modules so that you have access to individual custom components or complete folders of components and applications that you have designed and may use again. For basic information about modules, see “About modules” on page 1-6.
To create a new module

You can create your own custom modules. This allows you to save copies of your work for future use in the compressed (jar) module form. Palette and lexicon files may be customized and included as part of the modules. Typically, if you choose to create a palette and a lexicon file, you select these options in the New Module Wizard, which creates an empty "module.lexicon" and "module.palette" file that you edit, as desired.

Note: For convenience, it is a good idea to create a "working" folder under the station directory (as described in step 1, below) to hold all your custom files source material. You can leave this folder in your station and use it to hold source files for any modules that you create.

To create a new module using Workbench, follow these steps:

Step 1 Connect to the station that you want to work with and, in the nav side bar, expand the My File System > Sys Home nodes. The station installation directory appears under this node.

Step 2 Right-click on the Sys Home node in the tree and select New > New Folder from the popup menu to create a "working folder". Give the folder a generic name, such as "ModuleSource" or "workingModule".

Step 3 Use the New Module Wizard to create the directory and files required for a new module. Refer to "New module wizard" on page 9-11 for more information about using the New Module Wizard. The wizard creates a new folder under a directory that you specify (typically, you want to specify the "working directory" that you create in step 1, above).

Step 4 In the nav side bar, create a new folder named "src" under the newly created module folder.

In the nav tree you should now have a folder structure similar to the following:

My File System/Sys Home/<workingDirectory>/<newModuleName>/src

Step 5 Add items to the src folder, as desired. Copy and paste components or files from your file system or from the station database. You can add subfolders under the src folder to organize data, as desired, or you can put everything directly into the src folder.

Step 6 In the <newModuleName> folder, double-click the "build.xml" file. It opens in Workbench text file editor.

Step 7 In the "build.xml" file, after the last <dependency/> element, type in one or more <resources/> elements to define the location of your source files.

For example, if you want to include all the "gif" files that are in an "images" folder under your "src" folder, you type the following line in the "build.xml" file:

<resources name="/images/*.gif"/>

The following listing is an example of how your "build.xml" file might look.

<!-- Module Build File -->
<module name = "newModuleName"
bajaVersion = "0"
preferredSymbol = "nM"
description = "My new graphic files"
vendor = "Acme"
>
<!-- Dependencies -->

<dependency name="baja" vendor="Tridium" vendorVersion="3.4" bajaVersion="0" />
<resources name="/images/*.gif"/>
</module>

Step 8 Save and close the "build.xml" file.

Step 9 From the console command line in Workbench (press F3 to open console window) navigate to the working directory and type the build command followed by a space and then the name of the module folder. For example:

C:\Niagara\Niagara-3.x.xx\workingDirectory> build moduleName

Press the Return key to initiate the build process. If the build is successful, the new jar file is built and located in the modules folder. If the build is not successful, no jar file is built and error messages are generated to help you troubleshoot the problem.

Step 10 You must restart Workbench to see the new module in the modules directory.

Note: If you chose to create a palette during the build process (using the New Module Wizard) an empty palette is available with the new module. Refer to "To add a new component to a palette (module.palette)" on page 10-10 for instructions about adding components to the palette.
Component Guides

The Component Guides provide summary information on common components.

Component Reference Summary

Note: For kitControl components, see the "Alphabetical list of kitControl components" section in the KitControl Guide.

Summary information is provided on components in the following modules:

- alarm
- alarmRdb
- backup
- baja
- bajaui
- chart
- control
- converters
- crypto
- devkit
- email
- file
- flr
- gx
- help
- history
- kitPx
- ldap
- net
- onCall
- program
- pxeditor
- report
- schedule
- sms
- timesync
- web
- workbench

Components in alarm module

- AlarmClass
- AlarmClassFolder
- AlarmConsoleOptions
- AlarmPortalOptions
- AlarmService
- AlarmSourceExt
- AlarmSourceInfo
- BooleanChangeOfStateAlarmExt
- BooleanCommandFailureAlarmExt
Components in alarm module

- ConsoleRecipient
- FaultAlgorithm
- EnumChangeOfStateAlarmExt
- EnumCommandFailureAlarmExt
- LinePrinterRecipient
- MemoryAlarmService
- OffnormalAlgorithm
- OutOfRangeAlarmExt
- StationRecipient
- StatusAlarmExt
- StringChangeOfValueAlarmExt

**alarm-AlarmClass**

An AlarmClass object is used to group alarms that have the same routing and handling characteristics. The AlarmClass is available in the alarm palette.

- Refer to "About alarm class" on page 5-32 for more details.

**alarm-AlarmClassFolder**

This is a container object provided for organizing groups of alarm class objects. The AlarmClass-Folder is available in the alarm palette.

- Refer to "About alarm class" on page 5-32 for related details.

**alarm-AlarmConsoleOptions**

The AlarmConsoleOptions component allows you to configure the parameters of the alarm console. The Options dialog box displays when you select the Workbench Tools > Options menu item.

- Refer to "Alarm console options" on page 2-26 for details about the individual alarm console options.
- Refer to About the alarm console for details about the alarm console.

The component is stored under the "/users/{user}/options" directory.

**alarm-AlarmPortalOptions**

This component allows you to configure the alarm portal parameters. The Options dialog box displays when you select the Workbench Tools > Options menu item.

- Refer to "Alarm portal options" on page 2-28 for details about the individual alarm console options.
- Refer to About the alarm console for details about the alarm console.

The component is stored under the "/users/{user}/options" directory.

**alarm-AlarmService**

The AlarmService uses AlarmClasses to route all alarm messages between AlarmSources and AlarmRecipients. Each station contains a single AlarmService. The AlarmService is available in the alarm palette.

- Refer to "About the alarm service" on page 5-7 for more details.

**alarm-AlarmSourceExt**

AlarmSourceExt is the abstract superclass of all Baja control alarming algorithms. The AlarmSourceExt is available in the alarm module. Some common alarm source extensions include OutOfRangeAlarmExt, BooleanChangeOfStateAlarmExt, BooleanCommandFailureAlarmExt, EnumChangeOfStateAlarmExt and EnumCommandFailureAlarmExt.

Refer to “About alarm extensions and components” on page 5-3 for more details.

**alarm-AlarmSourceInfo**

AlarmSourceInfo is a container slot on any network component, and also on each child device component. Properties under this slot are used to populate the alarm record when the network or device does not respond to the network's monitor ping. These properties work in the same fashion as those in an alarm extension for any control point. See "About alarm extension properties" on page 5-3 for AlarmSourceInfo property descriptions.

For more details, refer to these topics in the Drivers Guide:

- “About network Alarm Source Info”
- “Device Alarm Source Info”
alarm-BooleanChangeOfStateAlarmExt
BooleanChangeOfStateAlarmExt implements a change of state alarm detection algorithm for Boolean objects as described in BACnet Clause 13.3.2. This alarm extension is available in the Extensions folder of the alarm palette.

See the following links for more information:
- “Types of alarm extensions” on page 3-13
- “About alarm extensions and components” on page 5-3
- “About alarm extension properties” on page 5-3
- “About alarm extension manager” on page 5-26

alarm-BooleanCommandFailureAlarmExt
BooleanCommandFailureAlgorithm implements command failure alarm detection algorithm for Boolean objects as described in BACnet. If feedback and output values of the point are not equal for timeDelay duration, an offnormal alarm is generated. This alarm extension is available in the Extensions folder of the alarm palette.

See the following links for more information:
- “Types of alarm extensions” on page 3-13
- “About alarm extensions and components” on page 5-3
- “About alarm extension properties” on page 5-3
- “About alarm extension manager” on page 5-26

alarm-ConsoleRecipient
This component manages the transfer of alarms between the alarm history and the alarm console. The ConsoleRecipient is available in the alarm palette.

See the following links for more information:
- “About the console recipient” on page 5-36
- “Types of alarm recipients” on page 5-36
- “About the alarm service” on page 5-7

alarm-FaultAlgorithm
FaultAlgorithm is the super-class of all Fault detection mechanisms defined by Niagara, and contains properties that specify “fault” conditions. The default implementation does not generate any toFault alarms. A FaultAlgorithm is under each type of alarm extension, along with an OffnormalAlgorithm container. See “Types of alarm extensions” on page 3-13, and also “About alarm extensions and components” on page 5-3.

alarm-EnumChangeOfStateAlarmExt
EnumChangeOfStateAlarmExt implements a change of state alarm detection algorithm for Enum objects as described in BACnet Clause 13.3.2. Each algorithm instance defines a set of enumerated values that should be considered “offnormal” conditions and therefore generate an alarm. This alarm extension is available in the Extensions folder of the alarm palette.

See the following links for more information:
- “Types of alarm extensions” on page 3-13
- “About alarm extensions and components” on page 5-3
- “About alarm extension properties” on page 5-3
- “About alarm extension manager” on page 5-26

alarm-EnumCommandFailureAlarmExt
EnumCommandFailureAlarmExt implements command failure alarm detection algorithm for enum objects as described in BACnet. If feedback and output values of the enum point are not equal for more than timeDelay, an offnormal alarm is generated. This alarm extension is available in the Extensions folder of the alarm palette.

See the following links for more information:
- “Types of alarm extensions” on page 3-13
- “About alarm extensions and components” on page 5-3
- “About alarm extension properties” on page 5-3
- “About alarm extension manager” on page 5-26
alarm-LinePrinterRecipient

The LinePrinterRecipient component provides the capability to print alarms to line printers that are attached to a station that is running on a Win32 platform. This recipient can print to local and remote line printers. Alerts may be generated if the printing of an alarm fails, but the lineprinter recipient does not print alarms that it generates itself.

See the following links for more information:
- "About the lineprinter recipient" on page 5-44
- "Types of alarm recipients" on page 5-36
- "About the alarm service" on page 5-7

alarm-MemoryAlarmService

MemoryAlarmService provides an alternative to the standard file-based AlarmService. When you use this service, alarms are not stored persistently on the station’s host as they are with the standard file-based alarm service. The MemoryAlarmService is available in the alarm palette.

- Refer to "About memory alarm service" on page 5-7 for more details.

alarm-OutOfRangeAlarmExt

OutOfRangeAlarmExt implements a standard out-of-range alarming algorithm, and applies to points with a status numeric output. This alarm extension is available in the Extensions folder of the alarm palette. See “Types of alarm extensions” on page 3-13, and also “About alarm extensions and components” on page 5-3.

alarm-StationRecipient

Recipient for another station. This class receives alarms and formats them for another station. The StationRecipient is available in the alarm palette.

See the following links for more information:
- "About the station recipient" on page 5-41
- "Types of alarm recipients" on page 5-36
- "About the alarm service" on page 5-7

alarm-StatusAlarmExt

StatusAlarmExt provides alarming based upon any combination of status flags, and applies to all points/objects that accept extensions. This alarm extension is available in the Extensions folder of the alarm palette. See “Types of alarm extensions” on page 3-13, and also “About alarm extensions and components” on page 5-3.

alarm-StringChangeOfValueAlarmExt

(StringChangeOfValueAlarmExt provides the ability to alarm upon inclusion or exclusion of a particular string value, or more accurately, "regular expression" (regexp) of a point’s Out slot (string type). By default, matching is case sensitive, but this is configurable using the "Case Sensitive" property in the extension’s "Offnormal Algorithm" and "Fault Algorithm" container slots. By default, other configuration property values under Offnormal Algorithm and Fault Algorithm are:

- Expression — a value of .

This is the regexp value for "any text".
- Normal On Match — true

Thus, by default status remains ok until an edit is made to one or both properties above.

This alarm extension is available in the "Extensions" folder of the AX-3.6 and later alarm palette. See the following sections for more StringChangeOfValueAlarmExt related details:

- "Example"
- "Regexp notes"

Also see these sections for general alarm extension information:

- "Types of alarm extensions" on page 3-13
- "About alarm extensions and components" on page 5-3
- "About alarm extension properties" on page 5-3
• "About alarm extension manager" on page 5-26

Example
(Simple string) A hospital emergency room desires an alarm created whenever the moon enters a “full moon” phase. A StringWritable is created and given a StringChangeOfValueAlarmExt. In this extension:
In the Offnormal Algorithm’s “Expression” property, the following string is entered: *Full Moon*
The Offnormal Algorithm’s “Normal On Match” is set to false, and Case Sensitive is left at true.
In the station’s WeatherService, a WeatherProvider has a MoonPosition component, which serves as the link source. A link is made from the MoonPosition’s "Phase" property to the "In16 slot" of the StringWritable. On all phases of the moon but one, the StringWritable has a normal status. When MoonPosition’s phase changes to "Full Moon", the StringWritable has an alarm status, and remains so until the next moon phase ("Waning Gibbous").

Note that in this example, if the Expression string entry was simply: *Moon*, that alarms would occur during both phases that include the string "Moon", namely "Full Moon" and "New Moon".

**Regexp notes** The “Expression” property in both the Offnormal Algorithm and Fault Algorithm containers of a StringChangeOfValueExt can process a simple string value, as in the previous Example. The Expression property also processes a value using “regular expression” (regexp) syntax. This provides even more flexibility, such as with use of “or” operators, among others.

Regexp syntax is beyond the scope of this document, but a few regexp examples are listed below:

- Contains the word “alarm”:
  ```regex
  (*.)(alarm)(.*)
  ```
- Contains the word “offnormal” or “fault”:
  ```regex
  (*.)(offnormal)|(fault)(.*)
  ```
- Eight “1” or “0” characters, with the fourth and eighth characters being 1:
  ```regex
  (1|0){3}(1\{1|0\}{3}\{1
  ```
- Empty text:
  ```regex
  ^$
  ```
- Any text:
  ```regex
  .*
  ```
This is the default Expression property value, that is in an extension copied from the alarm palette.

**Components in alarmRdb module**

- rdbAlarmService

alarmRdb-RdbAlarmService
RdbAlarmService provides a means for using an RDBMS to store NiagaraAX alarm records instead of using the default alarm database (/^alarm\alarm.adb). This is different than exporting histories to an RDBMS. When you use the rdbAlarmService, it replaces the use of the station’s default alarm database.
- Refer to the Rdbms Driver Guide for information about setting up the RdbAlarmService component.

**Components in backup module**

- BackupService

backup-BackupService
The BackupService provides for complete configuration backups to a Workbench PC or a browser PC (user with Wb web profile). By default, the BackupService is included when you create a new station using the New Station wizard. The target Niagara host (JACE, Supervisor) must have the backup module installed.

A backup is a dist file (a zipped format) including minimally the station’s config.bog, current station console output (.txt file), and backup.log file. If other station file types and subfolders are not excluded (in the BackupService configuration), the backup dist file contains them too—for example, files of type: px, nav, html, jpg, png, and so forth. Also, the backup dist contains the zipped “nre-config” for that host (including license and certificates files), as well as pointers to the installed “nre-core,” OS, and JVM, each by version. Essentially, a backup dist provides a “configuration snapshot” of the entire JACE platform in zipped “dist” file format. This allows for a complete image restoration.
Note: Not included in a backup is runtime data that is actively managed by the station, such as the alarm and history databases. This data should be "backed up" using standard alarm routing and history archiving to a Supervisor host.

To restore a backup dist from Workbench, you open a platform connection to the JACE, then use the platform Distribution File Installer to install. Restoring from a backup may be necessary if the host hardware was replaced.

The default view of a station's BackupService is the BackupManager, which provides a Backup button to manually initiate a backup. A backup automatically performs a local station save first, and is run as a standard station Job. This means each backup provides a progress bar, and upon completion, a popup notification. Under the station's JobService, any backup appears as a "Fox Backup."

**BackupService configuration** Configuration lets you define the file types and/or folders not included in a station backup. The service's property sheet provides the following properties for configuration:

- **Enabled**
  
  Either true (default) or false. Currently, this setting makes no difference (manual backup still possible even if service has disabled status).

- **Exclude Files**
  
  Specifies file types to exclude from the backup dist, either by name or extension (each delimited by ";"). By default, the following files are excluded:
  
  - *.hdb;*.adb;*.lock;*backup*;console.*;config.bog.b*;config_backup*

- **Exclude Directories**
  
  Specifies station subdirectories to exclude from the backup dist, using relative ORD syntax. An ORD chooser control provides a Directory Chooser dialog in which you can select station subfolders. By default, the following subfolders are excluded:
  
  - file:^history, file:^alarm

- **Offline Exclude Files**
  
  Specifies file types to exclude from the backup dist, when the station is stopped on the source host. Either by name or extension (each delimited by ";"). By default, the following files are excluded:
  
  - *.lock;*backup*;console.*;config.bog.b*;config_backup*
  
  Note that history (*.hdb) and alarm (*.adb) files are backed up, unlike with a running backup.

- **Offline Exclude Directories**
  
  Specifies station subdirectories to exclude from the backup dist, when the station is stopped on the source host. Directories are specified using relative ORD syntax. An ORD chooser control provides a Directory Chooser dialog in which you can select station subfolders. By default, no directories are excluded, unlike with a running backup.

**Components in baja module**

- Category
- CategoryService
- Component
- DataFile
- Directory
- FileSystem
- Folder
- Format
- IpHost
- Job
- JobService
- LocalHost
- Module
- ModuleSpace
- Permissions
- PermissionsMap
- PxView
- ServiceContainer
- Spy
- Station
- UnrestrictedFolder
- User
- UserPrototypes
- UserService
Chapter 11 – Component Guides

Components in baja module

April 4, 2011

- Vector
- VirtualComponent
- VirtualGateway
- WsTextBlock
- ZipFile

**baja-Category**

Each Category represents a custom logical grouping, and has a unique category index number. You can assign components, files, and histories to one or more categories. All categorizable components have a CategorySheet view, which shows you that component’s stored category memberships (CategoryMask).

Categories reside under the station's CategoryService, which has views CategoryBrowser and CategoryManager. Categories play an integral role in station security, where you can give users permissions for some (or all) categories. For a general review, see “Security model overview” on page 7-1.

**baja-CategoryService**

The CategoryService is the station container for all Category(ies), which represent logical groupings to which you can assign components, files, and histories. The default view of this service, the CategoryBrowser, lets you centrally assign different objects to categories, using an expandable tree view of the station.

The CategoryService also provides a CategoryManager view, for you to create, edit and delete categories. Categories play an integral role in station security, where you can give users permissions for some (or all) categories. By default, the CategoryService is included when you create a new station using the New Station wizard. For more CategoryService details, see “CategoryService” on page 7-23.

**baja-Component**

Component is the required base class for all Baja component classes. The Component is available in the baja module.

**Using Containers** Containers allow you to logically group components. The current container is the component that contains components in the display window. A container may be selected as the current container by one of the following methods:

- Double-click the component in the Nav tree.
- Right-click the component in the Nav tree (which brings up a menu) and select a view.
- Right-click the component in a wire sheet (which brings up a menu) and select a view.

Container components include the following:

- Component can be used as a general container for components. It allows you to place components and links in a container.
- Page is a special component used to create a map of name/Ref pairs as dynamic slots.

**baja-DataFile**

DataFile represents a data file in the file system of a session.

**baja-Directory**

Directory is used to represent directories in File space implementations.

**baja-FileSystem**

FileSystem is a FileSpace for the local machine's file system.

**baja-Folder**

Folder is a special container designed to store components. The Folder is available in the baja palette.

**baja-Format**

Format (or "BFormat") is used to format objects into strings using a standardized formatting pattern language. The format string is normal text with embedded scripts denoted by the % percent character (use %% to insert a real %). A script is one or more calls chained together using the . dot operator. Calls are mapped to methods using reflections. Given call "foo", the order of reflection mapping is:

- special call (see below)
- getFoo(Context)
- getFoo()
- foo(Context)
- foo()
- get("foo")
The following special functions are available to use in a script:

- `time()` calls `Clock.time()` to get current time as an `AbsTime`
- `lexicon(module:key)` gets the specified lexicon text

Examples of formats:

- "hello world"
- "my name is %displayName%"
- "my parent’s name is %parent.displayName%"
- "%value% [%status.flagsToString() @ %status.priority%"
- "%time().toDateString()"
- "%lexicon(bajaui:dialog.error)"

Format is available in the `baja` Module.

**baja-IpHost**

- `IpHost` is used to represent a host machine that is identified with an IP address. The hostname of an `IpHost` is either a name resolvable via DNS or is a raw IP address.

**baja-Job**

A `Job` is used to manage a task that runs asynchronously in the background, but requires user visibility. Some example jobs include:

- *StationSaveJob* — From a station save, either initiated manually or from the auto-save function (see “PlatformServiceContainer configuration parameters” in the NiagaraAX Platform Guide).
- *FoxBackupJob* — From a station backup (zip) to a remote PC, see `BackupService`. Many drivers also have various job types too. For example, the NiagaraDriver includes a *StationDiscoveryJob* and *NiagaraScheduleLearnJob*.

Every job finishes displaying one of the following status descriptors:

- **Success** — Job completed successfully.
- **Canceled** — Job canceled by user.
- **Failure** — Job failed to complete.
- **Completed** — Job completed.

Also, if you have the station open in Workbench, you see a momentary “notification popup” in the lower-right corner of your display.

You can monitor and cancel a job from within the particular view where you initiated it, or centrally from the `JobServiceManager` view of a station’s `JobService`. You can also open a Jobs side bar to see all jobs in all opened stations (see “Using the jobs side bar” on page 10-9).

Regardless of how you access jobs, note the following:

- To see details on a job, click the “>>” button next to its status descriptor. A popup `Job Log` dialog displays all the interim steps about the job, including timestamps and relevant messages.
- To dispose of a job, click the close (“X”) button to remove it from the station.

**Note:** All jobs in a station are cleared upon a station restart.

**baja-StationSaveJob**

This component appears as a child of the job service and displays the following properties relative to the save job:

- **Job State** indicates which of the following states the save job is in currently: unknown, running, canceling, canceled, success, failed.
- **Progress** indicates a percentage (0-100) of progress toward completing the job.
- **Start Time** displays the time that the job started.
- **Heart Beat Time** displays the time of the last indication that the job is alive.
- **End Time** displays the time that the job ends

For related information, refer to:

- "baja-Job"
- "baja-JobService"

**Note:** All jobs in a station are cleared upon a station restart.
### Chapter 11 – Component Guides

#### Components in baja module

April 4, 2011

**baja-JobService**

The JobService contains jobs that were executed by different processes in the station. Each job appears as a child component. By default, the JobService is included when you create a new station using the **New Station** wizard. The default view of the JobService is the JobServiceManager.

**Note:** All jobs in a station are cleared upon a station restart.

**baja-LocalHost**

LocalHost represents the root of the Baja local Host namespace. The LocalHost is available in the baja Module.

**baja-Module**

Module encapsulates a Baja software module which is packaged and delivered as a JAR file with a "meta-inf/module.xml" description. Modules are the unit of software deployment in the Baja architecture. Module names must be one to 25 ASCII characters in length and globally unique. Modules are available in the ModuleSpace (called Modules under My Computer).

**baja-ModuleSpace**

ModuleSpace is the container for modules which are keyed by their module name. The ModuleSpace is available as Modules under My Computer.

**baja-Permissions**

Permissions are a property used to define the permissions given to a user’s PermissionsMap.

**baja-PermissionsMap**

Defines the security permissions to grant to a user. Permissions are added as dynamic properties with the name matching a Category and the value an instance of permissions. For more details, see “Permissions and security” on page 7-5 and “About permission levels” on page 7-6. If a user has been configured as a super user, then all permissions are automatically granted to all categories.

**baja-PxView**

PxView a dynamic view which may be added to components as a property or by overriding getAgents(). PxViews store the view contents in an XML file with a px extension. The view itself is defined as a tree of bajaui:Widgets.

**baja-ServiceContainer**

ServiceContainer (Services) is the container used, by convention, to store a station’s services. The ServiceManager is its primary view. A ServiceContainer is included in any station created using the **New Station** tool.

**baja-Spy**

Spy is an object wrapper for an instance of Spy.

**baja-Station**

Station (Config) represents the component configuration of a station in the Baja framework. See “Station” in the NiagaraAX Developer Guide for developer information. The Station is available in a fox connection to a NiagaraAX host, along with its file space (Files) and histories (History).

**Station Save**

Save the current state of the system to persistent storage. You should regularly backup your station or stations using the Save Action on the station.

**baja-UnrestrictedFolder**

UnrestrictedFolder is a special container designed to store objects for use on a palette. Normal isParentLegal() checks are not applied to UnrestrictedFolders. The UnrestrictedFolder is available in the baja palette.

**baja-User**

User is the component that represents a station connection, typically a specific person who needs to access the system. Users are children of the station’s UserService. User components are also children of the UserService’s UserPrototypes container, to allow “centralized user” support.

For more details, see the following sections:

- “Users and security” on page 7-2
- “User” on page 7-17 (all properties)
- “UserService security notes” on page 7-8

Also, see “Security model overview” on page 7-1.
**baja-UserPrototypes**

UserPrototypes is a frozen container on a station’s UserService. It contains a single frozen “Default Prototype” user, as well as any additional users needed for support of “centralized users” in the station’s NiagaraNetwork.

For more details, see “Users and security” on page 7-2.

**baja-UserService**

UserService is the service you use to add, edit, delete, and otherwise manage users of the station.

The UserManager is its primary view. Also available is a PermissionsBrowser view, in which you can review and change permissions for any user’s assigned Category(ies). See “Users and security” on page 7-2 and “UserService” on page 7-14 for more details. The UserService is available in the baja module. By default, the UserService is included when you create a new station using the New Station wizard.

*Note:* To facilitate user management, the UserService component has a unique permissions scheme. See “UserService security notes” on page 7-8 for details.

**baja-Vector**

Vector is a dynamic Struct which allows properties to be added at runtime.

**baja-VirtualComponent**

A VirtualComponent is the Baja base class for implementations of transient (non-persisted) components that reside in the station’s “virtual component space,” as defined by a VirtualGateway. Initial applications of virtual components are expected in various drivers for NiagaraAX. For a general explanation about Baja virtual components, see the Drivers Guide section “Virtual gateway and components”.

**baja-VirtualGateway**

A VirtualGateway is the Baja base class for a component that resides under the station’s component space (Config), and acts as a gateway to the station’s “virtual component space.” Note other object spaces are Files and History. Initial applications of virtual gateways are expected in NiagaraAX drivers. For a general explanation, see the Drivers Guide section “Virtual gateway and components”.

**baja-WsTextBlock**

WsTextBlock (Text Block) is a component you can drop onto a wire sheet (WireSheet) and position to add text notes. Properties include “Text” (to display), Foreground and Background colors, Font, Border, and whether the Text Block is directly “Selectable” in the wire sheet (by default, Selectable is true). If Selectable is false, you must select this component via its node in the Nav tree.

Text Block is available in the baja palette.

**baja-ZipFile**

ZipFile represents a zip file in the file system of a session.

### Components in bajaui module

- BorderPane
- Bookmark
- BoundTable
- Button
- CanvasPane
- CheckBox
- ConstrainedPane
- EdgePane
- Ellipse
- ExpandablePane
- FlowPane
- GridPane
- Label
- Line
- NullWidget
- RadioButton
- Rect
- Path
- Polygon
- PxInclude
- ScrollPane
- Separator
- Slider
- SplitPane
- TabbedPane
- TextEditorOptions
- ToggleButton
- ValueBinding

**bajaui-BorderPane**
BorderPane provides a border content for a widget similar to the CSS Box Model. Margin defines the space between the bounds and the border. Padding defines the space between the border and the child bounds. Border defines the look and width of the border around each of the sides.

**bajaui-Bookmark**
Bookmark provides a bookmark.

**bajaui-BoundTable**
BoundTable is a Table implementation that is ready to use with TableBindings to populate its model.

**bajaui-Button**
Button is a control button which fires an action when pushed.

**bajaui-CanvasPane**
CanvasPane is commonly used to provide absolute layout using Layout for most Widgets and Geom for Shapes. CanvasPane also provides support for scaling and/or aligning its contents.

**bajaui-CheckBox**
CheckBox is a specialized ToggleButton which displays its label next to a box which can be checked and unchecked.

**bajaui-ConstrainedPane**
ConstrainedPane is a pane with a constrained size. It allows the pane to be restricted by minimum width, maximum width, minimum height, and maximum height.

**bajaui-EdgePane**
EdgePane is a container with a layout like the java.awt.BorderLayout. It only supports five potential children in the frozen slots top, bottom, left, right, and center. The top and bottom widgets fill the pane horizontally use their preferred height. The left and right widgets use their preferred width, and occupy the vertical space between the top and bottom. The center widget gets all the remainder space. Any of the widgets may be a NullWidget.

**bajaui-Ellipse**
Ellipse renders a ellipse geometry.

**bajaui-ExpandablePane**
ExpandablePane contains two widgets. A summary widget is displayed all the time, with a button to the right used to expand and collapse the pane. When expanded, the expansion widget is displayed under the summary.

**bajaui-FlowPane**
FlowPane lays out its children from left to right and top to bottom fitting as many children as possible in each row. It is based on the java.awt.FlowLayout.

**bajaui-GridPane**
GridPane provides flexible layout based on a grid with a predefined number of columns. Cells are laid out left to right, flowing to the next row based on the columnCount property. Row height is determined by the max preferred height of the widgets in the row. If uniformRowHeight is true then all row heights are sized using the max row. Column width is determined by the max preferred width of the widgets in the column. If uniformColumnWidth is true then all column widths are sized using the max column. If rowLayout is set to fill then all widgets in a given row are sized to fill the row height. Otherwise the widgets use their preferred height and are aligned accordingly. If columnLayout is set to fill then all widgets in a given column are sized to fill the column width. Otherwise the widgets use their preferred width and are aligned accordingly. The columnGap field specifies how many pixels to leave between columns. The rowGap field specifies how many pixels to leave been rows. By default if the actual space of the pane is bigger than the preferred size, then the horizontalPaneAlignment and verticalPaneAlignment fields determine where to put the extra space. Or the stretchColumn and stretchRow properties may be
used to indicate that a specific column or row should be stretched to fill the additional space. Enabling the stretch feature trumps pane alignment. If the colorRows field is true then alternating rows are shaded to produce a striped effect.

**bajaui-HyperlinkLabel**

The HyperlinkLabel has the same properties as the Label (see "bajaui-Label"), plus an ORD property that allows you to assign an ORD to the label. When an ORD path is supplied for this property, the HyperlinkLabel causes a mouse cursor to change to a standard link cursor and the component performs a hyperlink when clicked.

**bajaui-Label**

Label is used to display text and/or an icon. Labels are always transparent, so their background is defined by their parent. Their preferred size is always an exact fit to contain the text and/or icon. Labels may be used by themselves to display information which cannot respond to user input, or they may be embedded in widgets such as Buttons.

**bajaui-Line**

Line renders a line between two points.

**bajaui-NullWidget**

The NullWidget is a place holder widget to use as a null property value. For example, NullWidgets are used in an EdgePane widget to hold a place for the Top, Left, Center, Right, and Bottom contents, as shown in the following illustration:

![NullWidgets](image)

**bajaui-RadioButton**

RadioButton is a specialized ToggleButton which displays its label next to a circle which can be checked and unchecked. It is used with groups of other RadioButton's to provide an choice which is exclusive of other options.

**bajaui-Rect**

Rect renders a rectangle shape.

**bajaui-Path**

Defines a general path to draw or fill, using a model and string format based on the SVG path element.

**bajaui-Polygon**

Models a closed area defined by a series of line segments, using string format "x,y,width,height".

**bajaui-PxInclude**

This widget provides a way for users to embed a single Px file in another Px file. The PxInclude widget is located in the NiagaraAX-3.3 bajaui palette. Refer to "About the PxInclude Widget".

**bajaui-ScrollPane**

ScrollPane layouts one child using a viewport which may be scrolled to view the entire child's actual size.

**bajaui-Separator**

Separator is used in ToolBars and Menus to provide a visible separator between groups of buttons.

**bajaui-Slider**

Slider provides a visual slider which is used to select and integer or floating point value between a fixed range.

**bajaui-SplitPane**

SplitPane is a pane with a divider between two child widgets. The children can be laid out horizontally or vertically. Use the SplitPane properties to configure the behavior and position of the divider between the two panes.
**bajaui-TabbedPane**

TabbedPane is a container which displays a set of LabelPane children one at a time using a set of "tabs" to select the currently displayed child. The LabelPane’s label is used to label each tab, and the content of the current selection fills the rest of the pane.

**bajaui-TextEditorOptions**

The TextEditorOptions stores the options used to configure text entry. The Status Colors options allow you to view and change the following (default):

- Show Spaces (false)
- Show Tabs (false)
- Show Newlines (false)
- Tab To Space Conversion (2)
- Show Margin (0)
- Color Coding
  - Foreground (00 00 00 black)
  - Whitespace (c0 c0 c0 gray)
  - Number Literal (80 00 80 purple)
  - String Literal (80 00 80 purple)
  - Identifier (00 00 00 black)
  - Keyword (00 00 ff blue)
  - Preprocessor (80 00 00 maroon)
  - Bracket (ff 00 00 red)
  - Line Comment (00 80 00 green)
  - Multi Line Comment (00 80 00 green)
  - Non Javadoc Comment (80 80 80 dark gray)
- Key Bindings (with default)
  - Move Up Up
  - Move Down Down
  - Move Left Left
  - Move Right Right
  - Page Up PageUp
  - Page Down PageDown
  - Line Start Home
  - Line End End
  - Document Start Ctrl + Home
  - Document End Ctrl + End
  - Word Left Ctrl + Left
  - Word Right Ctrl + Right
  - Cut Ctrl + X
  - Copy Ctrl + C
  - Paste Ctrl + V
  - Undo Ctrl + Z
  - Redo Ctrl + Alt + Z
  - Delete Delete
  - Backspace Backspace
  - Cut Line Ctrl + Y
  - Delete Word Ctrl + Delete
  - Tab Forward Tab
  - Tab Back Shift + Tab
  - Toggle Slash Slash Esc
  - Word Wrap Ctrl + W
  - Goto Line Ctrl + G
  - Find F5
  - Find Next Ctrl + F
  - Find Prev Ctrl + Shift + F
  - Replace F6
  - Reload Macros Ctrl + M
  - Select All Ctrl + A
- Undo Navigation (true)
- Match Parens (true)
- Match Braces (true)
- Match Brackets (true)
These are stored under /user/\{user\}/textEditor.options.

bajaui-ToggleButton

ToggleButton provides a two-state widget which may be selected and unselected.

bajaui-ValueBinding

ValueBinding is used to bind to Values typically under a Component. Widget properties may be overridden by creating dynamic slots of the same name with a Converter that maps the bound target to the property value.

### Components in chart module

- BarChart
- ChartCanvas
- ChartHeader
- ChartPane
- DefaultChartLegend
- LineChart

**chart-BarChart**

One of two chart types available (the other is LineChart).

**chart-ChartCanvas**

ChartCanvas is the canvas widget under a ChartPane.

**chart-ChartHeader**

ChartHeader is the header widget under a ChartPane.

**chart-ChartPane**

ChartPane is the container widget created when adding a Px chart.

**chart-DefaultChartLegend**

DefaultChartLegend is the legend widget under a ChartPane.

**chart-LineChart**

One of two chart types available (the other is BarChart).

### Components in control module

- BooleanPoint
- BooleanWritable
- DiscreteTotalizerExt
- EnumPoint
- EnumWritable
- NullProxyExt
- NumericPoint
- NumericTotalizerExt
- NumericWritable
- StringPoint
- StringWritable
- TimeTrigger

**control-BooleanPoint**

BooleanPoint is a basic read-only control point, with default slots: Facets, Out, and ProxyExt. See “About control points” on page 3-1 for details. The BooleanPoint is available in the Points folder of the control palette.

**control-BooleanWritable**

BooleanWritable extends BooleanPoint to include 16 levels of command priority control. The highest priority active command is reflected in the out property. Commands at the emergency and manual levels (1 and 8) are stored persistently. See “About control points” on page 3-1, and “About writable points” on page 3-19 for more details.

The BooleanWritable is available in the Points folder of the control palette.
control-DiscreteTotalizerExt
DiscreteTotalizerExt is a control point extension for accumulating runtime and change of state counts on binary or enum values. Two actions are available to clear (zero) accumulated totals, ResetChangeOfStateCount and ResetElapsedActiveTime.

The DiscreteTotalizerExt is available in the Extensions folder of the control palette.

control-EnumPoint
EnumPoint is a basic read-only control point, with default slots: Facets, Out, and ProxyExt. See “About control points” on page 3-1 for details. The EnumPoint is available in the Points folder of the control palette.

control-EnumWritable
WritableEnumPoint extends EnumPoint to include 16 levels of command priority control. The highest priority active command is reflected in the Out property. Commands at the emergency and manual levels (1 and 8) are stored persistently. See “About control points” on page 3-1, and “About writable points” on page 3-19 for more details.

The EnumWritable is available in the Points folder of the control palette.

control-NullProxyExt
NullProxyExt is the default implementation of AbstractProxyExt used to indicate that a point is not a proxy point. The NullProxyExt is in the control palette’s Extensions folder, but is already present by default on compatible point types. Presence indicates that you can add other types of extensions to the parent component, for example alarm or history extensions.

control-NumericPoint
NumericPoint is a basic read-only control point, with default slots: Facets, Out, and ProxyExt. See “About control points” on page 3-1 for details. The NumericPoint is available in the Points folder of the control palette.

control-NumericTotalizerExt
NumericTotalizerExt is a control point extension used for integrating a numeric point value over time. For example, a totalizer with a minutely totalization interval can convert an instantaneous flow reading in cubic feet per minute (cfm) into a value representing total cubic feet consumed. An available resetTotal action clears (zeroes) any accumulated total.

The NumericTotalizerExt is available in the Extensions folder of the control palette.

control-NumericWritable
NumericWritable extends NumericPoint to include 16 levels of command priority control. The highest priority active command is reflected in the Out property. Commands at the Manual and manual levels (1 and 8) are stored persistently. See “About control points” on page 3-1, and “About writable points” on page 3-19 for more details.

The NumericWritable is available in the Points folder of the control palette.

control-StringPoint
StringPoint is a basic read-only control point, with default slots: Facets, Out, and ProxyExt. See “About control points” on page 3-1 for details. The StringPoint is available in the Points folder of the control palette.

control-StringWritable
StringWritable extends StringPoint to include 16 levels of command priority control. The highest priority active command is reflected in the Out property. Commands at the Manual and manual levels (1 and 8) are stored persistently. See “About control points” on page 3-1, and “About writable points” on page 3-19 for more details.

The StringWritable is available in the Points folder of the control palette.

control-TimeTrigger
TimeTrigger is a component that fires a topic at configured times. It is available configured as both “Interval” or “Daily” in the Trigger folder of the control palette.

Components in converters module
- EnumToSimpleMap
converters-EnumToSimpleMap
EnumToSimpleMap maps ordinals to Simple instances of the same type.

Components in crypto module
- CryptoService
- SslProvider

crypto-CryptoService
CryptoService provides a central location to acquire cryptographic services, as SslProvider child components. The CryptoService is available in the crypto palette.

crypto-SslProvider
Provides SSL configuration. Modification of the properties here will not modify a keystore. In other words, the properties here must mirror the already existing keystore. For more details, see Bajadoc at BSSLProvider.bajadoc.

Components in devkit module
- LexiconOptions
devkit-LexiconOptions
The LexiconOptions stores the options used by the LexiconReport and LexiconEditor. The Lexicon options allow you to change the following:
- Hide Ref Values
- Hide Accelerators
- Show Missing Only
These are stored under /user/{user}/lexicon.options.

Components in email module
- Email
- EmailAlarmAcknowledger
- EmailRecipient
- EmailService
- IncomingAccount
- OutgoingAccount

e-mail-Email
Email represents an email message.

e-mail-EmailAlarmAcknowledger
The EmailAlarmAcknowledger component (AX-3.5 and later) provides a way for users to acknowledge alarms by sending an email reply to an email alarm notification. This component is available in the email palette and works with the On Call Service or directly with the Email Service. Also see “About the Email Alarm Acknowledger” on page 5-15.

Actions
Actions include: Received, which opens the Received email dialog box.

e-mail-EmailRecipient
The top-level email Messaging service. This service manages the routing of all email messages from message sources to message recipients. The EmailRecipient is available in the email palette.

Actions
Actions include RouteAlarm.

email-EmailService
EmailService manages the life-cycle of Email. The EmailAccountManager is its primary view. The EmailService is available in the email palette. EmailService may contain an IncomingAccount component and an OutgoingAccount component.

e-mail-IncomingAccount
IncomingAccount is a Email that receives mail. A number of properties specify the SMTP host, port, and user credentials to use, as well as other parameters. The IncomingAccount is available in the email palette.
IncomingAccount properties include the following:

- **Hostname**
  This is the name of the mail server. For example `mail.acme.com` could be a Hostname.

- **Port**
  This is the port number associated with the email account. Typically email incoming account port numbers are port "110", however, if you leave the setting at its default value of "-1" the IncomingAccount will search for and use a valid port.

  **Caution**
  With the default configuration (see "Delivery Policy" property, below) the incoming email account deletes all emails from the mail server when it checks the account to retrieve new email, even if the emails are already marked as read by another email client. If permanent retention of the emails is required then do one of the following: change the Delivery Policy setting from Delete or configure a second service account which the mail server forwards emails to and configure the station’s incoming account to check the second service account.

- **Account**
  This is the name of the distinct account that is authorized for access to the "Hostname" mail server. For example, if you are using an email account named "controls@acme.com" on the host described above, the account name is simply "controls". The Hostname in this case could be "mail.acme.com".

- **Password**
  This is the login credential for the Account specified in the previous field.

- **Pollrate**
  This field allows you to specify how often the account connects to the mail server and checks for unread mail messages. Increasing the pollrate value increases the time between polls.

- **Enabled**
  This field allows you to activate or deactivate the account by choosing true or false, respectively.

- **Status**
  This is a read-only display of the condition of service. The status displays {ok} if the account is polling successfully. Other indications include:
  - {down} which means that the polling is unsuccessful, perhaps because of an incorrect Hostname, Password, or Account name.
  - {disabled} because the Enable property is set to false

- **Last Poll Success, Last Poll Failure**
  These two properties display the time (in hours and minutes) of the last polling success and failure.

- **Last Poll Failure Cause**
  This display-only field provides an error message to indicate a reason for polling failure.

- **Debug**
  This Boolean property turns Debug mode on true or off, as desired. When Debug is turned on, you can see detailed debug information in a station’s standard output view (WorkbenchAX Platform > Application Director view) when the Station tries to send or receive email. This can be used to troubleshoot the accounts and faults.

- **Use Ssl**
  The Ssl (Secure Socket Layer) option is available starting in NiagaraAX-3.5. The option list allows you to disable Ssl (false) or enable it (true). Enable Ssl for communication with a host email server that requires it.

- **Store**
  This property allows you to choose between two standards of mail retrieval. You need to choose the option that is in use by your host mail server: `Imap` or `Pop3`.

- **Delivery Policy**
  This property (available starting in NiagaraAX-3.5) provides an option list that allows you to select how the incoming email account handles incoming emails at the mail server.
  The following options are available:
  - **Delete**
    With this configuration the incoming email account deletes all emails from the mail server when it checks the account to retrieve new email, even if the emails are already marked as read by another email client.
  - **Mark As Read**
    This option marks all emails as read on the mail server when it checks the account to retrieve new email.
- **Mark As Unread**
  This option marks all emails as unread on the mail server when it checks the account to retrieve new email.

**email-OutgoingAccount**
OutgoingAccount is a Email that sends mail. A number of properties specify the SMTP host, port, and user credentials to use, as well as other parameters. A "Max Sendable Per Day" property can limit the number of station-generated emails, where the default value is 100. The OutgoingAccount is available in the email palette.

OutgoingAccount properties include the following:

- **Hostname**
  This is the name of the mail server. For example mail.acme.com could be a Hostname.

- **Port**
  This is the port number associated with the email account. Typically email outgoing account port numbers are port "25", however, if you leave the setting at its default value of "-1" the OutgoingAccount will search for and use a valid port.

- **Account**
  This is the name of the distinct account that is authorized for access to the "Hostname" mail server. For example, if you are using an email account named "controls@acme.com" on the host described above, the account name is simply "controls". The Hostname in this case could be "mail.acme.com".

- **Password**
  This is the login credential for the Account specified in the previous field. Increasing the pollrate value increases the time between polls. During the time between polls, emails may be queued (up to the max queue size) until the next poll time. At the next poll time all queued emails are sent.

- **Pollrate**
  This field allows you to specify how often the account executes a send action.

- **Enabled**
  This field allows you to activate or deactivate the account by choosing true or false, respectively.

- **Status**
  This is a read-only display of the condition of service. The status displays {ok} if the account is polling successfully. Other indications include:
  - {down} which means that the polling is unsuccessful, perhaps because of an incorrect Hostname, Password, or Account name.
  - {disabled} because the Enable property is set to false

- **Last Poll Success, Last Poll Failure**
  These two properties display the time (in hours and minutes) of the last polling success and failure.

- **Last Poll Failure Cause**
  This display-only field provides an error message to indicate a reason for polling failure.

- **Debug**
  This Boolean property turns Debug mode on true or off, as desired. When Debug is turned on, you can see detailed debug information in a station’s standard output view (WorkbenchAX Platform > Application Director view) when the Station tries to send or receive email. This can be used to troubleshoot the accounts and faults.

- **Use Ssl**
  The Ssl (Secure Socket Layer) option is available on the OutgoingAccount starting in NiagaraAX-3.5. The option list allows you to disable Ssl (false) or enable it (true). Enable Ssl for communication with a host email server that requires it.

- **Transport**
  This field allows you to select from available options for email communication. The default setting and most common is SMTP.

- **Connection Timeout**
  This configurable field setting controls how long the station waits for a response from the mail server before generating an exception and setting the fault cause. It waits for the next scheduled poll and attempts to contact the mail server again at that frequency.

- **Use Authentication**
  This property allows you to specify that login credentials are required for sending any email. Sometimes authentication is not required for emails routed to recipients in the same domain. Setting this property to true makes the login credentials mandatory for any email.

- **Reply To**
  This field specifies the contents of the "From:" field in the email that is sent.
• **Persistent, Persistent Directory**
  Setting the Persistent property to true saves each queued email as an xml file in the designated persistence directory. Once the emails are actually sent, the xml files are deleted from the directory. The purpose of this is to keep a copy of the emails in the queue which would be lost if the station was stopped prior to the emails being sent. When the station restarts, emails are loaded from the "Persistent Directory" back to the queue.

• **Email Queue Tracking Properties**
  "Queue" is where emails reside while they are waiting to be sent. Assuming that the Account Status is "ok", typically, the length of time that an email is in the queue depends on the "Pollrate" setting. The following properties relate to the queue and mail management properties
  - **Allow Disabled Queuing**
    This property (when set to true) allows emails to reside in the queue even when the Enabled status is set to false.
  - **Queue Size**
    This property refers to how many emails are currently in the queue (waiting to be sent). You can clear the queue at any time by right-clicking on the appropriate outgoing account property and selecting Actions > Clear Queue from the popup menu.
  - **Max Queue Size**
    This property allows you to specify how many emails are allowed to occupy the queue.
  - **Number Sent**
    This property displays the number of emails that have been sent. You can reset this number to zero at any time by right-clicking on the appropriate outgoing account property and selecting Actions > Reset Number Sent from the popup menu.
  - **Max Sendable Per Day**
    This property allows you to specify how many emails may be sent in one day.
  - **Number Discarded**
    This read-only property (NiagaraAX-3.5 and later) displays a value to indicate how many emails did not successfully send.
  - **Last Discard**
    This read-only property (NiagaraAX-3.5 and later) displays a date and time value to indicate when the last email did failed to send.
  - **Last Discard Cause**
    This read-only property (NiagaraAX-3.5 and later) displays an error message that indicates the cause of the last email send failure.

**Components in file module**

- ApplicationFile
- AudioFile
- BajadocFile
- BogFile
- BogScheme
- BogSpace
- CFile
- CssFile
- ExcelFile
- GifFile
- HtmlFile
- ImageFile
- JavaFile
- JpegFile
- NavFile
- PaletteFile
- PdfFile
- PngFile
- PowerPointFile
- PrintFile
- PxFile
- TextFile
- VideoFile
- VisioFile
Components in file module

- WordFile
- XmlFile

**file-ApplicationFile**
- ApplicationFile stores an application file.

**file-AudioFile**
- AudioFile stores an audio file.

**file-BajadocFile**
- BajadocFile represents Bajadoc documentation. Bajadoc is a special file that can describe components in a database.

**file-BogFile**
- BogFile represents a BogFile in the file system of a session. A Bog File is a special file that can describe Components in a Database.

**file-BogScheme**
- BogScheme represents a BogScheme in the file system of a session. A Bog File is a special file that can describe Components in a Database.

**file-BogSpace**
- BogSpace represents a BogSpace in the file system of a session. A Bog File is a special file that can describe Components in a Database.

**file-CFile**
- CFile stores a c source file.

**file-CssFile**
- CssFile stores a CSS cascading style sheet.

**file-ExcelFile**
- ExcelFile stores a Microsoft Excel file.

**file-GifFile**
- GifFile stores a GIF image.

**file-HtmlFile**
- HtmlFile stores HTML markup.

**file-ImageFile**
- ImageFile stores an image.

**file-JavaFile**
- JavaFile stores a java source file.

**file-JpegFile**
- JpegFile stores a JPEG image.

**file-NavFile**
- NavFile stores XML nav markup.

**file-PaletteFile**
- Palette file is just a Bog File file with a different extension and icon.

**file-PdfFile**
- PdfFile stores a Adobe PDF file.

**file-PngFile**
- PngFile stores a PNG image.

**file-PowerPointFile**
- PowerPointFile stores a Microsoft PowerPoint file.

**file-PrintFile**
- PrintFile stores XML print markup.

**file-PxFile**
- PxFile is just a Bog File file with a different extension and icon.
file-TextFile
- TextFile stores plain text.

file-VideoFile
- VideoFile stores an video file.

file-VisioFile
- VisioFile stores a Microsoft Visio file.

file-WordFile
- WordFile stores a Microsoft Word file.

file-XmlFile
- XmlFile stores an xml file.

Components in flr module
- FLR

flr-FlrService
- The FloatingLicenseRepository (FLR) component provides the service for setting up a floating license server in NiagaraAX. The component has one action “Reload”. This action reloads or “reads” the license pack file (LPF) into the FLR server application. This component is found in the flr palette.

For details, refer to the NiagaraAX Floating License Repository (FLR) - Engineering Notes document.

Components in gx module
- Brush

gx-Brush
- Brush is used to change presentation. The Brush is available in the gx Module.

Components in help module
- BajadocOptions

help-BajadocOptions
- The BajadocOptions stores the options used by the BajadocViewer. The Bajadoc options allow you to change the following:
  - Show Baja Only
  - Flatten Inheritance

These are stored under /user/{user}/bajadoc.options.

Components in history module
- AuditRecord
- AuditHistoryService
- BooleanCovHistoryExt
- BooleanIntervalHistoryExt
- ConfigRule
- ConfigRules
- CovAlgorithm
- EnumCovHistoryExt
- EnumIntervalHistoryExt
- FoxHistory
- FoxHistorySpace
- HistoryConfig
- HistoryDevice
- HistoryEditorOptions
- HistoryGroup
- HistoryGroupings
- HistoryId
- HistoryPointList
- HistoryPointListItem
- HistoryService
- HistoryShortcut
- IntervalAlgorithm
- LocalDatabaseConfig
- LogHistoryService
- NumericCovAlgorithm
- NumericCovHistoryExt
- NumericIntervalHistoryExt
- StringCovHistoryExt
- StringIntervalHistoryExt

**history-AuditRecord**

The AuditRecord keeps a History of changes made by users. If enabled, it registers itself as the Auditor for the system when the service is started. The AuditRecord is available in the History Module under the HistoryService.

**history-AuditHistoryService**

The AuditHistoryService keeps a history of changes made by users. If enabled, it registers itself as the auditor for the station when the service is started. The AuditHistoryService is available in the history palette.

One of the important aspects of security is the ability to analyze what has happened after the fact. The Niagara component model is designed to audit all property modifications and all action invocations. Auditable actions include:

- Property changed
- Property added
- Property removed
- Property renamed
- Properties reordered
- Action invoked

Component modifications are only audited when the modification method is passed a non-null context with a non-null user. The history module includes a standard implementation of an audit trail stored to an AuditHistory history.

For more details, see “About user audits” on page 7-9.

**history-BooleanCovHistoryExt**

BooleanCovHistoryExt is a history extension that is used for recording on change of value for boolean point data. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.

**history-BooleanIntervalHistoryExt**

BooleanIntervalHistoryExt is a history extension that is used for recording on intervals for boolean point data. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.

**history-ConfigRule**

ConfigRule is used to determine the overrides for an existing history configuration. The ConfigRule is available in the history Module.

**history-ConfigRules**

ConfigRules is the container for rules that determine the configuration of histories that are pushed to the local device. Configuration rules are applied when a history is created. Changing a rule has no effect on existing histories. The ConfigRules is available in the history Module.

**history-CovAlgorithm**

CovAlgorithm determines when to log a point’s value according to change of value. The CovAlgorithm is available in the history Module Extensions Directory under some Change Of Value extensions as Collector.

**history-EnumCovHistoryExt**

EnumCovHistoryExt is a history extension used to record on a change of value for Enum point data. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.
**history-EnumIntervalHistoryExt**  
EnumIntervalHistoryExt is a history extension used to record on intervals for Enum point data. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.

**history-FoxHistory**  
FoxHistory is the implementation of BIHistory that works with the FoxHistorySpace.

**history-FoxHistorySpace**  
FoxHistorySpace provides access to a History Database using the fox protocol.

**history-HistoryConfig**  
HistoryConfig is the configuration for a History in the History Database.

**history-HistoryDevice**  
HistoryDevice represents a source device for histories.

**history-HistoryEditorOptions**  
The HistoryEditorOptions stores the options used to configure history options. These are stored under `/user/{user}/textEditor.options`.

**history-HistoryGroup**  
The HistoryGroup component provides a way to organize alternate navigation presentations for a station's history space. Use the properties in this component to specify metadata properties for grouping histories. Add the HistoryGroup component to the HistoryGroupings container-component by dragging and dropping it from the history palette or by clicking the **New** button in the History Group Manager view.

Also see the following topics:

- "About history grouping" on page 4-30
- "About the History Group property sheet view" on page 4-31
- "About the History Group Manager view" on page 4-31

**history-HistoryGroupings**  
The HistoryGroupings component is available in AX-3.5 as a property of (frozen slot on) the HistoryService component. This component serves as a container for HistoryGroup components. The default view of the HistoryGroup component is the HistoryGroupManager view. You can add HistoryGroup components under the HistoryGroupings component by dragging and dropping a HistoryGroup from the History palette or by You can add HistoryGroup components to this component by clicking the **New** button in the History Group Manager view.

Also see the following topics:

- "About history grouping" on page 4-30
- "About the History Group property sheet view" on page 4-31
- "About the History Group Manager view" on page 4-31

**history-HistoryId**  
The HistoryId component is a container for History id.

**history-HistoryPointList**  
This component is available in the history module. It is a container that holds the "history-HistoryPointListItem" components that you add to it. The default view of this component is the Live History Chart view. The property sheet view is where you configure the HistoryPointList properties.

The HistoryPointList component properties include the following:

- **Max Samples**  
  Defines the maximum number of samples to store for each history extension displayed.

- **Time Window**  
  Defines the time range to display on the Time Axis while viewing the live chart. If the chart is "zoomed" you will be able to pan and view all the collected data defined by Max Samples.

- **Background**  
  Specifies the background color of the chart. The default setting is "null".

- **Show Horizontal Grid Lines**  
  Shows (true) or hides (false) horizontal grid lines on the chart.

- **Show Vertical Grid Lines**  
  Shows (true) or hides (false) vertical grid lines on the chart.
**Note:** If the Live History Chart view is invoked from a history extension, the following default property values are used to display the view:

- Max Samples value = 5000
- Time Window value = 10 minutes
- Start Time = 0 hours 0 minutes
- Sample Rate = Auto

In addition to the HistoryPointList properties, the property sheet view displays all associated HistoryPointListItem components below the properties. If the view is invoked from the History Point List component the items in the list can be selected/unselected and the view will update as needed.

Refer to "history-HistoryPointListItem" and "About the Live History Chart View" for more information.

**history-HistoryPointListItem**

This component is available in the history module. Each HistoryPointListItem is linked to a single history extension and is configured in the Add Item dialog box or in the HistoryPointListItem property sheet. HistoryPointListItem configurable properties include the following.

- **History Extension**
  The Ord to the History Extension of the Control Point you wish to view. This MUST be the History Extension and NOT the Control Point or its corresponding History Component.

- **Display On Startup**
  Indicates whether or not to automatically display the chart for this item when the view first comes up.

- **Start Time**
  Indicates how much of the collected history data you wish to view. The time that is entered in this property will be subtracted from the current time to get the initial history data.

**Note:** The following conditions apply:

- If no data is found within the given Start Time the LAST collected value is retrieved for the item.
- If the Start Time is 0 hours 0 minutes ALL collected history values is retrieved for the item.

- **Sample Rate**
  The rate at which to sample the "live" data.
  - **Auto**
    This value follows the interval defined in the history extension configuration
  - **Fixed**
    This value follows a defined interval that is specified by the user in terms of hours, minutes, and seconds.
  - **Cov**
    This value specifies that updates are plotted whenever there is a change of value.

- **Min Value Range**
  The minimum value to display on the value axis.
  - **Auto**
    This value uses the minimum value from the data collected.
  - **Fixed**
    This value uses the value specified by the user. This only applies to numeric points (Booleans and Enums do not use this property).

- **Max Value Range**
  This value is the maximum value to display on the value axis.
  - **Auto**
    This value uses the maximum value from the data collected.
  - **Fixed**
    This value uses the value specified by the user. This only applies to numeric points (Booleans and Enums do not use this property).

**Note:** If Min Value Range and Max Value Range are Fixed AND have the same values charts may share the value axis. If these two conditions do not exist, additional value axes may be added to the chart, as needed.

- **Line Color**
  This value specifies the desired color for the plot line.

- **Pen**
  This value specifies the line-weight and type to use for the plot line.

- **Item Name**
  This value specifies the name that is displayed on the view. This name must be unique within the list of items.
Refer to "history-HistoryPointList" and "About the Live History Chart View" for more information.

**history-HistoryService**

The History service provides http access to all histories in the Station. This service manages the History lifecycle, including creation and deletion. Additionally, HistoryService maintains the namespace for all Histories. As histories are created, they are added as slots to this service, and removed upon deletion. When the service is started, all existing histories are added to the service. Additionally, this service maintains global configuration for the histories. Each Station contains a single HistoryService. The HistoryService is available in the history module.

See the "About the history service" on page 4-2 for more information.

**CloseUnusedHistories** Close all Unused Histories in this service.

**FlushHistories** Flush all histories managed by this service.

**history-HistoryShortcut**

The HistoryShortcut (History Nav Shortcut) component provides a way to include convenient access to histories from various locations in a station nav tree hierarchy.

The HistoryShortcuts component is available on the History palette. For details, see "About history nav shortcuts" on page 4-32.

**history-IntervalAlgorithm**

IntervalAlgorithm logs a value periodically at a fixed interval. The IntervalAlgorithm is available in the history Module Extensions Directory under some Interval extensions as Collector.

**history-LocalDatabaseConfig**

LocalDatabaseConfig is the configuration for a LocalHistoryDatabase.

**history-LogHistoryService**

The LogHistoryService keeps a History of Niagara log records. If enabled, it registers itself as the LogHandler for the system when the service is started. The LogHistoryService is available in the History Module.

**history-NumericCovAlgorithm**

NumericCovAlgorithm determines when to log a numeric point’s value according to change of value. The NumericCovAlgorithm is available in the history Module Extensions Directory under NumericChangeOfValue as Collector.

**history-NumericCovHistoryExt**

NumericCovHistoryExt is a history extension used to record on change of value for numeric point data. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.

**history-NumericIntervalHistoryExt**

NumericIntervalHistoryExt is a history extension used to record on interval for numeric point data. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.

**history-StringCovHistoryExt**

StringCovHistoryExt is a history extension used for collecting a string control value on change of value. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.

**history-StringIntervalHistoryExt**

StringIntervalHistoryExt is a history extension for collecting a string control value at intervals. This extension is available in the history Module Extensions Directory. Refer to “Types of history extensions” on page 3-14 for more information about this extension.

### Components in kitPx module

- ActionBinding
- AnalogMeter
- Bargraph
- BackButton
- BoundLabel
- BoundLabelBinding
Components in kitPx module

Chapter 11 – Component Guides

April 4, 2011

- ButtonGroup
- ButtonGroupBinding
- ExportButton
- ForwardButton
- GenericFieldEditor
- ImageButton
- IncrementSetPointBinding
- LogoffButton
- RefreshButton
- SaveButton
- SetPointBinding
- SetPointFieldEditor

**kitPx-ActionBinding**

kitPx-ActionBinding invokes an action on the binding target component when an event is fired by the parent widget. The ORD of an action binding must resolve down to a specific action within a component.

Additional information and related topics include:

- “About action bindings” on page 6-26
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

**kitPx-AnalogMeter**

kitPx-AnalogMeter is a widget that is designed to look and act like an analog meter. This component comes with a value binding that should be bound to a value by an ORD.

Additional information and related topics include:

- “About Widgets” on page 6-12
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

**kitPx-Bargraph**

kitPx-Bargraph is a widget that is designed to display a single value in a bar graph. In addition to action bindings, value and setpoint bindings are available.

Additional information and related topics include:

- “About value bindings” on page 6-24
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

To plot more than one value using a single widget (using a line chart), you can use a chart widget, as described in “Create a Chart widget” on page 6-50, or for history tables, “About the history chart view” on page 4-11.

**kitPx-BackButton**

kitPx-BackButton is designed for “Touchscreen” displays that require a larger button. This widget works like the standard workbench "Back" button that is located in the top left corner of the workbench user interface. The button is dimmed when no previous page has been visited and is enabled when a previous page is available to go back to when you click it. It is located in the kitPx palette and is pre-configured so that all you have to do is drag it onto a Px page and save the page for it to take effect.

Additional information and related topics include:

- “kitPx-ButtonGroup” on page 11-27
- “kitPx-ExportButton” on page 11-27
- “kitPx-ForwardButton” on page 11-27
- “kitPx-LogoffButton” on page 11-28

**kitPx-BoundLabel**

kitPx-BoundLabel is a widget that simply provides a label widget (see “bajaui-Label” on page 11-12) with a binding already available.

Additional information and related topics include:

- “About bound label bindings” on page 6-24
- “Types of bindings” on page 6-21
kitPx-BoundLabelBinding
kitPx-BoundLabelBinding is used exclusively for connecting a value to a bound label widget. Bound labels, which are located in the kitPx module, have properties that you can edit and access from the Px Editor properties side bar.

Additional information and related topics include:
- “About bound label bindings” on page 6-24
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

kitPx-ButtonGroup
kitPx-ButtonGroup is a widget that provides a convenient way to bind a group of buttons to a common boolean or enum point. This widget is comprised of a standard GridPane with a “ButtonGroupBinding” already available. The ButtonGroup properties are editable in the Px Editor properties side bar.

Additional information and related topics include:
- “kitPx-ButtonGroupBinding”
- “kitPx-ExportButton” on page 11-27
- “kitPx-ForwardButton” on page 11-27
- “kitPx-LogoffButton” on page 11-28
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

kitPx-ButtonGroupBinding
kitPx-ButtonGroupBinding is used exclusively for connecting a value to a ButtonGroup widget. ButtonGroups, which are located in the kitPx module, have properties that you can edit and access from the Px Editor properties side bar.

Additional information and related topics include:
- “kitPx-ButtonGroup” on page 11-27
- “kitPx-ExportButton” on page 11-27
- “kitPx-ForwardButton” on page 11-27
- “kitPx-LogoffButton” on page 11-28
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

kitPx-ExportButton
kitPx-ExportButton can be used in “Touchscreen” displays that require a larger button. It works the same way as the Export button that is located on the workbench toolbar menu (opens the Export dialog box when clicked). The ExportButton widget is located in the kitPx palette and is pre-configured so that all you have to do is drag it onto a Px page and save the page for it to take effect.

Additional information and related topics include:
- “kitPx-BackButton” on page 11-26
- “kitPx-ButtonGroup” on page 11-27
- “kitPx-ForwardButton” on page 11-27
- “kitPx-LogoffButton” on page 11-28

kitPx-ForwardButton
kitPx-BackButton is designed for “Touchscreen” displays that require a larger button. This widget works like the standard workbench “Forward” button that is located in the top left corner of the workbench user interface. The button is dimmed when no “forward” page is available and is enabled when a page is available to go forward to when you click it. It is located in the kitPx palette and is pre-configured so that all you have to do is drag it onto a Px page and save the page for it to take effect.

Additional information and related topics include:
- “kitPx-BackButton” on page 11-26
- “kitPx-ButtonGroup” on page 11-27
- “kitPx-ExportButton” on page 11-27
- “kitPx-LogoffButton” on page 11-28
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22
kitPx-GenericFieldEditor

kitPx-GenericFieldEditor is a field editor that allows you to edit properties from a graphic view on non-specific fields. It is designed for layout on panes and is comprised of standard widgets like buttons, text fields, and check boxes. Specialized field editor widgets include: SetPointFieldEditor (see “kitPx-SetPointFieldEditor” on page 11-29).

Additional information and related topics include:

- “About field editor bindings” on page 6-27
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

kitPx-ActionButton (ImageButton)

kitPx-ActionButton is a button that uses images to display the state of the button. For example, the action button may have three separate images to indicate the normal, mouseOver, and pressed states. In addition to other properties, the image button includes the following distinctive properties:

- **Mouse Over**
  this property allows you to assign an image that appears when the mouse hovers over the button.

- **Normal**
  this property allows you to assign an image that appears when the button is not in a pressed or mouseOver state.

- **Pressed**
  this property allows you to assign an image that appears when the button is pressed.

See the following topics for related information about buttons:

- “kitPx-RefreshButton” on page 11-28
- “kitPx-SaveButton” on page 11-29
- “bajaui-Button” on page 11-11
- “bajaui-ToggleButton” on page 11-14

kitPx-IncrementSetPointBinding

kitPx-IncrementSetPointBinding is used to increment (increase) or decrement (decrease) a setpoint value.

Additional information and related topics include:

- “About increment setpoint bindings” on page 6-26
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

kitPx-LogoffButton

kitPx-LogoffButton is designed for “Touchscreen” displays that require a larger button. When clicked, this widget automatically initiates a “logoff” command and “disconnects” the current user from any active session. The Logoff button is located in the kitPx palette and is pre-configured so that all you have to do is drag it onto a Px page and save the page for it to take effect.

Additional information and related topics include:

- “kitPx-BackButton” on page 11-26
- “kitPx-ButtonGroup” on page 11-27
- “kitPx-ExportButton” on page 11-27
- “kitPx-ForwardButton” on page 11-27
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

kitPx-RefreshButton

kitPx-RefreshButton is used to issue a refresh command when it is clicked. The “Refresh” text that appears on the button is included by default in the Text property. This button is designed to work well with “Touchscreen” displays that require a larger button. The Refresh button is located in the kitPx palette and is pre-configured so that all you have to do is drag it onto a Px page and save the page for it to take effect.

See the following topics for related information about similar types of buttons:

- “kitPx-BackButton” on page 11-26
- “kitPx-ButtonGroup” on page 11-27
- “kitPx-ExportButton” on page 11-27
- “kitPx-ForwardButton” on page 11-27
**kitPx-SaveButton**

- kitPx is used to issue a save command when it is clicked. The “Save” text that appears on the button is included by default in the Save property—but, like the other properties, it may be edited, as desired.

See the following topics for related information about buttons:

- “kitPx-ActionButton (ImageButton)” on page 11-28
- “kitPx-RefreshButton” on page 11-28
- “bajaui-Button” on page 11-11
- “bajaui-ToggleButton” on page 11-14

**kitPx-SetPointBinding**

- kitPx-setPointBinding is used to display the current value of a setpoint and also to provide the ability to modify it. The setpoint binding ORD must resolve down to the specific property that is being manipulated.

Additional information and related topics include:

- “About setpoint bindings” on page 6-25
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

**kitPx-SetPointFieldEditor**

- kitPx-SetPointFieldEditor is a special field editor that is designed to allow you to edit setpoint values from a graphic view. It is designed for layout on panes and is comprised of standard widgets like buttons, text fields, and check boxes. For editing non-specific properties, use the kitPx GenericFieldEditor (see “kitPx-GenericFieldEditor” on page 11-28).

Additional information and related topics include:

- “About field editor bindings” on page 6-27
- “Types of bindings” on page 6-21
- “Types of binding properties” on page 6-22

### Components in ldap module

- **ActiveDirectoryExt**
- **LdapConfiguration**
- **LdapUserService**
- **LdapV2**
- **PrototypeFolder**

**ldap-ActiveDirectoryExt**

- ActiveDirectoryExt (ActiveDirectoryConfig) is the frozen child “config” container under an ActiveDirectoryUserService, and contains properties that specify the connection URL, domain, and other attributes.

**ldap-LdapConfiguration**

- LdapConfiguration is the frozen child “config” container under the LdapUserService, and contains various properties that specify the LDAP attribute and connection methods.

**ldap-LdapUserService**

- LdapUserService allows users to be downloaded from an LDAP server, and replaces the standard UserService in a station. LDAP users are stored transiently and are hidden.

The LdapUserService also allows creation of local users (non-transient users)—note that such users exist by default, i.e. users “admin” and “guest”. This allows station login even if LDAP is not working. If a non-transient user is found in the service at login, the LDAP server will not be queried.

The similar ActiveDirectoryUserService operates the same way, but is for use with the Windows Active Directory service. Both the LdapUserService and ActiveDirectoryUserService are found in the ldap palette. The two services differ by the child “config” container with properties that specify connection and attribute settings for the LDAP server or Active Directory service.

- The LdapUserService has an LdapV2 (LdapConfig) child container.
- The ActiveDirectoryUserService has an ActiveDirectoryExt (ActiveDirectoryConfig) child container.

The primary view for both services is the standard User Manager.
However, configuration of the “Default Prototype” under the “User Prototypes” (PrototypeFolder) is how you associate Niagara station security settings with a group of LDAP users (or Active Directory users). This prototype is referenced (by name) in the “Attr Prototype” property in the “config” container of the user service, that is, the “LdapConfig” container or “ActiveDirectoryConfig” container.

For more details, refer to the NiagaraAX LDAP User Service Guide.

Components in net module

- **InternetAddress**
- **HttpProxyServer**

**net-InternetAddress**

InternetAddress models an Internet address which is a composite of a hostname (or raw IP address) and a port number.

**net-HttpProxyServer**

HttpProxyService (available starting in NiagaraAX-3.4) is used to support connections to the Internet through a non-transparent proxy.

All services that make use of the bajax.baja.net.HttpConnection class will automatically roll over to using the proxy server once the HttpProxyService has been configured and enabled. The Weather Service is one of the services that is affected by this feature.

To use this component you must:

- add it to your station (under the Services node, for example)
- configure the following properties in the Property Sheet view:
  - **Status**
    This display-only property displays the status of the Http Proxy Service.
  - **Fault Cause**
    This display-only property provides an error message that indicates the reason for a fault.
  - **Enabled**
    This property has a true (enabled) and false (disabled) option.
  - **Server**
    This property provides a text field for entering the address of the proxy server you are connecting to.
  - **Port**
    This property is for specifying the port number for communicating with the proxy server.
  - **Exclusions**
    This text field allows you to designate addresses that are allowed to be contacted directly, therefore “excluding” them from having to be contacted through the proxy server. The default addresses in the field are typical addresses followed by a slash(/) and the subnet mask designation.
  - **Authentication Scheme**
    This property provides the following two options:
    - **None**
      no authentication is required at the proxy server when this option is set.
    - **Basic**
      basic authentication is required at the proxy server when this option is set.
  - **User**
    This is the login name to be used when authentication is set to **Basic**.
  - **Password**
    This is the password text that is to be used when authentication is set to **Basic**.
Components in onCall module

- **onCallService**
- **onCallRecipient**
- **OnCallSchedule**

**onCall-OnCallService**

Available in NiagaraAX-3.5 and later, the On Call Service is a customization of the alarm service that allows you to send alarm notifications to users based on a priority list (“Contact List”). This service initiates an email (or text message) notification for designated alarms, sending the notification sequentially, as alarms escalate, to users based on their assigned priority. The OnCallService component is available in the onCall module. Also see “About the On Call Service” on page 5-8.

**Actions** Actions include **Execute**.

**onCall-OnCallRecipient**

The On Call Recipient (AX-3.5 and later) manages the transfer of alarms between the alarm service and On Call Contacts. For example, a station may send alarm notifications by email or cell phone to one or more contacts if they are specified in the currently assigned On Call Contact List. The On Call Recipient component is linked to an Alarm Class component and provides a place to specify the scheduling details and other routing options. The OnCallRecipient is available in the onCall module. Also see “About the On Call Recipient” on page 5-41.

**Actions** Actions include **Route Alarm**.

**onCall-OnCallSchedule**

The OnCallSchedule (On Call List Schedule) is used to set times for making On Call Lists active. The OnCallSchedule component is available in the onCall module.

**Actions** Actions include **Cleanup**.

Components in program module

- **Program**
- **ProgramModule**
- **ProgramService**

**program-Program**

Program uses an instance based classfile to implement user defined component logic. The Program can be viewed and edited using the **ProgramEditor**. Program is available in the program palette.

**Actions** Actions include **Execute**.

**program-ProgramModule**

ProgramModule provides a **Program Module Builder** view used to build standard NiagaraAX modules from **Program** components. This provides a mechanism to version and provision Program modules just like any other NiagaraAX modules.

Starting in AX-3.5, the ProgramModule is available in the program palette.

**program-ProgramService**

The **ProgramService** provides a (default) **Batch Editor** view to launch a batch operation on multiple selected component slots. For more details, refer to the **Batch Editor - Engineering Notes** document.

The ProgramService also provides a secondary **RobotEditor** view to create “Robots”, which are similar to Program components (written using Java code), but are not persisted in the station database.

The ProgramService is available in the program palette, but typically exists in most station’s **Services** container, as it is included among default services when using the **New Station** tool (wizard) in Workbench.

**Actions** Actions include **Run Robot**.

Components in pxeditor module

- **NewPxViewDialog**

**pxeditor-NewPxViewDialog**

NewPxViewDialog allows you to create a new Px view.
Components in report module

- **BqlGrid**
- **ComponentGrid**
- **EmailRecipient**
- **ExportSource**
- **ReportPane**
- **ReportService**
- **SectionHeader**

**report-BqlGrid**

Available in NiagaraAX-3.4 and later, the BqlGrid component allows you to create a Grid Table or Grid Label Pane view of any collection of data that you can access with a Bql query and the BFormat syntax. The BqlGrid component is available in the Reporting folder of the report palette. Refer to "About the BqlGrid component" on page 6-59 for more details.

**report-ComponentGrid**

The ComponentGrid allows you to define and design your report content (typically in the Grid Editor view). Use the component grid to link and layout the data that you want to put into your report. The ComponentGrid component is available in the Reporting folder of the report palette. Refer to "About the ComponentGrid component" on page 6-60 for more details.

**report-EmailRecipient**

The EmailRecipient component contains properties that allow you to specify where the report is to be emailed. The property sheet view displays the properties that you configure for this function. The EmailRecipient component is available in the Reports folder in the report palette. Refer to "About the EmailRecipient component" on page 6-58 for more details.

**report-ExportSource**

The ExportSource component allows you to define a report display source (typically a Px file) for exporting and it allows you to schedule a time that you want to export it. The property sheet view contains the properties that you configure for these functions. This component is available in the report palette. Refer to "About the ExportSource component" on page 6-58 for more details.

**report-FileRecipient**

The file recipient component allows you to save a report to a location under a station file system. This component contains a single property that allows you to specify a location (file directory) for saving the report. This component is available in the report palette. Refer to "About the FileRecipient component" on page 6-59 for more details.

**report-ReportPane**

The ReportPane widget is available in the ReportWidgets folder of the Report palette. It provides a container for layout of Px page report views. The ReportPane has the standard Visible, Enabled, and Layout properties, but also has unique properties. Refer to "About the ReportPane component" on page 6-61 for more details.

**report-ReportService**

The report service is the parent, or container, for the ExportSource, EmailRecipient, and ComponentGrid components. In order to use the report service, copy the ReportService component from the Report module to the Services folder in the Workbench nav tree. It is available in the Reporting folder of the Report palette. Refer to "About the ReportService component" on page 6-57 for more information about the ReportService component.

**report-SectionHeader**

The SectionHeader component is used to put a title or heading at the top of a report. It is located in the ReportWidgets folder in the Report palette. More information about the SectionHeader component is available in "About the SectionHeader component" on page 6-61.

Components in the Sms module

The Sms module contains components that allow you to set up a service for sending text messages. The following components are included in the Sms module:

- **SmsService**
Chapter 11 – Component Guides

Components in schedule module

Schedules allow you to program commands to occur at specific times. Each schedule component is designed to provide an output based on the current time. Components can receive this command by linking to this output. See the “Weekly Scheduler view” on page 8-6 for more information on using schedules.

- BooleanSchedule
- CalendarSchedule
- EnumSchedule
- NumericSchedule
- StringSchedule
- TriggerSchedule
- BooleanScheduleSelector
- NumericScheduleSelector
- StringScheduleSelector
- EnumScheduleSelector

schedule-BooleanSchedule

A deployable weekly schedule that provides a continuous StatusBoolean output. Other weekly schedule types include EnumSchedule, NumericSchedule, and StringSchedule. See “About weekly schedules” on page 8-4 for more details.

Input - If the “in” property is linked and its value is non-null, then this value overrides the scheduled output. The BooleanSchedule is available in the schedule palette.
Components in schedule module

**schedule-CALENDAR_SCHEDULE**

The CalendarSchedule provides a calendar for scheduling holidays or other schedule overrides. The CalendarSchedule is available in the schedule palette.

**schedule-ENUM_SCHEDULE**

A deployable weekly schedule that provides a continuous StatusEnum output. Other weekly schedule types include BooleanSchedule, NumericSchedule, and StringSchedule. See "About weekly schedules" on page 8-4 for more details.

Input - If the “in” property is linked and its value is non-null, then this value overrides the scheduled output. The EnumSchedule is available in the schedule palette.

**schedule-NUMERIC_SCHEDULE**

A deployable weekly schedule that provides a continuous StatusNumeric output. Other weekly schedule types include BooleanSchedule, EnumSchedule, and StringSchedule. See "About weekly schedules" on page 8-4 for more details.

Input - If the “in” property is linked and its value is non-null, then this value overrides the scheduled output. The NumericSchedule is available in the schedule palette.

**schedule-STRING_SCHEDULE**

A deployable weekly schedule that provides a continuous StatusString output. Other weekly schedule types include BooleanSchedule, EnumSchedule, and NumericSchedule. See "About weekly schedules" on page 8-4 for more details.

Input - If the “in” property is linked and its value is non-null, then this value overrides the scheduled output. The StringSchedule is available in the schedule palette.

**schedule-TRIGGER_SCHEDULE**

A schedule that fires topics - there is no continuous output. The TriggerSchedule is available in the schedule palette.

**schedule-BOOLEAN_SCHEDULE_SELECTOR**

ScheduleSelector components provide an easy way to select a preconfigured schedule of the proper data type for controlling a particular component. BooleanScheduleSelector components only link BooleanSchedule components to a control component of the Boolean data type.

See also,

- About ScheduleSelector components
- Types of ScheduleSelector components
- Types of ScheduleSelector component properties
- Example ScheduleSelector configurations

**schedule-NUMERIC_SCHEDULE_SELECTOR**

ScheduleSelector components provide an easy way to select a preconfigured schedule of the proper data type for controlling a particular component. NumericScheduleSelector components only link NumericSchedule components to a control component of the Numeric data type.

See also,

- About ScheduleSelector components
- Types of ScheduleSelector components
- Types of ScheduleSelector component properties
- Example ScheduleSelector configurations

**schedule-STRING_SCHEDULE_SELECTOR**

ScheduleSelector components provide an easy way to select a preconfigured schedule of the proper data type for controlling a particular component. StringScheduleSelector components only link StringSchedule components to a control component of the String data type.

See also,

- About ScheduleSelector components
- Types of ScheduleSelector components
- Types of ScheduleSelector component properties
- Example ScheduleSelector configurations
schedule-EnumScheduleSelector

ScheduleSelector components provide an easy way for to select a preconfigured schedule of the proper data type for controlling a particular component. EnumScheduleSelector components only link EnumSchedule components to a control component of the Enum data type.

See also,

- About ScheduleSelector components
- Types of ScheduleSelector components
- Types of ScheduleSelector component properties
- Example ScheduleSelector configurations

Components in timesync module

- TimeSyncClient
- TimeSyncService

timesync-TimeSyncClient

Slot of a TimeSyncService used to poll a time protocol server. The TimeSyncClient is available in the timesync palette.

timesync-TimeSyncService

A time protocol (RFC 868) client and server. To synchronize with other servers, TimeSyncClients must be added to the service. As a convenience, a disabled default client has already been added (it will need configuring). The service uses the clients to poll their configured servers, and if the service detects a drift greater than the tolerance property, the service will reset the system time. The module palette contains clients preconfigured for well known time protocol servers. The primary view of this Component is TimeSyncManager.

From the PropertySheet, you can set Enabled and Server EnabledEnabled (to false) to disable the time sync client. Server Enabled enables the time sync server. In order to sync between stations, enable master TimeSync service to be a server, then add a TimeSyncClient in the station, configured for the server Station. The TimeSyncService is available in the timesync palette.

ForceSync Force Time Synchronization.
Sync Time Synchronization.

Components in web module

- WebService

web-WebService

WebService encapsulates access to the HTTP server as well as the servlet infrastructure used to expose custom applications over HTTP. The WebService is available in the web palette. It is also one of the default services in a station created by using the New Station tool. Only one WebService is supported in a station.

Components in workbench module

- ComponentFinder
- KioskService
- WbFieldEditorBinding
- WbViewBinding
- WsOptions

workbench-ComponentFinder

The ComponentFinder dialog provides a means of finding Components.
workbench-KioskService

workbench-KioskService is used to enable the Kiosk mode. Kiosk mode provides a way to run a NiagaraAX workbench station so that it fulfills many of the needs of a stand-alone operator workstation as well as many needs of a touchscreen interface. In order to automatically start Kiosk mode, you must have a locally connected display.

Note: The Kiosk profile is not invoked or displayed by remote browser clients. You cannot use a remote computer with a touchscreen and expect to get the same Kiosk interface.

This component is located in the workbench palette. To set a station to Kiosk mode, add the service to the station's "Services" folder (Config > Services) and set the enabled property to "true". While Kiosk mode is not limited to touchscreen applications, it does provide advantages that make it well suited for use in a touchscreen application.

workbench-WbFieldEditorBinding

WbFieldEditorBinding is used to bind WbFieldEditors to an object. It allows any existing WbFieldEditor (BooleanFE, EnumFE, AbsTimeFE, etc) to be used in a PX presentation.

workbench-WbViewBinding

WbViewBinding is used to bind WbViews to an object. It allows any existing WbView (PropertySheet, WireSheet, manager view, etc.) to be used in a PX presentation.

workbench-WsOptions

The WireSheet options allow you to view and change the following:

- Show Thumbnail
- Show Grid
- Show Status Colors

These are stored under /user/[user]/wiresheet.options.
Plugin Guides

There are many ways to view plugins (views). One way is directly in the tree. In addition, you can right-click on an item and select one of its views. Plugins provide views of components.

In Workbench, access the following summary descriptions on any plugin by selecting Help > On View (F1) from the menu, or pressing F1 while the view is open.

Types of plugin modules

Following, is a list of the types of plugin modules:

- Plugins in alarm module
- Plugins in backup module
- Plugins in chart module
- Plugins in devkit module
- Plugins in email module
- Plugins in help module
- Plugins in history module
- Plugins in html module
- Plugins in ldap module
- Plugins in program module
- Plugins in pxEditor module
- Plugins in raster module
- Plugins in report module
- Plugins in schedule module
- Plugins in timesync module
- Plugins in wiresheet module
- Plugins in wbutil module
- Plugins in workbench module

Plugins in alarm module

- alarm-AlarmConsole
- alarm-AlarmDbMaintenance
- alarm-AlarmDbView
- alarm-AlarmClassSummary
- alarm-AlarmExtManager
- alarm-AlarmInstructionsManager
- alarm-AlarmPortal

alarm-AlarmConsole

The Alarm Console allows you to view and acknowledge Alarms. It can be started by Right-clicking the alarmRecipient in the AlarmService and selecting Views > Alarm Console.

Viewing Alarms  Multiple Alarms from a single source are visualized as a single row in the alarm console. Color coded icons provide a visual indication for unacknowledged/inAlarm, acknowledged/inAlarm, and unacknowledged/not inAlarm.

- alarm
- redAlarm
- greenAlarm
• "orangeAlarm"
  Double-clicking a row in the Table shows the history of the alarms associated with that point. You can sort the Alarms in order of any column by pressing the column bar (once for ascending, twice for descending). Available commands include:

  • Acknowledge
  • Hyperlink
  • Notes
  • Silence
  • Filter

**Acknowledging Alarms**  Select an Alarm by Left-clicking it. In order to acknowledge an Alarm, press the **Alarm Acknowledge** toolbar button or select **Alarm > Acknowledge** from the Menu. You can select multiple Alarms and acknowledge them simultaneously. In order to silence Alarms, press the **Alarm Silence** toolbar button or select **Alarm > Silence** from the Menu.

**Acknowledge**  **Alarm Acknowledge** allows you to acknowledge the currently selected Alarm(s).

**Hyperlink**  **Hyperlink** allows you to hyperlink to Alarm URL.

**Silence**  **Silence** allows you to silence the currently selected Alarm(s).

**Filter**  **Filter** allows you to filter alarms.

**Alarm Report Dialog**  From the Alarm console, you can view the Alarm Report to see all alarms on the point. Select an Alarm and Double-click it to see the Alarm Report.

You can sort the Alarms in order of any column by pressing the column bar (once for ascending, twice for descending). Available commands include:

  • Acknowledge
  • Hyperlink
  • Notes
  • Filter

**Viewing Alarm Record**  From the Alarm Report Dialog, you can view the Alarm record to see all information on the Alarm. Select an Alarm and Double-click it to see the Alarm record.

Available commands include:

  • Acknowledge
  • Hyperlink
  • Notes
  • Filter

**Notes**  **Notes** allows you to add user notes to Alarm records.

**alarm-AlarmDbMaintenance**  AlarmDbMaintenance is a view of the alarm service. It allows you view and manage alarm records.

For more information refer to:

  • "About the alarm database maintenance view"
  • "About the alarm service"

**alarm-AlarmDbView**  AlarmDb is a view of the alarm service. It allows you view and sort alarm records.

For more information refer to:

  • "About the alarm service"

**alarm-AlarmClassSummary**  AlarmClassSummary is a view of the alarm service. It presents a table of information about all alarm classes that are assigned to the alarm service.

For more information refer to:

  • "About the alarm class summary view"
  • "About the alarm service"

**alarm-AlarmExtManager**  AlarmExtManager allows you to manage Alarm extensions.
alarm-AlarmInstructionsManager

AlarmInstructionsManager view displays a standard table-type report that provides a way to view, assign, and edit alarm instructions. For details, refer to “About the Instructions Manager view”.

alarm-AlarmPortal

The Alarm Portal allows you to view and acknowledge Alarms from multiple Stations. It can be started from the main Menu by selecting Tools > AlarmPortal.

From the Alarm Portal, you can view the Alarm record to see all information on the Alarm. Select an Alarm and Double-click it to see the Viewing Alarm Record. Available commands include:

- Acknowledge
- Silence
- Hyperlink
- Notes
- Filter

Plugins in backup module

- backup-BackupManager

backup-BackupManager

The BackupManager is the default view for a station’s BackupService. From this view you can issue a backup command, to back up the station’s configuration to your local PC, in dist file format. When you issue a Backup command, a File Chooser dialog appears to select the destination directory on your PC (see File Ord Chooser) and the file name for the backup dist file.

The default backup destination depends on your station connection, as either:

- Workbench (Fox) — !backups
  A subdirectory “backups” under your Niagara release directory. If you have not previously made station backups, this directory is automatically created.
- Browser access (Wb Web Profile) — !backups
  A subdirectory “backups” under the Niagara subfolder of your installed Java 2 runtime environment (Java plugin).

For example: C:\Program Files\Java\j2rel1.4.2_05\niagara\backups.

If you have not previously made station backups, this directory is automatically created.

The default name for a backup file uses a format of: backup_stationName_YYMMDD_HHMM.dist

For example, “backup_J403IP98c_050618_1429.dist” for a backup made of station “J403IP98c” on June 18, 2005 at 2:29 pm.

In the BackupManager, a progress bar and Job Log (>> control) is provided for an initiated backup.

The BackupManager displays a table of the 10 most recent backups, with the following data columns:

- Timestamp
  Station date and time when the backup was initiated.
- Host
  IP address of the requesting (remote) PC for the backup.
- Path
  File path used on the requesting (remote) PC for saving the backup. Typically, this is relative to the default Niagara directory (!), however, it may be an absolute file path.
- User
  The station user that initiated the backup.

Plugins in chart module

- chart-ResourceManager

chart-ResourceManager

The Resource Manager is an available view on any running station. It provides a line chart of both CPU and memory usage of the host platform, and updates in real time. In addition, individual resource statistics are provided in a table, which you can refresh by clicking the Update button.

Plugins in devkit module

- devkit-LexiconEditor
The LexiconEditor Plugin allows you to view and modify the localization of lexicon files. The LexiconEditor is invoked by selecting **Lexicon Tool** from the main **Tools** Menu. From there you can select a lexicon by clicking on one. The LexiconEditor is invoked if you Double-click on a Module. It will present the list of keys with default and lexicon value. If you select a key, you can change the lexicon value by entering it at the bottom and pressing **Change**. You can select a different lexicon or Module using the selection list at the top. You can also check **Hide Icons**, **Hide Accelerators** and/or **Show Missing Only** to select the keys that will be displayed.

**LexiconEditor Menus** The Workbench main menu functions are available. When the LexiconEditor is visible, the following LexiconEditor menu functions are also available:

- Hide Ref Values
- Hide Accelerators
- Show Missing Only

**LexiconEditor Pulldowns and Buttons** The lexiconEditor has pulldowns and buttons that include:

- Lexicon
- Module
- Hide Ref Values
- Hide Accelerators
- Show Missing Only
- Value
- Change
- Add New Key

**LexiconEditor Toolbar** The Workbench toolbar contains navigation and editing buttons as described in About the toolbar.

- **Lexicon** Lexicon pulldown allows you to select another lexicon directly from the LexiconEditor.
- **Module** Module pulldown allows you to select another Module directly from the LexiconEditor.
- **Hide Ref Values** Filter values starting with / from lexicon view. This is available if you do not want to localize references (like icons).
- **Hide Accelerators** Hide entries that define keyboard accelerators. This is available if you do not want to localize the accelerators.
- **Show Missing Only** Hide entries that are localized. This is available if you do not want to see localized keys.
- **Value** Value allows you to enter a new value for a lexicon entry. You must press **Change** for the value to be entered.
- **Change** Change places the new value into the list of keys. You must press **Save** to write values to the lexicon file.
- **Add New Key** Add New Key allows you to add an additional key to the lexicon. You must press **Save** to write values to the lexicon file.

**LexiconReport**

The LexiconReport Plugin provides a report on localization of lexicon files. The LexiconReport is invoked by selecting **Lexicon Tool** from the main **Tools** menu. From there you can select a lexicon by right-clicking on one. It will present the list of Modules with lexicons and the last time that the Module lexicon was modified and the last time the lexicon was modified. It also shows the number of keys missing from the lexicon for each Module. You can check **Hide Icons and/or Hide Accelerators** to ignore these keys which are not usually localized. If you Double-click a Module, you will go to the LexiconEditor. You can create new lexicons and delete lexicons.

**LexiconReport Menus** The Workbench main menu functions are available. When the LexiconReport is visible, the following LexiconReport menu functions are also available:

- Hide Ref Values
- Hide Accelerators

**LexiconReport Pulldowns and Buttons** The LexiconReport has pulldowns and buttons that include:

- Hide Ref Values
- Hide Accelerators
Chapter 12 – Plugin Guides

Plugins in email module

- **email-EmailAccountManager**

  **email-EmailAccountManager** allows you to view email accounts. It is available on the EmailService.

Plugins in help module

- **help-BajadocViewer**

  **help-BajadocViewer** provides the ability to navigate and browse Baja reference documentation. It shows documentation for the following:
  - **Subclasses**
  - **Properties**
  - **Actions**
  - **Topics**
  - **Constructors**
  - **Methods**
  - **Fields**

  In order to view Bajadoc, either right-click on a Bajadoc file and select Views > Bajadoc Viewer or select Bajadoc On Target from the main Help Menu or popup Menu.

  See Object Model in the Developer Guide for more information.

  **BajadocViewer Menus**

  - **Show Baja Only**
  - **Flatten Inheritance**

  **Show Baja Only**

  This option allows you to view only the documentation for slots (Properties, Actions, and Topics). When it is set to false, documentation on the Java constructors, methods and fields is also displayed.

  **Flatten Inheritance**

  This option allows you to flatten the inheritance hierarchy into a single set of documentation. When it is false only the Java members and Baja slots declared in the specified class are displayed. When it is set to true all the Java members and Baja slots inherited from super classes are also shown.

  **Subclasses**

  Subclasses provides a subclass tree of all that are subclassed from this item.

  **Properties**

  Properties represent a storage location of another Niagara object. Flags are boolean values which are stored as a bitmask on each slot in a Baja Object. Some flags apply to all slot types, while some only have meaning for certain slot types.

  **Table 12-1 Flags**

<table>
<thead>
<tr>
<th>Flag</th>
<th>Char</th>
<th>Applies</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>readonly</td>
<td>r</td>
<td>P</td>
<td>The readonly flag is used to indicate slots which are not accessible to users.</td>
</tr>
<tr>
<td>transient</td>
<td>t</td>
<td>P</td>
<td>Transient properties do not get persisted when saving a object graph to the file system. Transient properties are usually also readonly, unless they are designed to be a linkable input slot.</td>
</tr>
<tr>
<td>hidden</td>
<td>h</td>
<td>P,A,T</td>
<td>Hidden slots are designed to be invisible to the user, and exist only for Java developers. User interfaces should rarely display hidden slots.</td>
</tr>
</tbody>
</table>
Plugins in history module

- history-DatabaseMaintenance
- history-DeviceHistoriesView
- history-GroupManager
- history-HistoryChart
- history-HistoryChartBuilder
- history-HistoryEditor
- history-HistoryExtManager
- history-HistorySummaryView
- history-HistoryTable
- history-LiveHistoryChart

**history-DatabaseMaintenance**

The DatabaseMaintenance allows you to maintain the histories in a station from the Workbench. You can Clear Old Records, Clear All Records or Delete Histories.
**history-DeviceHistoriesView**

The Device Histories View is available on any device that supports import and export of histories (for example, Niagara devices, BACnet devices, and others). The view shows a filtered list of history shortcuts for that particular device. This view displays all the related shortcuts in a table. You can double-click on any single entry in the table to open that history in the History Chart view.

**history-GroupManager**

The HistoryGroupManager provides a tabular view of all history groups. It is the default view of the HistoryGroupings component and provides information about the groups contained in the History-Group component.

Refer to the following sections for related information:

- "About history grouping" on page 4-30
- "About the History Group property sheet view" on page 4-31
- "About the History Group Manager view" on page 4-31

**history-HistoryChart**

The HistoryChart is a view that allows you to display and configure charts of history records. Any point History can be charted by double-clicking directly on it under the History node in the nav tree.

The HistoryChart properties are configurable when editing the HistoryChart view in a Px page, as shown in Figure 12-1.

![Figure 12-1 History Chart display properties are configurable in the Px page view](chart.png)

- **defaultDelta**
  When set to `true`, this property causes the history chart view to plot delta values on initial display and any time the view is refreshed.

- **defaultLiveUpdates**
  When set to `true` this property sets the chart view to Live Update mode on initial display and whenever the view is refreshed.

- **defaultTimeRange**
  This property allows you to choose a specific time range option that appears on initial display and whenever the history chart view is refreshed.

- **enabled**
  This property allows you to disable (`false`) or enable (`true`) the history chart view.

- **layout**
  This property provides four values that define the size of the history chart view display area.

- **showDeltaEditor**
  This property allows you to hide (`false`) or show (`true`) the delta mode button on the history chart view.

- **showLiveUpdates**
  This property allows you to hide (`false`) or show (`true`) the live update button on the history chart view.

- **showTimeRangeEditor**
  This property allows you to hide (`false`) or show (`true`) the Time Range Editor option list on the history chart view.

- **visibility**
  This property allows you to hide (`false`) or show (`true`) the history chart view.

**history-HistoryChartBuilder**

The HistoryChartBuilder is a view that allows you to view and configure charts of one or more histories. Add a history by double-clicking or dragging into the configuration area. For any chart, you can specify a Time Range, Title, and whether to show grid lines. Each history has a selectable Chart Type of either Line or Discrete Line. After you Build a chart, you can Save it.
**history-HistoryEditor**

The HistoryEditor allows you to view and query a History in a Station.

The HistoryEditor allows you to Hide or Unhide selected records.

**history-HistoryExtManager**

The HistoryExtManager provides a tabular view of all history extensions. It is the default view of the HistoryService and provides information about the control point, extension type, name and status of each entry. Refer to the following references for information about the history extension manager, its associated menus, toolbar icons, and other details.

Refer to the following sections for related information:

- "About the History Ext Manager menu" on page A-8
- "About the history extension manager view" on page 4-3
- "About the history extension manager popup menu items" on page A-11

**history-HistorySummaryView**

The HistorySummaryView allows you to view the summary information about a History from the Workbench.

**history-HistoryTable**

The HistoryTable is a view that allows you to view tables of histories. The selected entries are shown as timestamp, trendFlags, status and value in each row of the Table.

You can resize columns in the HistoryTable. If you move the cursor over the line between columns, it will change to a resize cursor. You can then drag the line to the desired size.

If want to reorder the columns in the HistoryTable, drag the column header to a new location.

**Query**  
Query lets you select the period for the query. Selections include:

- Time Range
- Today
- Yesterday
- Last Week
- Last 7 Days
- Last Month
- Last Year
- Month-to-date
- Year-to-date

**Filter**  
Filter lets you use the filter you have configured for the data in the Table.

**Filter Config**  
Filter lets you configure the filter for the data in the Table.

**history-LiveHistoryChart**

Starting in NiagaraAX-3.3 background and live history charting is available for history data. This feature includes the ability to display historical data (trend data) in a Live History Chart view that plots a range of data from a configurable start time to the current time and continues plotting as new data is generated by the source. Refer to “About the Live History Chart View” on page 4-12 for more details.

### Plugins in html module

- html-WbHtmlView
- html-SpyViewer

**html-WbHtmlView**

- **Introduction**
- HTML Support
- Stylesheet Support

**Introduction**  
The WbHtmlView allows you to view HTML files.

**WbHtmlView Menus**

The Workbench main menu functions are available.

**WbHtmlView Toolbar**

In the WbHtmlView, the toolbar contains navigation and editing buttons as described in “About the toolbar” on page 2-13. In addition, Find, FindNext and FindPrev toolbar buttons are available.
**HTML Support HTML Tags** The WbHtmlView attempts to ignore mismatched or missing Tags. It can parse any HTML, no matter how badly messed up the Tags are, although it might do a pretty bad job of rendering the results. It does simplistically attempt to repair missing `<p>`, but other problems are solved by ignoring Tags. Warnings will appear on the command line showing its best guess as to what the problem was. Valid tags include:

- **a** - anchor Ex:`<a href="#fragment">Title</a>` and `<a name="fragment">Title</a>` (Attributes href and name)
- **applet** - not supported
- **b** - bold text style Ex:`<b>bold text</b>`
- **body** - document body
- **br** - forced line break
- **code** - computer code fragment
- **col** - not supported
- **colgroup** - not supported
- **dd** - definition description
- **div** - not supported
- **dl** - definition list
- **dt** - definition term
- **em** - emphasis Ex:`<em>emphasis text</em>`
- **font** - local change to font (Attributes Color, name and size)
- **h1** - heading Ex:`<h1 class='title'>Title</h1>`
- **h2** - heading
- **h3** - heading
- **h4** - heading
- **h5** - heading
- **h6** - not supported
- **head** - document head
- **hr** - horizontal rule
- **html** - document root element
- **i** - italic text style
- **img** - embedded image Ex:`<img src="../doc/icons/x16/home.png">` An `<img>` without an align attribute is treated as an 'inline' image. An align of left or right causes text to flow around the image.
- **li** - list item
- **link** - a media-independent link Ex:`<link rel='StyleSheet' href='module://bajaui/doc/style.css' type='text/css'/>`
- **meta** - not supported
- **object** - not supported
- **ol** - ordered list
- **p** - paragraph Ex:`<p class='note'>Note</p>`
- **pre** - preformatted text
- **span** - not supported
- **style** - not supported
- **table** - table (Attributes align, border, bordercolor, cellpadding, cellspacing and width)
- **tbody** - not supported
- **td** - table data cell supports ALIGN (left, right, and center), BGCOLOR, COLSPAN, ROWSPAN and WIDTH
- **tfoot** - not supported
- **th** - table header cell supports ALIGN (left, right, and center), BGCOLOR, COLSPAN, ROWSPAN and WIDTH
- **thead** - not supported
- **title** - document title
- **tr** - table row supports ALIGN (left, right, and center) and BGCOLOR
- **tt** - teletype or monospaced text style
- **ul** - unordered list

**HTML Attributes** HTML Elements have associated properties, called attributes, which may have values. Attribute/value pairs appear before the final `">"` of an element's start tag. Valid attributes include:

- **align** - vertical or horizontal alignment Deprecated; elements: img, object? values: bottom, left, middle, right or top.
- **align** - table position relative to window Deprecated; elements: table; values: center, left or right
Plugins in html module

Chapter 12 – Plugin Guides

April 4, 2011

- **align** - align, text alignment *Deprecated*; elements: div?, h1?, h2?, h3?, h4?, h5?, h6?, p; values: center, justify, left or right
- **align** - alignment; elements: col?, colgroup?, tbody?, th, thead?, tr; values: center, justify, left or right
- **bgcolor** - background Color *Deprecated*; elements: h1, h2, h3, h4, h5, h6?, p, td, th, tr
- **border** - controls frame width around table; elements: table
- **cellpadding** - spacing within cells; elements: table
- **cellspacing** - spacing between cells; elements: table
- **class** - class name or set of class names for stylesheets; elements: most elements
- **color** - text Color *Deprecated*; elements: font, h1, h2, h3, h4, h5, h6?, p, pre, td?, th?, tr?
- **colspan** - number of cols spanned by cell; elements: td, th
- **content** - associated information; elements: meta?
- **href** - URI for linked resource; elements: a, link
- **id** - name to an element; elements: most elements
- **lang** - Language Code; elements: most elements *not supported*
- **name** - named link end; elements: a
- **name** - meta information name; elements: meta?
- **rel** - forward link types; elements: link; values: stylesheet
- **rowspan** - number of rows spanned by cell; elements: td, th
- **size** - size of font; elements: font; value: fixed 1-7 or relative -7 to +7
- **summary** - purpose/structure for speech output; elements: table
- **type** - advisory content type; elements: link; values: text/css
- **width** - table width; elements: table

**Character Entity References** Character Entity References are supported including the following:

- & - ampersand &
- ’ - apostrophe ’
- © - copyright ©
- > - greater than >
- " - double quotation, left "
- ’ - single quotation, left ’
- < - less than <
- — - em dash —
- ” - non breaking space ”
- – - en dash –
- ” - double quotation, right ”
- ’ - single quotation, right ’
- ” - quotation mark ”
- ® - registered trademark ®
- ™ - trademark ™

**Stylesheet Support Introduction** Stylesheets are supported using a link in the header as follows:

```html
<head>
<title>Sample</title>
<link rel='StyleSheet' href='module://bajaui/doc/style.css' type='text/css'/>
</head>
```

See the default stylesheet used for Niagara developer documentation: module://bajaui/doc/style.css or the CSS stylesheet used for this document at docbook.css.

**Pseudo-classes and Pseudo-elements** Anchor pseudo-classes include:

- A:link unvisited links *unsupported*
- A:visited visited links *unsupported*
- A:active active links *unsupported*

**CSS1 Properties** Stylesheet elements supported include:

- **background** - The 'background' property is a shorthand property for setting the individual background properties (i.e., 'background-color', 'background-image', 'background-repeat', 'background-attachment' and 'background-position') at the same place in the style sheet.
- **background-attachment** *unsupported*
- **background-color** - This property sets the background Color of an element.
  - background-image *unsupported*
  - background-position *unsupported*
  - background-repeat *unsupported*
- border unsupported
- border-bottom unsupported
- border-bottom-width unsupported
- border-color unsupported
- border-left unsupported
- border-left-width unsupported
- border-right unsupported
- border-right-width unsupported
- border-style unsupported
- border-top unsupported
- border-top-width unsupported
- border-width unsupported
- clear unsupported
- color - This property describes the text Color of an element (often referred to as the foreground Color).
- display unsupported
- float unsupported
- font unsupported
- font-family unsupported
- font-size unsupported
- font-style unsupported
- font-variant unsupported
- font-weight unsupported
- height unsupported
- letter-spacing unsupported
- line-height unsupported
- list-style-image unsupported
- list-style-position unsupported
- list-style-type unsupported
- margin unsupported
- margin-bottom unsupported
- margin-left unsupported
- margin-right unsupported
- margin-top unsupported
- padding unsupported
- padding-bottom unsupported
- padding-left unsupported
- padding-right unsupported
- padding-top unsupported
- text-align
- text-decoration unsupported
- text-indent unsupported
- text-transform unsupported
- white-space unsupported
- width unsupported
- word-spacing unsupported

**html-SpyViewer**

SpyViewer allows you to view diagnostic information about the system. It contains the following:
- `sysinfo` - `sysinfo` provides system information.
- `stdout` - `stdout` provides access to standard output.
- `systemProperties` - `systemProperties` provides access to system properties.
- `logSetup` - `logSetup` allows you to configure your log severities dynamically. There is also an option to flush the current settings to `log.properties`.
- `sysManagers` - `sysManagers` provides information on managers. These include:
  - `registryManager`
  - `schemaManager`
  - `componentNavEventManager`
  - `moduleManager`
  - `engineManager`
  - `leaseManager`
  - `serviceManager`
Plugins in ldap module

- licenseManager
- stationManager
- navSpace - provides information on the navSpace.
- userinterface - if System - userInterface provides information on the user interface framework.
- fox - fox provides information on fox client and server sessions.

Plugins in onCall module

- onCall-OnCallListManager
- onCall-OnCallContactManager
- onCall-OnCallUserReportView

onCall-OnCallListManager
The On Call List Manager view (AX-3.5 and later) is the default view of the On Call Service. This view displays a table listing of all existing On Call lists and allows you to add, delete, and edit On Call Contacts. See also, "About the On Call List Manager view" on page 5-10.

onCall-OnCallContactManager
The On Call Contact Manager view (AX-3.5 and later) is the default view of the On Call List component. This view displays a table listing of all contacts in the selected On Call list and allows you to add, delete, and edit On Call Contacts. See also, "About the On Call Contact Manager view" on page 5-12.

onCall-OnCallUserReportView
The On Call user Report view (AX-3.5 and later) is the default view of the On Call Contact component. This view provides a tabular presentation of the details associated with any On Call List that the selected user is assigned to. The purpose of this view is to provide each On Call Contact with a configurable table of information that shows scheduled times and priorities associated with all of On Call Contact Lists that they are assigned to. See also, "About the On Call User Report view" on page 5-13.

Plugins in program module

- BatchEditor
- ProgramEditor
- ProgramModuleBuilder
- RobotEditor

program-BatchEditor

The Batch Editor is the default view on the ProgramService. It allows you to perform a variety of operations on slots of multiple components by issuing a single “batch” command. You can add (specify) components using drag and drop from the Nav tree, or copy and paste into the view, or by using the “Find objects” (Bql Query Builder) function—or any combination of the three methods.

As needed, use the Clear Selected Items control to remove any items before running the operation.

The Batch Editor can be a real time saver when the same configuration change needs to be replicated among multiple component slots. For complete details, refer to the Batch Editor - Engineering Notes document.

program-ProgramEditor

The ProgramEditor Plugin provides the ability to view and edit Program Components. To view,
Right-click a Program and select ProgramEditor. It shows ProgramEditor Edit, ProgramEditor Slots, ProgramEditor Imports and ProgramEditor Source tabs.

ProgramEditor Edit Edit allows you to edit the onExecute, onStart, onStop and freeForm methods. An example from the demo Database follows:
ProgramEditor Slots  Slots allows you to view and change the slots of the program component. It includes Slot, #, Name, Display Name, Definition, Flags and Type for each slot. See SlotSheet for more information on slots.

ProgramEditor Imports  Imports allows you to view the Modules that have been imported. It also allows the following:
- ProgramEditor ImportType
- ProgramEditor ImportPackage
- ProgramEditor Remove

ProgramEditor ImportType  ImportType allows you to import a new type.

ProgramEditor ImportPackage  ImportPackage allows you to import a new type.

ProgramEditor Remove  Remove allows you to import a new type.

ProgramEditor Source  Source allows you to view and edit the source of the program component. The editor supports special Color coding for Java Files. An example from the demo Database follows:

```java
/* Auto-generated ProgramImpl Code */
import java.util.*;              /* java Predefined*/
import javax.baja.sys.*;         /* baja Predefined*/
import javax.baja.status.*;      /* baja Predefined*/
import javax.baja.util.*;        /* baja Predefined*/
import com.tridium.program.*;    /* program Predefined*/
public class ProgramImpl
    extends com.tridium.program.ProgramBase
{
    ////////////////////////////////////////////////////////////////////////////
    // Getters
    ////////////////////////////////////////////////////////////////////////////
    public BStatusNumeric getOut() { return (BStatusNumeric)get("out"); }
    public BStatusNumeric getInA() { return (BStatusNumeric)get("inA"); }
    public BStatusNumeric getInB() { return (BStatusNumeric)get("inB"); }
    ////////////////////////////////////////////////////////////////////////////
    // Setters
    ////////////////////////////////////////////////////////////////////////////
    public void setOut(javax.baja.status.BStatusNumeric v) { set("out", v); }
    public void setInA(javax.baja.status.BStatusNumeric v) { set("inA", v); }
    public void setInB(javax.baja.status.BStatusNumeric v) { set("inB", v); }
    ////////////////////////////////////////////////////////////////////////////
    // onExecute
    ////////////////////////////////////////////////////////////////////////////
    public void onExecute()
    throws Throwable
    {
        BStatusNumeric inA = getInA();
        BStatusNumeric inB = getInB();
        BStatusNumeric out = getOut();
        out.setValue( inA.getValue() + inB.getValue() );
    }
}
```

ProgramEditor Menus  The Workbench main menu functions are available. When the ProgramEditor is visible, the following ProgramEditor menu function is also available:
- ProgramEditor ImportType
- ProgramEditor ImportPackage
- ProgramEditor Remove
- Add Slot Ctrl + A
• Delete  
• Rename Slot Ctrl + R  
• Reorder  
• ProgramEditor Compile & Save F9  
• ProgramEditor Compile Ctrl + F9

**ProgramEditor Toolbar**  
The Workbench toolbar contains navigation and editing buttons as described in "About the toolbar" on page 2-13. When the ProgramEditor is visible, additional toolbar buttons include:

• Find F5  
• Replace F6  
• ProgramEditor Compile & Save F9  
• ProgramEditor Compile Ctrl + F9  
• Console Prev  
• Console Next

**ProgramEditor Compile & Save**  
CompileSave allows you to compile and save the source of the program component. The shortcut is F9.

**ProgramEditor Compile**  
Compile allows you to compile the source of the program component. The shortcut is Ctrl + F9.

**program-ProgramModuleBuilder**  
The Program Module Builder is the default view on the ProgramModule, a component available starting in AX-3.5. It lets you create a NiagaraAX module from one or more Program components, such that they may be versioned and provisioned just like other NiagaraAX modules.

**program-RobotEditor**  
The RobotEditor is used to write Robots that can be run via the ProgramService.

**RobotEditor Menus**  
The Workbench main menu functions are available. When the RobotEditor is visible, the following RobotEditor menu function is also available:

• RobotEditor Compile Ctrl + F9  
• RobotEditor Compile & Run F9

**RobotEditor Toolbar**  
The Workbench toolbar contains navigation and editing buttons as described in "About the toolbar" on page 2-13. When the RobotEditor is visible, additional toolbar buttons include:

• Find F5  
• Replace F6  
• RobotEditor Compile Ctrl + F9  
• RobotEditor Compile & Run F9  
• Console Prev (?need to find SearchConsolePrev.html source?)  
• Console Next (?need to find SearchConsoleNext.html source?)

**RobotEditor Compile**  
Compile allows you to compile the source of the Robot component. The shortcut is Ctrl + F9.

**RobotEditor Compile & Run**  
Compile& Run allows you to compile and run the source of the Robot component. The shortcut is F9.

---

**Plugins in pxEditor module**

• pxEditor-PxEditor

**pxEditor-PxEditor**  
The PxEditor provides tools for creating and editing Px files. The Px editor is the view that is used to create graphic presentations in Niagara AX. For more details about the Px editor, refer to the following:

• About Px Editor  
• About presentation xml (Px)  
• About the Px Editor menu

---

**Plugins in raster module**

• raster-RasterViewer
**raster-RasterViewer**  
- The RasterViewer is used to display bitmapped image files: GIF, JPEG, PNG. It displays the image in the main window with Format and image Size at the bottom.

**Plugins in report module**

- **report-GridTable**  
  - The Grid Table view is a view of the ComponentGrid component. This view provides a tabular display of all the points that are assigned to the ComponentGrid.
  
  For more details, see “About the Grid Table view” on page 6-61.

- **report-GridLabelPane**  
  - The Grid Label Pane view is a view of the ComponentGrid component. This view provides a tabular display of all the points that are assigned to the ComponentGrid. In the Grid Table Pane view, you can write to points (issue commands) using the popup menu, if you have write permissions.
  
  For more details, see “About the Grid Label Pane view” on page 6-62.

- **report-ComponentGridEditor**  
  - The Grid Editor view is a view of the ComponentGrid component. This view provides a layout display that you use to assign points that you are going to use in a report.
  
  For more details, see “About the Grid Editor view” on page 6-63.

**Plugins in schedule module**

- **schedule-CalendarScheduler**  
  - The CalendarSchedule view is used to define calendar days in a CalendarSchedule. Typically, calendar days represent holidays.
  
  Use the Add button to add a calendar day (or range of days). Each entry requires a unique name, a date type, and other specific calendar data criteria. Other controls in the CalendarSchedule allow you to edit priority, rename, or delete calendar date entries.
  
  For more details, see “Calendar Scheduler view” on page 8-14.

- **schedule-CurrentDaySummary**  
  - The CurrentDaySummary view is available on BooleanSchedule, EnumSchedule, NumericSchedule, and StringSchedule components. It provides a simple linear listing of all schedule events for the current day, moving left-to-right from 0-to-24 hours.
  
  For more details, see “Summary” on page 8-13.

- **schedule-Scheduler**  
  - The Scheduler allows you to view and edit schedule components, namely BooleanSchedule, EnumSchedule, NumericSchedule, and StringSchedule. Each of these components has a Scheduler view. The only difference between these different schedules is the output type.

  **Note:** For more details, see “Weekly Scheduler view” on page 8-6.

  There are four major elements in the Scheduler interface, separated by tabs in the view:
  
  - Weekly Schedule
  - Special Events
  - Properties
  - Summary

  **Weekly Schedule**  
  - Defines the regular (repeating) day-of-week schedule events for each day of the week.
  
  *Creating A Time Range* Right-click and drag down in the slider column for desired the day.

  *Deleting A Time Range* Click on a time range and press the delete or backspace key.
Editing A Time Range  
Time can be adjusted four ways: Dragging the top, bottom or center of a time range, or using the fine grained start and finish editors. To fine-tune a time range click on a time range then adjust the times in the editors to the left.

**Note:** IMPORTANT: The finish time is exclusive; it is the first non-effective time after the effective period. The start time is inclusive.

Output is assigned to each time range and can be edited just below the time editors on the left.

**Special Events**  
Special events override (yet intermingle with) events in the normal weekly schedule.

**Adding, Prioritizing, Renaming, and Deleting.** Use the controls at the bottom for this purpose.

**Editing**  
At least one time range must be present for an exception to work. Output is assigned to the time ranges. The slider operates exactly like the normal weekly sliders.

**Properties**  
Define the schedule’s effective period, default output, facets, and whether automatic special-event cleanup occurs.

**Default Output**  
This is the value of the schedule’s output when no normal or exceptional schedule is effective.

**Cleanup Special Events**  
If set to true (default), special events that have expired are automatically removed from the view. This occurs on the day following the scheduled special event.

**Summary**  
Shows months with selectable days, including all schedule event activity for any day selected.

**schedule-TriggerScheduler**  
The TriggerSchedule view is used to define schedule events in a TriggerSchedule. Trigger schedules are defined by combination of calendar day (or days) and trigger event time(s), including time ranges, each with a repeating interval.

Use the bottom-*left* Add button to add a scheduled day (or range of days). Each entry requires a unique name, a date type, and other specific calendar data criteria. Other controls in the TriggerSchedule allow you to edit priority, rename, or delete calendar day entries.

Use the bottom-*right* Add button to add trigger events to any selected scheduled day(s). Use the time selector to specify the individual trigger event. Use the Range controls to define a time range with repeating interval for trigger events to occur.

For more details, see “About trigger schedules” on page 8-19.

**Plugins in timesync module**

- **timesync-TimeSyncManager**

  The TimeSyncManager is used to display the status of TimeSyncClients, as well as add new or edit existing TimeSyncClients. By default, it displays Server Name, Status, Poll Delta, Poll Local Time, and Poll Server Time for each TimeSyncClient.

**Plugins in wiresheet module**

- **wiresheet-WireSheet**

  The WireSheet view shows the contents of this component. It can be used on a component of a running station or a component in a Bog File. If in a running station, it is active and real-time updates are provided. In order to command or select a different view of the item, you may right-click to get the popup menu.

  **WireSheet Menus**  
The WireSheet includes the following menus:

  - **WireSheet Main Menu**
  - **WireSheet Component Menu**
  - **WireSheet Background Menu**
  - **WireSheet Link Menu**

  **WireSheet Main Menu**  
The WireSheet main menu functions are available. When the *wiresheet; is visible, the following WireSheet menu functions are also available:

  -  
  - Arrange
WireSheet Component Menu If you Right-click any Component in the WireSheet, you can choose from the following:

- views - Go to any of the views of the Component.
- Actions - Perform any of the Actions on the Component.
- Cut Ctrl + X
- Copy Ctrl + C
- Paste Ctrl + V
- Duplicate Ctrl + D
- Delete
- CompositeEditor
- Rename
- Reorder
- Pin Slots

WireSheet Background Menu If you Right-click the Background of the WireSheet, you can choose from the following:

- Cut Ctrl + X
- Copy Ctrl + C
- Paste Ctrl + V
- Duplicate Ctrl + D
- Delete
- Delete Links
- Arrange
- Select All
- workbench-CompositeEditor

WireSheet Link Menu If you Right-click any link in the WireSheet, you can choose from the following:

- Cut Ctrl + X
- Copy Ctrl + C
- Paste Ctrl + V
- Duplicate Ctrl + D
- Delete
- Delete Links
- Arrange
- Select All
- CompositeEditor

WireSheet Toolbar The Workbench toolbar contains navigation and editing buttons as described in “About the toolbar” on page 2-13. When the WireSheet is visible, additional toolbar buttons include:

- Delete Links

Delete Links may be accessed from the Menu under Edit or from the toolbar. It allows you to eliminate the selected link(s). You can Delete Links only in the WireSheet.

Pin Slots Pin Slots provides the capability to make Properties of a Component visible in the WireSheet view of the Component. Right-click on the Component and select Pin Slots. This will bring up the Pin Slots Dialog.

The selected Properties are now visible in the WireSheet.

Arrange Arrange allows you to arrange the items in the WireSheet. You can Arrange All or Arrange Selection.

Select All Select All allows you to select all items in the WireSheet.

Show Thumbnail Show the thumbnail view in the upper right corner of the WireSheet. This allows you to toggle whether this function is enabled. This function may be accessed from the Menu under WireSheet. It allows you to display a thumbnail of the WireSheet view in the corner of the WireSheet. You can use the thumbnail to move around the WireSheet by Dragging the shaded area in the thumbnail. You can also hold down the Ctrl key and move the thumbnail around the WireSheet to keep it out of your way.
Show Grid  When enabled, the Grid is displayed in the background of the WireSheet. This helps you to align Components when you move them. You may control whether the Grid layer is enabled or visible from the WireSheet Menu or the Tools > Options Menu. This allows you to toggle whether this function is enabled.

Show Status Colors  Show the Status Colors. This allows you to toggle whether this function is enabled. This function may be accessed from the Menu under WireSheet. It allows you to display StatusColors in the WireSheet.

workbench-PrintDialog  Print provides the capability to print the WireSheet. The WireSheet will remain fixed at logical size of 100 x 100 "blocks". Printing will scale the WireSheet drawing to fit the page size (minus header and footer). Thus if you build your WireSheet logic in the top left corner, you will get a large scale for your print out. If you use the entire WireSheet down to the bottom right corner, you will get a much smaller scale for your print out. Margins are 1” for left and 1/2” for top, bottom, and right. A standard header is included which displays container’s reference and current date. A future version will create a footer listing external links and knobs.

workbench-CompositeEditor  Composite Editor provides the capability to expose child slots of a Component as slots on the parent. Right-click on the Component and select Composite Editor. This will bring up the Composite Editor Dialog. The selected Properties are now visible in the WireSheet.

workbench-ExportDialog  Export provides the capability to Export views. You can Export any Table found in the workbench (anything built with bajaui:Table). The Table options menu (that little button to the right of the header), includes a Print and Export command. These commands allow you to Export the Table to PDF, HTML, or CSV (ExcelFile). The Export uses the current sort order and visible columns you have displayed.

Plugins in wbutil module

- wbutil-CategoryBrowser
- wbutil-CategoryManager
- wbutil-CategorySheet
- wbutil-PermissionsBrowser
- wbutil-ResourceEstimator
- wbutil-TodoList
- wbutil-UserManager

wbutil-CategoryBrowser  CategoryBrowser is the default view of a station’s CategoryService. Use it to assign objects in the station into categories. This view presents an expandable tree table where the table columns are the available categories, and rows are the categorizable objects.

- Yellow rows are objects explicitly assigned into a category.
- Dimmed rows represent objects inheriting their parent’s categories.

Note:  For any object except the three root objects: station (components), file, and history, you can check to inherit its parent’s categories. For root objects, you must select at least one category.

For any component, you can alternately use its CategorySheet view to assign it categories. See “Categories and security” on page 7-2 for details on how categories affect security, and “Category-Browser” on page 7-25 for more details on this CategoryService view.

wbutil-CategoryManager  CategoryManager is a view on the CategoryService that allows you to create, enable and delete categories. Categories are used by the security model, as well as for future features. You can then use the CategoryBrowser view to centrally assign objects to categories. Or, at the individual component level, use a component’s CategorySheet view to assign it to categories.

You can assign an object to many categories at the same time. Each object stores its own categories. See “Categories and security” on page 7-2 for details on how categories affect security, and “Category-Manager” on page 7-23 for more details on this CategoryService view.

wbutil-CategorySheet  CategorySheet is used to assign a component into one or more categories (or configure it to inherit categories). Every component has a CategorySheet view. See “Categories and security” on page 7-2 for details on how categories affect security, and “CategorySheet” on page 7-26 for more details on this component view.
wbutil-PermissionsBrowser
PermissionsBrowser is an available view on the UserService, for reviewing the permissions any user has on each object. It provides an expandable tree table (similar to the CategoryBrowser view of the CategoryService). In the PermissionsBrowser, columns represent station user accounts, and rows are the objects in the station, with each table cell showing user permissions.

- Yellow rows are objects explicitly assigned with permissions.
- Dimmed rows represent objects inheriting their permissions.

Double-click a cell to bring up the permissions dialog for that user (unless user has super user rights). This allows you to globally change that user’s permission levels for any category in the station.

See “Permissions and security” on page 7-5 for details on how permissions affect security, and "PermissionsBrowser" on page 7-20 for more details on this UserService view.

wbutil-ResourceEstimator
The Resource Estimator tool allows you to estimate station resources based a number of variables, which you enter in various fields. It is one of several tools in Workbench’s Tools menu.

For more information, refer to “Resource estimator” on page 9-13.

wbutil-TodoList
The Todo List tool allows you to enter, summarize, group, and prioritize pending Workbench tasks. It is one of several tools in Workbench’s Tools menu.

For more information, refer to “Todo list” on page 9-15.

wbutil-UserManager
The UserManager is the primary view of the UserService. You use it to add, edit, and delete users for accessing the station. See “Users and security” on page 7-2 for details on how users affect security, and “UserManager” on page 7-15 for more details on this UserService view.

For an overview on the station security model, see “Security model overview” on page 7-1.

Plugins in workbench module

- workbench-CollectionTable
- workbench-DirectoryList
- workbench-HexFileEditor
- workbench-JobServiceManager
- workbench-LinkSheet
- workbench-ModuleSpaceView
- workbench-NavContainerView
- workbench-NavFileEditor
- workbench-PropertySheet
- workbench-SlotSheet
- workbench-StationSummary
- workbench-TextFileEditor
- workbench-ServiceManager
- workbench-WbPxView
- workbench-WbServiceManagerView

workbench-CollectionTable
The CollectionTable allows you to view tables. One way to create a Table is through a BQL collection like:

```
local:|fox:|station:|slot:/ControlObjects|bql:select displayName,type, out, facets from control:ControlPoint
```

The Table options menu (see “Table controls and options” on page 2-18, for more details about the table options), allows you to Reset Column Widths, Print and Export.

workbench-DirectoryList
The DirectoryList Plugin provides a listing of the subdirectories and files found in a given Directory. If you Double-click an item, you will go to its default view.

Files will be displayed with an icon based on file type.

DirectoryList Menus
The Workbench main menu functions are available. When the DirectoryList is visible, the following popup menu functions are also available:
Plugins in workbench module

- Views - show the view menus for the Component.
- Actions - Perform any of the Actions on the Component.
- New - Create a new file of standard types (if a Directory).

- Cut Ctrl + X
- Copy Ctrl + C
- Paste Ctrl + V
- Duplicate Ctrl + D
- Delete Delete
- Rename
- Reorder

DirectoryList Toolbar  The Workbench toolbar contains navigation and editing buttons as described in “About the toolbar” on page 2-13.

Refresh  Refresh allows you to synchronize the cached components with the actual file system.

New  New allows you to make a new Folder or File in the selected Folder of these types:

- New Folder allows you to make a new Folder in the selected Folder.
- BogFile.bog
- HtmlFile.html
- JavaFile.java
- NavFile.nav
- PrintFile.print
- TextFile.txt

workbench-HexFileEditor

workbench-HexFileEditor allows you to view hexadecimal files. It provides a binary view of a file’s contents.

workbench-JobServiceManager

workbench-JobServiceManager is the default view on a station’s JobService. It provides a table listing of up to the last 10 jobs executed by the station since the last station start. Order is oldest job at top, most recent job at bottom.

To see details on any job, click the “>>” button next to its status descriptor. A popup Job Log dialog displays all the interim steps about the job, including timestamps and relevant messages.

To dispose of any job, click the close (“X”) button to remove it from the station.

Note: Only the last ten jobs are saved. All jobs in a station are cleared upon a station restart.

workbench-LinkSheet

workbench-LinkSheet allows you to view and delete links. It provides a view of the links on a Component.

LinkSheet Main Menu  The Workbench main menu functions are available. When the LinkSheet is visible, the following LinkSheet menu functions are also available:

- Delete Links
- GoTo

LinkSheet Toolbar  The Workbench toolbar contains navigation and editing buttons as described in “About the toolbar” on page 2-13. When the LinkSheet is visible, additional toolbar buttons include:

- Delete Links
- GoTo  Go To goes to the selected item.

workbench-ModuleSpaceView

workbench-ModuleSpaceView allows you to view Modules.

OptionsButton  The Options Button provides the ability to toggle columns on and off like Mozilla does.

workbench-NavContainerView

workbench-NavContainerView is a default listing of nav children.

workbench-NavFileEditor

workbench-NavFileEditor allows you to view and edit Nav Files. It provides a view of the Pages in the station and a view of the Nav Tree. You can drag Pages to the Nav Tree to add them to the Nav File. The name and Ord are shown at the bottom of the window.
In order to use the Nav File, you must place the filename in the Default Nav File property of the WebService.

**workbench-PropertySheet**

The Property Sheet shows all the user visible Properties of the Component. This view also lets you change any Properties that you have authority to change. It can be used on a Component of a running Station or a Component in a Bog File.

In order to see Properties of Components in the PropertySheet, press the + sign to expand the Component.

When you want to enter a URL, you can Copy the Component or URL and Paste it into the Property-Sheet using the Paste shortcut Ctrl + V.

When a Property has been changed, its symbol will become red until you press ![Save](image)

**PropertySheet Menus** The Workbench main menu functions are available. If you Right-click any Component in the PropertySheet, you can choose from the following:

- Views - show the view menu for the Component.
- Actions - Perform any of the Actions on the Component.
  - Cut Ctrl + X
  - Copy Ctrl + C
  - Paste Ctrl + V
  - Duplicate Ctrl + D
  - Delete
  - Rename
  - Reorder
  - Config Flags

**PropertySheet Toolbar** The Workbench toolbar contains navigation and editing buttons as described in “About the toolbar” on page 2-13.

- ![Config Flags](image) Configure Flags on a component. This is available on Properties. Right-click a Property to view the Config Flags Dialog.

- ![Links](image) Links provide the mechanism to dynamically attach Components. They allow you to attach an output Property of one Component to an input Property of another Component. The links are visible in the Property Sheet of the Component. Links show whether they are direct or indirect and their source Property.

In order to view the Properties of the link, Left-click the + plus sign on the Component to expand it. Each link shows the following:

- Link Type and source
- Source Ref - This is the linked Component.
- Source Slot Name - This is the linked Component’s property.
- Target Slot Name - This is the current Component’s property.
- Enabled - This shows whether the link is currently enabled.

See for more information on creating links.

**OrdChooser** In order to select an Ord instead of typing it, you can use one of the Ord editors. They include:

- Bql Builder
- Directory Ord Chooser
- File Ord Chooser
- History Ord Chooser
- Ref Chooser

Once you have selected an editor, you can use the ![button](image) to the right of the selection box. It will present the selected editor.

**workbench:FileOrdChooser** In order to select a file Ord instead of typing it, you can use the FileOrdChooser.

You can select FileSpaces, Bookmarks and directories and files. In addition toolbar functions are provided including:

- ![Back](image) Back moves back to the previous view.
- ![Uplevel](image) Uplevel moves up one level in tree.
Plugins in workbench module

- **Home** Home moves up one level in tree.
- **New Folder** New Folder creates a new Directory.
- **ListView** ListView allows you to use the list view.
- **DetailsView** DetailsView allows you to use the details view.
- **Bookmarks** You can press the Bookmarks button to add the selection to Bookmarks.
- **Show/Hide Preview** Show/Hide Preview toggles whether the preview pane is visible.

**workbench:DirectoryOrdChooser** In order to select a Directory Ord instead of typing it, you can use the DirectoryOrdChooser.

You can select FileSpaces, Bookmarks and directories. In addition toolbar functions are provided including:

- **New Folder** New Folder creates a new Directory.
- **Bookmarks** You can press the Bookmarks button to add the selection to Bookmarks.

**workbench:HistoryOrdChooser** In order to select a reference Ord instead of typing it, you can use the HistoryOrdChooser.

You can select items from the tree by type slot or Handle.

**workbench:RefChooser** In order to select a reference Ord instead of typing it, you can use the RefChooser.

You can select items from the tree by type slot or Handle.

**workbench:BqlQueryBuilder** In order to select a BQL query instead of typing it, you can use the BqlQueryBuilder.

BQL is one Scheme used to Query in the Niagara Framework. An Ord is made up of one or more Queries. A Query includes a Scheme and a body. The bql Scheme has a body with one of the following formats:

- BQL expression
- Select projection FROM extent Where predicate

You can create the Ord Qualifier, Select, FROM and Where portions of a Query.

**Ord Qualifier** In the left window, you can select an Ord to use as the qualifier. It will immediately be placed in the BQL statement at the top when you select it.

If you select the history Scheme, your options will vary from those shown here.

**workbench:ProjectionBuilder** In order to build the projection for a BQL request instead of typing it, you can use the ProjectionBuilder in Bql Builder. You can select an item from the center window to use with the select statement. Press the right arrow to add each one to the projection.

**Bql Expressions** An expression can be one of the following:

- field like displayName
- x.y.z
- any method that returns non-void and takes zero parameters

After you build the BQL statement, you can remove the “Select” to provide a BQL expression instead of a Select statement.

**workbench:ExtentBuilder** An extent can be one or more of the following:

- "*" all available from the target
- all property slots
- all methods that return non-void and take zero parameters

In order to build the Extent for a BQL request instead of typing it, you can use the ExtentBuilder in Bql Builder. You can select the Restrict Type and choose the module and item to use with the FROM clause. It will immediately appear in the BQL statement at the top.

This also changes the items that are available in the projection.

If you choose a history Scheme, the ExtendBuilder will provide different selections. The extent for a History typically can be one of the following:

- "from /demo/Float" where demo is the station name
- "from !Float" where "!" signifies the current station

**workbench:QualifierBuilder** In order to build the Qualifier for a BQL request, you can type it in the QualifierBuilder in Bql Builder. As you type, it will immediately appear in the BQL statement at the top.
**Edit Facets**  Edit Facets allows viewing and editing of facets. In order to change facets, you use the button to the right of the facets. It will present the Edit Facets dialog box.

From here you can **Add**, **Remove** or select the **Enum Range Dialog**.

**Add**  Add allows you to add a Key and Type.

**Remove**  Remove allows you to remove facets.

**Enum Range Dialog**  In order to view or set the range of values for a Enum, you can use the . It will present the Enum Range Dialog:

You can enter one of the standard Enumerations in the field under the Use Enum Type in Range (module:name).

Press Use Enum Type in Range (module:name) to use the Enumeration that you entered. In order to enter or change an Enumeration, enter the Ordinal in the field above the Add button. Next enter the new value for the Tag and press **Modify**. Press **OK** to complete the dialog.

**workbench-SlotSheet**

The Slot Sheet shows all the user visible slots of the Component. This includes Properties, Actions, and Topics.

The SlotSheet is a Table that shows the following for each slot:

- Slot
- #
- Name
- Display Name
- Definition
- flags
- Type

The SlotSheet also optionally shows any Name Maps. The SlotSheet includes the following menus:

- SlotSheet Main Menu
- SlotSheet Component Menu

**SlotSheet Main Menu**  The Workbench main menu functions are available. When the SlotSheet is visible, the following **SlotSheet** menu functions are also available:

- Add Slot Ctrl + A
- Rename Slot Ctrl + R
- Config Flags
- Config Facets
- Reorder
- Add Name Map

**SlotSheet Component Menu**  If you Right-click any Component in the SlotSheet or the background, you can choose from the following:

- Add Slot Ctrl + A
- Copy Ctrl + C
- Delete Delete
- Rename Slot Ctrl + R
- Config Flags
- Config Facets
- Add Name Map

**SlotSheet Toolbar**  The Workbench toolbar contains navigation and editing buttons as described in “About the toolbar” on page 2-13. When the SlotSheet is visible, additional toolbar buttons include:

- Add Slot
- Rename Slot
- Config Flags
- Reorder

**Add Slot**  Add Slot allows you to add a slot to the Component.

**Rename Slot**  Rename Slot allows you to rename a slot in the Component.

**Add Name Map**  Add Name Map allows you to add a Name Map to the Component. You Right-click on the Property displayNames to delete or rename Name Map and displayNames_xx to delete or rename Name Map (xx) where xx is the Language Code.
**Config Facets** Configure Facets on the Component. This is available on Properties. Right-click a Property to view the Config Facets Dialog.

**workbench-StationSummary**

StationSummary is the default view on a Station. It holds primary components (e.g. Config, Files, History) and shows specific configuration information about the station's host platform, including:

- Station Name
- Host
- Host Model
- Host Id
- Niagara Version
- Java Version
- OS Version
- Locale
- Current Time

**workbench-TextFileEditor**

The TextFileEditor Plugin provides a powerful Color coded text editor. It supports Color coding of C, java and xml file types. See File Types for more information on Color coding of specific file types. See TextEditorOptions to change editor options including Color coding.

**TextEditorOptions**

The Workbench main menu functions are available.

**TextEditor Toolbar**

The Workbench toolbar contains navigation and editing buttons as described in “About the toolbar” on page 2-13.

**File Types**

The TextFileEditor Plugin provides a powerful Color coded text editor. It supports Color coding of C, java, properties, Python and xml file types. See TextEditorOptions to change editor options including Color coding.

**C Files**

The TextFileEditor supports special Color coding for C files including:

- Preprocessor - #include
- Line Comment - / comment /
- Multiline Comment - /* comment */
- String literal - "string" and 'string'
- Number literal - '0' and 'F'
- Keyword - blue - if

**CSS Files**

The TextFileEditor supports special Color coding for CSS files including:

- Identifier - HTML element or CSS identifier
- Line Comment - / comment /
- Multiline Comment - /* comment */
- String literal - "string" and 'string'
- Number literal - '0' and 'F'
- Keyword - blue - if

**HTML Files**

The TextFileEditor supports special Color coding for HTML files including:

- Identifier - HTML element
- Multiline Comment - <!-- Comments here -->
- String literal - "string" and 'string'
- Number literal - '0' and 'F'
- Keyword - blue - if

**Java Files**

The TextFileEditor supports special Color coding for Java files including:

- Bracket - ( { [ ]
- Keyword - if
- Line Comment - / comment /
- Multiline Comment - /* comment */
- String literal - "string" and 'string'
- Number literal - '0' and 'F'

**JavaScript Files**

The TextFileEditor supports special Color coding for JavaScript files including:

- Bracket - ( { [ ]
- Keyword - if
- Line Comment - / comment /
- Multiline Comment - /* comment */
- String literal - "string" and 'string'
- Number literal - '0' and 'F'

**Properties Files** The TextFileEditor supports special Color coding for properties files including:
- Line Comment - 
- Bracket - =

**Python Files** The TextFileEditor supports special Color coding for Python files including:
- Bracket - { } () []
- Keyword - if
- Line Comment - 
- String literal - "string" and 'string'
- Number literal - '0' and 'F'

**Xml Files** The TextFileEditor supports special Color coding for Xml files including:
- Multiline Comment - <!-- comment -->
- Bracket - <>
- String literal - "string" and 'string'

**workbench-ServiceManager**

Service Manager allows you to view services. It is available on the ServiceContainer.

**workbench-WbPxView**

PxView is a dynamic view which may be added to Components as a property. PxViews store the view contents in a PxFile which is an XML file with a PX extension. The view itself is defined as a tree of bajau:Widgets.

For more information about Px views, refer to "About Px views" on page 6-2. For more information about Px view menus, refer to "About the Px Editor menu" on page A-7. Related Px information is available as listed below:

- "About Px files" on page 6-3
- "About Px viewer" on page 6-4
- "About Px Editor" on page 6-5

**WbPxView Menus** The Workbench main menu functions are available. When the Px Viewer is visible, the following menu functions are also available:

- PxViewer View Source Xml

**PxViewer View Source Xml** You can view the source XML of a PX Page by selecting View Source Xml from the main menu.

**workbench-WbServiceManagerView**

Workbench Service Manager allows you to view services. It is available from the Tools menu.
References

In this appendix (introduction)
This appendix contains the following reference information:

- **About keyboard shortcuts**
  Explains how to use the keyboard to enter menu bar and popup menu commands – without using the mouse.

- **Types of menu bar items**
  Describes the different menu items available from the menu bar. Refer to "About the menu bar" on page 2-13 for an overview of the menu bar.

- **Types of popup menu items**
  Describes the popup menus that appear in different views and contexts.

- **Types of toolbar icons**
  Describes the types of icons that are in the toolbar. For an overview of the toolbar, refer to "About the toolbar" on page 2-13.

About keyboard shortcuts
Workbench provides a number of keyboard shortcuts for common actions. These are performed by holding down the combination of keys listed. They include:

- F1 - Help On View
- F3 - Console
- F4 - Hide Console
- F5 - Find
- F6 - searchReplace;
- F7 - Goto File
- F8 - searchConsoleNext
- F9 - Save amp; Compile
- Alt + Left - Back
- Alt + Right - Forward
- Alt + Up - Up Level
- Alt + Home - Home
- Alt + Space - Recent Ords
- Ctrl + A - Add Slot
- Ctrl + C - Copy
- Ctrl + D - Duplicate
- Ctrl + F - Find Next
- Ctrl + G - Goto Line
- Ctrl + L - Open Ord
- Ctrl + N - New Window
- Ctrl + O - Open File...
- Ctrl + P - Print
- Ctrl + R - Rename Slot
- Ctrl + S - Save
- Ctrl + T - New Tab
- Ctrl + V - Paste
- Ctrl + W - Word Wrap
Types of menu bar items

This section describes the menu items that appear in the Workbench menu bar:

- **File menu**
  See "About the File menu" on page A-2

- **Edit menu**
  See "About the Edit menu" on page A-4

- **Search menu**
  See "About the Search menu" on page A-5

- **Bookmarks menu**
  See "About the Bookmarks menu" on page A-6

- **Tools menu**
  See "About the Tools menu" on page A-6

- **Window menu**
  See "About the Window menu" on page A-6

- **Px Editor menu**
  See "About the Px Editor menu" on page A-7

- **History Ext Manager menu**
  See "About the History Ext Manager menu" on page A-8

- **Help menu**
  See "About the Help menu" on page A-8

### About the File menu

The File menu in the menu bar has the following options:

The **File** menu in the menu bar provides the following options:

- **Open Ord**
  You may open a ORD by selecting **File > Open > Open Ord** from the main menu or from the toolbar open button.
  The Ord Chooser also allows you to directly type the Ord of a location in order to go there. If no view is specified, the default view for the item will be presented. You may also paste an Ord instead of typing it by pressing the paste shortcut Ctrl + V after you have copied a node or Ord into the clipboard.

- **Open File**
  You may open a file by selecting **File > Open > Open File...** from the main menu.

- **Open Directory**
  You may open a Directory by selecting **File > Open > Open Directory...** from the main menu.

- **Open Station (Fox)**
  You may open a Station by selecting **File > Open > Open Station (Fox)...** from the main menu. This will cause the following popup window to be presented so that you can complete each field.
  Address - This is the address of the computer running the Station that you wish to access.
  User name - This is the user name given to you by your system administrator.
  Password - This is the password given to you by your system administrator.
  Remember these credentials - This will save this connection in your connection list.
  Once you successfully connect to the Station, it will appear in the tree and your home page will be displayed.
  If you will be away from the system, you should close the Station to prevent unauthorized access.
• **Open Platform**
  You may open a Platform by selecting `File > Open > Open Platform...` from the main menu. This will cause the following popup window to be presented so that you can complete each field.
  Host - This is the address of the computer running the Platform that you wish to access.
  Port - This is the port used.
  Password - This is the password given to you by your system administrator.
  Remember these credentials - This will save this connection in your connection list.
  Once you successfully connect to the Platform, it will appear in the tree and the available tools will be displayed.

• **Find Stations**
  You may find Stations by selecting `File > Open > Find Stations...` from the main menu. This command finds all the stations running on the network. It will search for 5 seconds, then display a Table of all the stations found. You may display additional columns about each station using the options button (on the right of the header). Double-click a Station to open a Fox connection to it.

• **Back**
  Back allows you to go to the previous view. The shortcut is Alt + Left.

• **Forward**
  Forward allows you to go to the next view. You must have used the Back command previously. The shortcut is Alt + Right.

• **Up Level**
  Up Level allows you to go to the next level up. The shortcut is Alt + Up.

• **Save**
  Saves the value of the Component.

• **Save Bog**
  Save the Component changes to the Bog File file.

• **Save All**
  Save all open views. This saves all Tabs when browsing with multiple Tabs.

• **Recent Ords**
  Recent Ords allows you to see recent Ords. The shortcut is Alt + Space.

• **Refresh**
  Refresh allows you to refresh the current view.

• **Home**
  Home allows you to go to the home view. The shortcut is Alt + Home.

• **Printing**
  Printing provides the capability to print the current view. When it appears dimmed, printing is not available.

• **Export**
  Export provides the capability to Export the current view. When it appears dimmed, Export is not available.

• **Logging off the System**
  You may exit the system by a number of means. You may Close the session, Close All sessions, Exit, or Close the current window. Each of these causes different actions and should be understood.

• **Close Session**
  You may logoff the Station at any time by selecting `File > Close` from the main menu. Once you successfully close a session, it will be removed from the tree. This could leave a user interface running without an open session.

• **Disconnect**
  You may logoff the system at any time by Right-clicking the connected system in the tree and select Disconnect. This allows you to close a session with a Station without removing it from the tree.

• **Dismiss**
  You may logoff a connected system at any time by Right-clicking the connected system in the tree and select Dismiss. This allows you to close a session with a Station and remove it from the tree.

• **Exiting the System**
  You may exit the system at any time by selecting `File > Exit` from the main menu. This differs from logoff in that it also causes the user interface to stop.

• **Close the Current Window**
  You may close the current window at any time, if it is not the primary window, by any of the following methods:
  • selecting `File > Close` from the main menu
  • pressing the box in the top left corner and selecting Close from the menu
About the Edit menu

- **Cut**
  Cut copies the current Selection to the clipboard and changes its Color to gray until a Paste is performed to delete it. If the Selection is a string, Cut makes a Copy of the current text selection and places it in the clipboard and removes it from the current string. It may be accessed by selecting an item and:
  - Right-clicking the item(s) and choosing Cut.
  - Right-click in the tree and choosing Cut.
  - In the Wire Sheet press the \( \text{Cut} \) toolbar icon.
  - In the Wire Sheet select **Edit > Cut** from the main menu.
  - pressing the shortcut key \( \text{Ctrl} + \text{X} \) (hold down \( \text{Ctrl} \) and press \( \text{X} \)) when in a window other than the main browser window.

You can use **Drag** to Cut and Paste in one operation.

- **Copy**
  Copy copies the current contents of the clipboard to the destination component as a set of new dynamic properties. If the Selection is a string, Copy makes a copy of the current text Selection and places it in the clipboard. To Copy a Component, do any of the following:
  - Right-click a Component in a view or tree and choose Copy
  - Right-click the background in the Wire Sheet choosing Copy
  - In the Wire Sheet press the \( \text{Copy} \) toolbar button.
  - In the Wire Sheet select **Edit > Copy** from the main menu
  - pressing the shortcut key \( \text{Ctrl} + \text{C} \) (hold down \( \text{Ctrl} \) and press \( \text{C} \)) when in a window other than the main browser window.

You can copy a selected group of Components in the Wire Sheet. You can use **Drag** to Copy also.

In order to Copy a Component, you must Copy it from the Palette or an existing Database. You can follow one of the following steps:
  - In the Palette Sidebar, expand a module (like control) and sub-directory (like Points), Right-click on a Component (like BooleanWritable) and select Copy.
  - In the namespaces sidebar (tree), expand System, Modules, a module (like control), Files, module palette, and sub-directory (like Points), Right-click on a Component (like BooleanWritable) and select Copy.
  - OR Right-click on a Component that you want to Copy from a Wire Sheet, Property Sheet or the tree and select Copy.

- **Paste**
  Paste copies the contents of the clipboard to the destination Component as a set of new dynamic properties. If the target is a string, Paste places a reference to the source that was cut or copied into clipboard. It may be accessed by cutting or copying item(s) and:
  - Right-clicking the item and choosing Paste
  - Right-click in the tree and choosing Paste
  - In the Wire Sheet press the **Paste** toolbar icon.
  - In the Wire Sheet select **Edit > Paste** from the main menu
  - pressing the shortcut key \( \text{Ctrl} + \text{V} \) (hold down \( \text{Ctrl} \) and press \( \text{V} \)) when in a window other than the main browser window.
the main browser window.
You can use Drag to Cut and Paste in one operation.
You can add a Component to a running Station or an offline Bog File file. You can do this using any of the following:
• In the Wire Sheet, Right-click on the background and select Paste to add the new Component. The new Component is created and is selected.
• In the tree, Right-click on a Container and select Paste to add the new Component inside the Container.
See the Bajadoc Index for reference information. If you select Help > Guide On Target with a Component selected, you will get the Guide for that Component. If you select Help > Bajadoc On Target with a Component selected, you will get the bajadoc for that Component. The BooleanWritable bajadoc is at module://control/doc/javax/baja/control/BBooleanWritable.bajadoc.

• Paste Special
Paste Special copies the contents of the clipboard to the destination Component when it is a Special Transferable.
• Duplicate
Duplicate copies the current Selection and places a duplicate in the same Container. This function may be access from the menu under Edit (shortcut Ctrl + D) or from the toolbar.
• Delete
Delete removes the current Selection from its parent Container. It may be accessed by selecting an item and:
• Right-clicking the item(s) and choosing Delete
• Right-click in the tree and choosing Delete
• In the Wire Sheet press the Delete toolbar button.
• In the Wire Sheet select Edit > Delete from the main menu
• Undo
This reverses the last Action as if it had not been performed. It is only available for certain actions such as:
• Paste Component
• Cut Component
• link
• Delete Links
• Redo
This restores an Action after Undo has removed it. It is only available after a successful Undo.

About the Search menu
The Search menu in the menu bar has the following options:
• Find
Find allows you to search in the file for the selected string. You can Match Case or Match Word. The shortcut is F5.
• Find Next
Find Next allows you to find the next occurrence of the selected string. The shortcut is Ctrl + F (hold down Ctrl and press F).
• Find Prev
Find Prev allows you to find the previous occurrence of the selected string. The shortcut is Ctrl + Shift + F (hold down Ctrl and Shift and press F).
• Replace
Replace allows you to replace the next occurrence in the file. The shortcut is Ctrl + R (hold down Ctrl and press R).
• Goto Line
Goto Line allows you to go to a line number in the file. The shortcut is Ctrl + G (hold down Ctrl and press G).
• Goto File
Goto File allows you to go to a file. The shortcut is Ctrl + F3 (hold down Ctrl and press F3).
• Find Files
Find In Files allows you to find the all occurrences of a string in files. You can Match Case or Match Word. You can choose Files to Find. You can select a Folder. You can choose whether to Search subfolders.
• Replace Files
Replace Files allows you to replace the all occurrences in the files.
• **Console Prev**  
  Console Prev allows you to go to the previous console error. The shortcut is F7.

• **Console Next**  
  Console Next allows you to go to the next console error. The shortcut is F8.

**About the Bookmarks menu**  

The Bookmarks menu in the menu bar has the following options:

• **Add To Bookmarks**  
  You may add a Bookmark by selecting *Bookmarks > Add to Bookmarks* from the main menu.

• **Manage Bookmarks**  
  You may manage Bookmarks by selecting *Bookmarks > Manage Bookmarks* from the main menu.

• **Bookmarks Go Into**  
  You may select Bookmarks by selecting *Bookmarks > Go Into* from the main menu.

• **Bookmarks File**  
  You may select Bookmarks by selecting *Bookmarks > File* from the main menu.

**About the Tools menu**  

The Tools menu in the menu bar has the following options:

• **Viewing and Changing the Options**  
  The *Options* allow you to customize the framework for the way you use it. It can be selected from the main Menu by selecting *Tools > Options*. It includes the following:
  • General
  • Lexicon
  • Text Editor
  • Wire sheet

• **ColorChooser**  
  The ColorChooser allows you to choose Colors.

• **New Module Wizard**  
  The *New Module* Wizard allows you to build a new Module. It can be selected from the main Menu by selecting *Tools > New Module*.

• **New Station Wizard**  
  The *New Station* Wizard allows you to build a new station Database. It can be selected from the main Menu by selecting *Tools > New Station*.
  You must enter a *Station Name*. You can also choose whether this is a *JACE Station* or a *Supervisor Station*. Press *Next* to proceed. Next you should enter an *Admin Password*. You can also change the *Fox Port* and *HTTP Port*. Press *Finish* to proceed. You are then presented a view of your newly created Station at `local://file:!stations/stationname/config.bog|bog://slot/`.

• **Manage Credentials**  
  Manage Credentials is available in the main *Tools* menu by selecting *Manage Credentials...* You can *Reset* or *Remove* selected Credentials or *Remove All* Credentials. You can also *Open* selected Credentials.

• **Request License**  
  Request License is available in the main *Tools* menu by selecting *Request License...*. You can request a license by submitting the form.

**About the Window menu**  

The Window menu in the menu bar has the following options:

• **Side Bars**  
  • Show Side Bar  
    You can choose whether to have Side Bars by selecting *Window > Side Bars > Show Side Bar* from the main menu.
    For more information about the side bar refer to “About the side bar panes” on page 2-2.

• **Bookmarks**  
  You can choose to show the Bookmarks Side Bar by selecting *Window > Side Bars > Bookmarks* from the main menu.
  For more information about the Bookmarks side bar refer to “About the bookmark side bar” on page 2-4.
• **Help Sidebar**
  The typical configuration provides a Help Sidebar frame in the left side of the main window. If it is not open, you can choose to display the Help Side Bar by selecting **Window > Side Bars > Help** from the main menu.
  Initially, the Help Sidebar is empty until you press **Load Help**.
  **Load Help** will reappear any time any Module’s timestamp is changed or a new Module is added or removed. **Load Help** searches through all the available Modules to create the help Directory. The Help Sidebar provides a view of the available Help.
  For more information about the Help Sidebar refer to “About the help side bar” on page 2-5.

• **Jobs Sidebar**
  The Jobs SideBar shows all the current jobs in all the stations with which you have a connection. Controls are provided to allow you to view a job log or dismiss a completed job.
  For more information about the Jobs side bar refer to “About the jobs side bar” on page 2-9.

• **Nav**
  You can choose to show the Nav side bar by selecting **Window > Side Bars > Nav** from the main menu.
  For more information about the Nav side bar refer to “About the nav side bar” on page 2-6.

• **Palette**
  You can choose to show the Palette Side Bar by selecting **Window > Side Bars > Palette** from the main menu.
  For more information about the Palette side bar refer to “About the palette side bar” on page 2-8.

• **PathBar Uses NavFile**
  You can toggle this option ON or OFF by selecting **Window > Side Bars > PathBar Uses NavFile**. When ON, the PathBar (located at the top of the Workbench main window) displays your current path, as defined by the NavFile (logical path). When OFF (not selected) the PathBar displays your absolute path regardless of whether it is mapped to the NavFile or not. You must refresh the view after changing this setting in order to see the PathBar change.

• **Active Plugin**
  The Active Plugin function gives focus to the current view. From the main menu you can select **Window > Active Plugin** or use the shortcut Ctrl + F4. It is very useful to use F3/Ctrl + F4 to toggle between the **Console** and the Text File Editor.

• **Hide Console**
  You can hide the console by selecting **Window > Hide Console** from the main menu or using the shortcut Ctrl + F2.

• **Console**
  The Console provides the capability to issue console commands directly. From the main menu you can select **Window and Console** (F3) or **Hide Console** (F4) to determine if the console is visible.
  Refer to “Types of console commands” on page A-16 for information about console commands.

**About the Px Editor menu**

The **Px Editor** menu appears in the menu bar when Px Editor is the active view. The Px Editor has the following context-sensitive options:

• **Toggle View/Edit Mode**
  This command toggles the active view between Px Editor (for editing) and Px View (view only). If there are unsaved changes in your Px file, you are prompted to save before switching from Px Editor to Px View.

• **View Source Xml**
  Selecting this command displays the Px source file in a separate read-only window.

• **Go to Source Xml**
  Selecting this opens the Px source (xml) file directly in the text file editor. Files can be edited and saved using the editor.

• **Grid**
  This command toggles the grid display on and off.

• **Snap**
  This command toggles the snap-to-grid feature on and off.

• **Show Hatch**
  This command toggles the hatching pattern visibility on and off. When hatching is on, dim angular lines (hatching pattern) displays on objects to make them more visibly distinct.
• **Set Target Media**  
  This command is available when you are editing a Px file directly in the Px Editor—not when you are editing the Px file as a view of a component. When selected, this command displays the **Set Target Media** dialog box to allow you to choose your expected media viewer (HTML Px Media or Workbench Px Media). See “About presentation media” on page 1-14 for more details about media types.

### About the History Ext Manager menu

The **History Ext Manager** menu appears in the menu bar when History Extension Manager is the active view. The History Ext Manager menu has the following options:

- **Enable Collection**  
  Select this menu item to enable (start the collection process) for the selected entries.

- **Disable Collection**  
  Select this menu item to disable (stop the collection process) for the selected entries.

- **Rename History**  
  Select this menu item to rename the selected history. This menu item displays the Set History Name dialog box.

- **Edit System Tags**  
  Select this menu item to open the **Set System Tags For Selected History Extensions** dialog box. Use this dialog box to edit system tags associated with a single history extension or perform batch edits when you have more than one history extension selected.

### About the Help menu

The Help menu in the menu bar has the following options:

- **Help Contents Index**  
  The help contents provides a common point of access to all system documentation. It is accessed by selecting Help > Contents Index from the menu or pressing the 📚 Help button on the toolbar to see the Help Index.

- **Help On View**  
  This provides help for the current Plugin. It is accessed by selecting Help > On View from the menu with the Plugin in use.

- **Help Guide On Target**  
  This provides context sensitive help for Components. It is accessed by selecting Help > Guide On Target from the menu when the current view is a view of a Component. It is also available by Right-clicking a Component and choosing Views > Guide Help.

- **Help Bajadoc On Target**  
  This provides context sensitive Bajadoc help for Components. It is accessed by selecting Help > Bajadoc On Target from the menu when the current view is a view of a Component. It is also available by Right-clicking a Component and choosing Views > Bajadoc Help.

- **Help Find Bajadoc**  
  This is accessed by selecting Help > Find Bajadoc from the menu. It searches for the requested bajadoc.

- **Help About**  
  This is accessed by selecting Help > About from the menu. It provides the software release and license information.

### Types of popup menu items

Workbench provides view–specific, or context–specific commands for editing components in many of the views. Following, is a list of the standard Workbench popup (right–click) menus.

- **Nav side bar**  
  For descriptions of the popup menu items that are available in the nav side bar refer to “About the nav side bar popup menu items” on page A-9.

- **Wire sheet**  
  For descriptions of the wire sheet popup menu items, refer to “About the wire sheet popup menu items” on page A-10

- **Property sheet**  
  For descriptions of the property sheet popup menu items, refer to “About the property sheet popup menu items” on page A-10.
• **Px Editor**  
For descriptions of the Px Editor popup menu items, refer to "About the Px Editor popup menu items" on page A-10.

• **History extension manager**  
For descriptions of the History extension manager popup menu items, refer to "About the history extension manager popup menu items" on page A-11.

• **Todo list**  
For descriptions of the Todo list popup menu items, refer to "About the Todo list popup menu items" on page A-11.

• **Point Manager**  
For descriptions of the Point Manager popup menu items, refer to "About the point manager popup menu items" on page A-12.

### About the nav side bar popup menu items

The nav sidebar provides a tree−type hierarchical view of the system. For an overview of the nav side bar, refer to "About the nav side bar" on page 2-6.

The nav side bar menu is the popup menu that displays command options when you right−click on a component item in the nav side bar. The nav side bar menu has the following options:

• **Views**  
Goes to any of the views of the selected component.

• **Actions**  
Perform any available actions on the component.

• **New**  
Create a new item of standard types.

• **Cut**  

• **Copy**  

• **Paste**  

• **Duplicate**  

• **Delete**  

• **Find**  
This menu item displays the Component Finder dialog box.

• **Link Mark**  
This menu item sets a selected point to your popup menu, making it temporarily available for “Linking From” or Linking To” other points.

• **Link From**  
This menu item allows you to link a selected point to another point that has been marked, using Link Mark from the popup menu.

• **Link To**  
This menu item allows you to link a selected point to another point that has been marked, using Link Mark from the popup menu.

• **Rename**  
Select this menu item to rename the selected point. This menu item displays the Set Point Name dialog box. You can only rename one point at a time.

• **Reorder**  
This menu item displays the Reorder Points dialog box, which provides the following commands for reordering points within the selected parent component.
  • Move Up
  • Move Down
  • Sort by Name
  • Sort by Type
  • Reset

• **Composite**  
This menu item displays the Composite Editor dialog box.

• **Refresh**  
This menu item updates the display of the currently active view.
- **Go Into**
  Go Into allows you to re-root the nav tree at any arbitrary node. Right-click the node and select the "Go Into" command. This will make that node the new root of the tree. All the nodes you have "gone into" are persistently saved as a special type of Bookmark. Use the pulldown to switch between them. This feature is quite handy when working with multiple Stations or deep File systems and Databases.

**About the wire sheet popup menu items**

Most of the wire sheet menu commands are described in "About the nav side bar popup menu items". Following are wire sheet specific popup menu options:

- **Arrange**
  Provides options for aligning components on the wire sheet in order to make them easier to view:
  - **Arrange All**
    Redistributes the layout of all components on the wire sheet.
  - **Arrange Selection**
    Redistributes the layout of all selected components on the wire sheet.

- **Select all**
  Selects all components on the active wire sheet.

**About the property sheet popup menu items**

Most of the property sheet menu commands are described in "About the nav side bar popup menu items". Following are wire sheet specific popup menu options:

- **Config flags**
  Opens the Config dialog box which you can use to add configuration flags on individual slots.

**About the Px Editor popup menu items**

The Px Editor popup menu displays when you right-click on an object in the Px Editor view. The menu commands are dimmed or available, depending on the type of object that you select.

The following menu commands are on the Px Editor popup menu:

- **New** (refer to "About the Edit menu" on page A-4)
- **Cut** Ctrl + X (refer to "About the Edit menu" on page A-4)
- **Copy** Ctrl + C (refer to "About the Edit menu" on page A-4)
- **Paste** Ctrl + V (refer to "About the Edit menu" on page A-4)
- **Delete** Delete (refer to "About the Edit menu" on page A-4)
- **Edit Properties...** (refer to "About the properties side bar" on page 2-11)
- **Align > Left**
  This command is available when you select two or more objects in the Px Editor. Choose the **Left** command to align the left edges of two or more objects along a vertical line.

- **Align > Right**
  This command is available when you select two or more objects in the Px Editor. Choose the **Right** command to align the right edges of two or more objects along a vertical line.

- **Align > Top**
  This command is available when you select two or more objects in the Px Editor. Choose the **Top** command to align the top edges of two or more objects along a horizontal line.

- **Align > Bottom**
  This command is available when you select two or more objects in the Px Editor. Choose the **Bottom** command to align the bottom edges of two or more objects along a horizontal line.

- **Reorder > To Top**
  This command is available when you select one or more objects in the Px Editor. Choose the **To Top** command to move the selected object to the top position (inside its parent object) in the Widget Tree. This command will place the object in front (with respect to the view pane, or z-axis) of all other objects in the parent object, but will not move the object out of its parent object.

- **Reorder > Up**
  This command is available when you select one or more objects in the Px Editor. Choose the **Up** command to move the selected object one position higher in the Widget Tree and forward one position in the view pane. This command will not move the object out of its parent object.

- **Reorder > Down**
  This command is available when you select one or more objects in the Px Editor. Choose the **Down** command to move the selected object one position lower in the Widget Tree and back one position in the view pane. This command will not move the object out of its parent object.
• **Reorder > To Bottom**
  This command is available when you select one or more objects in the Px Editor. Choose the **To Bottom** command to move the selected object to the bottom position (inside its parent object) in the Widget Tree. This command will place the object behind (with respect to the view pane, or z-axis) all other objects in the parent object, but will not move the object out of its parent object.

• **Border > Add Border**
  This command is available when you select one or more objects in the Px Editor. Choose the **Add Border** command to wrap selected object(s) with a border pane. Each selection is wrapped in a separate border pane.

• **Border > Remove Border**
  This command is available when you select one or more border panes in the Px Editor. Choose the **Remove Border** command to delete selected border pane(s).

---

**About the history extension manager popup menu items**

The history extension manager popup menu has the following items:

• **Views**
  This menu item provides a submenu that lists all the available views of the history extension manager.

• **Actions > Update History Id**
  This menu item provides a way to refresh the History Id after a rename. It applies the formatting property (as designated by the enclosing % signs) of the Name Format field to the Id of the History Config Id. For example, if the History Name property under a history extension is set to `parent.name`, then the History Config Id is initially named based on this parent display name. However, if you rename the parent component, the History Config Id property does not automatically or immediately change. The Update History Id action invokes a renaming of the History Config Id based on the formatting property, so if the parent component (in this example case) is changed, the Update History Id action changes the Id property and, if different from the history name, it results in a change in the history name as well. See “About history names” on page 4-26 for more information about history naming.

• **Go To Point**
  This menu item displays the property sheet view of the point associated with the selected entry.

• **Go To History**
  This menu item displays the default view of the history associated with the selected entry.

• **Enable Collection**
  Select this menu item to enable (start the collection process) for the selected entries.

• **Disable Collection**
  Select this menu item to disable (stop the collection process) for the selected entries.

• **Rename History**
  Select this menu item to rename the selected history. This menu item displays the Set History Name dialog box. You can only rename one history at a time.

• **Edit System Tags**
  Select this menu item to open the **Set System Tags For Selected History Extensions** dialog box. Use this dialog box to edit system tags associated with a single history extension or perform batch edits when you have more than one history extension selected.

Refer to “About the History Ext Manager menu” on page A-8 for information about the History Ext Manager menu. Refer to “About the history extension manager view” on page 4-3 for general information about the history extension manager view.

---

**About the Todo list popup menu items**

The Todo list popup menu has the following items:

• **Add**
  This menu item opens the **Add** dialog box, when clicked. Use this menu item to add a new item to your Todo checklist and assign a Summary and Group to the item. This menu item is available even if no items are selected.

• **Mark Complete**
  This menu item, when clicked, dims and lines-through the selected item(s) in the Todo list so that the item(s) appears to be “crossed off” the list. If an item is already marked complete and this menu item is selected, the item will be restored to its “unmarked” state. With no items selected, this menu item is dimmed (unavailable).
Types of popup menu items

About the point manager popup menu items

The point manager popup menu has the following items:

- **Views**
  This menu item provides a submenu that lists all the available views of the point manager. These same views are available from the view selector menu (see “About the view selector” on page 2-15) when the point extension manager is the active view.

- **Actions**
  This menu item allows you to perform any available actions on the component. For example, write to a “writable” point.

- **New**
  This menu item allows you to add a new component to the points manager. Valid options are presented in the submenu.

- **Cut**

- **Copy**

- **Paste**

- **Duplicate**

- **Delete**

- **Find**
  This menu item displays the Component Finder dialog box.

- **Link Mark**
  This menu item sets a selected point to your popup menu, making it temporarily available for “Linking From” or “Linking To” other points.

- **Link From**
  This menu item allows you to link a selected point to another point that has been marked, using Link Mark from the popup menu.

- **Link To**
  This menu item allows you to link a selected point to another point that has been marked, using Link Mark from the popup menu.

- **Rename**
  Select this menu item to rename the selected point. This menu item displays the Set Point Name dialog box. You can only rename one point at a time.

- **Reorder**
  This menu item displays the Reorder Points dialog box, which provides the following commands for reordering points within the selected parent component.
  - Move Up
  - Move Down
  - Sort by Name
  - Sort by Type
  - Reset

About the point manager popup menu items

The point manager popup menu has the following items:

- **Edit**
  Displays the Edit dialog box, when clicked, allowing you to change the Summary and the Group fields associated with the item.

- **Move to Top**
  Moves the selected item to the top of the list.

- **Move Up**
  Moves the selected item up in the list, one increment per click.

- **Move Down**
  Moves the selected item down in the list, one increment per click.

- **Move to Bottom**
  Moves the selected item to the bottom of the list.

- **Remove**
  Displays a “Remove selected items?” prompt, when clicked; deletes selected items when the prompt is affirmed.

Refer to “Todo list” on page 9-15 for general information about the Todo list view.
• **Composite**  
This menu item displays the **Composite Editor** dialog box.

• **New Folder**  
This menu item allows you to add and name a new points folder.

• **New**  
This menu item allows you to add and name a new point.

• **Edit**  
This menu item displays the **Point Editor** dialog box.

### Types of edit commands

In addition to view–specific editing tools, Workbench provides commands for editing components in many of the views. Following, is a list of descriptions of the standard commands that are available in Workbench views for editing components.

- **Drag**  
Dragging files or components only works within a single Workbench application. However, it is possible to drag files from Windows Explorer into the Workbench to see the default view. Dragging a component or file using the left mouse button performs a Copy operation. Dragging a component or file using the right mouse button always prompts you for a Copy, Move, or Cancel command selection.

- **Cut**  
Use the Cut command to delete the selected object and send it to the clipboard.

- **Copy**  
Use the Copy to send the selected object to the clipboard without deleting it.

- **Paste**  
Use the Paste command to copy the current contents of the clipboard to the destination as a set of new dynamic properties.

- **Duplicate**  
Use duplicate to create a copy of the current selection in the same container as the selection.

- **Delete**  
Use the Delete command to remove a selected item from its parent container.

- **Undo**  
Use the Undo command to reverse the previous command. Undo is only available for certain commands, such as, Paste, Cut, Delete, and the Link action.

- **Redo**  
Use the Redo command to restore a command–action after the Undo command has removed it.

- **Rename**  
Use Rename to change the name of a Component.

### Types of toolbar icons

For an overview of the Workbench toolbar, refer to "About the toolbar" on page 2-13. Some icons are always visible as you navigate through the system. Additional icons may be added and removed from view when different views are active. When icons appear dimmed, their functions are unavailable. Icons that appear on the toolbar are grouped in the following categories:

- **Standard toolbar icons**  
These icons may be dimmed (or unavailable in certain views) but they are always present on the toolbar. Refer to “Standard toolbar icons” on page A-14 for the listing of Standard toolbar icons.

- **Slot sheet toolbar icons**  
These icons appear only when the Slot Sheet is active. Refer to “Slot Sheet toolbar icons” on page A-14 for the listing of Slot Sheet toolbar icons.

- **Px Editor toolbar icons**  
These icons appear only when the Px Editor or Px Viewer is active. Refer to “Px Editor toolbar icons” on page A-14 for the listing of Px Editor toolbar icons.

- **History extension manager toolbar icons**  
These icons appear when the History Editor view is active. Refer to "About the history extension manager toolbar icons" on page A-15 for the listing of History Editor toolbar icons.

- **History Editor toolbar icons**  
These icons appear when the History Editor view is active. Refer to "About the history editor toolbar icons" on page A-15 for the listing of History Editor toolbar icons.
• **Todo list toolbar icons**
  These icons appear when the Todo list view is active. Refer to "About the Todo list toolbar icons" on page A-15 for the listing of Todo list toolbar icons.

**Standard toolbar icons**
For an overview description of the toolbar, refer to "About the toolbar" on page 2-13. Following are the icons that appear in all views:

- ![Back](image)
  See "Back" on page A-3 for details about the Back function.
- ![Forward](image)
  See "Forward" on page A-3 for details about the Forward function.
- ![Up Level](image)
  See "Up Level" on page A-3 for details about the Up Level function.
- ![Recent Ords](image)
  See "Recent Ords" on page A-3 for details about the Recent Ords function.
- ![Home](image)
  See "Home" on page A-3 for details about the Home function.
- ![Refresh](image)
  See "Refresh" on page A-3 for details about the Refresh function.
- ![Left Side Bar](image)
  See "Side Bars" on page A-6 for details about the Side Bars function.
- ![Open](image)
  See "About the File menu" on page A-2 for details about all the Open functions.
- ![Save Ctrl + S](image)
  See "Save" on page A-3 for details on the Save function.
- ![Save Bog](image)
  See "Save Bog" on page A-3 for details on the Save Bog function.
- ![Printing Ctrl + P](image)
  See "Printing" on page A-3 for details on the Printing function.
- ![Cut Ctrl + X](image)
- ![Copy Ctrl + C](image)
- ![Paste Ctrl + V](image)
- ![Duplicate Ctrl + D](image)
  See "Duplicate" on page A-13 for details on the Duplicate function.
- ![Delete Delete](image)
  See "Delete" on page A-13 for details on the Delete function.
- ![Undo Ctrl + Z](image)
  See "Undo" on page A-13 for details on the Undo function.
- ![Redo Ctrl + Alt + Z](image)
  See "Redo" on page A-13 for details on the Printing function.

**Slot Sheet toolbar icons**
For an overview description of the toolbar, refer to "About the toolbar" on page 2-13. Following are the icons that appear when the Slot Sheet view is active:

- ![Add Slot](image)
  Creates a new slot (appearing as a row) on the slot sheet.
- ![Rename Slot](image)
  Displays the Rename Slot dialog box, when clicked. This icon is dimmed when no slot, or more than one slot is selected in the slot sheet editor view.
- ![Config Flags](image)
  Displays the Config Flags dialog box, when clicked. This icon is dimmed unless one or more slots are selected in the slot sheet editor view.
- ![Reorder](image)
  Displays the Reorder dialog box, when clicked.

**Px Editor toolbar icons**
For an overview description of the toolbar, refer to "About the toolbar" on page 2-13. Following are the icons that appear when the Px Editor is the active view:

- ![Toggle View/Edit Mode](image)
  Displays, alternately, the Px Editor or the Px Viewer in the view pane. This icon appears inset when the Px Editor view is active and it appears normal when the Px Viewer is active. See "About Px views" on page 6-2 for more details about the Px Editor and Px Viewer.
- ![Right (Px Editor) side bar menu](image)
  Displays a dropdown menu of side bar options for the Px Editor. The following options are available:
  - Bound Ords
    Shows or hides the Bound Ords side bar (refer to "About the bound ords side bar" on page 2-10).
  - Widget Tree
    Shows or hides the Widget Tree side bar (refer to "About the widget tree side bar" on page 2-10).
  - Properties
    Shows or hides the Properties side bar (refer to "About the properties side bar" on page 2-11).
- ![Left align](image)
  Aligns left edges of selected objects along a vertical line.
- ![Right align](image)
  Aligns right edges of selected objects along a vertical line.
- ![Top align](image)
Aligns top edges of selected objects along a horizontal line.

- **Bottom align**
  Aligns bottom edges of selected objects along a horizontal line.

- **To Top**
  Moves selected objects to the highest position (with regard to z-order) in the parent object.

- **To Bottom**
  Moves selected objects to the lowest position (with regard to z-order) in the parent object.

- **Select**
  Activates the pointer tool used to select objects in the Px Editor view using the mouse.

- **Add Polygon**
  Activates the polygon tool for drawing polygons.

- **Add Path**
  Activates the path tool that allows you to draw bezier curves in the Px Editor view.

- **Add Point**
  Activates the Add Point tool that allows you to add a point to a path or a polygon in the Px Editor view.

- **Delete Point**
  Activates the Delete Point tool that allows you to remove a point from a path or a polygon in the Px Editor view.

### About the history extension manager toolbar icons

The Workbench toolbar contains navigation and editing buttons as described in About the toolbar. For an overview description of the history editor view, refer to “About the history extension manager view” on page 4-3. Following, are the icons that appear when the history extension manager view is active:

- **HistoryExtManager Enable Collection**
  Click this icon to enable (start the collection process) for the selected entries.

- **HistoryExtManager Disable Collection**
  Click this icon to disable (stop the collection process) for the selected entries.

- **HistoryExtManager Rename History**
  Click this icon to rename the selected history. When clicked, the Set History Name dialog box appears.

- **HistoryExtManager Edit System Tags**
  Click this icon to open the Set System Tags For Selected History Extensions dialog box. Use this dialog box to edit system tags associated with a single history extension or perform batch edits when you have more than one history extension selected.

### About the history editor toolbar icons

For an overview description of the history editor view, refer to “About the history editor view” on page 4-15. Following are the icons that appear when the history editor view is active:

- **Hide**
  With one or more records selected, this icon is available to set the trend flag of all selected records to “hidden”. With no records selected, the icon is dimmed (unavailable).

- **Unhide**
  With one or more records selected, this icon is available to set the trend flag of all selected records to “hidden”. With no records selected, the icon is dimmed (unavailable).

- **Filter**
  Displays the Configure Flags dialog box, when clicked. This icon is available even if no records are selected.

- **Configure Outliers**
  Displays the Configure Outliers dialog box, when clicked.

### About the Todo list toolbar icons

For an overview description of the Todo list view, refer to “Todo list” on page 9-15. Following are the icons that appear when the Todo list view is active:

- **Add**
  This icon opens the Add dialog box, when clicked. Use this icon to add a new item to your Todo checklist and assign a Summary and Group to the item. This icon is available even if no items are selected.
• **Mark Complete**
  This icon, when clicked, dims and lines-through the selected item(s) in the Todo list so that the item(s) appears to be “crossed off” the list. If the item is already marked as completed and this icon is selected, the item will be restored to its “unmarked” state. With no items selected, this toolbar icon is dimmed (unavailable).

• **Edit**
  Displays the Edit dialog box, when clicked, allowing you to change the Summary and the Group fields associated with the item.

• **Move to Top**
  Moves the selected item to the top of the list.

• **Move Up**
  Moves the selected item up in the list, one increment per click.

• **Move Down**
  Moves the selected item down in the list, one increment per click.

• **Move to Bottom**
  Moves the selected item to the bottom of the list.

• **Remove**
  Displays a “Remove selected items?” prompt, when clicked; deletes selected items when the prompt is affirmed.

### Types of console commands

The following sections provide descriptions of how to use the Workbench console in terms of:

The following types of commands may be typed in from the Workbench console.

- **Niagara shell commands**
  These commands are used at the command line and may be typed in directly. See “Niagara shell commands” on page A-16:

- **nre commands**
  These commands are used at the command line and may be typed in using the “nre” prefix. See “nre (station) commands” on page A-17.

- **wb commands**
  These commands are used at the command line and may be typed in using the “wb” prefix. See “wb (Workbench) commands” on page A-17.

- **plat commands**
  These commands are used at the command line and may be typed in using the “plat” prefix. See “plat (platform) commands” on page A-17:

### Niagara shell commands

- **cd**
  This command displays and changes the current directory. Type `cd <directory name>` to change to a specific directory. Type `cd` to display the current directory.

- **debug**
  This command turns debug tracing on and off. Type `debug on` to turn on debug. Type `debug off` to turn off debug.

- **print**
  This command prints a message to the output stream. Type `print <message>` to print the literal message to the console.

- **reset**
  This command resets the environment to its default state. Type `reset` to set the environment to its default state.

- **set**
  This command displays and modifies environment variables.
  - Type `set` to display all the environment variables.
  - Type `set <prefix>` to display all the environment variables that start with the specified prefix.
  - Type `set <name>=` to remove the “named” variable.
  - Type `set <name>=<value>` to set the “named” variable to the “value” specified.

- **which**
  This command resolves a filename in a path. Type `which <filename>` to find the first occurrence of the specified “filename”.

April 4, 2011
**nre (station) commands**

Use the following syntax with the nre command:

```
nre [options] <class> [args]*
```

The following parameters may be used with the nre command.

- **class**
  This is a class name or a module:classname to execute.

- **args**
  This is the name of one or more arguments to pass through to main.

The following `options` may be used with the nre command.

- **-version**
  This option displays the nre version.

- **-modules:<x>**
  This option displays the modules that match the pattern defined by "x".

- **-hosted**
  This option displays the id for the system host.

- **-licenses**
  This option displays a summary of the license information.

- **-props**
  This option displays a list of the system properties.

- **-locale:<x>**
  This option allows you to set the default locale. For example, to set the default locale to US English, type: `-locale:en_US`

- **-@option**
  This option allows you to pass the specified option to the Java VM.

- **-testheap**
  This option tests and displays the max heap size.

- **-buildreg**
  This option causes a rebuild of the registry.

**wb (Workbench) commands**

The `wb` command starts up an instance of Workbench. Use the following syntax with the `wb` command:

```
wb [options] <ord>
```

The following parameter may be used with the `wb` command.

- **ORD**
  This option specifies the ORD of the initial view that you want display when Workbench starts up.

The following options may be used with the `wb` command.

- **-profile**
  This option specifies the workbench profile to assign when Workbench starts up.

- **-file:ord**
  This option specifies the initial file to display when Workbench starts up.

- **-locale:<x>**
  This option sets the locale on startup.

- **-@<option>**
  This option allows you to pass the specified option to the Java VM.

**plat (platform) commands**

Use the following syntax with the `plat` command:

```
plat <command> <flags> <command-flags>
```

The following commands may be used with `plat`.

- **details**
  This command displays a configuration summary for a remote host.

- **fget**
  This command gets one or more files from a remote host.

- **flist**
  This command provides file details for a single file, or for all files in a directory.

- **ipconfig**
  This command displays the TCP/IP configuration for a remote host.
Types of console commands

Chapter A – References

April 4, 2011

- **jacejar**
  - This command creates Niagara module files that can be run on embedded hosts.

- **liststations**
  - This command lists stations that are managed by the Niagara platform daemon.

- **moduleinstall**
  - This command installs Niagara modules to a remote host.

- **reboothost**
  - This command requests that a remote Niagara platform daemon reboot its host.

- **script**
  - This command runs one or more platform commands in a script.

- **startstation**
  - This command requests that a Niagara platform daemon start a station.

- **stopstation**
  - This command requests that a Niagara platform daemon stop a station.

- **tellstation**
  - This command sends text to the console of a running Niagara station.

- **watchstation**
  - This command monitors the output of a Niagara station.

- **installdaemon**
  - This command installs the Niagara platform service (Win32 only).

- **uninstalldaemon**
  - This command removes the Niagara platform service (Win32 only).

- **installdialup**
  - This command installs the Niagara dialup service (Win32 only).

- **uninstalldialup**
  - This command removes the Niagara dialup service (Win32 only).

The following options may be used with the `plat` command.

- **-usage**
  - `plat -usage` prints the help listing in the console
  - `plat <command> -usage` prints the command specific usage in the console

- **-?**
  - `plat -?` prints the help listing in the console
  - `plat <command> -?` prints the command specific usage in the console

- **-help**
  - `plat -help` prints the help listing in the console
  - `plat <command> -help` prints the command specific usage in the console

- **-locale:<x>**
  - This option sets the default locale (en_US).

- **-@<option>**
  - This option passes the option to the Java VM.

- **-builde**
  - This option forces a rebuild of the registry.
Glossary

- **action**: Action is a slot that defines a behavior that can be invoked on a component.

- **admin**: This term indicates one of two levels of permissions (admin and operator) available in NiagaraAX. Admin and Operator levels are also specified by the terms read, write, and invoke. So you may have permission-levels of operator Read, operator Write admired, domineered, and so on.

- **administrator**: This term typically describes a system or application user that can perform certain high-level functions that other users cannot perform.

- **agent**: An agent is a special object type that provides services for other object types. Agents are registered on their target types via the module manifest and queried via the registry interface.

- **alarm**: Alarms provide the ability to be notified when a special event occurs. See AlarmConsole or AlarmPortal for more information.

- **animate**: In NiagaraAX-3.x, animation allows you to change, or "update" graphics based on data values that come from object sources that are connected (or "bound") to them. In the PxEditor, right-click a property and select animate. See also, "Animating Graphics" on page 6-20.

- **API**: API is a Application Programming Interface. It defines how software engineers access the capabilities of software like the Niagara Framework.

- **applet**: A small Java program that can be embedded in an HTML page. Applets differ from full-fledged Java applications in that they are not allowed to access certain resources on the local computer, such as files and serial devices (modems, printers, etc.), and are prohibited from communicating with most other computers across a network. The common rule is that an applet can only make an Internet connection to the computer from which the applet was sent. See also BAppletView.bajadoc for more technical information.

- **archive**: Archive is a history that is stored in a different station from where it originated.

- **audit**: The Audit keeps a history of changes made by users. If enabled, it registers itself as the Auditor for the system when the service is started. One of the important aspects of security is the ability to analyze what has happened after the fact. See history-AuditHistoryService for more information.

- **BACnet**: BACnet refers to data communication protocol for Building Automation and Control Networks. Developed under the auspices of the American Society of Heating, Refrigerating and Air-Conditioning Engineers (ASHRAE), BACnet is an American national standard, a European pre-standard, and an ISO global standard. The protocol is supported and maintained by ASHRAE Standing Standard Project Committee 135. See the BACnet Guide for more information on BACnet in the Niagara Framework.

- **Baja**: Baja is a term coined from Building Automation Java Architecture. The core framework built by Tridium is designed to be published as an open standard. This standard is being developed through Sun’s Java Community Process as JSR 60. See Baja vs. Niagara in the Developer Guide for more information.

- **Bajadoc**: Bajadoc is the Baja reference documentation. Baja reference documentation includes both Java API details as well as Baja slot documentation. See help-BajadocViewer for more information.

- **binding**: A Binding is used to bind a Widget to a data source. Bindings are bound to one Object using an Ord. Subclasses are registered as agents on the type of objects to which they can be bound to. See also "Data binding" on page 6-20 for more information.
**bog file** A Bog file contains baja components. It can be a complete database or any collection of components. A bog file is a special file that can describe components in a database. All views can be used on components in a bog file just as if they were in a station. See “Bog Files” in the *NiagaraAX Developer Guide* for more information.

**bookmark** Bookmark identifies a single bookmark. See Bookmarks and About the bookmark side bar for more information.

**BooleanPoint** BooleanPoint defines a read only control point with only an output element. See also, “Types of control points” on page 3-1.

**BQL** BQL is an acronym for Baja Query Language. BQL has a select statement similar to the select statement of Structured Query Language (SQL). It is typically used to provide programmable access to information in Niagara. See “BQL” in the *NiagaraAX Developer Guide* for more details.

**bql scheme** The "bql" Scheme is used to encapsulate a BQL query.

**build** The build tool is used to build the Niagara Framework itself. You may utilize this build tool to manage your own Niagara modules. See “build.html” in the Developer Guide for more information.

**chart** A chart is a graphical representation of data. The HistoryChart is a view that allows you to view and configure charts of histories. See “Types of history views” on page 4-10 for more information.

**client** The client part of a client-server architecture. Typically, a client is an application that runs on one computer and relies on a server to perform some operations. For example, an email client is an application that enables you to send and receive e-mail.

**collection** A collection represents a group of objects, known as its elements. Some collections allow duplicate elements and others do not. Some are ordered and others unordered. See Collection.bajadoc for more technical information.

**color** Color stores a color specification via an alpha, red, green, and blue component. See BColor.bajadoc for more information.

**command** Command typically refers to an Action in the Niagara Framework. See “About point actions” on page 3-3 for more information on point commands.

**component** A component is the primary building block of the Niagara Framework. See also, “About components” on page 1-9.

**composite** A composite allows you to expose child slots of a component as slots on the parent. See “About composites” on page 3-21 for more information.

**connect** Connect refers to entering a valid address for a system to establish a connection, a user name and password. A connection creates an active session for use of the system.

**console** Console provides a simple runtime console for managing and debugging the station. See “About the console” on page 2-13 for more information.

**container** Containers allow you to logically group components. The current container is the component that contains the components in the display window. See baja-component Containers for more information.

**context** Context is used in operations that may perform differently depending on their context. Examples include operations that may require auditing or localization.

**control** The control module provides normalized components for representing control points. All control points subclass from the ControlPoint base class. Control points are typically used with the driver framework to read and write points in external devices. See “Control” in the *NiagaraAX Developer Guide* for more information.

**control point** In the narrowest terms, control points refer to the 8 point types found in the Baja control palette under the “Points” folder. See “About control points” on page 3-1.

In broader terms, control points include other components found in both the control and kitControl palettes. Most of these are "classed" from the 8 basic point types. See “Other control components” on page 3-2.
ControlPoint is the base class for all point types in the Baja control architecture. A ControlPoint typically maps to one value being read or written via a driver. All ControlPoints have a StatusValue property called "out". ControlPoints inherit from BooleanPoint, EnumPoint, NumericPoint and StringPoint.

If the predefined proxyExt is not a NullProxyExt then the point is considered a proxy point which means that it is a local representation of a point which actually exists in an external device. The driver framework is used to maintain synchronization.

credentials  Manage Credentials is available in the main Tools menu by selecting Manage Credentials... You can Reset or Remove selected Credentials or Remove All Credentials.

CSS  Cascading style sheet.

CSV  The CSV ("Comma Separated Values") file format is used to exchange data between applications. CSV is one format option that may be used for exporting data from tables in some NiagaraAX views (for example, history tables).

daemon  Daemon typically refers to the Niagara platform daemon, the server process required by a Niagara host to run a station. There is also a separate "dialup daemon" to handle dialup modem functions.

database  Database is used to store information. Examples of databases include the registry or a station database.

debug  Debug refers to testing or correcting software. The NiagaraAX Program Debugger provides debug capability for program components.

delete links  This action, available from the workbench toolbar removes the selected links.

dependencies  All modules include zero or one dependencies element. This element contains zero or more dependency elements which enumerate the module’s dependencies. Dependencies must be resolved by the framework before the module can be successfully used. Each dependency has one required attribute. The name attribute specifies the globally unique name of the dependent module. A dependency may also specify a bajaVersion and/or a vendor version. If the bajaVersion attribute is declared then it specifies the lowest bajaVersion of the dependent module required. It is assumed that higher versions of a module are backward compatible, thus any version greater than the one specified in a dependency is considered usable. Likewise the vendor and vendorVersion may be specified to declare a dependency on a specific implementation of a module. The vendor attribute may be specified without the vendorVersion attribute, but not vice versa. The required embed attribute specifies whether the dependency should be enforced on embedded Niagara devices.

The ModuleSpaceView supports the ability to right click a module and display all its dependencies. These dependencies are as declared by the module’s manifest. To compute the dependencies needed to use a specific API a new Dependencies command has been added to the BajadocViewer Menus. This command will compute all the classes and modules required to use a specific class in the API.

device extensions  DeviceExt is the abstract base class for device extensions which provide feature integrations between the device’s native protocol and model and the NiagaraAX framework-normalized model. See BDeviceExt.bajadoc for more information.

directory  Directory is the file type used to represent directories in "file space" implementations. See BDirectory.bajadoc for more information. See also, "Types of space" and "Types of files" on page 1-18.

disabled  Status disabled means a user manually disabled the component using the enabled property (enabled = false). Disabled always propagates down. For example if you set the network to "disabled", that forces all child devices disabled, which then forces all proxy points under each device disabled. See also, "About point status" on page 3-16.

disconnect  You may logoff a connection (for example, a platform, station, or application) by right-clicking the object in the tree and select Disconnect. This allows you to close a session without removing it from the tree. The "disconnected" object appears dimmed in the nav tree. Right-click and select Connect to reestablish a connection to the object.

discover  Discover allows you to find items that are defined using a driver’s framework. Refer to the Drivers Guide sections "About Device Discover, Add, and Match (Learn Process)” and “About Point Discover, Add, and Match (Learn Process)” for related examples.

domain  Security domains may be assigned to any component or set of components in the system. For example, security domains may be used to assign components into application domains such as
hvac, fire, and lighting or security domains can be used to assign components into customer groups such as tenant 1, tenant 2, etc.

**down** This term indicates a communication error at the network or device level. “Down” always propagates downward in a relational hierarchy. Down is controlled by the pingFail and pingOk methods. The reason why a device is down is always stored in the health.lastFailCause property.

**download** Download refers to passing data down to a device. You may download a station from its supervisor.

**driver** This term is used for software that provides a device-specific (or protocol-specific) framework for integration with another system. In NiagaraAX drivers have “manager” views that provide a consistent look and feel for configuring and learning of devices and points. The cornerstone of the driver tools is the ability to support batch edits and Learns. See also, “Driver Framework” in the NiagaraAX Developer Guide.

**element** The elements define the hierarchical structure of a document. The majority of elements have opening and closing tags. Within these tags, text or even the whole documents can be found. There are empty elements which contains only opening tags without any content.

An element may also model one single piece of information in the baja control architecture. The most common types of elements are:

- `BooleanElement`
- `NumericElement`
- `EnumElement`
- `StringElement`

All elements regardless of their value type share common attributes. Every element has a status property which provides a consistent mechanism to convey point status. Each element also contains a priority level for informational purposes. If the priority is PriorityLevel.none, this is not a prioritized element.

Elements are basic building blocks from which larger, more sophisticated control points are created. A control point contains one or more input elements and one or more output elements. Elements can also be linked between Baja Objects to move data.

**enumeration** Enumeration represents a value data item which has a fixed set of possible values. This set of values is called the Enumeration’s Range. The standard enumerations include:

- `alarm:AlarmRecordTypes`
- `alarm:AlarmTransition`
- `baja:Month`
- `baja:Weekday`
- `control:AlarmState`
- `control:AlarmType`
- `control:CollectionState`
- `control:DisableAction`
- `control:LoopAction`
- `control:NotifyType`
- `control:PriorityLevel`
- `control:Reliability`
- `control:TotalizationInterval`
- `driver:ArchiveMode`
- `driver:ArchiveResult`
- `driver:ArchiveState`
- `driver:PollFrequency`
- `driver:ProxyState`

See Enum Range Dialog or BEnum.bajadoc for more information.

**EnumPoint** EnumPoint defines a read only control point with only an output element. See also, “Types of control points” on page 3-1.

**export** Export refers to providing data from the system for external use. You can export any Table found in the workbench (anything built with bajaui:Table). The Table options menu (that little button to the right of the header), includes a Print and Export command. These commands allow you to export the ta-
extension  Extensions allow plug-in functionality to support features such as alarming and historical data collection. See also, "About point extensions" on page 3-10.

facets  Facets contain meta data – or additional data about an object. For example, "units of measurement" is a type of facet. See also, "About point facets" on page 3-7.

fault  Faults always propagate downward in a hierarchy relationship. The framework performs "fatal-fault" checking such as making sure a device is under the right network type. Fatal faults are also the mechanism used to perform licensing checks. Developers can also manage fault condition using the `configFail()` and `configOk()` methods. The reason a component is in fault is always stored in the `faultCause` property.

feature  A term that refers to a line in a license file that specifies a capability ("feature") for the associated framework. A feature is uniquely identified by a vendor and feature name. It contains an expiration and a set of optional properties. See also, "Workbench license manager" in the NiagaraAX-3.x Platform Guide.

file  This term (and icon) represents a file object in the file system of a session. See also, "Types of files" on page 1-18.

file scheme  The "file" scheme is used to identify files on the file system. All file Ords resolve to instances of `javax.baja.file.BIFile`. File queries always parse into a FilePath. File Ords include the following types:

- Authority Absolute: "/hostname/dir1/dir2"
- Local Absolute: "/dir1/dir2"
- Sys Absolute: "lib/system.properties"
- Station Absolute: "^config.bog"
- Relative: "myfile.txt"
- Relative with Backup: "../myfile.txt"

Sys absolute paths indicate files rooted under the Niagara installation directory identified via `Sys.getBajaHome()`. User absolute paths are rooted under the user home directory identified via `Sys.getUserHome()`. In the case of station VMs, user home is the directory of the station database.

filter  Filter is used to select specified items. An example is the Alarm Console Filter.

find  Find allows you to search for the selected string. The shortcut is F5. See Search Find for more information.

find files  Find Files allows you to find the all occurrences in the files. See Search Find Files for more information.

find next  Find Next allows you to find the next occurrence of the selected string. The shortcut is Ctrl + F (hold down Ctrl and press F).

find prev  Find Prev allows you to find the previous occurrence of the selected string. The shortcut is Ctrl + Shift + F (hold down Ctrl and Shift and press F).

flag  Flags are boolean values which are stored as a bitmask on each slot in a Baja Object. Some flags apply to all slot types, while some only have meaning for certain slot types.

folder  This object is a folder container in the file system of a session. See also, Folder.

format  Format is used to format Objects into Strings using a standardized formatting pattern language. The format String is normal text with embedded scripts denoted by the % percent character (use %%% to insert a real %). A script is one or more calls chained together using the . dot operator. Calls are mapped to methods using reflections. Given call "foo", the order of reflection mapping is:

- special call (see below)
- `getFoo(Context)`
- `getFoo()`
- `foo(Context)`
- `foo()`
- `get("foo")`

The following special functions are available to use in a script:

- `time()` calls Clock.time() to get current time as an AbsTime
• lexicon(module:key) gets the specified lexicon text
Examples of formats:
• "hello world"
• "my name is %displayName%"
• "my parent’s name is %parent.displayName%"
• "%value% [%status.flagsToString%] @ %status.priority%"
• "%time().toDateString%"
• "%lexicon(bajaui:dialog.error)%"

Fox Fox is a proprietary protocol which is used for all network communication between Stations as well as between the workbench and stations. Fox is a multiplexed peer to peer protocol which sits onto of a TCP connection.

fox scheme The "fox" Scheme is used to establish a Fox session. Fox is the primary protocol used by Niagara for IP communication. A "fox" query is formatted as "fox:" or "fox:<port>". If the port is not specified, then the default 1911 port is assumed.

FROM FROM is the mechanism to choose the extent. This may be a history or a class in a station. See ExtentBuilder for more information.

glyph A Glyph is a visual representation.

GotoFile In some views, this command allows you to go to a file that has been indexed with the file indexer. The shortcut is Ctrl + F7 (hold down Ctrl and press F7). See Search Goto File for more information.

GotoLine In some views, this command allows you to go to a line number in the file. The shortcut is Ctrl + G (hold down Ctrl and press G). See Search Goto Line for more information.

handle scheme The "h" Scheme is used to resolve a component by its handle. Handles are unique String identifiers for components within a componentSpace. Handles provide a way to persistently identify a component independent of any renames which modify a component’s slot path.

Help Help refers to the electronic documentation available. It includes electronic manuals as well as context specific help.

history History is an ordered Collection of timestamped records. Each history is identified by a unique id. Histories can be periodically archived to a remote history database (archive). A history database is a set of histories. History: is also used as a Scheme in Ords to refer to collected histories. See also, "About Histories" on page 4-1.

Home This term refers to a default page that appears as soon as you login to a station or application. In Niagara you can use navigation files ("nav" files) to create a unique navigation tree, including a home page, for each user or user-type. See also, "About the Nav file" on page 6-52.

host This is a term for a hardware system (or platform) that provides the operating environment for Niagara application. In a navigation tree, the host node is used to depict the platform, which is the first level of the navigation tree. Hosts always represent a physical piece of hardware. Localhost is a term used to indicate the local machine.

HTTP HTTP is short for HyperText Transfer Protocol, the underlying protocol used by the World Wide Web (World Wide Web). HTTP defines how messages are formatted and transmitted, and what actions Web Servers and browsers should take in response to various commands. For example, when you enter a URL in your browser, this actually sends an HTTP command to the Web Server directing it to fetch and transmit the requested Web Page. The other main standard that controls how the World Wide Web works is HTML, which covers how Web Pages are formatted and displayed.

HTTP is called a stateless protocol because each command is executed independently, without any knowledge of the commands that came before it. This is the main reason that it is difficult to implement World Wide Web sites that react intelligently to user input. This shortcoming of HTTP is addressed in a number of technologies, including Java, JavaScript and cookies.

icon An icon is a graphical representation. Icons are used in the workbench toolbar and nav tree.

image Image is a representation of a raster image.

import Import refers to receiving data from an external source. The Niagara Framework imports its Database from XML for backup and conversion.
**ip scheme** The "ip" Scheme is used to identify a BIpHost instance. Ords starting with "ip" are always absolute and ignore any base which may be specified. The body of a "ip" query is a DNS hostname or an IP address of the format "dd.dd.dd.dd".

**Java** Java is a high-level programming language developed by Sun Microsystems. Java source code files (files with a .java extension) are compiled into a format called bytecode (files with a .class extension), which can then be executed by a Java interpreter. Compiled Java code can run on most computers because Java interpreters and runtime environments, known as Java Virtual Machines (VMs), exist for most operating systems, including UNIX, the Macintosh OS, and Microsoft Windows. Bytecode can also be converted directly into machine language instructions by a just-in-time compiler (JIT).

Java is a general purpose programming language with a number of features that make the language well suited for use on the World Wide Web. Small Java applications are called Java Applets and can be downloaded from a Web Server and run on your computer by a Java-compatible World Wide Web browser. For more information, see http://java.com and http://java.sun.com/.


**learn** Learn allows you to discover and add items that are defined using the driver framework. Refer to the Drivers Guide sections "About Device Discover, Add, and Match (Learn Process)" and "About Point Discover, Add, and Match (Learn Process)" for related information.

**lexicon** A lexicon is used to provide alternative text for the workbench interface. For example, the text in menus, actions, and other things can be changed by using a custom lexicon entry. Lexicons also provides support for non-English languages. See also, "About lexicons" on page 1-19 and "Notes on English (en) lexicon usage" on page 9-7.

**links** Links are the relationships defined between components. Links provide the means to pass data between components. See "Links" in the Developer Guide for more information.

**local** Local is a scheme used in Ords. It is both a host scheme and a session scheme. It represents Objects found within the local VM. See also, "About schemes" on page 1-17.

**log** Log is used to log events. The LogHistoryService keeps a History of Niagara log records. If enabled, it registers itself as the LogHandler for the system when the service is started.

**logoff** Logoff refers to removing a user from an active session so that a password will have to be entered to logon for use of the system.

**logon** Logon is the act of entering a valid address, user name and password. This creates an active session for use of the system.

**match** Match is a feature provided in manager views that provide a "Discover" function. After discovery, the match feature makes it easier to properly configure and add objects (for example, points) to a "discovered" network.

**MIME** The Multipurpose Internet Mail Extensions (MIME) provide a mechanism to determine file type in a standardized way.

**module** The first step in understanding the Niagara architecture is to grasp the concept of modules. Modules are the smallest unit of deployment and versioning in the Niagara architecture. A module is:

- A JAR file compliant with PKZIP compression
- Contains a XML manifest in meta-inf/module.xml
- Is independently versioned and deployable
- States its dependencies on other modules and their versions
See "About modules" on page 1-6, or modules in the Developer Guide for more information.

**module scheme** The "module" Scheme is used to access BIFiles inside the module jar files. The module Scheme uses the "file:" Scheme's formatting where the authority name is the module name. Module que-
ries can be relative also. If the query is local absolute then it is assumed to be relative to the current module. Module queries always parse into a FilePath. See also, “About schemes” on page 1-17.

**monitor** Monitor refers to observing. The Ping Monitor periodically calls ping on all the “pingable” objects to monitor network and device health. PingMonitor provides built-in support to generate alarms when pingables are down. Refer to the Drivers Guide section “About Monitor” for more details.

**Mozilla** Mozilla is a browser used to access Web Pages from a Web Server. See http://www.mozilla.org/index.html for more information.

**name map** Name Map defines a new Display Name for a Language Code. You can Add Name Map to provide a new Display Name for a Language Code. A blank Language Code is used for all languages. You Right-click on the Property displayNames to delete or rename Name Map and displayNames_xx to delete or rename Name Map (xx) where xx is the Language Code. Bajadoc is available at BNameMap.bajadoc.

**nav file** Nav File stores XML nav markup. It allows you to define a navigation tree. You may use the NavFileEditor to modify this file. Bajadoc is available at BNavFile.bajadoc. See also, “About the Nav file” on page 6-52.

**network** Network is a collection of devices. In WorkbenchAX, the Device Manager view provides a summary of an attached network. See “About Network architecture” in the Drivers Guide for more information.

**Niagara Framework** The Niagara Framework is a system designed to manage and control information. Its primary application is for control systems because of its powerful and flexible integration capabilities. The system is made up of Stations that run the components of the Niagara Framework and views that provide the ability to view and command these components. See “Baja vs. Niagara” in the NiagaraAX Developer Guide for more information.

**normalization** In NiagaraAX, this term is used to indicate “data normalization”. This refers to the process of making data and features from various different communications protocols work together so that they can be integrated. The Niagara framework provides a way to normalize data across various protocols so that it may be viewed and controlled from a single user interface.

**null** The null flag indicates that the associated value should not be used. It represents a “don’t care” condition. It is used in combination with priority arrays so that points may take or release control of their level in a priority array based on their current state. It is also used in math, logic and other application blocks that take a variable number of inputs. Any input with the null flag set is ignored.

**NumericPoint** NumericPoint defines a read only control point with only an output element. Bajadoc is available at BNumericPoint.bajadoc.

**object** An Object is the base class required for all objects which conform to the Baja model. See BObject.bajadoc for more technical information. See Object Model in the Developer Guide for more information on the model.

**offline** Offline refers to accessing a Bog File file directly when the Station is not running.

**open** Open allows you to open any of the following:

- Ctrl + L
- Ctrl + O
- 
- Ctrl + Shift + O
- Open Daemon (Niagarad)...

See the File menu reference for more information.

**operator** This term indicates one of two levels of permissions (admin and operator) available in NiagaraAX. Admin and Operator levels are further specified by the terms read, write, and invoke. So you may have permission-levels of: operatorRead, operatorWrite, adminRead, adminWrite, and so on.

**options** Options allow you to customize the workbench for the way you use it. It can be selected from the main Menu by selecting Tools > Options. See “Types of Workbench options” on page 2-25 for more information.
ORD  Ord is an "Object Resolution Descriptor". An ORD is Baja's universal identification system for integrating heterogeneous naming systems into a single string. An ORD is composed of one or more queries. Each query has a Scheme which identifies how to parse and resolve the query into an Object.

```
ord := query (ws "|" ws query)*
query := scheme ws ":" ws body
scheme := alpha (alpha | digit)*
body := bodyChar (bodyChar)*
alpha := "a"-"z" | "A"-"Z" digit := "0"-"9" bodyChar := 0x32 - 0x127 except ":" ws := (space)*
```

Also see "Naming" in the NiagaraAX Developer Guide, and "About ORDs" on page 1-16.

overridden  Overridden indicates that the user has manually set the value of a component.

palette  Palettes allow you to save copies of your work for future use and are commonly associated with modules. Palette files may reside under a station file system or as part of a module. Also see "About palettes" on page 1-12 and "To create a palette" on page 10-10.

pathbar  In a workbench view, the part of the locator bar that shows your current path (not including the view selector) is referred to as the pathbar. The pathbar automatically updates each time a new view is selected to display the Ord of each view. It also allows you to select part of the Ord, by clicking on it, to select a destination. See "About the locator bar" on page 2-14 for more information.

permissions  Permissions define what rights a user has within each of the categories in a station. There are two Niagara permission levels: operator and admin. Within both levels, separate options exist for read access, write access, and invoke (action) access. See also, "Permissions and security" on page 7-5.

pin slots  This function provides the capability to make Properties of a component visible in the Wiresheet view of the component. See also, "Pin Slots" on page 12-17.

platform  Platform is the Niagara Platform Definition. See also, NiagaraAX Platform Guide.

plugin  A This is the term for a visualization (or view) for a component. A WbPlugin is a widget designed to provide plugin functionality in the Workbench tool environment.

point extension  Point extensions allow control point behavior to be extended in a consistent manner. Each property of a ControlPoint that subclasses from a PointExtension is considered an extension on the point. Extensions allow plug-in functionality such as alarming and historical data collection via special hooks that a ControlPoint provides to PointExtension.

print  Print provides automatic generation of a PDF for a view. Most standard widgets including labels, point widget, tables, Charts, and most layout panes are handled. Access to the PDF visualization is through the Print command in both Workbench and browser views.

profile  Profiles provide NiagaraAX software engineers with the ability to customize both the desktop Workbench and the Web Workbench interface. In addition, the type of profile used to log in to the station can result in certain views being inaccessible even if the user has permissions to access the view. See also, "About profiles" on page 6-29.

properties  Properties are the visible data associated with a component. They provide the primary means of interacting with components. Most components properties are visible in the component property sheet view.

proxy  Proxy is used locally to represent a remote object. See "About the proxy extension" on page 3-11 for more information.

ProxyExt  ProxyExt is the point extension supported in ControlPoints which are proxies for point data in an external system. See "About the proxy extension" on page 3-11.

Px file  A Px file contains Baja components. It can be a complete Database or any Collection of components. A Px File is a special file that can provide a visualization for components in a Database. The PxEditor is a view used to create and modify Px files. All views can be used on components in a Px just as if they were in a Station. Also see "About Px files" on page 6-3.

query  Query is part of an "Object Resolution Descriptor". An ORD is composed of one or more queries. Each query has a scheme which identifies how to parse and resolve the query into an object. A query is made up of a scheme and a body. Also see, "Naming" in the NiagaraAX Developer Guide "About ORDs" on page 1-16.

range  For an enum typ component, this is a range of ordinal/name pairs. Also, see Enum Range Dialog or "Effect of facets on point actions" on page 3-9.
**redo**  This toolbar button or menu item causes an Action to be redone. It is only available after an undo. The shortcut is Ctrl + Alt + Z (hold down Ctrl and Alt and press Z).

**refresh**  This toolbar button or menu item refreshes a page after its source has been edited, or if you encounter a reason to reload the view.

**registry**  The registry is a term for a small Database built by Niagara Framework whenever it detects that a module has been added, changed, or removed. The registry may be used to interrogate the system for summary information about the modules, types, Ord Schemes, and Agents installed without loading modules into memory.

**rename**  Rename allows you to change the name of a component. It is available on a component’s popup menu.

**reorder**  This toolbar and popup menu command is used to open Reorder dialog box when viewing a component’s slot sheet. A reorder command is also available in the Point Manager view and in the Px Editor.

**replace**  This search function feature allows you to replace the next occurrence in the currently opened file.

**replace files**  Replace Files allows you to replace the all occurrences in the files.

**restart**  This command restarts the selected station.

**scheme**  Scheme is part of an "Object Resolution Descriptor". The scheme identifies how to parse and resolve the query into an Object. The scheme "local" is both a Host scheme and a session scheme. It represents objects found within the local VM. Some common schemes include:

- ip Scheme
- fox Scheme
- file Scheme
- module Scheme
- station Scheme
- slot Scheme
- handle Scheme
- spy Scheme
- bql Scheme

See "Naming" in the Developer Guide and "About ORDs" on page 1-16.

**security**  Security in the Niagara framework covers some broad topics:

- Authentication: Logging in and verifying a user
- Encryption: When and how to use cryptography to secure data
- Permissions: Configuring and verifying user Permissions on objects
- Auditing: Logging user actions to create an audit trail

The heart of the Niagara security architecture is embodied by the UserService. The UserService contains a Table of SecurityDomains (see Security model overview), Profiles (see Security model overview), and Users. Domains are used to build groups of objects with common security needs. Profiles are used to define Permissions across zero or more Domains. Users are assigned to a Profile and used to represent an entity (human or machine) requiring authentication and security checks. See Security in the Developer Guide for more information.

**SELECT**  This is the primary statement used to access information in a Database. See workbench:ProjectionBuilder for more information.

**selection**  The selection is the set of currently selected items. Most operations in the system act on the selected items.

**servlet**  A Java program that runs as part of a network service, typically an HTTP Web Server and responds to requests from clients. The most common use for a servlet is to extend a Web Server by generating World Wide Web content dynamically. For example, a client may need information from a database; a servlet can be written that receives the request, gets and processes the data as needed by the client and then returns the result to the client. Applets are also written in Java but run inside the JVM of an HTML browser on the client. Servlets and Applets allow the server and client to be extended in a modular way by dynamically loading code which communicates with the main program via a standard programming interface. See also HttpServlet.bajadoc for more technical information.
Sidebar allows you to choose whether to view sidebars by selecting **Window > Side Bars > Show Side Bar** from the main menu. You can also select which sidebars you would like to view. See “About side bars” on page 2-3 for more information.

**slot** Slots are the building blocks for defining Niagara components. There are three types of slots:

- Property
- Action
- Topic

Also see “About slots” on page 1-9.

**slot scheme** The “slot” Scheme is used to resolve a Value within a Complex by walking down a path of slot names. Slot queries always parse into a SlotPath. Also see “About slots” on page 1-9 and “About ORDs” on page 1-16.

**space** Space defines a group of Objects which share common strategies for loading, caching, lifecycle, naming, and navigation. Also see “Types of space” on page 1-18.

**spy scheme** The “spy” scheme is used to navigate spy pages. The javax.baja.spy APIs provide a framework for making diagnostics information easily available. Also see “Types of schemes” on page 1-17.

**SQL** SQL is an acronym for Structured Query Language. SQL is an American National Standards Institute (ANSI) standard for accessing Database systems.

**stale** Stale indicates that a situation has occurred which renders data untrustworthy. How stale is determined is a driver specific issue. However the common case is that a period of time has elapsed without a successful read. TuningPolicy provides a staleTime property for configuring this period of time.

**station** Station is the component which represents a station in the Baja framework. See “About stations” on page 1-15, or “Station” in the **Developer Guide** for more information.

**station scheme** The “station” Scheme is used to resolve the componentSpace of a station Database. Also see “Types of schemes” on page 1-17.

**status** Status provides a bit mask for various standardized status flags in the Baja control architecture. Plus it provides for arbitrary extensions using facets. Also see, “About point status” on page 3-16.

**statuscolors** StatusColors are configurable by the baja lexicon and accessible by the Status API. You may use the **LexiconEditor** to change these values. Entries include alarm, disabled, fault, down, overridden and stale:

```
Status.alarm.bg=#FFFF0000 Status.alarm.fg=#FFFFFFFF
Status.disabled.bg=#FFD88AFF Status.disabled.fg=#FF000000
Status.fault.bg=#FFFFAA26 Status.fault.fg=#FF000000
Status.down.bg=#FFFFFF00 Status.down.fg=#FF000000
Status.overridden.bg=#FF86BEFF Status.overridden.fg=#FF000000
Status.stale.bg=#FF00FF00 Status.stale.fg=#FF000000
```

The WireSheet options allow you to choose whether to Show Status Colors. Also see, “Types of status flags” on page 3-16.

**StatusFormat** StatusFormat is used to provide a simple pattern language for formatting status values. Patterns are strings with script commands embedded using the % character:

```
"Value=%value% Status=%status%"
```

Examples:

- %value% = value using facets
- %value(precision=2)% = value using 2 decimal places
- %value(units=null)% = value using facets with no units
- %value(units=null|precision=i:2)% = combination of previous two
- %status% = status fully specified
- [%status.flags%] %status.facets% = same as %status%
- %status.flags% = status flags, but not facets
- %status.facets% = status facets, but not flags
- %status.activeLevel% = status active level
- %value% [%status.flags%] @ %status.activeLevel%

The BNF grammar for the pattern language:
script := valScript | statusScript
valScript := "value" [ "(" valFacets ")" ]
valFacets := valFacet [ "|" valFacet ]
valFacet := valAddFacet | valRemoveFacet
valAddFacet := name "=" value
valRemoveFacet := name "=null" value := DataUtil.marshal & unmarshal
statusScript := "status" [ "." statusSubset ]
statusSubset := statusFlags | statusFacets | statusFacetKey
statusFlags := "status.flags"
statusFacets := "status.facets"
statusFacetKey := "status." name

Also see, the Engineering Note document, BFormat (Baja Format) Property Usage.

StringPoint  StringPoint defines a read only control point with only an output element. Bajadoc is available at BStringPoint.bajadoc. See also, “Types of control points” on page 3-1.

subclasses Subclasses provides a subclass tree of all that are subclassed from this item.

tab Tab allows you to view multiple views in the same Window. See "Creating tabs in the view pane" on page 2-21 for more information.

table Table displays a grid of rows and columns. See also, “Table controls and options” on page 2-18.

tag An element bounded by the marks "<" and ">" is a tag. Tags are used to mark the semantic or the structure of a document. HTML and XML use tags. A sample is the tag <title> to mark the beginning of a title. See HTML Tags in the WbHtmlView for more information on tags supported by the HtmlView plugin.

toolbar A Toolbar is a row of button used to provide quick access to commonly used features. In the Niagara Framework there are two rows of buttons on the toolbar. The first are the common buttons that are always available. The second are the buttons based on the current view, mode and Selection. See also, “About the toolbar” on page 2-13

topic Topic defines a slot which indicates an event that is fired on a component. Also see “About slots” on page 1-9

undo This reverses the last Action as if it had not been performed. In Niagara it is only available for some actions. The shortcut is Ctrl + Z (hold down Ctrl and press Z).

up level Up Level allows you to go to the next level up. The shortcut is Alt + Up. See “Types of toolbar icons” on page A-13 for more information.

upload Upload refers to receiving data from a device. In Niagara you may upload a station to its supervisor so that you have a backup of its database.

URI Uniform Resource Identifiers (URIs, aka URLs) are short strings that identify resources in the World Wide Web: documents, images, downloadable files, services, electronic mailboxes, and other resources. They make resources available under a variety of naming schemes and access methods such as HTTP, FTP, and Internet mail addressable in the same simple way.

URI is an extensible concept: there are a number of existing addressing schemes, and more may be incorporated over time.

URL Uniform Resource Locator (URL) is the standard way of addressing over the Internet. The Niagara Framework uses this convention for many of its resource locations.

user This term represents is a valid name. It is used to logon to the system with a valid password.

view There are many ways to view your system. One way is directly in the tree. In addition, you can right-click on an item and select one of its views from the popup menu. Plugins also provide views of components. See “About the view selector” on page 2-15 and Viewing components for more information.

Web server A Web Server is a computer that delivers (serves up) Web Pages. Every Web server has an IP address and possibly a domain name. For example, if you enter the URL http://www.niagaraframework.com/ in your browser, this sends a request to the server whose domain name is niagaraframework.com. The server then fetches the page named index.html and sends it to your browser. Any computer can be turned into a Web server by installing server software and connecting the machine to the Internet. There are many Web server software applications, including public domain software from NCSA and Apache, and commercial packages from Microsoft, Netscape and others.

WHERE The Where clause is used to specify that only certain rows of the Table are displayed, based on the criteria described in that Where clause. See workbench:QualifierBuilder for more information.
**widget**  Widget is a class used to create light weight user interface components which can seamlessly be used in both the bajaui toolkit and in a 1.1 Applet environment.

**window**  A Window is a graphical area used to present a view of the system. This can refer to the primary window with Locator and tree or user created windows. See “Creating Additional Windows” on page 2-20 for more information.

**wizard**  Wizards are used to guide the user through common tasks. Some common wizards include:

- New Station Wizard
- Commissioning Wizard
- New Module Wizard

**Workbench**  This is the name for Niagara’s Integrated Development Environment (IDE) for non-programmers.

**XML**  eXtended Markup Language (XML) is a standard for tagging data. It is a subset of the Standard Generalized Markup Language (SGML) like HTML. See XML in the Developer Guide for more information.